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Preface

This preface introduces the CodeWarrior® Integrated Development Environment (IDE)
and its documentation. It contains the following sections:

. About this book on page viii
. Feedback on page xiii.
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About this book

Intended audience

Using this book

This book provides user information for CodeWarrior for the ARM Developer Suite. It
describes the major graphical user interface components of the CodeWarrior IDE, and
provides information on ARM-specific features.

This book is written for all developers who are using the ARM version of the
CodeWarrior IDE to manage their ARM-targeted development projects under Windows
NT, 95, 98, or 2000. It assumes that you are an experienced software developer, and that
you are familiar with the ARM development tools, as described in Getting Started. It
does not assume that you are familiar with the CodeWarrior IDE.

This book is organized into the following chapters:

Chapter 1 Introduction

Read this chapter for an introduction to the CodeWarrior IDE, and for a
summary of how it is used with the ARM development tools.

Chapter 2 Working with Projects

Read this chapter for details of how to use CodeWarrior project files to
organize your project source files, and specify the output from compiling
and linking your source. This chapter gives details of how to structure
multiple build targets, control dependencies between build targets, and
use other structural elements of a CodeWarrior project.

It also describes the ARM project stationery provided with the
CodeWarrior IDE, and describes how to use and modify the default
stationery to generate ARM and Thumb® executable images, libraries,
and disassembled code listings.

Chapter 3 Working with the ARM Debuggers

Read this chapter for details of how to use the ARM debuggers with the
CodeWarrior IDE. It describes how the CodeWarrior IDE interacts with
the ARM debuggers. It also describes parts of the CodeWarrior IDE that
are useful for finding errors in your code, such as the CodeWarrior IDE
message window.

viii
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Chapter 4 Working with Files

Read this chapter for details of how to work with source files in the
CodeWarrior IDE. This chapter provides basic information on managing
your source files, and describes how to use the CodeWarrior IDE file
comparison and merging functions.

Chapter 5 Editing Source Code

Read this chapter for details of how to use the CodeWarrior IDE built-in
text editor. It describes the basic functionality of the CodeWarrior editor,
and provides information on useful file navigation techniques that enable
you to find related header and source files, find function definitions, and
add markers to your source code.

Chapter 6 Searching and Replacing Text

Read this chapter for details of how to use the CodeWarrior IDE find and
replace facility to search text files and replace found text. It also describes
the CodeWarrior IDE batch search facilities that enable you to search
multiple source files and directories, and define named file lists for search
operations.

Chapter 7 Browsing Source Code

Read this chapter for details of how to use the CodeWarrior IDE browser
to view your source code from a number of object-oriented perspectives,
including class-based and inheritance-based views.

Chapter 8 Configuring the IDE

Read this chapter for details of how to set CodeWarrior IDE
configuration options that apply across all projects. It describes general
interface options, editor options, and syntax coloring options. In addition
it gives information on configuring command keybinding and the
CodeWarrior IDE toolbars.

Chapter 9 Configuring a Build Target

Read this chapter for important information on configuring
target-specific options for build targets within your projects. It describes
how to use the CodeWarrior IDE to configure options for the ARM
compilers, assembler, debuggers, fromELF, and other tools, to produce
machine code for execution on an ARM processor.

It also describes how to configure important target-specific options for
the CodeWarrior IDE, such which linker and postlinker to use, and the
access paths and file mappings that apply to a build target.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. ix
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Chapter 10 Using CodeWarrior IDE with Version Control Systems
Read this chapter for general information on using the CodeWarrior IDE
with version control systems such as SourceSafe and CVS.

Appendix A Perl Scripts

Read this appendix for general information on using Perl in conjunction
with the CodeWarrior IDE. It describes how to install and configure
plug-in support for Perl, and describes special considerations for using
Perl from the CodeWarrior IDE.

Appendix B CodeWarrior Reference

Read this appendix for a quick reference summary of the Code Warrior
IDE menu commands and default key bindings.

Typographical conventions
The following typographical conventions are used in this book:

typewriter  Denotes text that can be entered at the keyboard, such as commands, file
and program names, and source code.

typewriter  Denotes a permitted abbreviation for a command or option. The
underlined text can be entered instead of the full command or option
name.

typewriter italic
Denotes arguments to commands and functions where the argument is to

be replaced by a specific value.

italic Highlights important notes, introduces special terminology, denotes
internal cross-references, and citations.

bold Highlights interface elements, such as menu names and buttons. Also
used for terms in descriptive lists, where appropriate. Also denotes ARM
processor signal names.

typewriter bold

Denotes language keywords when used outside example code.

X Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Further reading

Preface

This section lists publications from both ARM Limited and third parties that provide
additional information on developing code for the ARM family of processors.

ARM periodically provides updates and corrections to its documentation. See
http://www.arm.com for current errata sheets and addenda.

See also the ARM Frequently Asked Questions list in the Technical Support area of the
ARM web site at http://www.arm.com.
ARM publications

This book contains information that is specific to the version of the CodeWarrior IDE
supplied with the ARM Developer Suite (ADS). Refer to the following books in the
ADS document suite for information on other components of ADS:

. ADS Installation and License Management Guide (ARM DUI 0139)

. ADS Assembler Guide (ARM DUI 0068)

. Getting Started (ARM DUI 0064)

. ADS Compiler, Linker, and Utilities Guide (ARM DUI 0067)

. ADS Debuggers Guide (ARM DUI 0066)

. ADS Debug Target Guide (ARM DUI 0058)

. ADS Developer Guide (ARM DUI 0056).

The following additional documentation is provided with the ARM Developer Suite:

. ARM Architecture Reference Manual (ARM DDI 0100). This is supplied in
Dynatext and PDF format.

. ARM Applications Library Programmer’s Guide. This is supplied in Dynatext
and PDF format.

. ARM ELF specification (SWS ESPC 0003). This is supplied in PDF format in
install_directory\PDF\specs\ARMELF.pdf.

. TIS DWARF 2 specification. This is supplied in PDF format in
install_directory\PDF\specs\TIS-DWARF2.pdf.

. ARM/Thumb Procedure Call Standard specification. This is supplied in PDF
format in install_directory\PDF\specs\ATPCS.pdf.

ARM DUI 0065C
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In addition, refer to the following documentation for specific information relating to
ARM products:

. ARM Reference Peripheral Specification (ARM DDI 0062)

. the ARM datasheet or technical reference manual for your hardware device.

Other publications

This book provides information specific to the ARM version of the Metrowerks
CodeWarrior IDE. For more information on Metrowerks, and the CodeWarrior IDE
generally, including version control plug-in availability, visit the Metrowerks web site
at http://www.metrowerks.com.

The following books are referenced in the text:

Friedl, J., Mastering Regular Expressions, 1997, O’Reilly & Associates, International
Thomson Publishing. ISBN 1565922573.

xii
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Preface

ARM Limited welcomes feedback on both the ARM Developer Suite and its
documentation.

Feedback on the ARM Developer Suite

Feedback on this book

If you have any problems with the ARM Developer Suite, please contact your supplier.
To help them provide a rapid and useful response, please give:

details of the release you are using

details of the platform you are running on, such as the hardware platform,
operating system type and version

a small stand-alone sample of code that reproduces the problem

a clear explanation of what you expected to happen, and what actually happened
the commands you used, including any command-line options

sample output illustrating the problem

the version string of the tool, including the version number and date.

If you have any problems with this book, please send email to errata@arm.com giving:

the document title

the document number

the page number(s) to which your comments apply
a concise explanation of the problem.

General suggestions for additions and improvements are also welcome.

ARM DUI 0065C
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Chapter 1
Introduction

This chapter introduces the CodeWarrior IDE. It contains the following sections:
. About the CodeWarrior IDE on page 1-2

. About CodeWarrior for the ARM Developer Suite on page 1-4

. Where to go from here on page 1-6.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved.
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Introduction

1.1 About the CodeWarrior IDE

The CodeWarrior IDE provides a simple, versatile, graphical user interface for
managing your software development projects. You can use CodeWarrior for the ARM
Developer Suite to develop C, C++, and ARM assembly language code targeted at
ARM and Thumb processors. It speeds up your build cycle by providing:

. comprehensive project management capabilities

. code navigation routines to help you locate routines quickly.

The CodeWarrior IDE enables you to configure the ARM tools to compile, assemble,
and link your project code.

Note
Throughout this book, the term compile, and compilation apply generically both to
compiling C and C++ source files, and assembling ARM and Thumb assembly
language source files.

There are two distinct meanings of zarget in CodeWarrior terminology:

Target system The specific ARM-based hardware, or simulated hardware, for
which you write code. For example, if you are writing code to run
on an ARM development board, the development board is referred
to as the target system.

Build target The collection of build settings and files that determines the
output that is created when you build your project.

The CodeWarrior IDE enables you to organize source code files, library files, other
files, and configuration settings into a project. Each project enables you to create and
manage multiple configurations of build target settings. For example, you can compile
a debugging build target and an optimized build target of code targeted at hardware
based on an ARM7TDMI™. Build targets can share files in the same project while using
their own settings.

The CodeWarrior IDE provides:

. a source code editor that provides syntax coloring, and is integrated with the
CodeWarrior IDE browser

. a source code browser that keeps a database of symbols defined in your code, and
enables you to navigate through your source code quickly and easily

. search and replace capabilities that enable you to use grep-style regular
expressions, and perform batch searches through multiple files

1-2
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. file comparison capabilities that enable you to locate, and optionally merge the
differences from one text file to another, and to compare the contents of
directories.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 1-3
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1.2 About CodeWarrior for the ARM Developer Suite

CodeWarrior for the ARM Developer Suite is based on Metrowerks CodeWarrior IDE
version 4.0. It has been tailored to support the ARM Developer Suite toolchain. It
provides:

ARM-specific configuration panels that enable you to configure the ARM
development tools from within the CodeWarrior IDE

ARM-targeted project stationery that enables you to create basic ARM and
Thumb projects from the CodeWarrior IDE.

Although most of the ARM toolchain is tightly integrated with the CodeWarrior IDE,
there are a number of areas of functionality, that are not implemented by the ARM
version of the CodeWarrior IDE. In most cases, these are related to debugging, because
the ARM debuggers are provided separately. In particular:

There are a number of configuration dialogs that are not used by the ARM
toolchain, such as the Runtime Settings target configuration dialog. See Chapter 9
Configuring a Build Target for more information on target configuration.

The ARM debuggers are not tightly integrated with the CodeWarrior IDE. This
means, for example, that you cannot set breakpoints or watchpoints from within
the CodeWarrior IDE. See How the ARM debuggers work with the CodeWarrior
IDE on page 3-2 for more information.

There are a number of menu commands and windows that are not implemented
by the ARM version of the CodeWarrior IDE. The menu commands and windows
not used by CodeWarrior for the ARM Developer Suite are:
File menu

The Import components menu item.

Project menu
The Precompile menu item. The ARM compilers do not support
precompiled headers.

Debug menu

None of the menu commands in the Debug menu are applicable to
ARM. See Chapter 3 Working with the ARM Debuggers for more
information.

1-4
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The following Browser menu items are not used:

Window menu

New Property
New Method
New Event Set

New Event.

The following windows are not used by CodeWarrior for the ARM
Developer Suite:

Help menu

Processes window
Expressions window

Global Variables window
Breakpoints window
Watchpoints window
Register window
Component Catalog window

Component Palette

The only help menu item used by CodeWarrior for the ARM Developer
Suite is the How to... menu item.

Interface items that are not used by the CodeWarrior for the ARM Developer Suite are
documented as Not used by CodeWarrior for the ARM Developer Suite in the
documentation and the online help.

If you are familiar with the CodeWarrior IDE in other environments, you will also
notice that some areas of functionality have been removed completely for the ARM
version, such as Rapid Application Development templates.

ARM DUI 0065C
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1.3 Where to go from here

The following documentation and examples will help you get started with the

CodeWarrior IDE:

. Read the Getting Started guide for a quick introduction to CodeWarrior for the
ARM Developer Suite.

. Examine the example ARM projects provided in the examples subdirectory of

your ADS installation directory.

. See Chapter 2 Working with Projects for detailed information on setting up your
CodeWarrior projects.

Note

If you are setting up a complex project environment please refer to Configuring
CodeWarrior for complex or multi-user projects on page 2-51 for important
information.

. See Chapter 9 Configuring a Build Target for information on configuring the
ARM toolchain from within the CodeWarrior IDE.

1.3.1 Online documentation and online help

Documentation for CodeWarrior for the ARM Developer Suite is available online as
part of the ARM Developer Suite documentation collection. If you have installed the
ADS using the default name, select Programs — ARM Developer Suite v1.1 —
Online Books from the Windows Start menu to access the collection.

In addition, CodeWarrior for the ARM Developer Suite provides context-sensitive
online help. Select How to... from the Help menu to open the main online help. Press
F1, or use the Windows help button to access context-sensitive online help.

1-6 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Chapter 2
Working with Projects

This chapter introduces the CodeWarrior IDE project file and shows how to create,
configure, and work with projects. It contains the following sections:

. About working with projects on page 2-2

. Overview of the project window on page 2-4

. Working with simple projects on page 2-13

. Working with project stationery on page 2-24

. Managing files in a project on page 2-37

. Configuring CodeWarrior for complex or multi-user projects on page 2-51
. Working with multiple build targets and subprojects on page 2-53

. Compiling and linking a project on page 2-72

. Processing output on page 2-81.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 2-1
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2.1 About working with projects

CodeWarrior IDE projects are the highest level structural element that you can use to
organize your source files and determine their output. This chapter describes many of
the basic tasks involving projects, such as:

. creating projects

. opening projects

. adding files to projects

. saving projects

. moving files in the project window.

It also describes more complex operations, including:

. creating nested projects
. creating multiple build targets
. dividing the project window into groups of files.

In addition, it describes:

. how the CodeWarrior IDE uses project stationery

. the ARM-specific project stationery provided with this version of the
CodeWarrior IDE

. how you can configure and use your own project stationery.

211 Project structure overview

A CodeWarrior project is a collection of source files, library files, and other input files.
You can organize the files in a project in various ways to provide a logical structure to
your source. The most important structural element in a project is the build target. The
build target defines how the source files within a project are processed, not the
CodeWarrior project itself.

Build targets

Every CodeWarrior IDE project defines at least one build target. A build target is a
specific configuration of build options that are applied to all, or some of the source files
in a project to produce an output file, such as an executable image, library, or code
listing.

Complex projects can define up to 255 build targets. You can use multiple build targets
to build different kinds of output files from one project file. For example, the
ARM-supplied stationery projects define at least three build targets, shown in

Figure 2-5 on page 2-12. See Using ARM-supplied project stationery on page 2-24 for
more information on ARM project stationery.

2-2

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with Projects

When you select build options for your project you apply them specifically to one or
more build targets. See Chapter 9 Configuring a Build Target for detailed information
on setting build options.

You can define a specific build order for the build targets in a project, so that the
CodeWarrior IDE builds one build target before building another, and optionally links
the output from the build targets. This means that you can create a build target that
depends on the output from some other build target. See Creating build target
dependencies on page 2-61 for more information.

Each build target in a project contains a collection of elements that the CodeWarrior
IDE uses to build the output file. Build targets within a project can share some, or all,
of their elements. A build target can include:

Source files and libraries

These are the basic input files for your project. They can be organized
into groups, or included from other build targets and project files. You
can use the project window to customize how individual source files are
treated in a build target. For example, you can turn debugging on and off,
compile, preprocess, and check the syntax of individual source files.

You can also specifically exclude an individual source file from a build
target. This enables you, for example, to have a proven but slow C
language implementation of an algorithm for debugging, and an
optimized assembly language implementation for product release.

Groups These are groups of files and libraries. You can group related source files
or libraries together to help organize your project sources conveniently.

Other build targets

You can use the output from one build target as input to another, or create
independent build targets that generate different types of output. You can
use dependent build targets, for example, to combine output objects from
ARM and Thumb build targets into a single output image. See Working
with multiple build targets and subprojects on page 2-53 for detailed
information on build targets.

Subprojects

These are independent projects that you include in your main project.
They can contain the same kinds of elements, such as files, build targets
and additional subprojects, as the main project. See Creating subprojects
within projects on page 2-67 for more information.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 2-3
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2.2 Overview of the project window

The project window shows information about the files and build targets in your project
file. The project window uses three distinct views to display your files and build targets:

. the Files view
. the Link Order view
. the Targets view.

The following sections describe the project window in detail:
. Navigating the project window
. Project views.

221 Navigating the project window

To navigate the project window, use the vertical scroll bar on the right side of the
window, or the Up and Down Arrow keys on your keyboard. If the project window
contains many files, use the Home key to scroll to the top of the list, or use the End key
to scroll to the end of the list.

Use the Page Up and Page Down keys to scroll one page up or one page down the
project window. See Selection by keyboard on page 2-37 for information on how to
select files as you type.

Using the Project Window toolbar

The toolbar in the project window has buttons and other items that provide shortcuts to
commands and information about the project. You can choose the items to display on
the toolbar, and the order in which those items are displayed. You can also choose to
hide or display the toolbar itself. See Customizing toolbars on page 8-37 for more
information on configuring toolbars in the CodeWarrior IDE.

2-4
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2.2.2 Project views

The project window provides three distinct views on the files, groups, and subprojects
that make up your project. These are:

. the Files view
. the Link Order view
. the Targets view.

To choose a view, click its tab at the top of the project window, as shown in Figure 2-1.

Click a tab to change view

S’
| ¥). CebugRel j

Figure 2-1 View tabs at the top of the project window

The project views are described in:

. Files view on page 2-5

. Link Order view on page 2-9
. Targets view on page 2-12.
Files view

The Files view (Figure 2-2 on page 2-6) shows a list of all the files, groups, and

subprojects for all the build targets in the project. You can use this view to arrange your
project into hierarchical groups without affecting the way the CodeWarrior IDE handles
a build target. This view also displays information about modification status, file access
paths, code size, data size, current build target, debugging status, and other information.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 2-5
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File column

Hierarchical
control

Touch column

Code column Data column Target column Debug column

-y
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Figure 2-2 Project window Files view
The Files view window contains the following columns:

File column

The File column lists project files and groups in a configurable
hierarchical view. A group can contain files and other groups. You can:

. Double-click a source filename in the File column to open the file
in the CodeWarrior editor, or a third-party editor set in the IDE
preferences panel.

. Click the hierarchical control to display and hide the contents of
groups.

. Right-click on a filename to display a pop-up menu of commands
that can be applied to the file. For example, to display the location
of the file, right-click the filename in the project window and select
Open in Windows Explorer from the pop-up menu.

The File column in the Files view displays all files in the current project,
whether or not they are included in the current build target.
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Code column

The Code column shows the size, in bytes or kilobytes, of the compiled
executable object code for files. For a group, the value is the sum of the
sizes for files in the group in the current target. If 0 is displayed in the
Code column, it means that your file has not yet been compiled. If n/a is
displayed, the file is not included in the current build target.

The values in this column do not necessarily reflect the amount of object
code that will be included in the final output file. By default, the linker
removes unused sections from input object files. See the description of
unused section elimination in the ADS Compiler, Linker, and Utilities
Guide for more information.

Data column

The Data column shows the size, in bytes, kilobytes (K), or megabytes
(M) of data, including zero-initialized data, but not stack space used by
the object code for files in the project. If 0 is displayed in the Data
column, it means that the file has not yet been compiled, or no data
sections are generated from this source code. If n/a is displayed, the file
is not included in the current build target.

Like the Code column sizes, the data values listed in the Data column are
not necessarily all added to the final output file. You can use the fromELF
utility to determine the sizes of code and data sections in the final output
image.

Debug column

The Debug column indicates whether debugging information will be
generated for individual files in a project if the ARM compilers and
assembler are not configured to generate debug information for all files
in the build target.

A black marker in this column next to a filename or group name indicates
that debugging information will be generated for the corresponding item.
A gray marker next to a group name indicates that debugging information
will be generated for only some of the files in the group.

To generate debugging information for a:

. file, click in the Debug column next to the file

. group, click in the Debug column next to the group
. project, Alt-click in the Debug column.

See Chapter 3 Working with the ARM Debuggers for detailed information
on how debug information is generated for files.
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Target column

The Target column indicates whether an item is in the currently selected
build target. The CodeWarrior IDE displays this column if a project has
more than one build target. A dark marker in this column next to a file or
group means that the corresponding item is in the current build target. A
gray marker next to a group indicates that only some of the files in that

group are in the current build target.

To assign or unassign a current build target for a:

. file, click in the Target column next to the file
. group, click in the Target column next to the group
. project, Alt-click in the Target column.

See Assigning files to build targets on page 2-58 for information on
adding or removing a file to or from a build target using the Target
column.

Touch column

The Touch column indicates whether a file is marked to be compiled,
assembled, or imported (libraries and object files). A marker in this
column next to a filename or group name indicates that the corresponding
item will be rebuilt at the next Bring Up To Date, Make, Run or Debug
command. A gray marker next to a group indicates that only some of the
files in that group are marked for compilation or assembly.

To touch or untouch:

. a file, click in the Touch column next to the file
. a group, click in the Touch column next to the group
. a project, Alt-click in the Touch column.

See Synchronizing modification dates on page 2-48 for more information.

Header Files pop-up menu

The Header Files pop-up menu:

. lists and opens header files for your project source files
. enables you to touch or untouch the selected item and set other
options.

For groups, the Header Files pop-up menu lists the files within the
group. Select a file from the pop-up menu to open that file. See Opening
header files from the Header Files pop-up menu on page 4-8 for more
information.

2-8
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File Control pop-up menu

The File Control pop-up menu is shown in Figure 2-3. To display this
pop-up menu, right-click on a filename or group name in the project
window.

From the File Control pop-up menu, you can choose a command to
operate on the selected item. The available commands depend on the
selected item. See Appendix B CodeWarrior Reference for more
information on the commands in this pop-up menu.

Open inwindows Explorer

Check Syntax
Preprocess
Compile
Dizaszamble

Delete

Figure 2-3 File Control pop-up menu in the project window

Checkout Status column

The Checkout Status column indicates whether files are checked in or
checked out of a Version Control System (VCS). This column is displayed
only if you configure your CodeWarrior project to use a source code
revision control system. See Chapter 10 Using CodeWarrior IDE with
Version Control Systems for more information.

Project Checkout Status icon

The Project Checkout Status icon shows:

. whether a project is writable

. the file access permissions for that project.

A revision control system can assign the permissions when you check in

or check out a project file. See Chapter 10 Using CodeWarrior IDE with
Version Control Systems for more information.

Link Order view

The Link Order view shows information about how the Code Warrior IDE will compile
and link the final output file for the current build target. Figure 2-4 on page 2-10 shows
an example.

ARM DUI 0065C
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When you add files to a project they are added in the same order in both the Files View
and the Link Order view. This means that, by default, the CodeWarrior IDE compiles
project files in the order shown in the Files view. You can change the order in which
files are compiled by rearranging them in the Link Order view. In addition, files are
displayed in the Link Order view only if they are included in the current build target.

Changing the order of files in the Link Order view can change the order in which the
object code is placed in the final binary output produced from your project. The
CodeWarrior IDE invokes the ARM linker with a list of object files in the order in which
they are compiled. By default, the ARM linker processes object files in the order in
which they are presented.

Note

The Link Order view is a convenient way to control the order in which source files are
processed. However, in general it is not advisable to depend the Link Order view to
control output image structure. The ARM Linker configuration panel provides limited
control over section placement. For finer control, use a scatter-load description file. See
Configuring the ARM linker on page 9-110 and the linker chapter of the ADS Compiler,
Linker, and Utilities Guide for more information.

I ¥ DebugRel j | g @ =3
[=] File | Code| Datalwf
¢ [ addc 0 0 =
¢ M hello.c I 0 =
¢ @ startup.c I 0 =
i
3 files 0 0 o

Figure 2-4 Example Link Order view

The Link Order view displays columns that are similar to those displayed in the Files
view. The most important difference is that there is no Target column in the Link order
view. The Link Order view gives information only for those files that are included in
the current build target. This means that a file must be selected in the Target column of
the Files view in order to be displayed in the Link Order view.
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The columns in the Link Order view are:

File column

The File column lists the files in the current build target. Unlike the Files
view, the Link Order view displays only files, not groups. Files are
displayed in the order in which they will be compiled, regardless of
whether they are in a group or not.

Code column, Data column, Debug column
These columns display the same information as in the Files view. See the
description in Files view on page 2-5 for more information.

Touch column

The Touch column indicates whether a file is marked to be compiled. A
marker in this column next to a filename indicates that the corresponding
item will be recompiled at the next Bring Up To Date, Make, Run or
Debug command.

To touch or untouch:
. a file, click in the Touch column next to the file
. the current build target, Alt-click in the Touch column.

See Synchronizing modification dates on page 2-48 for more information.

Header Files pop-up menu

The Header Files pop-up menu:

. lists and opens header files for your source files
. enables you to touch or untouch the selected item and set other
options.

See Opening header files from the Header Files pop-up menu on page 4-8
for more information.

File Control pop-up menu

Right-click on an entry in the project window to display the File Control
pop-up menu (Figure 2-3 on page 2-9 shows an example). The File
Control pop-up menu provides context-specific commands, depending
on the selected item.
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Targets view

The Targets view (Figure 2-5) shows information about the build targets in a project,
and build target dependencies.

The Targets view shows a list of the build targets in the project. This view also shows
the objects that the build targets depend on to create a final output file. Figure 2-5 shows
an example Targets view with the three default targets defined by the ARM stationery.
See Using ARM-supplied project stationery on page 2-24 for more information on the
DebugRel, Release, and Debug build targets. See Working with multiple build targets
and subprojects on page 2-53 for a detailed description of the Targets view, and for
information on working with build targets in general.

i g Example ARM Project. mcp _ (O]
Link. Order |
I ¥ DebugRel j (| @ @ =
] Targetz X
#. DebugRel =]

=
3 targets S

Figure 2-5 Example Targets view
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2.3 Working with simple projects

This section describes the basic project operations:

. Creating a new project

. Opening a project on page 2-15

. Closing a project on page 2-17

. Saving a project on page 2-18

. Importing makefiles into projects on page 2-19

. Choosing a default project on page 2-22

. Moving a project on page 2-22

. Importing and exporting a project as XML on page 2-23.

2.3.1 Creating a new project

The CodeWarrior IDE can base new projects on an existing, preconfigured project
stationery file that is used as a template for your new project. The CodeWarrior IDE
provides two options for creating new projects:

Projects based on project stationery

Project stationery can be preconfigured with libraries and source code
placeholders. Configuration options and build targets are predefined,
though you should still review some configuration options to ensure that
they are relevant to your development environment. This kind of project
file is useful for quickly creating new projects.

Empty projects

Empty projects do not contain any placeholder files or libraries, and use
default values for all tool configuration options. If you choose to create a
new empty project you must review all configuration options, define your
own build targets, and add all required libraries and files.

See Chapter 9 Configuring a Build Target for information on configuring project,
compiler, linker, and other target settings for your project. See Working with project
stationery on page 2-24 for more information on project stationery.
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To create a new project:

1. Select New... from the File menu. The CodeWarrior IDE displays a New dialog
box (Figure 2-6 on page 2-14).

Note

The New dialog box also contains a File tab and an Object tab. See Creating a
new file on page 4-3 for more information on creating new source files. The
Object tab is not used by the ARM version of the CodeWarrior IDE.

Mew E3

Project | Fie | Object|

S ARM Executable Image Froject name:
S ARM Dbiject Library |
=J@AHM Thumb Interwarking Image

9@ Ermpty Project Lacation:

”@ t4 akefile Importer Wizard IC:\‘ Gab
"5 Thumb Executable Image

"5 Thumb Object Library

Ao Eroest
Praject:

[ofs Cahicel

Figure 2-6 New dialog box

2. Ensure that the Project tab is selected and choose the project stationery file on
which you want to base your own project. You can choose from:

. An empty project, to create a project that contains no libraries or other
support files
. An ARM or Thumb Executable image, library, or interworking project. See

Using ARM-supplied project stationery on page 2-24 for more information
on the project stationery files supplied by ARM.

. The Makefile Importer Wizard. See Importing makefiles into projects on
page 2-19 for information on using this wizard.
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— Note
Using the keyboard

You can use Ctrl+Tab or the left and right arrow keys to move between the
Project, File, and Object tabs. To set the focus on the list of stationery:

a. Press Ctrl+Tab until the Project tab is selected.
b. Press Tab again.

c. Press the Up and Down keys to move to items in the stationery list.

3. Enter a name for your project and either enter the project location or click Set...
to choose a directory in which to store your project. By default, the CodeWarrior
IDE adds a .mcp filename extension to the project filename.

4. Click OK. The CodeWarrior IDE creates a new project based on the project
stationery you have selected. See:

. Adding files to a project on page 2-38, for information on how to add your
own source files to the new project

. Compiling and linking a project on page 2-72 for more information on
building your new project.

2.3.2 Opening a project

This section describes how to:

. open existing projects so you can work on them
. open subprojects from within a project window
. open projects created on other platforms.

You can have more than one project open at a time. To switch to one of several open
projects, select the project name from the Window menu. See Choosing a default
project on page 2-22 for information on how to select one of your open projects as the
default target for project-level commands.

To open a project file:

1. Select Open from the File menu. The CodeWarrior IDE displays an Open File
dialog box (Figure 2-7 on page 2-16).
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Open 21=]
Lookjn |3 Rps RO

RO_Datai
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Filez of type: IProiectFiIes j Cancel |

Figure 2-7 Open dialog

2. Ifnot already set, use the Files of Type pop-up menu to select Project Files. The
file list changes to show the project files that you can open.

3. Select the project file you want to open and click Open. The CodeWarrior IDE
opens the project and displays it in a project window.

Note

If the project was created with an older version of the CodeWarrior IDE, you will
be prompted to convert the older project to the newest version. If you decide to
update, the CodeWarrior IDE saves a backup of the project and then converts the
project to the newest version.

Using the Open Recent command

The CodeWarrior IDE maintains a list of the projects and files you have opened recently
in the File menu. Use the Open Recent menu command to reopen one of these projects.
See Configuring IDE extras on page 8-7 for information on setting the number of files
that the CodeWarrior IDE stores in this menu.

Opening subprojects from the project window

To open a subproject contained within your project, double-click the subproject file icon
in the project window. The CodeWarrior IDE displays the subproject in a new project
window. See Working with multiple build targets and subprojects on page 2-53 for more
information on using subprojects.

Opening project files created on other host platforms

Project files are cross-platform compatible. For example, you can open and use a project
created under MacOS on a Windows machine.

2-16
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— Note

The ARM version of the CodeWarrior IDE is supported on Windows only. However,
this feature might be useful if you are moving to ARM from another target environment
that also uses CodeWarrior development tools.

To use a project created on another host platform:

1. Ensure that the project has a .mcp filename extension. The CodeWarrior IDE uses
this file name extension to recognize project files. If the three-letter extension is
not present, the CodeWarrior IDE will be unable to identify the project file.

2. Copy only the project file, not its associated Data folder, from the other host
platform to your computer.

3. Open the project in the CodeWarrior IDE and rebuild it.

2.3.3 Closing a project
To close a project:
1. Ensure that its project window is the currently active window.
2. Select Close from the File menu, or click the Windows close button.

You do not have to close your project before quitting the CodeWarrior IDE application,
because your project settings are automatically saved. See Saving a project on
page 2-18 for details of how CodeWarrior saves project information.

The CodeWarrior IDE allows you to have more than one project open at a time, so you
do not have to close a project before switching to another project.

—— Note

Having multiple projects open at a time uses more memory, and also causes project
opening times to lengthen slightly.
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2.3.4 Saving a project

The CodeWarrior IDE automatically updates and saves your project when you perform
certain actions. This section describes the actions that cause a project file to be saved.

Your settings are saved when you:

. close the project

. change the Preferences or Target Settings for the project
. add or delete files for the project

. compile any file in the project

. edit groups in the project

. remove object code from the project

. exit the CodeWarrior IDE.

You do not have to save your project manually unless you want to create a copy of it.

Information saved with your project

When the CodeWarrior IDE saves your project, it saves the following information:

. the names of the files added to your project and their locations

. all configuration options

. dependency information, such as the touch state and header file lists
. browser information

. references to the object code of any compiled source code files.

Saving a copy of your project

If you want to save a backup copy of a project file before you make some changes to
the original, select Save a Copy As... from the File menu. The CodeWarrior IDE
creates a copy of the project file under a new name that you specify, and leaves the
original project file unchanged. The CodeWarrior IDE does not change the currently
open project to use the new file name.

——— Caution

Do not attempt to make a copy of an open project from the Windows desktop. This can
cause the project file to be corrupted. Always close the project before copying the
project file.
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2.3.5 Importing makefiles into projects

The CodeWarrior IDE can import Visual C nmake or GNU make files into CodeWarrior
project files. The CodeWarrior IDE uses the Makefile Importer wizard to process the
files. The wizard performs the following tasks:

parses the makefile

creates a CodeWarrior project

creates build targets

adds source files as specified in the makefile

matches the information specified in the makefile to the output name, output
directory, and access paths of the created build targets

selects a linker to use with the project.

Using the Makefile Importer wizard

To create a new project from a makefile:

1.

Select New... from the File menu. The CodeWarrior IDE displays the New dialog
box (see Figure 2-6 on page 2-14).

Click the Project tab and select the Makefile Importer Wizard from the list of
project stationery.

Either:

. Select Add Targets to Project and select a currently open project from the
pop-up menu if you want to add the imported makefile to an existing project
file (Figure 2-8 on page 2-20).

. Enter a name and location for the project to be created from the imported
makefile (see Creating a new project on page 2-13 for naming conventions)
and click OK.

ARM DUI 0065C
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New E
Proiect | File | Object|
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Figure 2-8 Adding files to an existing project
The CodeWarrior IDE displays the Makefile Importer Wizard (Figure 2-9).

Makefile Importer Wizard

— Makefile Location

IEI:MHM2ED\50urce'\Win32\AHMulate'\armulale.mak Browse |

— Settings
Tool Set Used In Makefile

Metrowerks Tool Set I.t’-‘-.F!M Linker j

— Diagnostic Settings
¥ Lag Targets Bypassed ¥ Laog Build Fules Discarded

[ Log Al Statements Bypassed

< Baclt I Finizh I Cancel

Figure 2-9 Makefile Importer Wizard

4, Enter the location of the makefile in the Makefile Location text field, or click
Browse to select the makefile from the standard file dialog.
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5.  Select Settings options:

Tool Set Used in Makefile
Select the makefile tool on which the makefile build rules are based
from the pop-up menu.

Metrowerks Tool Set
Select ARM Linker from the pop-up menu.

6.  Select Diagnostic Settings as required:

Log Targets Bypassed
Select this option to log information about the build targets parsed in
the makefile that were not converted to CodeWarrior build targets.

Log Build Rules Discarded
Select this option to log information about the build rules in the
makefile that were discarded in the conversion to a CodeWarrior
project.

Log All Statements Bypassed
Select this option to log the same information as the Log Targets
Bypassed and Log Build Rules Discarded options, and information
about other items in the makefile that were not understood during the
parsing process.

Diagnostic messages are displayed in a project message window. The project
message window is similar to the message window. See Using the message
window on page 3-15 for more information.

7. Click Finish. The Makefile Importer wizard displays a summary window
showing the current conversion settings (Figure 2-10).

Summary

Codetw/arior will create a new project with the following targets:

The following targets will be created: :l
Target Dec.dll
Target: Dec.di-Debug

Output Directary:
D hwwork Samazont DE SE samplestimport’,

{"Henerate Cancel

Figure 2-10 Makefile importer summary
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2.3.6

23.7

8. Click Generate to import the makefile. The CodeWarrior IDE generates a new
project based on the makefile.

Choosing a default project

The CodeWarrior IDE enables you to have more than one project open at a time. When
you select some project-level commands, such as Enable debugger or Bring up to
date the CodeWarrior IDE applies the command in the following way if there is more
than one project open:

. if one of the project windows is the currently active window, the CodeWarrior
IDE applies the command to that project

. if no project window is the currently active window and it is ambiguous as to
which project the command should be applied to, the CodeWarrior IDE applies
the command to the default project.

To specify a default project, select Project — Set Default Project — Project_name
where Project_name is the name of the open project you want to make the default.

When you start the CodeWarrior IDE, the first project you open becomes the default
project. If you close the default project, the default project becomes the project with the
front-most project window.

Moving a project

The CodeWarrior IDE stores all the information it requires about a project in the project
file. The project data directory contains additional information such as window
positions, object code, debug info, browser data, and other settings. However, the
CodeWarrior IDE does not need these files to recreate your project.

To move a project, drag the project file (ending in .mcp if it obeys the project file naming
convention) to its new location. The CodeWarrior IDE reconstructs the project state
when you select a Bring Up To Date or Make operation. In a revision control system,
you need only check in the main project file and not the data files.

If your project file references other files with absolute access paths, you might need to
modify the paths when you move the project. See Configuring access paths on
page 9-20 for more information.

2-22
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2.3.8 Importing and exporting a project as XML

You can export a project file in eXtensible Markup Language (XML) format. This
format is useful when you want to use the CodeWarrior IDE file comparison feature to
compare and merge the contents of different project files. See Comparing
XML-formatted projects on page 4-28 for more information.
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24.2

Working with project stationery

This section describes how to use the project stationery provided with CodeWarrior for
the ARM Developer Suite, and how to create your own project stationery. It describes:

. Project stationery overview
. Using ARM-supplied project stationery on page 2-24
. Creating your own project stationery on page 2-35.

Project stationery overview

A project stationery file is typically a minimal, preconfigured template project file. You
can use project stationery to create a new project quickly. When you create a new
project or open a project stationery file, the CodeWarrior IDE creates a new project and,
optionally, a new folder for the project. It then copies all the files related to the
stationery project to the new folder.

A stationery project can include:

. preconfigured build target settings for the project

. predefined build targets, subprojects, and build dependencies
. all files included in the stationery project.

The project stationery folder

The project stationery folder is located in the ARM Developer Suite installation folder.
By default this is c:\Program Files\ARM\ADSv1_1\Stationery. ARM-supplied project
stationery files for common types of projects are located in subdirectories in the project
stationery directory.

You can create your own project stationery by saving preconfigured projects, together
with their support files, in the project stationery directory. See Creating your own
project stationery on page 2-35 for more information.

Using ARM-supplied project stationery

The ARM version of the CodeWarrior IDE is supplied with a number of default
stationery projects to enable you to start an ARM, Thumb, or Thumb ARM
interworking project quickly and easily.

All the supplied stationery projects use:
. default target settings (little-endian ARM7TDMI)
. default ATPCS options for the compilers and assemblers

. separate build targets for debug and optimization options (see Predefined build
targets on page 2-27).

2-24
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This means that you must reconfigure the target options if, for example, you want to
build position-independent output, or target a different ARM processor. See Chapter 9
Configuring a Build Target for detailed information.

The following stationery projects are supplied with the CodeWarrior IDE for the ARM
Developer Suite:

ARM Executable Image

Use this project template to build an executable ELF image from ARM
code. This stationery project is configured to use:

. The ARM C compilers to compile all files with a .c filename
extension. If you want to use the C++ compiler to compile C code,
you must reconfigure the File Mappings configuration panel. See
Configuring file mappings on page 9-40 for more information.

. The ARM C++ compiler to compile all files with a . cpp filename
extension.

. The ARM assembler to assemble all files with a .s filename
extension.

. The ARM linker to link a simple executable ELF image.

. The AXD debugger to both debug and run executable images
output by the project.

ARM Object Library

Use this project template to build an object library in armar format from
ARM code. The library will contain ELF object format members. This
project is similar to the ARM executable image project. The major
differences are:

. it is configured to use the armar utility to output an object library.

. you cannot debug or run a standalone library file.

See the Toolkit Utilities chapter of the ADS Compiler, Linker, and
Utilities Guide for more information on armar.

Thumb Executable Image

Use this project to build an executable ELF image from Thumb code.
This stationery project is configured to use:

. The Thumb C compilers to compile all files with a .c filename
extension. If you want to use the Thumb C++ compiler to compile
C code, you must reconfigure the File mappings configuration
panel. See Configuring file mappings on page 9-40 for more
information.
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. The Thumb C++ compiler to compile all files with a . cpp filename
extension.
. The ARM assembler to assemble all files with a .s filename

extension. By default, the Thumb Executable Image stationery
configures the assembler to start in Thumb state. See the assembler
documentation in the ADS Compiler, Linker, and Utilities Guide for
information on switching the assembler to compile ARM code.

. The ARM linker to link a simple executable ELF image.
. The AXD debugger to both debug and run executable images
output by the project.
Thumb Object Library

Use this project template to build an object library in armar format from
Thumb code.

The library will contain ELF object format members. This project is
similar to the Thumb executable image project. The major differences

are:
. it is configured to use the armar utility to output an object library
. you cannot debug or run a standalone library file until it is linked

into an image.

See the Toolkit Utilities chapter of the ADS Compiler, Linker, and
Utilities Guide for more information on armar.

Thumb ARM Interworking Image

Use this project to build an executable ELF image from interworking
ARM and Thumb code. This stationery project is configured to use:

. Separate build targets for ARM code and Thumb code. The output
from the Thumb build targets is chained with the corresponding
ARM build targets. See Creating build target dependencies on
page 2-61 for information on defining build dependencies between

build targets.

. The ARM C and C++ compilers to compile code included in the
ARM build targets.

. The Thumb C and C++ compilers to compile code included in the
Thumb build targets.

. The ARM assembler to assemble both ARM and Thumb assembly
language source.

. The ARM linker to link the output from the Thumb and ARM build
targets into an executable ELF image.
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. The ATPCS interworking option for the ARM assembler and ARM
and Thumb compilers.

Predefined build targets

The non-interworking ARM project stationery files define three build targets. The
Interworking project stationery defines an additional three build targets to compile
Thumb-targeted code. The basic build targets for each of the stationery projects are:

Debug This build target is configured to build output binaries that are fully
debuggable, at the expense of optimization. It is intended to be used if
you plan to build separate Debug and Release versions of your code. This
build target provides the best debug view while you are developing your
code. It is also configured to output basic image information in an error
and messages window.

Release This build target is configured to build output binaries that are fully
optimized, at the expense of debug information. It is intended to be used
if you plan to build separate Debug and Release versions of your code.
This build target outputs optimized code suitable for release.

DebugRel  This build target is configured to build output binaries that provide
adequate optimization, and give an adequate debug view. It is intended to
be used if you plan to build a version of your code for debug, and release
the same code in order to reduce testing.

See Working with multiple build targets and subprojects on page 2-53 for more
information on using the ARM project stationery to create complex projects. See
Configuring debug and optimization on page 9-96 for information on how to set debug
and optimization options.

Using the Thumb ARM interworking stationery

The Thumb ARM interworking stationery is an example of a complex project that uses
multiple, dependent, build targets to compile ARM and Thumb code separately, and
then link the output into an interworking executable image. This section gives a brief
description of how to use the interworking stationery. See Working with multiple build
targets and subprojects on page 2-53 for a detailed description of how to use complex
projects.

To create an interworking project:

1.  Create a new project using the Thumb ARM interworking stationery. See
Creating a new project on page 2-13 for more information. The CodeWarrior IDE
displays the Files view for the new project (Figure 2-11).
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i @ Interworking Project. mcp

Link Drder Targets

| 8 ThumbDebugRel By A e

# | Fil | Code | Data ML |4

& =53 Subtarget Dutput o I =~
W B Thumb ARM Intenvarking .o 0 =

=
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Figure 2-11 Interworking project

2. Add your Thumb source files to the Thumb build targets:
a. Select Add Files... from the Project menu and select your Thumb source
files from the standard file dialog box. The CodeWarrior IDE displays an
Add Files dialog.

b. Deselect the ARM build targets and click OK (Figure 2-12). The
CodeWarrior IDE adds the files to the Thumb build targets only.

i4¢ Add Files

Add files to targets:

|E Targets

V' ThumbDebugRel
¥ ThumbDebug
¥ ThumbFelease
[~ ARMDebugRel
[~ ARMDebug

[~ AFMReleaze

Ll

=
Cancel |

Figure 2-12 Add Thumb files

3. Addyour ARM source files to the ARM build targets. Follow the same procedure
as step 2, but select the ARM build targets when you add the files. Figure 2-13
shows an example of the Files view for the Thumb DebugRel target. The Files
view shows all the files in the project. Files not in the current build target do not
have a black dot in the Target column, and have a code size of n/a.
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Figure 2-13 Interworking project Files view

Click the Targets tab to display the build target structure of the project.

Figure 2-14 shows an example. Each ARM build target is linked as a dependent
target to its corresponding Thumb build target. See Creating a new build target on
page 2-62 for more information.

?.Intemorking Project.mcp (O] x
| | |
Current main build target . i Dependent build target output
| ¥ ThumbDebugRel j B % @ s IinkF:ed with main bui% targeﬁ
Dependent subtarget B Targets s /
Nﬁ; ThumbDebugRel
8. AR .
=@ ThumbDebug
8. ARty .
=1 ThumbRelease
@ AFMF et .
+ @ ARMDebugRel
@ ARMDebug

@ ARMRelease

B targets

Figure 2-14 Interworking project Targets view
Click the Make button to build the ThumbDebugRel build target. The
CodeWarrior IDE:
a. builds the dependent ARMDebugRel build target
b.  builds the ThumbDebugRel build target
c. links the output from the two build targets.

To build the other interworking targets, select the appropriate Thumb build target
from the Targets pop-up menu. If you select an ARM build target, only the ARM
part of your project source is built.
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Converting ARM projects to Thumb projects

To convert an existing ARM project to Thumb, you must:

modify the file mappings to call the Thumb compilers
configure the appropriate ATPCS options for the compilers and assembler.

You must change the following configuration options for each build target in the

project:

1. Open the project you want to convert.

2. Select TargetName Settings... from the Edit menu and click File Mappings in
the Target Settings Panels list. The CodeWarrior IDE displays the File Mappings
panel (Figure 2-15).

44 DebugRel Settings
B Target Settings Panels  File Mappings
= Target - n
- Target Settings E File Type | Estension| &P ﬁ? o Compiler
- Access Paths TEXT . ARM C Compiler
- Build Extraz TE=T oG AR C++ Compiler
- Runtime Settings TE=T .CPp ARM C++ Compiler
S File b appings TE=T h +  ARM C Compiler
- Source Trees TEXT hpp +  ARM C++ Compiler
[E- Language Seftings TE=T 5 ARM Azzembler
- BAM Aszembler TEXT scf
- ARM C Compiler TE=T bt .
. ARM o+ Campiler 4 ARM ELF Impoter hd|
- Thumb C Compiler M apping Info
- Thurmb C++ Compil
=8 Linkerum - omper File Type: Ehoose...l Extension:
- FTF PastLinker Flags: Eompile“lm
- AR Linker
- ARM fromELF Add | | Change | Remave |
- Editar LI
Factory Settings | Frewert Fanel | Save |
Figure 2-15 File Mappings panel
3. Click the entry for the .c file extension and select Thumb C compiler from the

Compiler pop-up menu (Figure 2-16).

2-30

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with Projects

i45i DebugRel Settings EHE
B Target Settings Panels  File Mappings
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- Build Extraz TE=T oG AR C++ Compiler
Runtime Settings TE=T .CPp ARM C++ Compiler
appi TEXT h +  ARM C Compiler
- Source Trees TE=T hpp +  ARM C++ Compiler
[E- Language Seftings TE=T 5 ARM Azzembler
- ARM Assembler TEXT scf
- ARM C Compiler TE=T bt .
" ARM Co+ Compiler 4 ARM ELF Impoter hd|
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=8 Linkerum - omper File Type: |TEXT Choosze... | Extension:
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= Editor = :
- hd 15 C++ Eompller
. Thumb C++ Compiler
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Figure 2-16 Changing file mapping to use Thumb C compiler

Click Change to change the file mapping for .c source files. When you make
your project, the CodeWarrior IDE calls the Thumb C compiler to compile files
ending with a .c filename extension.

Modify the file mappings for .cpp and .h files to use the Thumb C++ compiler
and Thumb C compiler respectively. The File Mappings panel should look similar
to Figure 2-17.

i45i DebugRel Settings EHE
B Target Settings Panels  File Mappings
= Target -
- Target Settings E File Type | Extension @?’ ‘ﬁ? e Compiler
- Access Paths b .C Thumb C Compiler
- Build Extraz TE=T oG AR C++ Compiler
- Runtime Settings TE=T .CPp ARM C++ Compiler
appi TEXT h +  ARM C Compiler
- Source Trees TE=T hpp *  Thumb C++ Compiler
[E- Language Seftings TE=T 5 ARM Azzembler
- ARM Assembler TEXT scf
- ARM C Compiler TE=T bt .
" ARM Co+ Compiler 4 ARM ELF Impoter hd|
- Thumb C Compiler M apping Info
=8 Link::umb Ee+ Compiler File Type: Choosze... | Extension:
- FTP PostLinker Flags: || Compiler:[Thumb C Compier =]
- ARM Linker
- AR fromELF Add Remove |
- Editar LI

Factory Settings | Fievert Panel | Save |

Figure 2-17 Changed file mappings

Click Save to save the new file mappings.
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Click ARM Assembler in the Target Settings Panel list to display the Language
Settings panel for the ARM Assembler:

a. Select the Thumb Initial State option (Figure 2-18).

4 DebugRel Settings

= Target Target |ATPES| Dptionsl Predefinesl Listing Eontroll Extrasl

- Target Settings L - -
J N —&rchitecture or Processor—————— 1~ Eloating Paint
- Access Paths

E‘:':ﬂti;:“;':mngs [+RM7TOMI | | Pure-endian saftfp =
- File Mappings
- Source Trees
= Language Settings

B Target Settings Panels J B 4R &szembler

— Byte Order Initial State——;
& Little Endian ' ARM
" Big Endian & Thumb

o BAM
- AR C++ Compiler
- Thumb C Compiler
-~ Thumb C++ Compiler
= Linker Equivalent Command Line

- FTP PostLinker *eep -16-g =]
- ARM Linker

. BRM fromELF =
=- _Editor LI

Factory Settings | Frewert Fanel | Save |

Figure 2-18 Select Thumb initial state

b.  Click the ATPCS tab and select ARM/Thumb interworking, if required
(Figure 2-19). In general you must select interworking for any code that is
directly called from code running in the other state (either ARM or Thumb).
If you are not sure whether your Thumb code will be called from ARM
code, you should select the interworking option.

DebugRel Settings

B Target Settings Panels J B 4R &szembler

E- Target ATPCS . . L
- Target Settings Target | Dptlonsl Predefines | Listing Eontroll Extras I
- Access Paths — &Rk AThumb Procedure Call Standard Options—— — Calling Standard
- Buid Extras ¥ ARM/Thumb interwarking & ATPCS
- Runtime 5 ettings o -
- File Mappings " Bead-only position independent Hone
- Source Trees ™ Read-write position independent
[E- Language Seftings
- ribler — Predeclared Register Mames——
- &AM C Compil
omp 8[. Software stack checking & ATPCS
- ARM C++ Compiler P P @
- Thumb € Compiler On Oif '  None
-~ Thumb C++ Compiler
= Lirker Equivalent Command Line
- FTP PostLinker -keep -16 -g -apcs Anterwork/swstna ;I
- AR Linker
- ARM fromELF E
- Editar LI

Factory Settings | Frewert Fanel | Save |

Figure 2-19 Select ARM/Thumb interworking
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Ensure that the other language settings for the assembler are appropriate for
your project.

Click Save to save your changes.

Click Thumb C Compiler in the Target Settings Panel list to display the
Language Settings panel for the Thumb C compiler:

a.

C.

Click the ATPCS tab and select ARM/Thumb interworking, if required
(Figure 2-20 on page 2-33). In general you must select interworking for any
code that is directly called from code running in the other state (either ARM
or Thumb). If you are not sure whether your Thumb code will be called
from ARM code, you should select the interworking option.

44 DebugRel Settings

B Target Settings Panels |H Thumb C Compiler
B Target Target and Source ATPCS |W’amings| Ermors I Debugd Opt Preprocessorl Ced I L4

- Target Settings

- Access Paths ARM/Thumb Procedure Call Standard Options
- Build Extras ¥ ARMAThumb intensarking
- Runtime Settings

- File Mappings

- Source Trees

[E- Language Seftings

- AR Assembler

- ARM C Compiler

- ARM C++ Compiler
S T b C Compiler

-~ Thumb C++ Compiler
- Linker

- FTP PostLinker

- AR Linker

- ARM fromELF [

- Editar LI
Save |

Figure 2-20 Selecting the ATPCS Interworking option

™ Software stack check
" Bead-only position independent

™ Read-write position independent

Equivalent Command Line
-01 -g+ -apcs Anterwork, -0 __APCS_INTERWORK ;I

Factory Settings | Frewert Fanel |

Ensure that the other language settings for the Thumb compiler are
appropriate for your project. In particular, if you have changed any of the
default settings for the ARM compiler before converting your project to
Thumb, you might not have changed the equivalent settings for the Thumb
compiler.

Click Save to save your changes.

Repeat step 8 for the Thumb C++ compiler panel, if required.

Repeat all the above steps for each build target in the project.

Rebuild your project. The CodeWarrior IDE uses the Thumb compilers to rebuild
your code.
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Converting Executable Image projects to Library projects

To convert an Executable Image project to a Library project you must change the
following configuration options for each build target in the project:

1. Open the project you want to convert.

2. Select TargetName Settings... from the Edit menu and click Target Settings in
the Target Settings Panels list. The CodeWarrior IDE displays the Target Settings
panel

3. Click the Linker pop-up menu and select ARM Librarian (Figure 2-21 on
page 2-34).

44 DebugRel Settings

B Target Settings Panels B Target Settings
E- Target -
Target Mame: |DebugRel |

- Acoess Paths X -
- Build Extras Linker: :HM Lirker =
i i it M ONE
Fi.untlme SEttlngs Pre-linker: IARM Linker
- File Mappings .
Fostlinker:
- Source Trees
[E- Language Seftings Output Directony:
- AR Assembler : Choose... |
- ARM C Compiler {Project} -
- ARM C++ Compiler [ |

- Thumb C Compiler

-~ Thumb C++ Compiler

- Linker

- FTP PostLinker

- AR Linker

- ARM fromELF

- Editar LI

Factory Settings | Frewert Fanel | Save |

Figure 2-21 Select the ARM librarian

[T Save project entries using relative paths

4. Click Save to save your changes.

5.  Repeat all the above steps for each build target in your project.

6.  Rebuild your project. The CodeWarrior IDE calls armar to create an object
library.

Creating ROMable output

The default ARM-supplied project stationery is configured to generate a semihosted
ELF executable image. To convert a project to produce a simple binary image suitable
for embedding in ROM you must:

1. Configure the Target Settings panel to call fromELF as a postlinker. See
Configuring target settings on page 9-14 for more information.
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2. Configure the ARM fromELF panel to convert the executable ELF image output

by the linker to the binary format of your choice. See Configuring fromELF on
page 9-129 and Converting output ELF images to other formats on page 2-82 for
more information.

3. Configure the ARM Linker panel to create the image structure you require, or use
a scatter-load description file to specify your image structure. See Configuring the
ARM linker on page 9-110 for more information. See also the example ROM
projects in install_directory\Examples\rom and the description of writing code
for ROM in the ADS Developer Guide.

243 Creating your own project stationery

You can create your own stationery project file that includes the source files and project
options you want. You can use the stationery project when you create a new project.

A CodeWarrior project is a stationery project if:
. it is located in the project stationery folder
. the source files associated with the project are stored with the project.

CodeWarrior duplicates the stationery project file and its source files when you create
a new project and select your stationery project in the New Project dialog box. See
Creating a new project on page 2-13 for more information on creating a new project.

Before you create your own project stationery you should be familiar with the project
stationery supplied by ARM. See Using ARM-supplied project stationery on page 2-24
for more information.

To create your own custom stationery:

1.  Create a new project from an existing project stationery file, or create an empty
project.

2. Select Save A Copy As... from the File menu. The CodeWarrior IDE displays a
Save a copy of project as dialog box (Figure 2-22).
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Figure 2-22 Save a copy of project as dialog

3. Usethe dialog box controls to save the new project to the project stationery folder.
By default the stationery folder is:

Program Files\ARM\ADSv1_1\Stationery
4. Modify the project settings to suit your requirements. You can add and remove
files as necessary to create the base project you want.

Ensure that a copy of all the project source files are present in the project folder
so that they will be copied to new projects created with the project stationery.

Note
You do not need to copy the project data directory to the stationery folder.

5. Save your changes. The project is ready to use as a new project stationery file.

You can select your custom project stationery when you create a new project. The
project settings and source files in your stationery project are used to create the new
project.

See the following sections for more information on how to configure your project
stationery and include the files you want:

. Choosing general preferences on page 8-6
. Configuring target settings on page 9-14
. Managing files in a project on page 2-37.
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2.5 Managing files in a project

This section describes how to manage files in your project. It provides information on:
. Selecting files and groups

. Adding files to a project on page 2-38

. Grouping files in a project on page 2-42

. Moving files and groups on page 2-45

. Removing files and groups on page 2-46

. Touching and untouching files on page 2-47.

251 Selecting files and groups

From the project window, you can select one or more files and groups to open, compile,
check syntax, remove from the project, or move to a different group. Selecting a group
selects all the files in the group, regardless of whether or not the files appear to be
selected.

Selection by mouse-clicking
You can use the following methods to select files with the mouse:
. To select a single file or group in the project window, click its name.

. To select a consecutive list of files or groups either:

—  Click the first file or group in the list, and then Shift-click the last file or
group. Everything between and including the first and last file or group is
selected.

—  Drag-select files in the same way as on the Windows desktop.

. To select non-contiguous files or groups, Ctrl-click the file and group names.

Selection by keyboard

To select an item using the keyboard, type the first few characters of the name of the
item you want to select. As you type, the CodeWarrior IDE selects the file in the project
that most closely matches the characters you have typed. Press the Backspace key if you
make a mistake. Press the Enter key to open a file.

—— Note

Only files in currently expanded groups in the project window can be selected this way.
Files in collapsed groups are not matched with your keystrokes.
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2.5.2 Adding files to a project

This section describes how to add files to your project. You can use the following
methods to add files:

The Add Files command

Select Add Files... from the Project menu to add one or more files to the
current project. See Using the Add Files command on page 2-39 for
details.

Drag and drop

Use drag and drop to add one or more files to the current project. See
Adding files with drag and drop on page 2-41 for details.

The Add Window command

Select Add Window to add the file in the currently active editor window.
See Adding the current editor window on page 2-42.

When you add a file to a project, the CodeWarrior IDE adds the path to that file to the
project access paths, and displays a message in the message window.

Filename requirements

Filenames must conform to the following rules or the CodeWarrior IDE will not add
them to the project:

. Filename extensions for the file type you want to add must be defined in the File
Mappings configuration dialog. See Configuring file mappings on page 9-40 for
more information.

. You cannot add multiple copies of source files that generate object output, such a
C, C++, or assembly language source files. You can add multiple copies of header
files. The CodeWarrior IDE searches the defined search paths and uses the first
file with the correct name that it locates. It does not continue to search for header
files with the same name.

Where added files are displayed

When you add files to a project, they are placed either:

. after the currently selected item in the project window
. at the bottom of the project window if no item is currently selected in the project
window.
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To place a new file or group in a specific location, you must select the file or group
above the location where you want the file to be added before you select Add Files or
Add Window.

If you select a group, the added files are placed at the end of that group regardless of
whether or not the group is expanded or collapsed. See Selecting files and groups on
page 2-37 for more information on selecting files and groups of files.

—— Note

If you drag and drop a folder of source files onto your project window, a new group is
created and appended to your project. The added files are placed in the new group.

See Moving files and groups on page 2-45 for information on how to move a file, or
group of files, to a new location within the project.

Using the Add Files command

To add source code files, libraries, and other files to your project:

1. Select Add Files... from the Project menu. The CodeWarrior IDE displays an
Add Files dialog box (Figure 2-23).

Select files to add._.

Lock jn: |¢3 S j gl |°_

ahandle.z

chandle.c

File narme: I"swi.h" "chandle.c" "ahandle.s" Add
Filez of wpe: ISnurce Filez ﬂ Cancel |

Figure 2-23 Adding files to a project

2. Use the Files of type pop-up menu to filter the types of files displayed in the
dialog box.
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Note

If you select All Files, the dialog box displays all files regardless of their filename
extension. However, the CodeWarrior IDE will not add files that do not have a
recognized filename extension set in the File Mappings target configuration
panel. See Configuring file mappings on page 9-40 for more information.

3. Change directory to the location of the files you want to add and select the files

to be added:

. To select a single file, click on its file name. Alternatively, double-click the
file to add it to your project immediately.

. To select multiple files, press the Control key and click on the file names in
the dialog box.

. To select a contiguous group of files, click on the first file name in the

group, then press the Shift key and click on the last file in the group.
Alternatively you can drag the mouse over the files you want to select.

4. Click Add to add the selected files. If your project contains multiple build targets,
the CodeWarrior IDE displays an Add files to targets dialog box (Figure 2-24).
Select the build targets to which you want the files added, or click Cancel to close
the dialog box without adding any files to the project.

4 Add Files

Add files to targets:

N Targets

v DebugFel -
¥ Release

¥ Debug

i
Cahicel | ak I

Figure 2-24 Add files to targets dialog box
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Adding files with drag and drop

You can drag suitable files or folders directly to an open project window. When you
drag files onto the project window, the CodeWarrior IDE verifies that the files can be
added to the project. When you drag a folder, the CodeWarrior IDE checks to ensure
that the folder, or one of its subfolders, contains at least one file with a recognized
filename extension, and that file is not already in the project. Folders are added to the
project as new groups.

If the selection does not contain at least one file recognized by the CodeWarrior IDE,
the drag is not accepted. See Configuring file mappings on page 9-40 for more
information on configuring the CodeWarrior IDE to recognize files.

To add files to your project with drag and drop:

1. Select the files or folders you want to add to the project.
You can select files in many places, including the desktop or the multi-file search
list in the CodeWarrior IDE Find dialog box.

2. Drag your selection onto the project window.

3. Use the focus bar (an underline) that appears in the project window to select the
location where the files will be inserted.
To create a new group and add files to it, drop the files when the cursor is over the
blank space after the last group.

4. Release the mouse button (drop the files) to add the dragged items to the project.
The items are inserted below the position of the focus bar.

If your project contains multiple build targets, the CodeWarrior IDE displays an
Add files to targets dialog box (see Figure 2-24 on page 2-40). Select the build
targets to which you want the files added.

—— Note
. You cannot drag entire volumes, such as your hard disk, onto the project window.
. You can drag files from the project window to another application to open them

in that application.

See Removing files and groups on page 2-46 for more information on removing files
from the project window.
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Adding the current editor window

The Add Window command adds the file displayed in the active editor window to the
default project.

Note

The Add Window menu item is enabled when the active window is a text file, the file
is not yet in the project, and the file either has a recognized file name extension, or is an
unsaved window. See Configuring file mappings on page 9-40 for more information.
The Add Window menu item is disabled otherwise.

To add the current editor file:
1. Select a location in the project window.
2. Open the source code file or text file in the editor.

3. Select Add Window from the Project menu:

. If the editor window is untitled the CodeWarrior IDE displays the Save As
dialog box. The file is added to the open project after you save it.

. If your project contains multiple build targets, the CodeWarrior IDE
displays an Add files to targets dialog box (see Figure 2-24 on page 2-40).
Select the build targets to which you want the files added.

2.5.3 Grouping files in a project

The CodeWarrior IDE enables you to organize your source code files into groups.
Groups are the CodeWarrior IDE equivalent to a Windows folder. For example, if you
drag a folder of source files onto the project window, the CodeWarrior IDE creates a
new group with the same name as the folder. However, CodeWarrior IDE groups are
independent of the directory structure of your source files. You can create any group
structure you want in the CodeWarrior IDE.

Creating groups

To create a new group:

1. Ensure that the project window is the active window, and that the Files view is
selected.

2. Select alocation for the new group in the project window. The CodeWarrior IDE
will place the new group immediately below a selected item in the project
window hierarchy. If no item is selected the CodeWarrior IDE will place the
group at the top of the hierarchy.
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3. Select Create New Group from the Project menu. The CodeWarrior IDE
displays a Create Group dialog (Figure 2-25).

Enter name for new group:

| |
Cahicel | If I

Figure 2-25 Create Group dialog

4. Enter a name for the new group and click OK. The CodeWarrior IDE creates the
new group at the selected location.

Renaming groups
To rename a group you have already created:

1. Select the group you want to rename by clicking on it, or using the arrow keys to
navigate to the group in the project window.

2. Press the Enter key, or double click on the group in the project window. The
CodeWarrior IDE displays the Rename Group dialog box (Figure 2-26).

—— Note

If you select more than one group, the CodeWarrior IDE displays the Rename
Group dialog box once for each group. The Enter Group Name text field displays
the name of the current group.

Enter group name:

Cahicel | ak I

Figure 2-26 Rename group dialog

3. Enter a new name for the group and click OK to rename the group.
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Expanding and collapsing groups

Groups display files in collapsible hierarchical lists. There are a number of ways to
toggle a group list between its expanded state and its collapsed state:

Click the hierarchical control next to the group name to toggle the display of that

group only.

Alt-click a hierarchical control to toggle the display of the group and all its

subgroups. Other groups at the same level are not changed.

Ctrl-click any hierarchical control to toggle the display of all groups at the same

level.

Ctrl-Alt-click any hierarchical control to toggle the display of all groups and

subgroups. See Figure 2-27.

;.AHH Executable Image mcp M [=] E3
Control-Alt-Click any | | |
hierarchical control
to expand all groups . -
and subgroups | ¥ DebugRel j m o B
@ File Cade Data |4 |4
B mainc 36 0= ==
M retarget.c 116 4w =
¢ [ seralc I 0 =
-3 Asserbly lahguage sources 112 i =
B irit.s 28 (I =
B vectors.s 84 0= =
=13 Documentation 0 0 =l
B readme.tat na néa » =
W' = 53 Interupt handlers 0 0 =
¢ B int_handlerc i 0 - =
=3 Scatter load descriptions a a =l
B scat_coscf nfa nia » =
-3 Alternative descriptions a0 a0 =l
B scat_d.sck ha hia + =l
B flles 264 3

Figure 2-27 Expanding groups and subgroups
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254 Moving files and groups

To move one or more files or groups within a Files view, or to arrange build targets in a
Targets view:

1. Select the files or groups to be moved. Selecting a group includes all the files in
that group, regardless of whether or not those files are visually selected in the
project window. See Selecting files and groups on page 2-37 for more
information.

2. Drag the selected files or groups to their new location in the project window. A
focus bar (an underline) indicates where the selected files will be moved when the
mouse button is released:

. if your selection consists only of files, the focus bar is displayed under both
groups and files.

. if your selection includes one or more groups, the focus bar is displayed
only under other groups.

3. Release the mouse button when the focus bar is displayed at the position you want
place the files or groups. The selected files or groups are moved to the new
position (Figure 2-28 on page 2-46).

— Note

The focus bar has a small arrow at the left end that indicates the level of insertion into
the existing hierarchy. If the arrow is to the left of a group icon, the insertion will be at
the same level as the target group. If the arrow appears to the right of the icon, the files
are inserted into the target group.
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Focus bar arrow indicates

serial.c will be moved .
underneath the Scatter load If the focus bar arrow is Focus bar

descriptions group displayed here it indicates
that serial.c will be placed
inside the Scatter load descriptions

group

g.AFIH Executable Image mcp _ O] %]
S
| ¥y DebugRel j B @
hd File Code | Data |46 |
Drag serial.c B mainc I 0 e =
under Scatter load B retarget.c 116 4 = =
descnphou 0 0 0 . =
+[C3 Aszembly language sou... 12 1] =l
+_7 Documentation 1] 1] =
@ [+ Inteript handlers 1] 1] =
+H[_pScatter load descriptions 1] 1] &
/ |3 files 264 4

Figure 2-28 Moving a file

255 Removing files and groups

You can remove files from either the Files view or the Link Order view of the project
window.

Note
If you remove files from the Files view, they are removed from all the build targets in
the project. If you remove files from the Link Order view, the files are removed from
the current build target only. See Build targets on page 2-2 for more information on
build targets.

To remove one or more files or groups from the project window:

1. Click either the Files view tab or the Link Order view tab, depending on whether
you want to remove the files from the entire project, or from the current build
target only.

2. Select the files or groups you want to remove.
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— Note

Selecting a group includes all of the files in that group, regardless of whether or
not those files are visually selected in the project window. See Selecting files and
groups on page 2-37 for more information on selecting files.

Either:
. press Delete
. right click on the selected files and select Delete from the pop-up menu.

The CodeWarrior IDE displays a confirmation dialog (Figure 2-29).

Metrowerks Code'W arrior [ %]

Remove file from project "ARM Executable

° Image.mcp".

Removing a file from a project cannaot be undone. Are
you sure you wwant to remove file "serial.c” from project
"ARM Executable Inage mop"?

Figure 2-29 Remove file confirmation dialog

Click either:
. Cancel to leave the files in the project.
. OK to continue. The selected files and groups are removed from the project

or the current build target.

— Note

You cannot undo this operation. If you remove a file or a group by mistake, you
must re-add the removed files by one of the methods described in Adding files to
a project on page 2-38.

2.5.6 Touching and untouching files

The CodeWarrior IDE does not always recognize file changes, and might not recompile
changed files in some cases. Use the Touch column to mark files that need to be
compiled (see Figure 2-2 on page 2-6).

You can touch files in the following ways:

Click in the Touch column next to the filename in the Project Files view to toggle
the touch status of the file. A check mark is displayed in the Touch column next
to the filename to indicate that the file will be recompiled the next time you build
your project.
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. Select Touch from the Header Files pop-up menu for the file.

Note

If the file has not changed since it was last compiled, the first command in the
Header Files pop-up menu is Touch. If the file has been changed since it was last
compiled, the Untouch command is shown.

To unmark files so that they are not compiled, click in the Touch column again, or select
Untouch from the Header Files pop-up menu.

Note

You can only untouch files that have been marked for compilation with the Touch
command. You cannot untouch files that are marked for compilation because they have
been modified.

Synchronizing modification dates

To update the modification dates stored in your project file either:

. select Synchronize Modification Dates from the Project menu.
. click the check icon in the project window toolbar (Figure 2-30).
Link Order
I ¥ DebugRel j i v @ -
.@I File el l_r\. L lﬂl-ﬂ' 1.
¢ B3 dhy Synchrari'nze Mocl:iflc'at:orj Dlilleirl

Figure 2-30 Synchronize modification dates

The CodeWarrior IDE checks the modification date for each file in the project. If the
file has been modified since it was last compiled, the CodeWarrior IDE marks it for

recompilation. This command is useful if you have modified source files outside the
CodeWarrior IDE, for example, by using a third-party text editor.

2.5.7 Examining and changing project information for a file

You can use the Project Inspector window to view and configure information for the
source files in your project. The project inspector window consists of:

. An Attributes panel that displays file attributes such as the name and location of
the file, the code and data size of the file, if it has been compiled, and whether or
not debug information is generated for the file.

. A Targets panel that displays a list of the build target that include a specific file.

2-48 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with Projects

To open the Project Inspector window:

1. Select the source file or library for which you want to view information in the
Files view or the Link Order view of the project window.

2. Select Project Inspector from the Window menu. The CodeWarrior IDE
displays the Project Inspector window with the Attributes tab selected
(Figure 2-31 on page 2-49).

You can use this panel to specify whether debug information is generated for the
current file when it is compiled. See Controlling debugging in a project on
page 3-4 for more information on configuring debug information for files.

The project inspector window shows project information for the currently
selected file or files. You change the file selection without closing the project
inspector window.

:#%4 Project Inspector EHE
Targets

R
N Hello.c

Kind: Text file
Froject: Example AR Project. mcp

Code Size: 76
Data Size: 0
Full Path: C:AExample ARM Project',

Access Path: {Project}

Options
¥ Debug Info = ot eak
I | Iritialize: BEfare = | tErae it Wtmut

Hesyert | SavE: |

Figure 2-31 Project Inspector window for attributes
3. Click the Targets tab to display the Targets panel (see Figure 2-32 on page 2-50)
and select the build targets that you want to include the current file.

See Assigning files to build targets on page 2-58 for more information on how to
select files for inclusion in specific build targets.
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14 Project Inspector EHE

E hello.c
=] "

Kind: Text file
Project: Example ARM Project. mcp

|E Targets

vV DebugRiel
¥ Releass
vV Debug

Ll

=
|

Fesert | Save

Figure 2-32 Project Inspector window for targets

4. Click either:
. Save to save your changes

. Revert to discard your changes.
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2.6 Configuring CodeWarrior for complex or multi-user projects

The CodeWarrior IDE has a number of configuration options that can affect how, and
where, project source files and libraries are searched for. If set incorrectly, these options
can cause unexpected behavior for large or complex projects such as:

projects that have multiple source files with the same name in different directories

multi-user projects where more than one developer is modifying sources,
especially if a source control system is in use

projects that use embedded subprojects or build targets.

The following configuration options are recommended for complex, or multi-user
projects:

Ensure that the source and library directories specified for your project are not
searched recursively by configuring the Access Paths dialog.

In general, for large projects recursive searching of access paths is prohibitively
slow. In addition, in some circumstances CodeWarrior fails to find, or finds the
wrong, dependent subproject or source file.

The default ARM project stationery is set to search the library and include
directories nonrecursively. However, if you make a new project, the Code Warrior
default is to add the {Compiler} directories recursively to your system access
paths. This means that every subdirectory of the directory in which CodeWarrior
is installed is added recursively to your system paths.

See Setting access path options on page 9-25 for more information on configuring
recursive searching.

Ensure that the Always Search User Paths option is selected in the Access Paths
configuration panel.

If this option is not selected, and any source file is found in a system search path,
it is effectively promoted to an unchanging system file. This means that if a later
version of the source file is placed in a user search path, it is not found by
CodeWarrior until this option is selected. In particular, if your system paths are
defined to be searched recursively, CodeWarrior might find unexpected versions
of source files in system paths, and ignore newer versions in user paths.

See Setting access path options on page 9-25 for more information on configuring
the Always Search User Paths option.

Ensure that the Use Modification Date Caching option is not selected in the
Build Extras configuration panel. If this option is selected, CodeWarrior might
not be able to determine if a source file has been modified outside the immediate
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CodeWarrior environment. This applies if you are using a third-party editor, or for
multi-user development environments where source files can be modified and
checked in through version control systems.

See Configuring build extras on page 9-36 for more information on configuring
cache modification dates option.
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2.7 Working with multiple build targets and subprojects

You can use the CodeWarrior IDE to create project files that use complex build rules
and dependencies. This section describes how to create complex projects.

For example, the default ARM project stationery defines separate build targets for:
. release code

. debug code

. code that is intended for release, but must still be debuggable.

In addition, the Thumb/ARM interworking project stationery uses separate build targets
for ARM code and Thumb code, and defines build dependencies between the two build
targets.

Each build target in a project has its own configuration settings. For example, the debug
build target in the ARM-supplied project stationery has code optimizations disabled and
debugging information enabled. The release build target has code optimizations
enabled. See Using ARM-supplied project stationery on page 2-24 for more
information.

This section describes:

. Overview of complex projects on page 2-53

. Creating a new build target on page 2-57

. Assigning files to build targets on page 2-58

. Changing a build target name on page 2-60

. Creating build target dependencies on page 2-61

. Building all targets in a project on page 2-65

. Creating subprojects within projects on page 2-67.

271 Overview of complex projects

Complex projects are projects that contain either multiple build targets, or multiple
subprojects, or both. You can use multiple build targets and subprojects to create
complex build relationships between parts of your code that rely on each other, or that
must be compiled with different tools or build options:

Multiple build targets

A CodeWarrior project can contain multiple build targets, each with its
own target settings, source files, and output options. You can define build
and link dependencies between build targets that enable you to link the
output of multiple build targets. See Creating build target dependencies
on page 2-61 for detailed information on defining dependencies between
multiple build targets.
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Subprojects A subproject is a standalone project that is nested within another project
file. You can use subprojects to organize your build system into separate
project files that can be separately maintained. For example, you can use
subprojects to build and maintain libraries that are used in your main
project file.

You can link the output from any build target in a subproject with the
output object code from the main project. This means, for example, that
you can link a Release build of a library, with a Debug or DebugRel build
of your main project. See Creating subprojects within projects on

page 2-67 for detailed information on using subprojects.

Strategy for creating complex projects

You can create complex projects using either, or both, multiple build targets and
subprojects. A number of factors can affect the most appropriate choice, including:

Project structure

Software development projects often consist of several subprojects
worked on by different teams. You can create CodeWarrior subprojects
for team developments and use a master project to pull the subprojects
together.

The number of build targets

Projects can contain a maximum of 255 build targets. Before you reach
that limit, multiple build targets will affect available memory and project
load times. Projects with several build targets take up more disk space,
take longer to load, and use more memory.

If your project contains more than ten to twenty build targets you can
improve performance by moving some of them off to subprojects.

Including well tested code

Any code that is not built often and uses a distinct set of source files is a
good candidate for moving to a subproject. For example, you can include
a subproject based on the ARM Object library stationery, and link with
the Release target output to include well tested library code that has been
built with high optimization options. In addition, you can specify whether
or not a subproject is rebuilt when the main project is built. Dependent
build targets are always rebuilt when the main build target is built.

Including closely related code

Code that is an integral part of your main project, but requires distinct
build options, is a good candidate for a dependent build target. For
example, the Thumb ARM interworking project stationery uses separate
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build targets for ARM and Thumb code, and defines the ARM build
targets as dependents to the Thumb build targets to generate a
Thumb/ARM interworking image.

Access to source code

If you want access to all your project source code from a single project
file, then using multiple build targets is a good choice. Subprojects are
better when you want to keep separate, standalone project files.

Some CodeWarrior IDE features are designed to work at the project level.
For example, a multi-file Search and Replace operation can search all
source code for all build targets in the current project, but will not search
source code in a subproject unless the subproject source files are
specifically added to the search list.

Setting the current build target

If you define multiple build targets in your project, you must select the specific build
target when you:

. Set target options. When you set target options, the settings apply only to the
currently selected build target. See Chapter 9 Configuring a Build Target for more
information on configuring target options.

. Perform a build operation by selecting the Compile, Make, or Bring Up to Date
menu items. By default, these commands apply only to the selected build target.
This means that you must perform build operations separately for each build
target in your project.

— Note

If you define build dependencies between build targets, the CodeWarrior IDE
compiles all dependent build targets when you compile the main build target. You
can use this, for example, to set up a build target that builds all other build targets
in your project. See Building all targets in a project on page 2-65 for more
information.

See Compiling and linking a project on page 2-72 for more information on
building your project.

To set the active build target in a project:

From the CodeWarrior IDE menu bar

Select the build target from the Set Default Target hierarchical menu in
the Project menu.
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From the Build Target pop-up menu
Select the build target from the Build Target pop-up menu (Figure 2-33).

Build target pop-up menu

| | |

e
| ¥ DebugRel 4 j i =

Releaze
Debug

) Example Subproject.a
f Example Subproject.a

Figure 2-33 Build target pop-up menu

From the Targets View

Click once on the name of a build target to select it as the current build
target. Current build targets that the CodeWarrior IDE will build are
denoted by a circular icon (an archery target) with an arrow going into it
(Figure 2-34 on page 2-56).

§-AHM Executable Image.mcp =] E3
Currently selected 3
build target | % Debughel j ¥ e [
\ﬂ\ Targets T
i, DebugRel -]
4. Release
sy, Debug
Click a target
icon to select
a build target
3 targets

Figure 2-34 Targets view
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2.7.2  Creating a new build target

You can create new build targets from the Targets view of the project window. To create
a new build target in your project:

1.

Click the Targets tab in your project window to display the Targets view
(Figure 2-35). See Figure 2-5 on page 2-12 for an example of the Targets window.

Click the Targets tab to display
the Targets view

mARM E xecutahle\‘m\lage. mcp

|lﬁ DebugRel j B = 3
Figure 2-35 Targets view tab

Select Create New Target from the Project menu.
The CodeWarrior IDE displays a New Target dialog box (Figure 2-36 on
page 2-57).

:#% Mew Target <]

MHame for new target:

|F'IainBinaryDebugF|eI |

Mew target containg
€~ Empty target
* Clone existing target:

IDebugHeI - I
Cancel | ak. I

Figure 2-36 New Target dialog box

Enter the name of the new build target in the Name for new target text field.

Select the type of new target you want to create:

. Select the Empty target option if you want to create a new empty target. If
you select this option you must configure all the settings of the build target
as if you had created a new empty project.

. Select the Clone existing target option if you want to use the settings and

files from a previously defined target as a starting point for your new target.
Select the target you want to clone from the pop-up list of defined targets.

ARM DUI 0065C

Copyright © 1999, 2000 ARM Limited. All rights reserved. 2-57



Working with Projects

5.  Click OK to create the new build target. The new build Target is added to the list
of build targets displayed in the Targets view.

6.  Modify the new build target to suit your requirements. See:

. Assigning files to build targets on page 2-58 for information on how to
include specific source and library files in the build target.

. Chapter 9 Configuring a Build Target for information on how to configure
the target settings and options for you build target.

You can associate the new build target with other build targets to create dependent build
relationships.See Creating build target dependencies on page 2-61 for more
information on defining build target dependencies.

2.7.3  Assigning files to build targets

You can assign files to build targets using either:

. the Target column in the project window Files view

. the Project inspector.

You can assign the same file to any number of defined build targets in a project.

Including a file in a build target using the Target column

The Target column in the project window Files view indicates whether a file is in the
current build target. The CodeWarrior IDE displays this column only if the project has
more than one build target. If a file is in the current build target, a dot is displayed in the

Target column next to the file (see Figure 2-37 on page 2-59).

To toggle the inclusion of a file in a build target:

1.  Ensure that the build target you want to assign the file to is the currently active
build target. See Setting the current build target on page 2-55 for information on
how to change the active build target.

2. Click in the Target column next to the file (Figure 2-37):

. If the file is not already marked as being included in the current build, the
CodeWarrior IDE places the build marker in the column to indicate that the
file is included in the current build.

. If the file is already included in the current build, the CodeWarrior IDE
removes the file from the build.
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Click in the target column to toggle
inclusion in the current build target

L3 File Code | Data ) 4
0 addh 0 0« =
0 hello.c B4 0w o [7
0 addc 12 0+« =
ni'a n'a =

Figure 2-37 The target column

—— Note
To assign or remove all the current build target files, Alt-click in the Target
column.

Including a file in a build target using the Project Inspector

You can use the Project Inspector window to assign a file to any defined build target. To
use the Project Inspector:

1.
2.

Select the file you want to assign in the project window.

Select Project Inspector from the Window menu. The CodeWarrior IDE
displays the Project Inspector window.

Click the Targets tab. The CodeWarrior IDE displays a Target window for the file
you selected in step 1 (see Figure 2-38 on page 2-60).
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274

Changing a build target name

roject Inspector

-

k]

i hello.c
J =]

Kind: Text file
Project: Example ARM Project. mop

Targets

¥ Felease
v Debug

v DebugRel —

[]

Hesert Sae |

Click either:
Revert, to undo the changes you have made

Save, to apply the changes.

Figure 2-38 Project Inspector window for targets

Select the checkbox next to a build target to include the file in that build target.
Deselect the checkbox to exclude the file from that build target.

This section describes how to change the name of a build target. For detailed
information on setting other target options see Chapter 9 Configuring a Build Target. To
change the name of a build target in the Targets view of the project window:

1.

Click the Targets tab to display the Targets view in the project window (see
Figure 2-35 on page 2-57).

Double-click the name of the build target you want to rename. The CodeWarrior
IDE displays the Target Settings window for that build target (see Figure 9-5 on

Select the Target Settings panel from the list of available panels and change the
name of the build target in the Target Name text field (Figure 2-39).
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44 DebugRel Settings
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Figure 2-39 Renaming a build target

[T Save project entries using relative paths

4. Click Save to save your changes.

You can also open the Target Settings window by selecting Target Settings from the
Edit menu. See Configuring target settings on page 9-14 for more information.

2.75 Creating build target dependencies

You can configure a build target to depend on other build targets. Build target
dependencies are useful when you want to ensure that the Code Warrior IDE builds one
or more specific build targets before the main, containing build target. In addition, you
can create link dependencies between build targets. When you make your project, the
CodeWarrior IDE compiles the dependent build target first, and then links its output
with the output from the main build target.

This section describes how to set up build target dependencies. See also:

. Creating a new build target on page 2-57 for more information on creating build
targets.
. Setting the current build target on page 2-55 for more information on setting the

current build target.

. Strategy for creating complex projects on page 2-54 for information on strategies
for setting up complex projects with build targets and subprojects.

To create a new, dependent build target and link its output with an existing build target:

1. Open the project to which you want to add the build target. Figure 2-40 shows an
example.
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Create a new build target:

a.

i @ Dependent Build Project.mcp [_ O] ]
Link Order | Targets
I £ DebugRel j | v @ =3
# | Fie Code | Data (WL} |
¢ [ mainc 0 0 s =~
=
1 file 1] 1] S

Figure 2-40 Project window

Click the Targets tab to display the list of build targets.
Select Create New Target... from the Project menu.

Type a name for the new target and select whether the build target is to be
based on an existing build target, or created as a new build target. See
Creating a new build target on page 2-57 for detailed information.

Click OK. The new Target is displayed in the list of targets (Figure 2-41).
By default, the new target is not dependent on any existing targets.

{ @ Dependent Build Project. mcp M=
Link Order
I £ DebugRel j ) v @ >
i Targets T
¥, DebugRel =
@ Release
@ Debug
% Mew Target
E
4 targets il i 7

Figure 2-41 Creating a new build target
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3. Add the new build target as a dependent to the main build target by dragging it
below and to the right of the main build target (Figure 2-42).

Drag the dependent build target below
and to the right of the main build target

;lExampIe depqndent build target.

|lﬁ Debugy{el jED Q’ @ = D

[ Thrgets ¥
Sy ) FjebugHeI
4@ Pelease
@ Debug

4 targets i i
Figure 2-42 Dragging a build target

4. Click the plus sign next to the main build target to display the list of dependencies.
The dependent build target is listed in italics underneath the main build target (see
Figure 2-43 on page 2-64). You can add the dependent build target to as many
main build targets as you require. The CodeWarrior IDE compiles the dependent
build target before attempting to compile the main build target.

—— Note

By default, the CodeWarrior IDE does not link the output from the dependent
build target with the output from the main build target. You must explicitly chain
the build targets if you want to link their output. See the following steps for more
information.

The output file from the dependent build target is displayed in the Files view of
the project.
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Dependent build target

;IEuampIe dependent build t3 ﬁet.
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Figure 2-43 Dependent build target

5.  Add files to the dependent build target. When you use the Add Files command,
you can specify the build targets to which the files are added. To add a file to the
dependent build target only, deselect the main build targets in the Add Files dialog
(Figure 2-44).

4 Add Files

Add files to targets:

|E Targets

™ DebugRel
™ Releass
[ Debug

V' Mew Target

Ll

=
Cancel |

Figure 2-44 Adding files to the dependent build target
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6.  (Optional) Click in the Link column next to the italic build target entry to chain
the dependent build target to the main target if you want the CodeWarrior IDE to
link the object code from the dependent build target with the main build target. A
dot is displayed in the link column to indicate that the build targets are chained
(Figure 2-45 on page 2-65).
Click the Link Order tab if you want to display the order in which the output
objects are linked. You can drag and drop the files in the Link Order view to
change the link order.

Click in the link column to link

output from the dependent buld
target with the main build target.

E Example dependent build target.

| | | |
d

|lﬂ DebugRel j 5|__"| @' @ [= D

] Targets ¥
- ¥ DebugRiel \ =
@ Aol *
L Release
w1 Debug
s NewT arget

4 targets 0 I}

Figure 2-45 Linking output from a dependent build target

7. Click the Make button, or select Make from the Project menu. The CodeWarrior
IDE compiles the dependent build target first, and links its output with the output
from the main build target if you have chained the output as described in step 6.

2.7.6  Building all targets in a project

The CodeWarrior IDE does not have single Build All command that will build all build
targets in a project. However, you can use target dependencies to create a dummy build
target that does nothing other than build all the other targets in your project.
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To create a Build All Targets build target:

1. Create a new build target using the Empty Target option in the new target dialog.
See Creating a new build target on page 2-57 for details.

2. Leave the target settings for the new build target as they are. That is, do not define
a linker or other target settings for the new build target.

3. Drag the existing build targets underneath and to the right of the new build target
listing in Targets view to create a build dependency. See Creating build target
dependencies on page 2-61 for more information on creating dependent build
targets.

The Build All Targets build target displays an italicized list of dependent build
targets. Figure 2-46 shows an example based on the ARM stationery. The new
build target is named Build All Targets.

i @ Dependent Build Project. mcp

Lirk. Order

Ilﬂ. DebugRel j (| @ @ =

Targets

4y DebugRel

- Release

{8 Debug

=i Build Al Targets
- @ Desbanb
G Palasse
@ Deiar

pl

[~

4 targets ] 0 S

Figure 2-46 Building all build targets

4. Ensure that the Build All Targets build target is the current build target. See
Setting the current build target on page 2-55 for more information.

5. Click the Make button, or select Make from the Project menu to build all the
dependent build targets.
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2.7.7 Creating subprojects within projects

A subproject is a standalone project that is nested within another project file. You can
use subprojects to organize your build into separate project files that can be separately
maintained. For example, you can use subprojects to build and maintain libraries that

are used in your main project file.

Subprojects are listed in the Files view of the project window with the other components
of your project. They can be assigned to any build target in the main project. When you
add a subproject, you can select the build targets to which it belongs.

You can configure your main project so that a Make command builds one or more build
targets in a subproject when it builds the containing build target in the main project. You
can also configure the main project so that it links the output from any build target in a
subproject to any build target in the main project. This means, for example, that you can
link the Release build target output from a subproject in which the code is well tested,
with the Debug or DebugRel build target of your main development project.

There are three important steps to compiling and linking the output from a subproject
with your main project:

1. Add the subproject to one or more build targets in the main project.

2. Specify which, if any, build target in the subproject should be built when the main
project is built. By default none of the build targets is built when the subproject is
first added.

3. Specify which, if any, output objects are to be linked with the output from the
main project. By default, none of the build target output objects are linked when
the subproject is first added.

Each of the steps is independent of the other. For example, you can specify that:

. a subproject build target is built when the main project is built, but not linked with
the main project

. the output from a subproject build target is linked, but the subproject build target
is not built when the main project is built.

The following example shows how to add an ARM object library project as a subproject
to an ARM executable image project, and gives details on how to specify link and build
dependencies:

1. Open the project to which you want to add a subproject. In this example, the main
project is an ARM Executable Image project based on the default ARM
stationery. See Using ARM-supplied project stationery on page 2-24 for more
information on the ARM stationery projects.
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2.

Add the subproject to the main project. In this example, the subproject is an ARM
Object Library project based on the default ARM stationery. You can either:

. Drag and drop the library project file from the Windows desktop to the main
project window.

. Select Add Files... from the Project menu and use the standard file dialog
to select the subproject. Figure 2-47 shows an example.

Select files to add... EHE

Look jn: Ia Library Subproject j | ﬁ(l IEE_
Library_Subproject_Data
Library Subproject. mcp

File name: Add

Files of lype: (el

Figure 2-47 Adding a subproject
The CodeWarrior IDE displays an Add Files dialog (Figure 2-48).

i4¢ Add Files

Add files to targets:

B Targets |
IV DebugRel =
¥ Releass
vV Debug

=
Cancel |

Figure 2-48 Add subproject to build target dialog

Select the build targets to which you want to add the library project as a subproject
and click OK. The library project is added as a subproject to each of the selected
build targets. Figure 2-49 on page 2-69 shows an example of the Files view for
the project.
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i mARM Ezecutable Image.mcp [ [O] x|
Link Order | Targets
I . DebugRel j B 3»
# | File [ Code | Data L[4 |«
B mainc 36 =~
B Library Subproject. mep nfa =
2 files 36 1] A

Figure 2-49 Project with subproject

Click the Targets tab to display the Targets view for the project and click the plus
sign next to a build target containing the subproject to expand the hierarchy. Each
build target in the subproject is listed in the hierarchy. Figure 2-50 shows an
example.

i mARM Executable Image.mcp M= B3
Link Order

[ ® DebugRel liE e @ e

R Targets v
48 DebugRel =
EHB Library Subproject. mep
- @ DebugRel
- @ Felease
@ Debug
@ Releaze
- EE

[~
3 targets S

Figure 2-50 Subproject build target view

Click on the Target icon next to the subproject build targets you want to build
when the main project is built (Figure 2-51). The CodeWarrior IDE displays an
arrow and target icon for build targets that are selected. When the main project is
built, selected targets are built first if they have changed, or have been touched.

For example, in Figure 2-51 the DebugRel and Release build targets in the
Example Subproject will be built before the DebugRel build target in the main
project.
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m Example Subproject. mcp | _ [O] x]
¥ DebugRel - 5 =
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-1 %) DebugRel =
=B Example Subpraject mep
%) DebugRel
¥). Release
i & Debug
Click the targe/
icon to select : g Ez:‘jjse
the build target d
3 targets

Figure 2-51 Selecting subproject build targets for building

Click in the link column next to the subproject build targets you want to link with
the main project output (Figure 2-52 on page 2-70). You can select multiple build
targets in the subproject, and link them with any of the build targets in the main
project. If you select multiple subproject build targets they are linked in the order
given in the link view.

ilExample Subproject. mcp - [Ofx

| | |
Click in the link
| #. DetugRel by B [ column to link a
build target

B Targets k
—1 9. DebugRel #
- Example Subproject.mep
|

#). DebugRel
#). Feleaze
@ Debug
+- @) Releaze Linked build
=@, Debug targets
- Example Subproject.mep
@. DebugRel

@ Feleaze /

). Debug -

3 targets 0 0

Figure 2-52 Selecting subproject build targets for linking
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—— Caution

You can create link dependencies to any of the build targets in a subproject. This
means that, if you are using the ARM-supplied project stationery, you can create
a link dependency to any, or all, of the Debug, DebugRel, and Release build
targets in the subproject, all of which might contain the same code, built with
different optimization and debug options.

When you build your project, the ARM linker selects the first available object file
that resolves the unresolved symbol it is processing. In the Link order view, the
output filenames for each of the build targets are identical (see Figure 2-53 on
page 2-71). Select the output file in the Files view and use the Project Inspector
to determine which output object is being linked. See Examining and changing
project information for a file on page 2-48 for more information.

i mExample ARM Project. mcp =] B3
I £ DebugRel j | v @ =3
[e] File | Code! Datal 4
B main.c 36 0 =]
« [ Library Subproject.a néa n'a &
« [ Library Subproject.a néa nia
E
3 files 0 0 A4

Figure 2-53 Multiple build targets in the Link order view
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2.8 Compiling and linking a project

The CodeWarrior IDE provides a number of ways to compile and link a project. All
compiling and linking commands are available from the Project menu. Depending on
your project type, some of these commands might be disabled or renamed. Also, a
compiling or linking menu item might be disabled because CodeWarrior is executing
another command.

If you have multiple projects open at the same time, you can set the default project that
CodeWarrior will use. See Choosing a default project on page 2-22 for more
information.

This section describes:

. Overview of compiling and linking

. Compiling files on page 2-74

. Making a project on page 2-77

. Removing objects from a project on page 2-79.

2.8.1 Overview of compiling and linking

This section assumes you are familiar with how to create a project, add source files and
libraries, group your files, and set the project and build target options. You should also
be familiar with features such as moving files in the project window, the project window
columns, and project window pop-up menus. See Overview of the project window on
page 2-4 for more information.

Note

. The CodeWarrior IDE can only compile and link files that belong to an open
project. You must have a project open before trying to compile its files.

. The Check Syntax command uses the compiler for the default build target to
check the syntax of source files that are not in a project.

Choosing a compiler

The CodeWarrior IDE uses file mappings to associate a compiler, or other tool, with a
specific filename extension. For C and C++ source files, the CodeWarrior IDE uses the
file mappings for the current build target to distinguish between source files targeted at
the Thumb C compiler and the ARM C compiler.

In the project stationery provided with CodeWarrior for the ARM Developer Suite:
. the ARM project stationery maps .c files to the ARM C compiler
. the Thumb project stationery maps .c files to the Thumb C compiler.
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To change the compiler used for a build target, you must change the file mapping for
that build target. See Using ARM-supplied project stationery on page 2-24 and
Configuring file mappings on page 9-40 for more information.

If you want to select between the Thumb compiler and ARM compiler for source files
in the same build target, you can adopt your own file naming conventions. For example,
to identify Thumb source files:

. Use a filename extension such as . tcc for all source files that you want to compile
with the Thumb compiler

. Define a file mapping between the Thumb compiler and . tcc files in the Target
configuration panels for the build target. See Configuring file mappings on
page 9-40 for more information.

Selecting a build target

When you compile one or more files in a project, the CodeWarrior IDE compiles the
files only for the currently selected build target. For example, if your current build target
is the DebugRel build target and you recompile your source files, the object code for the
Release and Debug build targets is not updated, and the CodeWarrior IDE does not
show the files in those build targets as being up to date. See Setting the current build
target on page 2-55 for more information.

—— Note

If you want to compile all the build targets in a project with a single command you can
create a master build target that includes all your other build targets as dependents. See
Creating build target dependencies on page 2-61 for more information.

Output file naming conventions and locations

When you compile an individual file, or make a project, the CodeWarrior IDE gives
conventional names to your output objects and images. By default, project output is
stored in subdirectories of the project data directory. You can change the output location
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by setting the default output directory in the Target Settings panel. See Configuring
target settings on page 9-14 for more information. Table 2-1 describes the output file
naming conventions and default locations.

Table 2-1 Default output names and locations

Output Naming convention Default location in the project folder
Executable ELF image Project Name.axf Project_Name_Data\Target_Name
Partially linked ELF object Project Name.o Project_Name_Data\Target_Name
ARM library Project Name.a Project_Name_Data\Target_Name
Object code filename.o Project_Name_Data\Target_Name\ObjectCode

2.8.2 Compiling files

This section describes how to use the CodeWarrior IDE to compile one or more source
files without invoking the linker to link the files. You can use the CodeWarrior IDE to
compile:

. the current editor window
. one or more selected files in a project
. all the files in a project.

The object files generated by the compilation are placed in a data subdirectory of your
main project folder. See Making a project on page 2-77 for information on compiling
and linking your source files and libraries.

Note
The CodeWarrior IDE compiles the files only for the currently selected build target. See
Setting the current build target on page 2-55 for more information on setting the build
target for a compilation.

The CodeWarrior IDE provides feedback on the progress of a compilation. When you
compile source code files and libraries, the CodeWarrior IDE:

. Places an animated build icon in the project window Touch column next to the file
currently being compiled.

. Displays the Build Progress window (Figure 2-54). The Build Progress window
displays a line count and the name of the file currently being compiled.
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Building Example ARM Project. mcp

F'roiect:| Exarnple ARM Project mep Talget:| DiebugRel Stop I
File | Task | File Count|  Line Count
dhiy_1.c | Compiling. | 1] 0

Totals | 2| I

Figure 2-54 Build Progress window

Compiling the current editor window

To compile a single file that is open in an editor window:

1.
2.

Ensure that the file you want to compile is part of a currently open project.
Click on the editor window to make it the currently active window.

Select Compile from the Project menu.

—— Note

The Compile menu item is unavailable if:

. there is no open project

. the active editor window does not have a source code filename extension

. the source code file for the active editor window is not included in your
project.

Compiling selected files from the project window

You can use the project window to compile one or more selected files, whether or not
those files are open in an editor window. To compile source files from the project

window:

1. Open the project that contains the files you want to compile.

2. Select one or more source files. See Selecting files and groups on page 2-37 for
information on selecting multiple files in the project window.

3. Select Compile from the Project menu. The CodeWarrior IDE compiles the files

you have selected regardless of whether they have been changed since the last
compilation.

— Note
The Compile menu item is unavailable if there is no open project.
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Bringing a project up to date

When you have many newly added, modified, or touched files in your project, you can
use the Bring Up To Date command to compile all the files. This command only runs
the appropriate compiler or the assembler, it does not invoke the linker.

To bring a project up to date:

1. Ensure that the project window for the project you want to bring up to date is the
active window.

2. Select Bring Up To Date from the Project menu. Source files in the project are
compiled if:

. the source file is new to the project and has not previously been compiled
. you have changed the file since the last compilation
. you have used the Touch command to mark a file for recompilation.

Note

The CodeWarrior IDE compiles files only for the currently selected build target. See
Setting the current build target on page 2-55 for more information on setting the build
target for a compilation.

Recompiling files after making changes

The CodeWarrior IDE does not always recognize file changes and might not
automatically recompile a file. For example, if you modify a file with a third-party
editor and you have the Use modification date caching option selected in the Build
Extras configuration panel, the CodeWarrior IDE will not recognize that the file has
been modified. To force CodeWarrior to recompile a changed file:

1. Click on the Header Files pop-up menu for the file you want to recompile and
select Touch. See Touching and untouching files on page 2-47 for more
information on touching files.

2. Select either Bring Up To Date or Make from the Project menu to recompile the
files you have touched.

Note
To update the modification dates stored in the project file for all files in your project,
select Synchronize Modification Dates from the Project menu. See Synchronizing
modification dates on page 2-48 for more information.
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Preprocessing source code

You can preprocess a file if you want to see what the code looks like just before
compilation. The preprocessor prepares source code for the compiler by:

. Interpreting directives beginning with the # and $ symbols, such as #define,
#include and #ifdef.

. Removing C and C++ style comments. Comments are any text enclosed in /x =/,
or any line prefixed with //.

To preprocess a C or C++ source file:

1. Open the file you want to preprocess, or select the file in the currently open
project window.

2. Select Preprocess from the Project menu. The preprocessed source file is
displayed in a new editor window with the name Preprocessed fiTename.

3. (Optional) Select one of the save commands from the File menu to save the
contents of the window to a file.

Checking syntax

You can check the syntax of your source code without compiling output objects. You
can check the syntax of any source file, regardless of whether it is included in a project.
However, you must have a project file open in order to check the syntax of source files
that are not in a project, because the Check Syntax command uses the compiler defined
for the current default build target. To check the syntax of a source file:

1. Select the source files to be checked. Either:
. select one or more source files in the project window
. open a source file in the editor and ensure that the editor window is the

currently active window.

2. Select Check Syntax from the Project menu. The CodeWarrior IDE invokes the
compiler for the current build target to check the syntax of the selected files.
Syntax errors are reported in a messages window.

2.8.3 Making a project

Select Make from the Project menu, or click the Make button in the project window
toolbar, to compile and link your source. This command builds the project by:

. compiling newly added, modified, and touched source files to produce ELF
object files
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. linking object files and libraries to produce an ELF image file, or a partially
linked object
. performing any postlink operations that you have defined for your build target,

such as calling fromELF to convert an ELF image file to another format.
If the project has already been compiled using Bring Up To Date or another command,
then the Make command performs only the link and postlink steps.
Setting the link order

You can specify the order in which files are compiled and linked using the Link Order
view of the project window. By rearranging the order of the files you can resolve link
errors caused by file dependencies. To set the link order:

1. Click the Link Order tab in the project window. The Link Order view is
displayed in the project window (Figure 2-55).

i @ dhry.mcp =] B3

I £ DebugRel j | v @ =3
| File | Code! Datal 4
B dhy 2c 472 0e @4
B dhy 1. 33400 10244 « =
B dhyh 0 (U |
. -
3 files 3k 10K A

Figure 2-55 Link Order view

2. Dragfilesinto the correct link order. Use drag-and-drop to reposition the files into
the build order you require.

The next time you select Bring Up To Date, Make, Run, or Debug, the new build order
is used when compiling the project files.

See Link Order view on page 2-9 for more information.

Note
. Changing the order of files in the Link Order view can change the order in which
the object code is placed in the final binary output produced from your project.
The CodeWarrior IDE invokes the ARM linker with a list of object files in the
order in which they are compiled.

By default, the ARM linker links object files in the order in which they are
presented. You can change the linker behavior by explicitly placing output
sections first or last in an image, or by using a scatter-load description file to
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specify the output image structure. See Configuring the ARM linker on
page 9-110 and the linker chapter of the ADS Compiler, Linker, and Utilities
Guide for more information.

You can generate link information by selecting options in the ARM Linker
configuration panel and remaking your project. See Configuring the ARM linker
on page 9-110 for more information.

2.8.4 Removing objects from a project

When you compile your project, the CodeWarrior IDE saves the object code generated
by the compiler and assembler in the project data directory. The object code increases
the size of the project folder. The Remove Object Code command removes object code
from a specific target, or from all targets.

—— Caution

Do not delete the contents of the data directory manually.

Removing object code

To remove the object code from a project:

1.

Ensure that the project window for the project is the current window, or that the
project from which you want to remove object code is selected as the current
default project.

—— Note

If you remove object code while an editor window is active, the CodeWarrior IDE
will remove object code from the current default project, regardless of whether
the file displayed in the current editor window belongs to that project.

Select Remove Object Code from the Project menu. The CodeWarrior IDE
displays a Remove Objects dialog box (Figure 2-56).

Metrowerks Code'W arrior E

Remove object code from project "Example ARM

& Project B1.mcp".

Removing object code from a target will require it to be
rehuilt. Do you want to remove the object code from only
the current target or from all targets in project "Example
ARM Project B1 .mcp"?

Al Targets | Current Target |

Figure 2-56 Remove Objects dialog box
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3. Click either:

. All Targets, to remove all object code data for all build targets in the
project, resetting the Code and Data size of each file in the project window
to zero.

. Current Target, to remove the objects for the current build target only. See

Setting the current build target on page 2-55 for more information on
changing the build target.

. Cancel, to cancel the operation so that object code is not removed.

2-80 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with Projects

29 Processing output

This section describes how to process project output. It describes:

. Disassembling code

. Converting output ELF images to other formats on page 2-82
. Creating libraries with armar on page 2-83

. Running batch files with the batch runner on page 2-84.

29.1 Disassembling code

You can configure the CodeWarrior IDE to call the ARM command-line tool fromELF
to display an assembly language listing for an object file, or library file. You can
disassemble an object file built from:

. the currently open source file in the editor window

. selected source files in the project window.

You can disassemble library files selected in the project window. You can also
disassemble output that has been processed by the fromELF utility. See Disassembling
fromELF output on page 2-83 for more information.

—— Note

To disassemble an image file built from your current project, you must configure your
build target to call fromELF as a postlinker. See Configuring target settings on
page 9-14 and Configuring fromELF on page 9-129 for more information.

Disassembling from the editor window
To disassemble an object file built from the current editor window source file:
1. Ensure that the editor window is the currently selected window.

2. Select Disassemble from the Project menu. If the object file is up to date, the
disassembled code is displayed in a new editor window. If the object file is not up
to date, the CodeWarrior IDE compiles the source file first.

3. (Optional) Select Save from the File menu to save the disassembled source code.

Disassembling from the project window
To disassemble an object file or source file from the project window:

1. Ensure that the project window is the currently selected window.
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Select one or more files to disassemble. You can select both source and library
files.

Either:

. select Disassemble from the Project menu.

. right click on the selected file and select Disassemble from the pop-up
menu.

If the object file is up to date, the disassembled code is displayed in a new editor
window. If the object file is not up to date, the CodeWarrior IDE compiles the
source file first. Disassembled source for each selected file is displayed in its own
editor window.

(Optional) Click on an editor window and select Save from the File menu to save
the disassembled source code.

2.9.2 Converting output ELF images to other formats

You can configure the CodeWarrior IDE to call fromELF to convert executable ELF

output from the linker to a number of binary formats suitable for embedding in ROM,

including:

. Plain binary

. Motorola 32-bit S-Record

. Intel 32-bit Hex

. Extended Intellec Hex

. Verilog Hex Format.

See the ADS Compiler; Linker, and Utilities Guide for more information on using

fromELF, including information on splitting fromELF output for multiple memory

banks.

To configure fromELF to process output images you must:

1. Configure the Target settings panel to call fromELF as a postlinker. See
Configuring target settings on page 9-14 for detailed instructions.

2. Configure the fromELF utility to generate the output you want. See Configuring
fromELF on page 9-129 for detailed instructions.

3. Select Make from the Project menu or click the Make button. The CodeWarrior
IDE compiles and links your code to produce an executable ELF output file, and
then calls fromELF to convert the output to the binary format of your choice.
The converted output is saved in:

ProjectName\ProjectName_Data\TargetName
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together with the executable ELF output.

—— Note

The fromELF utility can only convert executable ELF to binary formats. It cannot
convert object code or libraries.

Disassembling fromELF output

You can configure the CodeWarrior IDE to call fromELF to:
. convert output to a different binary format
. disassemble the converted output.

To disassemble converted binary output, you must configure the CodeWarrior IDE to
call fromELF twice:

1. Configure the Target settings panel to call fromELF as a Post-linker. See
Configuring target settings on page 9-14 for detailed instructions.

2. Configure the fromELF utility to generate the output you want. See Configuring
fromELF on page 9-129 for detailed instructions.

3. Configure the ARM Debugger or the ARM Runner panel to call fromELF as a
third-party debugger to disassemble the converted output binary. See Configuring
the ARM Debugger on page 9-136 for detailed instructions.

4.  Select Run or Debug from the Project menu, depending on whether you have
configured the Runner or Debugger panel to call fromELF. See Configuring the
ARM Runner on page 9-153 for more information on configuring a debugger to
run your images. The CodeWarrior IDE compiles and links your code to produce
an executable ELF output file, and then calls fromELF as a postlinker to convert
the output to the binary format of your choice.

When the compile and postlink operations are finished, the CodeWarrior IDE
calls fromELF as a third party debugger with the command-line options you have
specified in the configuration panel. Refer to the Utilities chapter of the ADS
Compiler, Linker, and Utilities Guide for detailed information on the
command-line options to fromELF.

2.9.3 Creating libraries with armar

To configure the Code Warrior IDE to call armar to output libraries in ar format you must
configure the Target Settings panel to call armar as the linker. See Configuring target
settings on page 9-14 for more information. armar combines object files from the

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 2-83



Working with Projects

compiler and assembler with any other object files in your build target, such as partially
linked ELF output from a subproject, into an object library. The output library is saved
in the build target subdirectory of the project data directory:

ProjectName\ProjectName_Data\TargetName

The easiest way to build library code is to use the ARM-supplied default project
stationery to create a library project. See Using ARM-supplied project stationery on
page 2-24 for more information.

2.9.4 Running batch files with the batch runner

The CodeWarrior IDE provides a batch runner utility that you can use to run a DOS
batch file from your project. To use the batch runner you must:

. Configure the file mappings for your build target to recognize .bat files. By
default, the ARM project stationery is not configured to recognize batch files.

. Configure the batch runner as the postlinker in the Target Settings panel.

Note

You can configure only one postlinker. This means that you cannot use the batch
runner and fromELF in the same build target.

. Add the batch file to the build target and make the build target. The batch runner
is run only after a successful link operation.
Configuring file mappings to recognize batch files

You must configure the file mappings for each build target to which you want to add
batch files.

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-8).

2. Click File Mappings in the Target Settings Panels list to display the configuration
panel (Figure 2-57 on page 2-85).
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44 DebugRel Settings

B Target Settings Panels  File Mappings
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Figure 2-57 File Mappings panel

3. Click the entry for the .c mapping in the File Mappings list to select it.
4. Change the filename extension, from .c to .bat.

5.  Click the Compiler pop-up menu and select None. Figure 2-58 shows an
example.

Mapping Infa

File Type: Chooze... | Extension:
Flags: Ij Compiler: [¥lH

Add | Change | Hemovel

Figure 2-58 Specifying batch file mappings
6.  Click Add to add a new file mapping.

7.  Click Save to save your changes.

Configuring the batch runner as the postlinker

To run batch files from your project, you must configure the batch runner to be run as a
postlinker in the Target Settings configuration panel.

To configure the batch runner:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-8).
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44 DebugRel Settings

Click Target Settings in the Target Settings Panels list to display the
configuration panel (Figure 2-59).
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=
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Output Directory:

{Project}

[T Save project entries using relative paths

Lef L] 1

Choose... |
Clear |

Factory Settings |

Fesert Fanel

Save |

Note

Either:

Figure 2-59 Target Settings panel

Click Save to save your changes.

Adding batch files and making the build target

To add the batch files and make your build target:

Select Add Files... from the Project menu

Drag and Drop the batch files onto the project window.

Click the Post-linker pop-up menu and select Batch File Runner. See
Configuring target settings on page 9-14 for more information on the other
options on this panel.

You can add one or more batch files to any build target you have configured to accept
files with a .bat extension. You can add any number of batch files to the build target,

however the batch runner will only run the batch file listed first in the Link Order view
of the project window.

If you try to add batch files to build targets in the current project that you have not
configured to accept .bat file extensions, the CodeWarrior IDE displays a warning
message and adds the batch files only to the properly configured targets.
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See Adding files to a project on page 2-38 for more information.

Touch your project files, if required, to ensure that the project is rebuilt. The batch
file runner is executed only after a link step. If your project is up to date, the linker
is not executed and the batch file runner is not run. See Touching and untouching
files on page 2-47 for more information.

Click the Link Order tab to specify which batch file is to be run, if you have
added more than one batch file to the build target. Drag the batch file you want to
execute so that it is displayed before any other batch file (Figure 2-60).

i mExample ARM Project. mcp =] B3
es Targets

[ ® Debuokel oy 3e
[e] File | Code! Datal 4
¥ @ mainc 36 0. =~
@ addh i 1o
¢ [ addc g U]
¢ [ batch2 bat nfa nfa [
¢ [ batchl bat nfa n.-"aé =
E
3 files 0 0 v

Figure 2-60 Setting the link order

Select Make from the Project menu, or click the Make button to build your
project. The first batch file in the link order list is executed after the linker has
completed, regardless of the order of the batch files in the Files view. For
example, batch2.bat in Figure 2-60 is executed first.
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Chapter 3
Working with the ARM Debuggers

This chapter describes how to use the CodeWarrior IDE and the ARM debuggers to run
and debug your code. It contains the following sections:

. About working with the ARM debuggers on page 3-2
. Controlling debugging in a project on page 3-4
Running and debugging your code on page 3-10

. Using the message window on page 3-12.
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3.1

3.141

About working with the ARM debuggers

You can call any of the ARM debuggers from the CodeWarrior IDE to either debug, or
run images output from a make operation. This section gives an overview of how the
ARM debuggers integrate with the CodeWarrior IDE.

How the ARM debuggers work with the CodeWarrior IDE

CodeWarrior for the ARM Developer Suite enables you to call an ARM Debugger with
a number of optional arguments, depending on the debugger you are using. When you
select Debug or Run from the Project menu, the CodeWarrior IDE starts your selected
debugger and instructs it to load the image file output from the current build target.
When the image is loaded into the debugger, all control passes to the debugger. You
must use the debugger interface to perform operations such as stepping, inserting
breakpoints, and examining memory.

Note

The CodeWarrior IDE displays a Debug menu in the main menu bar. The Debug menu
is not used by CodeWarrior for the ARM Developer Suite.

Selecting the ARM debugger and ARM runner

You can select any of the ARM debuggers to either run or debug your executable
images. You do not have to use the same debugger for running and debugging. The
following debuggers are available:

. ARM eXtended Debugger (AXD)
. ARM Debugger for Windows (ADW)
. ARM symbolic debugger (armsd).

In addition, you can select a third party debugger in place of the ARM debuggers. See
Configuring the debugger on page 9-135 for detailed information on selecting a
debugger and a runner. See the ADS Debuggers Guide for detailed information on using
the ARM debuggers.

Using the Run/Debug button

The CodeWarrior IDE uses the same button both to run and to debug output images,
depending on whether or not debugging is enabled for your project. The tool tip for the
button displays either Run or Debug, depending on how the build target is configured.
See Enabling debugging for a build target on page 3-4 for more information.

3-2
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Selecting debug options

There are a number of options to the ARM compilers that affect the quality of the debug
view available to the debuggers. You can set the debug configuration options in the
compiler configuration panels. The debug options are used to create the Debug,
DebugRel, and Release build targets. See below for more information. See Configuring
the compilers on page 9-72 for more information on setting build options yourself.

Using the Debug, DebugRel, and Release build targets

The default project stationery provided with CodeWarrior for the ARM Developer Suite
defines at least three build targets for each project type:

Debug This build target is configured to generate the most complete debug
information possible for each source file in the build target.

DebugRel  This build target is configured to generate adequate debug information
for each source file in the build target.

Release This build target is configured with debug table generation turned off.

—— Note

You must select Enable Debugger for the Debug and DebugRel build targets in order
to debug, rather than run, your output image. See Enabling debugging for a build target
on page 3-4 for more information.

See Using ARM-supplied project stationery on page 2-24 for more information on the
default build targets. See also Working with multiple build targets and subprojects on
page 2-53 for more information on using multiple build targets in your projects.
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3.2 Controlling debugging in a project

You can specify whether debugging is enabled for one or more source files, for each
build target in a project. To enable debugging for a build target:

. Select Enable Debugger from the Project menu to instruct the CodeWarrior IDE
to execute a debugging session, rather than run session, when you click the
Run/Debug button in the project toolbar. In some circumstances, this command
also turns on debug table generation for all source files in the build target. See
Enabling debugging for a build target on page 3-4 for more information.

. Configure the ARM tools to generate debug table information when your source
code is compiled and assembled. There are two, independent ways to enable
debug table generation:

—  Use the debug column in the project window to enable debug table
generation for individual source files. See Generating debug information
for individual source files on page 3-5 for more information.

—  Use the Compiler and Assembler configuration panels to configure the
ARM tools to generate debug tables. If debugging is turned on in the
configuration panels, debug tables are generated for all source files in the
current build target. See Generating debug information for all source files
in a build target on page 3-7 for more information.

Note

The debug settings specified in the configuration panels override the settings for
individual source files. This means that you can generate debug table information
for an individual source file if the configuration panel debug option is turned off,
but you cannot turn off debug table generation for a specific source file if the
configuration panel debug option is turned on.

3.21 Enabling debugging for a build target
To enable debugging for the current build target:

1. Select the build target for which you want to enable debugging. See Setting the
current build target on page 2-55 for more information.

2. Select Enable Debugger from the Project menu. The CodeWarrior IDE response
depends on whether or not source files in the current build target have debugging
enabled in debug column:

. If no source files have debugging enabled in the debug column, the
CodeWarrior IDE displays a confirmation dialog (Figure 3-1 on page 3-5).
See the steps below for more information.

3-4 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with the ARM Debuggers

Metrowerks Code'W arrior E

Enable debugger for target "Release".

& The debugger requires certain target settings in order to
function correctly. Do you want Codeiarrior to
configure these settings automatically for the target
"Releaze"?

Cancel |

Figure 3-1 Enable debugging confirmation

. If at least one source file has debugging enabled in the debug column, the
CodeWarrior IDE does not change the debug status of any source files in
the build target. The debug target is configured to execute a debug session
when you click the Debug/Run button in the project toolbar.

3. Click Yes if the Enable debugging confirmation dialog is displayed and you want
to enable debugging. The CodeWarrior IDE:

. enables debugging in the debug column for every source file in the current
build target
. is configured to execute a debug session when you click the Run/Debug

button in the project toolbar.

—— Caution

Selecting Disable Debugger from the Project menu does not deselect debugging
for individual source files. This means that, if your project is based on the default
ARM stationery and you turn on debugging for the Release build target, you must
manually deselect the source files in order to turn debug table generation off
again, and build an output image without debug tables. See Generating debug
information for individual source files on page 3-5 for more information.

Adding source files to a debug-enabled build target

When you add source files to a build target, the debug state of the file is configured to
match the state of the Enable Debugger menu command setting in the Project menu.

3.2.2 Generating debug information for individual source files

You can enable debug table generation for one or more individual source files in the
current build target provided the ARM tools are not configured to generate debug
information for the entire build target. See Generating debug information for all source
files in a build target on page 3-7 for more information. If the ARM tools are configured
to generate debug information, selecting or deselecting individual source files has no
effect.
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Note
You can also use the Project Inspector window to enable or disable debugging
information. See Examining and changing project information for a file on page 2-48
for more information.

To generate debugging information for a source code file:

1. Select the build target for which you want to enable debugging. See Setting the
current build target on page 2-55 for more information.

2. Select the source files or groups for which you want to enable debugging:

. Click in the Debug column next to a single source file to turn on debug table
generation.

. Alt-click in the Debug column next to a source file or group to enable
debugging for all source files in the current build target.

. Click in the Debug column next to a group to enable debugging for all
source files in a group.
Note

To enable debugging for source files in a subtarget or subproject you must
open the build target or subproject.

For selected files, the debug column displays a Debug Info marker (on page 3-7)
and marks the source files for recompilation.

For selected groups, the Debug column displays one of three markers:

. a black marker indicates that all source files in the group generate
debugging information

. a gray marker indicates that only some of the source files in the group
generate debugging information

. no marker indicates that no debugging information is generated for source
files in the group.
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Figure 3-2 Debug Info markers

3. Select Make from the Project menu or click the Make button to build your
project. The ARM tools generate debug information for selected source files only,
provided the tool configuration panels are not configured to generate debug
information.

3.2.3 Generating debug information for all source files in a build target

There are two ways in which you can configure the CodeWarrior IDE to generate debug
information for all files in the current build target:

. Select Enable Debugger from the Project menu when no files in the current
build target are individually selected to generate debug information:

— if no files are individually selected for debug table generation, the
CodeWarrior IDE selects all files in the current build target

— if any file is selected for debug table generation, the CodeWarrior IDE does
not change the debug selection settings.

See Enabling debugging for a build target on page 3-4 for more information.
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Use the ARM compiler and assembler configuration panels to turn on debug table
generation. You can use these panels to generate debug table generation for each
tool. If you want to generate debug information for all source files in your current
build target, you must select the appropriate options for each compiler, and for the
ARM assembler.

Note

The default ARM project stationery is configured to generate debug information for all
source files in the Debug and DebugRel build targets. See Using the Debug, DebugRel,
and Release build targets on page 3-3 for more information.

Example: Using the compiler configuration dialogs

The following example shows how to enable debug setting for the ARM C compiler.
The steps for the assembler and C++ compilers are similar. To enable debug table
generation for all C source files in a build target:

1.

Open your project window and select the build target you want to configure. See
Selecting a build target on page 2-73 for more information.

Click the Target Settings button to display the Target Settings window for the
build target you want to configure. See Displaying Target Settings panels on
page 9-8 for more information.

Click the ARM C Compiler entry in the Target Settings Panels list, and click the
Debug/Opt tab to display the configuration panel (Figure 3-3 on page 3-8).

44 DebugRel Settings

B Target Settings Panels H 4Fit C Compiler
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Figure 3-3 ARM compiler Debug/Opt panel
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Select Enable debug table generation to instruct the compiler to generate
DWARF2 debug tables. See Configuring debug and optimization on page 9-96
for more information on the other options available on this panel. See Configuring
assembler options on page 9-63 for detailed information on selecting Assembler
debug options.

Click Save to save your changes. When you make your project, the compiler
generates debug tables for all C source files in the current build target, regardless
of the debug settings of individual files in the target.

ARM DUI 0065C
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3.3 Running and debugging your code

This section describes how to run executable images from within the CodeWarrior IDE,
and how to call one of the ARM debuggers to run or debug your code.

3.3.1 Running a project
To call an ARM Debugger to run an executable image from the CodeWarrior IDE:
1. Ensure that the project you want to run is the currently active window.

2. Ensure that debugging is not activated for your project. See Enabling debugging
for a build target on page 3-4 for more information.

3. Select the Run from the Project menu, or click the Run/Debug button
(Figure 3-4).

Click the Run/Debug button
to run or debug your project

i 3
| | | |

R \

|ﬂ Releaze j ED Q’/ @ L D

Figure 3-4 The Run/Debug button

The CodeWarrior IDE compiles and links the currently selected build target, if
necessary, and creates an executable image file. It then executes the image file
with the debugger selected in the ARM Runner target configuration panel (see
Configuring the ARM Runner on page 9-153).

Note

If the current build target is configured to produce non-executable output, such as
a library or a partially linked object, the Run menu item is not available.

3.3.2 Debugging a project
To call an ARM Debugger to debug an executable image from the CodeWarrior IDE:
1. Ensure that the project you want to debug is the currently active window.

2. Ensure that you have set the correct debug options for your build target. See:

. Configuring the ARM Debugger on page 9-136 for information on how to
select an ARM debugger.
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. Configuring assembler and compiler language settings on page 9-51 for
information on how to enable debug table generation for the assembler and
compilers.

—— Note

If your project is based on ARM-supplied stationery there are at least three
separate build targets defined:

. Debug
. DebugRel
. Release.

If you are planning separate Debug and Release versions of your code, select
Project — Set Current Target... — Debug to set the Debug build target. The
Debug build target is configured to generate the most complete debug
information at the expense of optimization.

If you are planning to release the same code you are debugging, select Project —
Set Current Target... — DebugRel. This build target generates adequate debug
information and provides good optimization.

Select Enable Debugger from the Project menu, if debugging is not already
enabled.

Select Debug from the Project menu. The CodeWarrior IDE compiles and links
your build target, if required, and calls the debugger you have specified in the
ARM Debugger configuration panel (see Configuring the ARM Debugger on
page 9-136).

See the ADS Debuggers Guide for detailed information on using the ARM debuggers.
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34 Using the message window

This section describes the message window. The message window displays messages

about events that have occurred when compiling, linking, or searching files. There are

two basic types of message window:

. the Errors & Warnings message window

. the Notes message window.

These are described in:

. Overview of the message window on page 3-12

. Using the message window on page 3-15.

3.441 Overview of the message window

The message window displays the following types of messages:

Errors Error messages are given by the compilers, assembler, linker, or fromELF
in response to errors that prevent them from completing an operation. The
final output from the tool is not created.

Warnings  Warning messages are given by the compilers, assembler, or linker, in
response to a problem, or potential problem from which the tool can
recover. Problems that cause warning messages might result in problems
in the final output file.

Notes These are informational messages that are given in response to an
operation.

Note
Some Notes messages indicate a problem that is serious enough to stop
output being produced.

The different message types are displayed in two variants of the message window:

Error & Warnings message window
This message window displays error and warning messages from the
compiler, assembler, linker, and postlinker. Notes are not displayed in the
Errors & Warnings message window.

Notes message window
This message window displays all other types of message, including:

. The results of a batch Find operation.
3-12 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C
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. Messages displayed when the CodeWarrior IDE adds an access
path to your project.

. A message if you try to build an up-to-date project, if this option is
selected in the Build Settings preferences panel. See Configuring
build settings on page 8-6 for more information.

Error and warning messages are not displayed in the Notes message
window.

The message window contains interface elements that enable you to perform common
tasks such as:

. viewing error messages, warning messages, and other diagnostic messages

. navigating to locations in your source code that caused an error message or
warning message.

Some user interface items in the message window are not described here. See Overview
of the editor window on page 5-3 for more information on:

. the Markers pop-up menu

. the Document Settings pop-up menu
. the Version Control pop-up menu

. the Line Number button.

. the File Path caption

Figure 3-5 on page 3-14 shows an example of the Errors & Warnings message window.
The major interface components of the window are described below.

—— Note

Not all interface elements appear in all message windows. For example, Notes message
windows display the Source Code pane only if it is applicable to the specific message.

ARM DUI 0065C
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Figure 3-5 The Errors & Warnings message window
The major interface components of the message window are:

Errors button
The Errors button toggles the view of error messages on and off. See
Viewing error and warning messages on page 3-16 for more information.
Warnings button

The Warnings button toggles the view of warning messages on and off.
See Viewing error and warning messages on page 3-16 for more
information.

Project Information caption

The Project Information caption gives a short description of the view you
are looking at in the message window. Your project name is displayed
here.

Extra Information button

The Extra Information button expands a message to show information
about the project, target, and file that caused a message.
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Stepping buttons

The Stepping buttons enable you to step up or down through the
messages in the window. See Stepping through messages on page 3-16
for more information.

Message List pane
The Message List pane displays your messages. See Viewing error and
warning messages on page 3-16 for more information.

Source Code Disclosure triangle
The Source Code Disclosure triangle enables you to hide the Source
Code pane of the message window.

Source Code pane

The Source Code pane of the message window enables you to view the
source code at the location referred to by a message. See Viewing error
and warning messages on page 3-16 for more information.

Pane resize bar

The pane resize bar enables you to reallocate the amount of space in the
message window given to the Source Code pane and Message List pane.
Click and drag this bar up or down to change the amount of space on your
computer screen that is allocated to both panes.

3.4.2 Using the message window

The message window displays any error and warning messages given by the compilers,
assembler, linker, and other tools when processing a menu command such as Make,
Bring Up To Date, or Check Syntax. This section explains how to interpret, navigate,
and use the information that appears in the message window. It describes:

. Viewing error and warning messages on page 3-16

. Filtering error and warning messages on page 3-16

. Stepping through messages on page 3-16

. Correcting compilation errors and warnings on page 3-17
. Correcting link errors on page 3-18

. Searching library files on page 3-19

. Printing the message window on page 3-19

. Saving the message window on page 3-20.
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Viewing error and warning messages

The message window is opened by the CodeWarrior IDE to display messages. To close
the message window either:

. click its close box
. select Close from the File menu while the message window is the active window.

To reopen the message window, select Errors & Warnings Window from the
Windows menu.

Note

This menu item is available only if a list of Errors or Warnings has already been
generated as the result of a Make, or compile operation.

Filtering error and warning messages

You can choose whether the Errors & Warnings message window displays either error
messages, or warning messages, or both by using the Errors button and the Warnings
button at the top of the message window.

By default, both the Errors button and the Warnings button are selected when the
CodeWarrior IDE displays an Errors & Warnings message window. You can specify
which types of message you want to view:

. To view only error messages in the Message List pane, click the Warning button
to deselect it and ensure that the Error button is selected.

. To view only warning messages in the Message List pane click the Error button
to deselect it and ensure that the Warning button is selected.

. To view both error messages and warning messages in the Message List pane,
ensure that both buttons are selected.

Note
Notes are not displayed in the Errors & Warnings message window.

Stepping through messages

To move to a specific message in the list of messages displayed in the message window
either:

. click the up and down stepping buttons
. click the error message you want to select
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use the up and down arrow keys.

As you move through the error and warning messages, the source code that caused the
message is displayed in the Source Code pane. See the following sections for
information on how to correct errors and warnings.

Correcting compilation errors and warnings

To correct a compilation error or warning from the Source Code pane of the message
window:

1.

Ensure that the Source Code pane of the message window is visible. If it is not
visible, click the Source Code Disclosure Triangle to display the pane (see on
page 3-14).

Select a message in the Message List pane of the message window to view the
statement that caused the message. The Source Code pane displays the source

code that caused the message. A statement arrow points to the line of code that
the compiler or assembler reports as an error. (Figure 3-6 on page 3-18).

—— Note

If you have corrected an error or modified the source code since the message list
was generated, the CodeWarrior IDE might not be able to locate the correct
position in the source code file. In this case, the CodeWarrior IDE displays an
alert telling you that the position of the error or warning could not be found. You
must recompile your project to update the list of errors and warnings in the
message window.
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return 0;
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Figure 3-6 Statement arrow pointing to an error
3.

Either edit the source code directly in the Source Code pane or open the file in its
own Editor window.

To open a source code file that corresponds to a given message either:

. select the message in the Message List pane and press Enter

double-click the message in the Message List pane.

Note

You can use the Header Files pop-up menu, Functions pop-up menu, or the Line
Number button to navigate the source code for a selected message. See Overview
of the editor window on page 5-3 for more information.

Correcting link errors

There are many possible causes of link errors. Some of the most common are:

You have misspelled the name of a library routine. This means that the routine
that the linker is searching for does not exist.

You are using inconsistent ATPCS options for the compilers and assembler. See
Configuring assembler ATPCS options on page 9-58 and Configuring compiler
ATPCS options on page 9-80 for more information.

3-18
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Your project is missing the necessary libraries. Check that your access paths
include the directories where you store your libraries. See Configuring access
paths on page 9-20 for more information.

Check also that the setting for the Use ARMLIB to find libraries option is as
you expect. If this option is selected, the ARM tools use the ARMLIB
environment variable to search for libraries. See Configuring linker options on
page 9-117 for more information.

You have not correctly linked the output from a dependent build target or
subproject. You must explicitly specify that output from a subproject or subtarget
is linked into your final output image. See Working with multiple build targets and
subprojects on page 2-53 for more information.

You have not correctly set up your linker output options. See Configuring the
ARM linker on page 9-110 for more information.

Link errors are displayed in the message window in the same way as compilation errors.
See Viewing error and warning messages on page 3-16 for information on how to move
through the message window.

Searching library files

You can use armar to create a searchable text file of symbols in library files. For
example, to create a text file of the symbol tables for all little-endian ARM C library

files:
1.
2.

Open a DOS command prompt window.

Change directory to: install_directory\lib\armlib.

Type:
armar -zs libname >> filename.txt

for each of the little-endian libraries.

Edit the duplicate symbol names from the text file, if you want to.

Printing the message window

To print the message window:

1.
2.
3.

Ensure that the message window you want to print is the active window.
Select Print from the File menu. The Print dialog box is displayed.

Select the print options you require and click OK. The message window is
printed.
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Saving the message window
To save a message window to a text file:

1. Ensure that the message window you want to save is the active window. You must
click in the Error & Warnings message section of the window, not the Code
section, in order to save the error and warning messages.

2. Select Save A Copy As... from the File menu. The CodeWarrior IDE displays a
standard file dialog box.

3. Enter aname for the file and click Save. The CodeWarrior IDE saves the contents
of the active message window to a text file.

Copying the message window to the clipboard

To copy the contents of the message window to the Windows clipboard:

1. Ensure that the message window is the currently active window.

2. Select Copy from the Edit menu. The entire contents of the message window is
copied to the clipboard. You can paste the clipboard contents into a text editor or
other application.
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Chapter 4
Working with Files

This chapter describes how to work with source files in the CodeWarrior IDE. It
contains the following sections:

. About working with files on page 4-2

. Creating and opening files on page 4-3

. Saving files on page 4-12

. Closing files on page 4-16

. Printing files on page 4-18

. Reverting to the most recently saved version of a file on page 4-20
. Comparing and merging files and folders on page 4-21.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved.



Working with Files

4.1 About working with files

This chapter gives information on how to use the CodeWarrior IDE to perform basic
operations on files, including source files, project files, and text files. It describes basic
file operation such as opening, closing, saving, and printing files.

In addition, it describes how to use more sophisticated features of the CodeWarrior IDE,
such as:

. navigating between related files (see Switching between source and header files
on page 4-10)

. using the built-in file comparison features to compare and merge one or more files
(see Comparing and merging files and folders on page 4-21).

This chapter does not provide detailed information on editing or managing files within
a project. See:

. Chapter 2 Working with Projects for information on how source files fit into the
project structure

. Chapter 5 Editing Source Code for information on how to use the CodeWarrior
editor to edit files

. Chapter 10 Using CodeWarrior IDE with Version Control Systems for more
information on working with files that you have checked into a revision control
system.
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4.2 Creating and opening files

There are several ways to open a file with the CodeWarrior IDE. This section describes:
. Creating a new file

. Opening files from the File menu on page 4-5

. Opening files from the project window on page 4-6

. Opening header files from an editor window on page 4-9.

— Note
You cannot open libraries with the CodeWarrior editor.

421 Creating a new file
You can create a new text file in the following ways:

. Using the New Text file menu command to create a new text file immediately.
See Using New Text File on page 4-3.

. Using the New... menu command to create a new text file with the New dialog
box. See Using the New dialog on page 4-4.

Using New Text File

To create a new source file:

1. Select New Text File from the File menu. A new, untitled editor window is
displayed with the text insertion point on the first line of the window.

2. Enter your text or source code, as required. See Chapter 5 Editing Source Code
for more information on editing text.

3. Save the text file. See Saving files on page 4-12 for more information.

—— Note

A new text file is not associated with any project. You must specifically add the new file
to your project. See Adding files to a project on page 2-38 for more information.
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Using the New dialog

You can use the New dialog to create a new source file and optionally include it in a
project. To create a new source file:

1.

Select New... from the File menu and click the File tab in the New dialog box.
The CodeWarrior IDE displays the File panel with a list of new file types
(Figure 4-1).

Note

See Creating a new project on page 2-13 for more information on the Project tab.
The Object tab is not used by the ARM version of the CodeWarrior IDE.

New ]
Project  File | Object I
53l Component Catalog File File rarne:
@ Text File IExampIe.c
Location:
IE:\ExampIe Projects\Mew Folder | Set... |
[ Add to Project
Project:
Targets:
’TI Cancel |

Figure 4-1 The New dialog box

Click Text File to create a new Text file.

Note

The Component Catalog File list item is not used by the ARM version of the
CodeWarrior IDE.

Enter a file name for the new file in the File name text field. If you want to add
the new file to a build target in an existing project you must ensure that the
filename you enter uses a filename extension that is defined in the File mappings
panel for the build target. See File Mappings panel on page 9-42 for more
information.

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Working with Files

Enter a directory path to the new file in the Location field, or click Set... and
select the directory from the standard file dialog.

Select the Add to Project checkbox if you want to add the new file to an existing

project (Figure 4-2):

a. Click the Project pop-up menu to select the project you want to add the file
to from the pop-up list of currently open projects. The Targets field displays
a list of the build targets defined for the project you select.

b. Select the build targets to which you want to add the source file.
Click OK to create the new file. If you have selected Add to Project, the new file

is added to the selected build targets, provided the filename extension of the new
file is defined in the File mappings configuration panel for the build targets.

New ]
Project  File | Object I
53l Component Catalog File File rarne:
@ Text File IExampIe.c

Location:
IE:\ExampIe Projects\Mew Folder | Set... |

¥ &dd to Project
Project:

IAF!M Executable Image.m * l

Targets:

()8 I Cancel |

Figure 4-2 Add new file to project

4.2.2 Opening files from the File menu

You can open two types of files in the CodeWarrior IDE:

Project files. See Working with simple projects on page 2-13 for information on
opening projects.

Text files, such as a source code file, header file, or other text file.

ARM DUI 0065C
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Opening text files
To open a text file or a source code file:

1. Select Open... from the File menu. The CodeWarrior IDE displays an Open
dialog box (Figure 4-3).
Open

Loaok jn: Ia cpp j gl |°_ i

w strmtst cpp

newtst cpp
shapez.cpp

File: name: DOpen

[ e |
Cancel |

Source Files

Files of bope:

Figure 4-3 Open dialog box

2. Select All Files from the Files of Type pop-up menu. The list of displayed files
changes to show all the files in the current directory, including text files.

3. Select the file you want to open and click Open. The CodeWarrior IDE opens the
file in an editor window. See Chapter 5 Editing Source Code for more information
on editing the file you have opened.

4.2.3 Opening files from the project window

There are a number of ways to open files from within the project window, depending on
the type of file you want to see. These are:

Using the File column
Use this column to open a file that is in the project.

Using the Group pop-up menu
Use this pop-up menu to open a text source file from within a collapsed
group.

Using the Header Files pop-up menu

Use this pop-up menu to open a header file #incTuded from a project
source file.
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To open a file from the File column:

Working with Files

1. Select the file or files you want to open from the File column in the File view or
Link Order view of the project window. See Selecting files and groups on
page 2-37 for information on selecting multiple files in a project.

2. Open the selected files. Either:

. double-click the selected files
. press the Enter key.

The CodeWarrior IDE opens selected text files in an editor window. If project
files are selected, the CodeWarrior IDE opens the project. If library files are
selected they are ignored. To view the contents of library files, right click on the
library file and select Disassemble from the pop-up menu.

See Overview of the project window on page 2-4 for more information on the File
column.

Opening files from the Group pop-up menu

You can open a source file from the pop-up menu for the group that contains the file,
even if the group is collapsed and the file is not visible in the project window.

To open a file from the Group pop-up menu:

1. Select the group that contains the source file you want to open.
2. Click the pop-up button for the group. A Group pop-up menu is displayed that
contains a menu item for each file within the group. Figure 4-4 shows an example.
{ @ Ips_irq.mcp =10] =]
Link Order | Targets
I 8 Semihosted j j y @ [
# | Fie Code | Data [4]
B main.c 500 16 oo E~
M retarget.c néa nfa =
B serialc néa nfa =

FHCT Interrupt handlers 96 0 « =

[E3R ] s senbly source] I 0 Z]

FHZ3 Dacumentation 0 0 init. s
vechors.s
|

8 files 556 16 A

Figure 4-4 Group pop-up menu
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3. Select the menu item for the source file that you want to open. The file is opened
in an editor window.

Opening header files from the Header Files pop-up menu
To open a header file that is associated with a source file:
1. Select the source file in the project window.

2. Click the Header Files pop-up button. A list of header files is displayed.
Figure 4-5 shows an example.

Two types of header file are displayed:

. Header files enclosed in angle brackets <. ..> are system header files found
in the System access paths. See Configuring access paths on page 9-20 for
information on how the CodeWarrior IDE searches for system header files.

. Header files that are not enclosed in angle brackets are header files that are
found in the User access paths. You might have created these header files
yourself, or been supplied with them in order to use exported functions of
a library. See Configuring access paths on page 9-20 for more information
on how the CodeWarrior IDE searches for user header files.

! oExample ARM Project. mcp M [=]E3

Link Order || Targets

I ¥ Debug j N @ =
# | Fie Code | Data (ML [
@l Helo.c 76 0+ o+ =L
W addc 12 0+ =
M3 Comman 64 0« + =
B E) startup. o B4 0+ [
B Example ARM library.mep na T Touch
M Example ARM library.a 4711 9422
startup.h
tadd h
[~
5 files 4K 9t A

Figure 4-5 Header Files pop-up menu in the project window

3. Select the header file you want to open from the list. The CodeWarrior IDE opens
the header file in an editor window.

Note

. You can press Ctrl-" to switch between a source file and its header file. See
Switching between source and header files on page 4-10 for more information.
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If you click the Header Files pop-up button for a library file that is part of your
project, you will only have the option to Touch or Untouch the library file. You
cannot open the corresponding header file for a library file in this way. See

Touching and untouching files on page 2-47 for more information on touching
files.

4.2.4 Opening header files from an editor window

The following sections describe various ways to open header files from within an editor
window:

Open a header file using the Header Files pop-up menu on page 4-9
Opening a header file with the Find and Open menu item on page 4-9
Switching between source and header files on page 4-10.

Open a header file using the Header Files pop-up menu

To open a header file from within a source file you are editing:

1.

Click the Header Files pop-up menu at the top left of the editor window (see
Figure 5-10 on page 5-22). The pop-up menu lists all header files used by the
source file.

Select a file from the list displayed in the Header Files pop-up menu to open it
in a new editor window.

—— Note

If there are no files available in the pop-up menu, it means either:
. the source file has not yet been compiled

. your text file does not contain any source code

. the source file does not include any header files.

Opening a header file with the Find and Open menu item

You can use the Find and Open menu item to open header files in two different ways:

If you are editing a source file and the source file contains the name of a header
file:

1. Select the name of the header file you want to open. For example, if the
source file contains:

ARM DUI 0065C
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#include <stdio.h>

#include <string.h>

// source code

you can double click on stdio or string to select it. You do not need to
select the .h part of the name.

2. Select Find and Open ‘Filename’ from the File menu. The CodeWarrior
IDE searches for the selected file and opens it in an editor window. If the
file cannot be found, a system beep sounds. The CodeWarrior IDE uses the
settings specified in the Access Paths configuration dialog to search for the
header file.

. If you are editing a source code file and want to open a file without selecting any
text:

1. Select Find and Open File from the File menu. The CodeWarrior IDE
displays a Find and Open File dialog (Figure 4-6)

Find and Open File

Open: | |
™ Search Only in System Paths

Cancel | ak. I

Figure 4-6 Find and open file dialog box

2. Type the name of the header file you want to open in the Open text field.
The CodeWarrior IDE uses the settings specified in the Access Paths
configuration dialog to search for header files.

3. Select the Search Only in System Paths option if you want to restrict the
search to the directories specified in the System Paths pane of the Access
Paths configuration dialog.

Turn the Search Only in System Paths option off to search both System
Paths pane and User Paths pane directory paths (all paths specified in the
Access Paths).

See Configuring access paths on page 9-20 for more information on configuring access
paths.
Switching between source and header files

You can use the Ctrl-" keyboard shortcut to switch back and forth between a header file
and its corresponding source file. To do this, your header file must have the same name
as your source file, except for the file extension.

4-10
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For example, if you are editing myFile.cpp and you want to see the associated header
file, press Ctrl-" to display myFile.h in a new editor window. Type the same keyboard
shortcut again to switch back to myFile.cpp file.

The CodeWarrior IDE searches the project directories defined in the Access Paths
settings panel to find the header file. See Configuring access paths on page 9-20 for
more information on configuring access paths.

ARM DUI 0065C
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4.3 Saving files

This section describes the ways that the Code Warrior IDE can save files. It contains the
following sections:

. Saving project files
. Saving editor files
. Saving a backup copy of a file on page 4-14.

4.3.1 Saving project files

Projects are opened for exclusive read/write access and are continually updated on the
disk. Projects are saved when they are closed, when you exit the CodeWarrior IDE, or
when you select Save A Copy As... from the File menu. You do not need to save
projects explicitly.

4.3.2 Saving editor files

You can save editor files either explicitly, or automatically when your project is built.

Saving one file
To save your changes to a single text file:
1. Ensure that the text window you want to save is the active window.

2. Select Save from the File menu. If the file is an existing file, the CodeWarrior IDE
saves the file.

3. Ifthe file is a new and untitled file, the CodeWarrior IDE displays the Save As
dialog box. Enter a new name and location for your file. See Renaming and saving
a file on page 4-13 for more information.

Note
The Save menu item is disabled if:
. The window is new and has no data
. The contents of the active window have already been saved, and have not been

modified since the last save. Modifying a file and then undoing the change marks
the file as modified.

. The active window is the project window.
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Saving all files

To save your changes to all the files currently open, press the keyboard shortcut
Shift-Ctrl-S. The CodeWarrior editor saves all the modified files to your hard disk.
Saving files automatically

The CodeWarrior IDE can automatically save changes to all your modified files
whenever you select any of the following menu options from the Project menu:

. Preprocess

. Compile

. Disassemble

. Bring Up To Date
. Make

. Run/Debug.

You can use the Save All Before Build feature to save your work before building and
running your program. If you are experimenting with a change and do not want to save
changes, you can turn this option off.

—— Caution

The ARM debuggers read source files from disk. If you are debugging at source level
and select this option, the debuggers will not read any unsaved modifications to the
source.

See the description of the Save All Before Build option in Configuring build settings
on page 8-6 for more information.

Renaming and saving a file

To save a text file under a new name:

1. Ensure that the text window you want to rename is the active window.

2. Select Save As from the File menu. The CodeWarrior IDE displays the Save
Document As dialog box (Figure 4-7 on page 4-14).
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Save document as EHE

Save jn: Ia Thumb Library

Thumb_Library_Data
Thumb_Object_Library_Data
add.c

Thumb Library. mep

File name: IT_remotelc: Save I
Save as type: I j Cancel |

Figure 4-7 Save Document As dialog box

3. Enter the new name and location of the file.

4.  Click Save to save the file under its new name. The CodeWarrior IDE saves the
file and changes the name of the editor window to the name you entered. If the
file is in the current project, the CodeWarrior IDE updates the project to use the
new name.

Note

See Saving a backup copy of a file on page 4-14 if you want to save a copy of a file, but
you do not want to change the name of the file used in the project.

Saving as a Mac OS, or UNIX text file

The ARM-supplied version of the CodeWarrior IDE is supported on Windows
platforms only. However, you can use the CodeWarrior IDE to open text files created
on other platforms. When you open a text file originally created in a Mac OS, or UNIX
text editor, the CodeWarrior IDE converts the text file internally to be compatible with
Windows and corrects inconsistent line endings. When you finish editing the file, the
CodeWarrior IDE saves the file in its original format.

See Specifying Other Settings on page 8-17 for more information on saving text files in
a different text format.
4.3.3 Saving a backup copy of a file

You can save backup copies of both text and project files.
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Saving a copy of a text file
To save a backup copy of a text file before you change the original:
1. Ensure that the text window you want to save is the active window.

2. Select Save A Copy As... from the File menu. The CodeWarrior IDE displays
the Save document as dialog (Figure 4-8).

Save document as EHE
Save jn: Ia E=ample &R Project j gl
ARM_E=ecutable_lmage_Data startup.c
Example Thurmb Project startup.h
Example_ARM_Project_Data tadd.h
add.c test.c
addh testh
Hello.c
File name: Im Save I
Save as ype: ISource Filez j Cancel |

Figure 4-8 Save document as
3. Type the name and location for the new file in the File name text field.

4. Click Save. The CodeWarrior IDE saves a copy of the file with the new name. It
does not change the file in the editor window or in the current project, and it does
not change the currently-open project to use the new file.

Saving a copy of the current project

To save a copy of the current project:

1. Ensure that the project window you want to save is the active window.

2. Select Save A Copy As... from the File menu. The CodeWarrior IDE displays a
Save a Copy dialog box.

3. Type the name you want to use for the copy of the project if you want to change
the default.

4. Click Save to save the project.

See Comparing XM L-formatted projects on page 4-28 for information on exporting a
project to XML.

ARM DUI 0065C
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4.4 Closing files

Every editor or project window in the CodeWarrior IDE is associated with a file. When
you close the window, you close the file. This section describes:

. Closing project files
. Closing editor files.

441 Closing project files

To close a project file, select Close from the File menu, or click the Windows close
button. Source files opened from the project remain open when you close the project.
Projects are saved when you close the project window. See Saving a project on

page 2-18 for more information on saving project files.

4.4.2 Closing editor files

This section describes how to close editor files.

Closing one file
To close an editor window:

1. Select Close from the File menu, or click the close box for the window.

If you have unsaved changes to the text file, the CodeWarrior IDE asks if you
want to save the changes before closing the window (Figure 4-9).

Metrowerks Code'W arrior E

“startup.c” not saved.

& Changes made to the file "startup.c" will be dizcarded if
this file iz not saved. Do you want to save changes to
this file before closing it?

Don't Save |

Cancel |

Figure 4-9 Unsaved changes alert

2. Click one of:
. Save, if you want to save your changes before closing the file.

. Don’t Save, if you want to close the file without saving your changes. All
unsaved changes are discarded.

. Cancel, if you want to cancel the close and return to the editor window
without saving your changes.
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—— Note

The Close command also saves other properties of the window, such as the size,
location, and the selected text in the active window. See Editor settings on page 8-15 for
information on how to configure these options. If the appropriate options are enabled,
the editor window will occupy the same position on your screen and will have the same
text selected the next time the source code file is opened.

Closing all files
To close all open editor windows:

1. Ensure that an editor window is the active window. You cannot close all files from
the project window.

2. Select Close All Editor Documents from the File menu, or press Ctrl-Shift-W,
or press Alt and click in the close box of an editor window. If any file contains
unsaved changes, the editor prompts you to save information before closing the
window that contains changes (see Figure 4-9 on page 4-16).

—— Note

Close All closes only the editor windows. The Find dialog box and project windows
remain open.

ARM DUI 0065C
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4.5 Printing files

Use the print options in the CodeWarrior IDE to print open files, a project file, or the

contents of a window.

The topics in this section are:

. Setting print options

. Printing a window.

451 Setting print options

To configure printing options:

1. Select Print Setup... from the File menu. The CodeWarrior IDE displays the
printer dialog box for your printer.

2. Use the dialog box to select the paper size, orientation, and other settings. The
specific settings and options depend on the printer you have connected to your
computer. See your printer and operating system documentation for more
information on printer options.

3. Click OK to save your selected printer options.

4.5.2 Printing a window

To print a window:

1. Ensure that the window you want to print is the active window. If the active
window is:

. an editor window, the CodeWarrior IDE prints the text file associated with
that window

. a project window, the CodeWarrior IDE prints a screen representation of the
project window.

2. Select Print from the File menu. The Print dialog box for your printer is
displayed.

3. Select your print options. The options available will vary depending on your
printer. See your printer and operating system documentation for more
information on print options.
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In addition, there are two CodeWarrior-specific print options:

Print Selection Only
This option is available only if text is selected in an editor window.
Select this option to print only the selected text. If this option is not
selected, the CodeWarrior IDE prints the entire file.

Print using Syntax Highlighting
Select this option to print the editor window with syntax coloring. On
a black and white printer, colors are printed as shades of gray. If this
option is not selected, the CodeWarrior IDE prints the file in black and
white without syntax coloring.

Click Print in the Print dialog box. The CodeWarrior IDE spools the file to your
printing software for printing.
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4.6 Reverting to the most recently saved version of a file

You can revert to the most recently saved version of a file if you have edited the file and
you do not want to keep the changes you have made. To revert to the saved version of

a file:

1.

Ensure that the window for which you want to discard changes is the active
window.

Select Revert from the File menu. The CodeWarrior IDE displays a confirmation
alert (Figure 4-9).

Metrowerks Codew arrior

Revert changes to file "main.c™.

& Reverting file "main.c” will dizcard all changes made ta
thiz file since you last saved it. Do you want to dizcard
all changes ta this file?

Figure 4-10 Revert to a previous file

Click OK to discard changes to the current file and open the last saved version of
the file. All changes you have made since the last time you saved the file are
discarded.

Click Cancel if you do not want to revert to the last saved version of the file. The
file you are working on is not changed or saved to disk, and you can continue
editing it.

Note

You can use multiple undo to retrace your changes in an editor file. See Specifying
Other Settings on page 8-17 for more information.

You can use the CodeWarrior IDE in conjunction with a version control system
to recover previous checked-in versions of your editor files. See Chapter 10 Using
CodeWarrior IDE with Version Control Systems for more information.
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4.7 Comparing and merging files and folders

You can use the CodeWarrior IDE to compare two text files, mark the differences
between the files, and apply changes between the files. In addition, you can compare
the contents of two folders.

The following sections show you how to use the CodeWarrior IDE file comparison
features:

. File comparison and merge overview on page 4-21
. Choosing files to compare on page 4-23

. Applying and unapplying differences on page 4-24
. Choosing folders to compare on page 4-25

. Comparing XML-formatted projects on page 4-28.

4.71 File comparison and merge overview

The file comparison window displays two text files, and the differences between them.
Differences are listed as insertions, deletions, and non-matching lines. The file
comparison window has controls that enable you to examine, apply, and unapply the
differences between the files. The currently selected difference is shown with a darker
color and is outlined in black to contrast it from the other differences visible in the
window. Figure 4-11 shows an example.

Source file Comparison column Destination file

@ File Compare Results

B Source:  C:\Program Files\&RkAA. Sdhiy 1.c | BDestination: C:4Program Files &R kY. Sdhp 1.c
char Ch_ 1 _Glob, char Ch 1 _Glob, = |
Ch_2_Gloh; Ch_2_Glob;
int Arr 1 Glob [& int Arr 1 _Glob [5—
int Arr 2 Glob [B int Arr 2 _lob [EI
extern char *nalloc () Fifndef EEG
Enumeration Func_1 (}: Boolean Reg = false:
<% forward declaration nece #define REG
~% RHEG becomes defines
Fiind=f REG <% 1.2, no reglzter wi
Boolean Reg = fal=ss: telse
Toolbar #define REG Boolean Reg = true:; ~

4 »
\
Differences list

\E Differences 12 Differences: 0 Applied, 12 Unapplied
Mormatching lines

o of

Figure 4-11 The Compare Files window
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The main parts of the File Compare Results window are:

Source file column

This column displays the source text file that the CodeWarrior IDE uses
as a basis for its comparison with the destination file. The source file is
displayed on the left side of the File Compare Results window. You can
edit this text.

Destination file column

This column displays the destination file that is compared with the source
file. The destination file is displayed on the right side of the file
comparison window. Differences between the source file and the
destination file can be added to, or removed from, the destination file.
You can edit this text.

Comparison column

This column displays a graphical representation of where text was added
or removed between the source and destination files. This column is
displayed between the source and destination panes in the comparison
window.

Differences list

The Differences list lists the insertions, deletions, and lines of
mismatching text between the two files. Select an item in the list to
display the difference in the source and destination panes. Text in the
Differences list is displayed in italics when a difference is applied to the
destination file.

Toolbar

The toolbar has buttons to apply or remove changes between the two files
to the destination file. The toolbar also has buttons to undo and redo
changes to the source and destination files. See Customizing toolbars on
page 8-37 for information on how to customize the toolbar.
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Table 4-1 shows the control icons.

Table 4-1 Toolbar control icons

Control Action

Apply difference

= Unapply difference
Undo

‘2
Redo

2y

4.7.2 Choosing files to compare
To open a file comparison window and select text files to compare:

1. Select Compare Files from the Search menu. The CodeWarrior IDE displays the
Compare Files Setup dialog box that prompts you for a source file and a
destination file to compare (Figure 4-12).

: ompare Files Setup

&' Compare Files " Compare Folders

_ Source
C:A\Example Projectzimodified @ T |
o]

__ Destination

C:AExample Projectsiunmodified @ T |

Text Compare Options

Falder Compare Options
™ Case sensitive = | Wrwshav difterent files:
[ lgnore extra space ™| Compare et filecantents [ Compare

Figure 4-12 Compare Files Setup window

2. Ensure that the Compare Files radio button is selected. This enables you to select
files, rather than folders, by using the Choose buttons.
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3. Click Choose for each of the source and destination sections of the window to
browse for the files to compare.

Alternatively, you can drag and drop files from the Windows desktop to the
source and destination sections of the window.
4. Set the text compare options you want. The available options are:

Case sensitive

Select this option to consider the case of characters as part of the
comparison operation. To ignore case, deselect this option.

Ignore extra space

Select this option to ignore extra space and tab characters at the
beginning and end of lines.

The folder compare options are not available when the Compare Files radio
button is selected. See Choosing folders to compare on page 4-25 for information
on the folder comparison options.

5.  Click Compare to compare the two files and display the File Compare Results
window.

Comparing open editor windows

To compare two files that are already open in editor windows:

1. Select Compare Files from the Search menu. The CodeWarrior IDE displays a
Compare Files Setup dialog that prompts you for a source file and a destination
file to compare (Figure 4-12 on page 4-23).

2. Click the Editor Files pop-up menu next to the source and destination paths
(Figure 4-12 on page 4-23). The CodeWarrior IDE displays a list of all open
editor windows.

3. Select a file name from the pop-up menu to make it the source or destination file.

4. Click Compare to compare the two files and display the comparison window.

4.7.3  Applying and unapplying differences

Use the Comparison window toolbar and Differences list to select the differences that
you want to apply from the source file to the destination file.
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Applying a difference
To view and apply a difference from the source file to the destination file:
1. Click the entry for the difference in the Differences list.

2. Click the Apply button in the toolbar, or select Apply Difference from the
Search menu. The CodeWarrior IDE changes the destination file to match the
source file for the selected difference. The applied difference is displayed in
italics in the Differences list.

-+ - B E

H Differences 4 Differences: 1 Applied, 3 Unapplied

Ly Laisfad faar L

Lines Deleted From Destination
Lines Deleted From Destination
Monmatching lines

i ;I_L

Figure 4-13 Applied difference

Unapplying a difference
To reverse a difference you have applied:

1. Click the entry for the difference you want to unapply. Applied differences are
displayed in italics in the Differences list.

2. Click the Unapply button in the toolbar, or select Unapply Difference from the
Search menu.

—— Note

The Apply Difference and Unapply Difference commands erase all actions from the
Undo stack. When you exit the File Compare Results window after applying or
unapplying differences, all undo and redo actions are cleared from the Undo stack.

4.7.4 Choosing folders to compare

You can use the CodeWarrior IDE comparison features to compare complete folders of
files. To compare two folders:

1. Select Compare Files from the Search menu. The CodeWarrior IDE displays a
Compare Files Setup dialog that prompts you for a source folder and destination
folder to compare (Figure 4-14).
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:#4 Compare Files Setup

" Compare Files &' Compare Folders
_ Source

ﬁ C:\Program Files'Metrowerk 55 ourcehgnu_go E] Ehaesa |
__ Destination

ﬁ C:\Program Files'Metrowerk 255 ourcesharbor E] Ehaesa |

Folder Compare Options

Text Compare Options

[T Case sensitive ™ Only show different files

™ lgnore extra space ™ Compare text file contents

Figure 4-14 Compare Folders Setup dialog box

Ensure that the Compare Folders radio button is selected. This enables you to
select folders, rather than files, by using the Choose buttons, and enables the
Folder Comparison Options described below.

Click Choose... for each of the source and destination sections of the window to
browse for the folders to compare.

Alternatively, you can drag and drop folders from the Windows desktop to the
source and destination sections of the window.

Set the folder comparison options you want. The available options are:

Only Show Different Files
Select this option to display only files that are different in both folders
in the Files In Both Folders list of the Compare Folders window
(Figure 4-15 on page 4-27). By default, this option is disabled, so all
files in the source and destination folders are displayed.

Comparisons between files in the source and destination folders are
normally based on the file modification dates and file sizes. This is
usually good enough to determine if there are differences between the
two files. If there are invisible items in the folders, the comparison will
skip over those items.

Compare Text File Contents

Select this option to perform a more accurate comparison of the files
in the two folders. The comparison performs a Compare Files
command on every file in the source and destination folders and checks
neither the modification dates nor the file sizes. The file comparison is
slower, but the comparison information is more accurate.

See Choosing files to compare on page 4-23 for information on the file
comparison options.
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Click Compare to compare the two folders. The CodeWarrior IDE displays the
Folder Compare Results window (Figure 4-15 on page 4-27). The names of
source code files, header files, text files, and folders are displayed in plain face.
All other file names are displayed in italics.

R Files in Both Foldersﬂ R Files Only in Sourceﬂ B Files Only in Destination: ﬂ
dhiy.h il — armzd.map — s s —
dhry_1.c . s
dhry_Z.c .
readme. tet .

= = =

Source Folder: C:A\Program Files\ARMY\ADS w1 _14Examplesidhiy
Destination Folder: C:\Program Files\ARM4ADS5w1_15\Examplesdhiyans
Selected ltem
File:
Difference(z]:

4

Figure 4-15 Folder Compare Results window
The files are displayed in three lists:

Files in Both Folders
This list displays all files in both the source and destination folders,
unless the Only Show Different Files option is enabled. Files that are
different in the two folders have a small bullet to the right of their
name.

Files Only in Source
This list displays all the files that exist only in the source folder.

Files Only in Destination
This list displays all the files that exist only in the destination folder.

Click on a file name in any of the lists to display specific information about the
selected file in the Selected Item box at the bottom of the folder comparison
window.

Double-click on a file in the Files In Both Folders list to open a Compare Files
window for resolving the differences between the two files.

—— Note

You can click on a zoom box (. El |) for any of the three lists to expand them to fill the
window. Click the zoom box again to collapse the lists back to their original size.
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4.7.5 Comparing XML-formatted projects

The CodeWarrior IDE can export a project file to extensible markup language (XML)
format. You can use the file comparison facility to compare two XML files, and merge
the contents of the files. In addition, you can import a merged XML file into the
CodeWarrior IDE and save the imported file as a new CodeWarrior project.

To compare two CodeWarrior projects and apply changes from one to the other:

1. Convert the projects you want to compare to XML format:

a.  Ensure that the same build target is currently selected for both project files
when you export them to XML format. Otherwise, the Differences List
might not properly reflect the differences in the two files.

b. Ensure that the project window for the first project is the currently active
window.

c. Select Export Project from the File menu. The CodeWarrior IDE displays
an Export project as dialog box (Figure 4-16).

Open HE
Look jn: I {23 Examples j | |‘j€| E =
azm @ explasm @ ram_integratar
cpp (23 flashinad (23 sorts
databort D inline [ swi
doc (20 interwork.
dhiy @ picpid
dhryansi Cdrom

File name: IF!ps_IF!Q.mcp.xml Dpen I
Filez of type: IImportabIe #ML Files j Cancel |

Figure 4-16 Export project as dialog box

d.  Save the project as an XML file.

e. Repeat steps a to d for the second project.

2. Select Compare Files from the Search menu. The CodeWarrior IDE displays the
Compare File Setup dialog box (see Figure 4-12 on page 4-23).

3. Choose the XML-formatted versions of the two project files in the Compare Files
Setup dialog box. See Choosing files to compare on page 4-23 if you do not know
how to do this.

4. Click Compare. The CodeWarrior IDE displays the Differences list for the two
projects. See Figure 4-11 on page 4-21 for an example of the File Comparison
window.
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5. Apply the changes you want to the destination file. See Applying and unapplying
differences on page 4-24 for more information.

6.  Select Save from the File menu to save your modified XML file.

7.  Select Import Project... from the File menu. The CodeWarrior IDE displays a
standard open file dialog box.

8. Select the XML file you want to import and click Open. The CodeWarrior IDE
displays a Save As dialog asking you to name the project file that will be created,
and choose a location to save the project.

9.  Enter the name and location of the new project, and click Save. The CodeWarrior
IDE converts the XML-formatted file into a project file and saves the project file.
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Chapter 5

Editing Source Code

This chapter describes how to use the CodeWarrior IDE text editor to edit your source
code. It contains the following sections:

About editing source code on page 5-2
Overview of the editor window on page 5-3
Configuring the editor window on page 5-7
Editing text on page 5-10

Navigating text on page 5-17.
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5.1 About editing source code

The CodeWarrior editor is a full-featured text editor designed for programmers. Its
features include:

pop-up menus on every editor window for opening header files and quickly
navigating among functions

integrated version control menus that enable you to work with your version
control system from within the CodeWarrior IDE

syntax highlighting that formats source code for easy identification of comments
and keywords in your source files.

This chapter describes the basics of how to use the CodeWarrior editor. You can
customize the way the CodeWarrior editor works. See Editor settings on page 8-15 for
more information. See also:

Chapter 4 Working with Files for information on basic file operations such as
opening, saving, and comparing source files

Chapter 6 Searching and Replacing Text for information on searching and
replacing text in source files

Chapter 7 Browsing Source Code for information on using the CodeWarrior
source code browser.

5-2
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5.2 Overview of the editor window

The editor window provides pop-up menus and other controls that enable you to
perform basic editing operations. Figure 5-1 shows an example of the CodeWarrior
editor window.

Functions pop-up Document Settings
menu pop-up menu

Header Files Markers pop-up Version Control

pop-up menu menu

h' {}' M Dv |:'|-'T Path: | C:\Program Files\ARMYA, . \arw.cpp

#include <stdio h=
#include "l k"

File Path caption

Dirty File marker

. . . Toolbar Disclosure button
extarn wold (1: ) Defined imn kool .o to £

i whakles for BMW ta be
£ by armlink.

wald o (BMW  *pkme)
i

gl ==L (] i shenld e "
it V7 heald be Text editing area

phami—=h ] i shenld e /

phame— =l £ shenld e

¥
vaid b (EMW *plome)

Lne3a lede]

Line number Pane splitters
button

Figure 5-1 The editor window

The major interface components of the editor window are:

IE' Header Files pop-up menu

You can use the Header Files pop-up menu, shown in Figure 5-10 on
page 5-22, to either:

. open header files referenced by the current file
. use the Touch and Untouch commands from this pop-up menu.

See Touching and untouching files on page 2-47 for more information.
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Functions pop-up menu
. You can use the Functions pop-up menu shown in Figure 5-5 on
page 5-18 to jump to a specific function in another text file within your
source code. See Using the Functions pop-up menu on page 5-17 for
more information.

EI Markers pop-up menu

You can use the Markers pop-up menu (Figure 5-2) to add and remove
markers in your text files.

You can use markers for:

. quick access to a line of text
. remembering where you left off
. other identification purposes.

N; Eﬁl Eﬂ Path:ﬁ
Add marker...
Remove markers...

Mo markers defined

Figure 5-2 The Marker pop-up menu

See Using markers on page 5-19 for more information.

Document Settings pop-up menu

You can use the Document Settings pop-up menu (Figure 5-3), to turn
color syntax highlighting on or off for the current file, and to set the
method for saving the file.

See Syntax Coloring on page 8-22 for details of how to modify syntax
coloring.

Eil Ef_ Path:’ﬁ

* Syntax Colaring

b acintozh
« D05
Ui

Figure 5-3 The Document Settings pop-up menu
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Version Control pop-up menu

The Version Control pop-up menu indicates the read/write revision
control database status of the current file. You can modify the file if the
pop-up icon box shows the Unlocked icon or the Read/Write icon. The
icons and their meanings are described in Performing common VCS
operations on page 10-7.

Depending on the VCS system your are using, you can use this pop-up

menu to:

. get a new copy of your file

. checkout the file for modification

. make the file writable so you can make changes without

performing a checkout.
See Performing common VCS operations on page 10-7 for more
information about revision control system software.
File Path caption

The CodeWarrior IDE displays the directory path of the current file in the
File Path caption, at the top right of the window shown in Figure 5-1 on
page 5-3.

Dirty File marker

The Dirty File marker indicates if the file displayed in a window has been
modified after it was last saved or opened. The states of the Dirty File
marker are:

¥
<

Pane splitter controls

unchanged file

modified and unsaved file (dirty)

Pane splitter controls split the editor windows into panes so you can view
different portions of a file in the same window.

Use these controls to adjust the sizes of the panes after you have created
them. Figure 5-4 on page 5-8 shows an editor window with multiple
panes.

See Splitting the window into panes on page 5-8 for more information on
pane splitter controls.
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Line Number button

The Line Number box shown in Figure 5-1 on page 5-3 displays the
number of the line that contains the text insertion point. You can also use
this button to go to another line in the file.

See Going to a specific line on page 5-20 for more information on setting
the text insertion point on another line.
Toolbar Disclosure button

The Toolbar Disclosure button hides or displays the editor window
toolbar along the top of the window. If the toolbar is hidden, a row of
controls is displayed at the bottom of the editor window.

See Displaying window controls on page 5-7 for more information on
using the Toolbar Disclosure button.
Text editing area

The text editing area of the editor window is where you enter and edit
text. See Editing text on page 5-10.

5-6
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5.3 Configuring the editor window

The editor enables you to customize your view of the file with which you are working.
This section describes the following options available in the editor window:

. Setting text size and font

. Displaying window controls

. Splitting the window into panes on page 5-8
. Saving editor window settings on page 5-9.

See Customizing toolbars on page 8-37 for more information on configuring the editor
window toolbar.

5.3.1 Setting text size and font

Use the Font & Tabs preference panel to set the size or font used to display text in an
editor window. See Font & Tabs on page 8-19 for more information.

5.3.2 Displaying window controls

The toolbar comprises the row of pop-up menus and controls that appears along the top
of the editor window. Use the Toolbar Disclosure button, shown in Figure 5-1 on
page 5-3, to show or hide the toolbar.

To hide the toolbar, click the Toolbar Disclosure button. The CodeWarrior IDE hides
the toolbar, and displays the default toolbar pop-up menu controls along the bottom of
the editor window.

—— Note

. If you have customized the editor window toolbar, your custom toolbar items are
not displayed at the bottom of the window. When you display the toolbar again,
its custom configuration is restored.

. The File Path caption is no longer visible when the toolbar is hidden.

To re-show the toolbar if it is hidden, click the Toolbar Disclosure button. The toolbar
is displayed along the top of the editor window.

See Customizing toolbars on page 8-37 for general information on toolbars, including
toolbar customization.

You can select a default setting to display or hide the toolbar in editor windows. See
Showing and hiding a toolbar on page 8-38 for more information.
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5.3.3  Splitting the window into panes

You can split the editor window into panes to view different parts of a file in the same
window. Figure 5-4 shows an example. The following sections describe how to create,
resize, and remove multiple panes.

Metrowerks Code'W arrior for ARM Developer Suite ¥1.1 - [serial.c]

He] File Edit Search Project Debug ‘Window Help _|ﬁ||1|

ACEE2cx<xhBAAAA BB »r @O a0

#include "nisa. h" ’E
#include "st1l6c552 h" ;I

weold init serial A (wedid)
{ _|
*Zerd FCR = FOR_Fifo Enable | #* Enskble Tx and Ex FIFC Operaticn */
FCR_Fx_Fife Reset | /% Clesr Rx FIFO and FIFO Counters */
FCR_Tix Fifw Reset ; (% Clesr Tx FIFD and FIFD Counters */

i* a wvold sendchar( char *ch |

|» =] 4

* Clopyright (O) ARM Li H
= while (| (*Zeri LSR % LIZR_Ti Held Hmsty)) i

i1
*Zerd THR = *ch; f* Tremsmit nesxt cheare
I ¥
Thisz implements a simel
It outputs single chars
Initialize the port wit
vI

[ [E ] d Line: 1 N
|

&%I_

Figure 5-4 Multiple panes in a window

]IE = Creating a new pane

You can click and drag a pane splitter control to create a new pane in an editor window.
Pane splitter controls are on each scroll bar (the top and left side) of a pane in the editor
window. To use a pane splitter control:

1. Drag the pane splitter control toward the desired location of the new pane. As you
drag the control, a gray focus line tracks your progress and indicates where the
new pane will go.

2. Release the mouse button to create a new pane.

Alternatively, you can double-click the pane splitter control to split a pane into two
equal parts.
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Resizing a pane
To resize a pane:

1. Click and drag the pane resize boxes to change the sizes of the panes in an editor
window. As you drag a resize box, a gray focus line indicates your progress.

2. Release the mouse button to redraw the pane in its new position.

Removing a pane
To remove a pane from an editor window:

1. Click and drag aresize box to any edge of the window. As you drag the resize box,
a gray focus line indicates your progress. If you drag the box close to the edge of
the window, the gray lines are no longer displayed.

2. Release the mouse button when the gray lines are no longer displayed. The editor
removes one of the panes from the window.

Alternatively, you can double-click on a resize bar to remove a split.

5.3.4  Saving editor window settings

The current settings of an editor window are automatically saved:
. when you close the window
. when the toolbar is hidden or displayed.

The settings that are saved include the size and location of the window, and the display
of the toolbar. When you re-open an editor window, the CodeWarrior IDE uses the
saved window settings.
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54 Editing text

The CodeWarrior IDE provides many methods for editing source files. These methods
are described in:

Basic editor window navigation

Basic text editing on page 5-11

Selecting text on page 5-12

Moving text with drag-and-drop on page 5-13
Balancing punctuation on page 5-14

Shifting text left and right on page 5-15
Undoing changes on page 5-15

Controlling color on page 5-16.

5.4.1 Basic editor window navigation

This section describes basic text navigation techniques and shortcuts you can use in text
editor windows.

Scrollbar navigation

Use the scrollbars to adjust the field of view in an editor window in the CodeWarrior
IDE.

Keyboard navigation

Table 5-1 shows the keystrokes you can use to move the insertion point in a file.

Table 5-1 Text navigation with the keyboard

To move insertion point to... Keystroke
Previous word Ctrl-left arrow
Next word Ctrl-right arrow
Beginning of line Home

End of line End

Beginning of file Ctrl-Home

End of file Ctrl-End
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Table 5-2 shows the keystrokes you can use to scroll to different locations in a file,
without moving the insertion point.

Table 5-2 Scroll with the keyboard

To scroll to... Keystroke
Previous page Page Up

Next page Page Down
Beginning of file Ctrl-Home

End of file Ctrl-End
Previous line Ctrl-up arrow
Next line Ctrl-down arrow

5.4.2 Basic text editing

The CodeWarrior IDE supports the standard Windows editing operations provided by
most Windows text editors.

Adding text

To add text to an open file:

1. Click once in the text editing area of the window to set the new location of the
text insertion point.

2. Begin typing on the keyboard to enter text.

See Basic editor window navigation on page 5-10 for ways to move the insertion point
in an editor window.

Deleting text

You can delete text in any of the following ways:

. press the Backspace key to delete text that is behind the text insertion point

. press the Delete key to delete text that is in front of the text insertion point

. select the text you want to delete and press the Backspace or Delete key to delete
the selection. See Selecting text, below, for details on how to select text.

ARM DUI 0065C
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Using cut, copy, paste, and clear

You can use the standard Windows editing commands to remove text, or to copy and
paste in a window, between windows, or between applications. See Edit menu on
page B-5 for more information on these commands.

5.4.3 Selecting text

There are several ways to select text in the editor window. This section describes how
to select text:

. using keystroke shortcuts
. using the mouse.

Selecting text using keystroke shortcuts

To select text using keystroke shortcuts, hold down the Shift key while pressing a text
navigation key sequence.

Table 5-3 shows the keystrokes for selecting text, starting at the current insertion point.

Table 5-3 Text selection with the keyboard

Select text to Keystroke

Previous word Shift-Ctrl-left arrow
Next word Shift-Ctrl-right arrow
Beginning of line Shift-Home

End of line Shift-End

Beginning of page Shift-Page Up

End of page Shift-Page Down
Beginning of file Shift-Ctrl-Home

End of file Shift-Ctrl-End

To select blocks of code quickly, use the Balance command. See Balancing punctuation
on page 5-14 for more information.
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Selecting text using the mouse

Table 5-4 gives a summary of how to select text with the mouse.

Table 5-4 Selecting text with the mouse

To select a...

Do this...

Single word

Double-click on the word.

Single line

Either:

Triple-click anywhere in the line.

Move the mouse pointer to the left edge of the editor window
so the mouse pointer points right, and press the mouse button.
This selection method is available when the Left Margin
Click Selects Line option is on in the Editor Settings
preference panel.

Range of text

Use any of the following methods:

Click and drag the mouse in a portion of your window where
there is text.

Set your text insertion point to mark the beginning of your
selection, and press the Shift key while clicking the place in
your text where you want the selection to end.

Move the mouse pointer to the left edge of the editor window
so the mouse pointer points right, and click and drag the mouse
pointer to select lines of text.

This selection method is available when the Left Margin
Click Selects Line option is on in the Editor Settings
preference panel.

Function

Press the Shift key while selecting a function in the Functions pop-up
menu to display and highlight an entire function in the editor window.
This is particularly useful for copy and paste operations, and for using
drag-and-drop to move code around in your file.

Use the drag-and-drop features of the editor if you have text in your editor window that
you would like to move to a new location. To use drag-and-drop editing, you must
enable this feature in the IDE configuration panels. See Edifor settings on page 8-15 for
information on how to turn this feature on or off.

The CodeWarrior editor accepts drag-and-drop text items from other applications that
support drag-and-drop editing.

ARM DUI 0065C
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Moving text in the text editing area

To drag and drop text between text areas in the CodeWarrior IDE:

1.

Either:
. create a new text file
. open an existing text file.

See Creating and opening files on page 4-3 for more information.

Drag and drop text in any of the following ways:

. Select and drag text from an editor window to any destination that can
accept a drop. You can drag and drop text to a new location in the current
editor window, or to another open editor window.

. Drag selected text into an editor window from other applications that
support drag-and-drop.

. Drag and drop an icon of a text file directly into the editor window.

5.4.5 Balancing punctuation

The CodeWarrior IDE provides manual balancing and automatic balancing to ensure
that every parenthesis (()), bracket ([1), and brace ({}) in your code has a counterpart,
where applicable.

Using manual balancing

To check for balanced parentheses, brackets, or braces:

1.
2.

Place the insertion point in the text you want to check.

Select Balance from the Edit menu. Alternatively, double-click on a parenthesis,
bracket, or brace character that you want to check for a matching character.

The CodeWarrior editor searches from the text insertion point until it finds a close
parenthesis, bracket, or brace, and then searches in the opposite direction until it
finds a matching open parenthesis, bracket, or brace. When it finds the match, it
selects the text between them. If the insertion point is not enclosed, or if the
punctuation is unbalanced, the CodeWarrior IDE emits a warning beep.

Note

You can use the Balance command to select blocks of code quickly.
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Using automatic balancing

You can have the editor check for balanced punctuation automatically. See Other
settings on page 8-9 for more information on how to configure the CodeWarrior IDE to
check punctuation automatically as you type.

5.4.6  Shifting text left and right

You can format your source code by shifting blocks of text left and right. This enables
you to indent large blocks of text easily.

To shift blocks of text left and right:
1. Select a block of text (see Selecting text on page 5-12).

2. Select Shift Right or Shift Left from the Edit menu.

The CodeWarrior editor shifts the selected text one tab stop to the right or left by
inserting or deleting a tab character at the beginning of every line in the selection.

See Font & Tabs on page 8-19 for information on configuring the number of spaces
defined for a tab character.

5.4.7 Undoing changes

The CodeWarrior editor provides several methods to undo mistakes as you edit a file.
The available methods are:

. undoing the last edit
. undoing and redoing multiple edits
. reverting to the last saved version of the file.

Undoing the last edit

The Undo command reverses the effect of your last action. The name of the undo
command on the Edit menu changes depending on your last action. For example, if
your most recent action was to type some text, the command changes to Undo Typing.
In this case, you can select Undo Typing to remove the text you just typed.

Undoing and redoing multiple edits

You can use multiple undo and redo commands when the Use Multiple Undo option is
selected in the Editor Settings IDE Configuration panel. See Other settings on page 8-9
for information on how to enable the Use Multiple Undo option.

ARM DUI 0065C
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When multiple undo is enabled, you can select Undo or Redo from the Edit menu
multiple times to undo and redo your previous edits.

For example, if you cut a word, paste it, then type some text, you can reverse all three
actions by choosing Undo three times. The first undo removes the text you typed, the
second unpastes the text you pasted, and the third uncuts the text you cut to restore the
text to its original condition.

You can redo the edits by selecting Redo three times.

Note

The keyboard shortcut for the Redo command changes when the Use Multiple Undo
option is turned off.

Undo actions are saved in a stack. Each undo action adds an item to the stack, and each
redo repositions a pointer to the next undo action. If you perform several undo and redo
actions you will lose actions off the stack. For example, if there are five undo actions
on the stack (ABCDE), and you redo two of them, the stack appears to the undo pointer as
ABC. When you perform a new action (ABCF), the undo events (DE) are no longer
available.

Reverting to the last saved version of a file

You can discard all changes you have made since the last time you saved your file.
Select Revert from the File menu to return a file to its last-saved version. See Reverting
to the most recently saved version of a file on page 4-20 for more information.

5.4.8 Controlling color

You can use color to highlight many elements in your source code, such as comments,
keywords, and quoted character strings. You can also highlight custom keywords that
are in a list of words you designate. See Syntax Coloring on page 8-22 for information
on configuring color syntax options.
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5.5 Navigating text

The CodeWarrior editor provides several methods for navigating a file that you are
editing.

This section describes the following methods:

. Finding a function

. Finding symbol definitions on page 5-18

. Using markers on page 5-19

. Going to a specific line on page 5-20

. Using Go Back and Go Forward on page 5-21.

. Opening a related header file on page 5-21.

See also Chapter 7 Browsing Source Code for details on the methods provided by the
integrated code browser for navigating through code.

—— Note

You can customize key bindings for the CodeWarrior editor. See Modifying key bindings
on page 8-34 for more information on how to the change key bindings that move the text
insertion point around in a file.

5.5.1 Finding a function

You can use the Functions pop-up menu to find a specific function within the source
file currently displayed in the editor window.

— Note
. If the pop-up menu is empty, the current editor file is not a source code file.
. You cannot use the Functions pop-up menu to navigate through ARM assembly

language code.

Using the Functions pop-up menu
To jump to a specific function in the current source file:

1. Ensure that the editor window that contains the function is the currently active
window.

2. Click on the Functions pop-up menu (Figure 5-5). The pop-up menu lists the
functions in your source file.

ARM DUI 0065C
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By default, the menu lists the functions in the order in which they appear in the
file. You can list functions in alphabetical order by pressing the control key before
you click on the Functions pop-up menu.

Note
You can change the default order of the functions in the Functions menu with the
Sort Function Popup configuration option. See Editor settings on page 8-15 for
more information.

If the function name in the pop-up list has a bullet next to it, it means that the text
insertion point is currently located within the definition for that function.

0w [
Bhrdtaf b
B

+g

h

main
g
Wik

Figure 5-5 The Functions pop-up menu

5.5.2 Finding symbol definitions
You can find symbol definitions in any source file within your current project.
To look up the definition of a symbol:
1. Select the symbol name in your source code.
2. Select Find Definition from the Search menu. Alternatively, you can press the
Alt key and double-click on the symbol name. The CodeWarrior IDE searches all
the files in your project for the definition of the symbol.
If CodeWarrior finds one or more matches in your project, it opens a window and
displays each of the matches for you to examine. If the browser is enabled for your
project, the CodeWarrior IDE displays the browser Symbol window (see Finding
overrides and multiple implementations of a function on page 7-27). Otherwise, the
CodeWarrior IDE displays a message window (see Using the message window on
page 3-15).
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5.5.3  Using markers

You can add or remove a marker in any of your text files using the facilities built into

the CodeWarrior editor. Markers function as bookmarks for setting places in your file
that you can jump to quickly, or for leaving notes to yourself about work in progress on
your code.

Adding a marker

To add a marker:

1.  Move the text insertion point to the location in the text you want to mark.

2. Select Add marker from the Markers pop-up menu. The CodeWarrior IDE
displays an Add Marker dialog box (Figure 5-6).

s 7% Add Marker <]

Hame for new marker:

|Implementatinn specifid |

Cancel | sdd |

Figure 5-6 Add Marker dialog box

3. Enter text in the dialog box to mark your insertion point location in the file with
a note, comment, function name, or other text that would be helpful to you.

4. Click Add. Your marker will be visible in the Markers pop-up menu
(Figure 5-7).

—— Note

If you select some text in a source file, then select Add Marker, the selected text will
appear as the new marker name in the Add Marker dialog. This is useful for quickly
adding specific functions or lines as markers.

M. Eil Ef_ Path: | C:%Pro
Add marker...
Remove markers...

Implementation specific

Figure 5-7 Example text file with a marker added
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Removing a marker
To remove a marker:

1. Click the Markers pop-up menu and select the Remove markers command.
CodeWarrior displays the Remove Markers dialog box (Figure 5-8).

44 Bemove Markers

Select markers bo remove;

N Markers
Implementation specific
Returk walue

| ¥

=
Femove | Cancel I Done I

Figure 5-8 Remove Markers dialog box

2. Select the marker you want to delete and click Remove to remove it permanently
from the marker list.

3. Click Done to close the Remove Markers dialog box.

Jumping to a marker
To jump to a marker:
1. Click the Markers pop-up menu.

2. Select the name of the marker from the list shown on the menu to set the text
insertion point at the marker location.

5.5.4 Going to a specific line

You can go to a specific line in an editor window if you know its number. Lines are
numbered consecutively, with the first line designated as line 1. To go to a particular
line:

1. Click Line Number on the editor window to open the Line Number dialog box

(Figure 5-9 on page 5-21).
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i Line Number

Gota line nurmber:
Cancell Ok I

Figure 5-9 Line Number dialog box
2. Enter the number of the line you want to jump to.

3. Click OK.

5.5.5 Using Go Back and Go Forward

The Go Back and Go Forward commands are only available when you use the
browser. If you already have the browser enabled, see Using Go Back and Go Forward
on page 7-22 for details on using these commands. See Chapter 7 Browsing Source
Code for more information on using the browser.

5.5.6  Opening a related header file

The CodeWarrior IDE enables you to open header files for the active editor window.
You can open a header file in two ways:

. using the Header Files pop-up menu
. using a keyboard shortcut.

Using the Header Files pop-up menu

You can use the Header Files pop-up menu to open header files referenced by the file
in the current editor window.

—— Note

You can also use the Touch and Untouch commands from this menu. See Touching and
untouching files on page 2-47 for more details.

To use the Header Files pop-up menu to open a header file:

1. Ensure that the project in which the source file is included is open. If the project
file is not open, the list of files in the Header Files menu is not displayed.

2. Inthe editor window for the your source file, click the Header Files pop-up menu
icon to display the menu (Figure 5-10).
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b on

Touch

startup.k
tadd.h

Figure 5-10 The Header Files pop-up menu

Note
. You can also open the Header Files pop-up menu from the project window.
. Some files cannot be opened in the editor window, such as libraries.

3. Select the header file you want to open from the menu. The header file is opened
in a new editor window.

Using a keyboard shortcut

You can open a header file using a keyboard shortcut:

1. Select the filename of the header file in the active editor window.

2. Type Ctl-D. The header file is opened in a new editor window.

See Creating and opening files on page 4-3 for more information.
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Chapter 6
Searching and Replacing Text

This chapter describes how to use the CodeWarrior IDE search and replace functions.
It contains the following sections:

. About finding and replacing text on page 6-2

. Finding and replacing text in a single file on page 6-3
. Finding and replacing text in multiple files on page 6-8
. Using grep-style regular expressions on page 6-15.
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6.1

About finding and replacing text

The search and replace facilities in the Code Warrior IDE enable you to search and
replace from either the current editor window, or from the Find dialog box. You can
search for and replace text in a single file, in every file in a project, or in any
combination of files. You can also search using regular expressions, similar to the
UNIX grep command.

The Find dialog, shown in Figure 6-1 on page 6-4, provides comprehensive search and
replace facilities. You can use the Find dialog to perform find and replace operations
for:

. text in a single file
. text in multiple files in your project
. text in arbitrary files that are not part of your current project.

You can use text strings, text substrings, and pattern matching in find and replace
operations. In addition, you can use the batch search option to display the results of a
find operation in a text window.

6-2
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6.2 Finding and replacing text in a single file

The Find dialog box enables you to search for text patterns in the active editor window.
When you find the text you are searching for, you can change it or look for the next
occurrence.

This section describes how to use the CodeWarrior IDE search functions to locate
specific text you want to replace in the active editor window. See:

. Searching for selected text
. Finding and replacing text with the Find dialog on page 6-4
. Using batch searches on page 6-6.

6.2.1 Searching for selected text

The CodeWarrior IDE provides two ways of searching for text selected in the editor
window, without opening the Find dialog box.

When you search for selected text, the CodeWarrior IDE uses the option settings that
you last chose in the Find dialog box. To change the option settings, you must open the
Find dialog box.

Finding text in the active editor window
To find text in the active window:

1. Select an instance of the text you want to find.

2. Select Find Selection from the Search menu. The CodeWarrior IDE searches for
the next occurrence of your text string in the current file only.

3. Either:

. Select Find Next from the Search menu, or press F3 to search for the next
occurrence of the text string.

. Press Shift-F3 to search toward the beginning of the file for the previous
occurrence of the text string.
Finding text in another window

This method is useful if you are working with a file in an editor window and you want
to find occurrences of a text string in another file. To find text in another editor window:

1. Select an instance of the text you want to find.

2. Select Enter ‘Find’ String from the Search menu. The editor enters the selected
text into the Find text field of the Find dialog box.

ARM DUI 0065C
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3. Click on the editor window that you want to search to make it active.

4. Either:

. Select Find Next from the Search menu, or press F3 to search for the next
occurrence of the text string.

. Press Shift-F3 to search toward the beginning of the file for the previous
occurrence of the text string.
6.2.2 Finding and replacing text with the Find dialog
To find and replace text with the Find dialog box:

1. Select Find... from the Search menu. The Find dialog box is displayed
(Figure 6-1).

Multi-file disclosure triangle

Multi-file search button ~ Reécent strings popups

: B | Find

Replace: [term int rme(woid); E] I

b m [ Batch [ lgnoreCaze W Regesp
W “rap [ Entire word

Feplace Al

Figure 6-1 The Find dialog box search and replace section

2. Ensure that multi-file searching is turned off so that only the active editor window
is searched. Multi-file searching is controlled by:

[ Multi-File Search Disclosure triangle
Click this triangle to toggle the display of the Multi-File Search section
of the Find dialog box.
Multi-File Search button
% Click this button to enable or disable the options in the Multi-File

Search section of the Find dialog box. When the Multi-File Search
button is not depressed, the items in the Multi-File Search section of
the Find dialog box are disabled.
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See Finding and replacing text in multiple files on page 6-8 for more information
on multi-file searching using the Find dialog box.

3. Type atext string into the Find text field, or select a string from the Recent
Strings pop-up menu.

The Recent Strings pop-up menu contains strings that have previously been used
for searches. Select an item in one of these pop-up menus to place it into the
corresponding text box.

You can use Cut, Copy, and Paste commands to edit text in the Find text field.

—— Note

See Searching for special characters on page 6-6 for information on how to
search for a Return or Tab character.

4. Type a text string into the Replace text field, or select a string from the Recent
Strings pop-up menu, if you want to replace the found string.

5.  Select the search options you want:

Batch Select this option to display the results of the search in a Search Results
message window (see Figure 6-3 on page 6-7). See Using batch
searches on page 6-6 for more information on using the Batch option
when searching.

Ignore Case
Select this option to treat uppercase and lowercase text in the search
string as identical. When this option is not selected, uppercase and
lowercase text are distinct.

Regexp Select this option to instruct the CodeWarrior IDE to interpret the text
in the Find text field as a regular expression. See Using regular
expressions on page 6-16 for more information.

Wrap Select this option if you want the search to wrap the end of the file.
CodeWarrior searches from the current insertion point to the end of the
file, and continues to the insertion point.

If you search multiple files with this option enabled, the CodeWarrior
IDE searches from the first file in the file list after it reaches the last
file.

Entire Word
Select this option to find only complete words (delimited by
punctuation or white-space characters) that match the search string.
When this option is not selected, the CodeWarrior IDE finds
occurrences of the search string embedded within larger words.
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6. Use the dialog box buttons, or menu items from the Search menu, to start the find,
or find and replace operation:

. Click Find, or select Find... or Find Next from the Search menu to search
forward from the text insertion point in the active editor window.

. Select Find Previous from the Search menu, or press the Shift key and
click Find, to search backwards from the text insertion point in the file.

. Click Replace to replace found text with the text in the Replace text field.

. Click Replace & Find to replace found text and find the next occurrence
of the find string. Press the Shift key to replace and search backwards.

. Click Replace All to replace all occurrences of the find string.
—— Caution

Undo is not available for the Replace All command. It is recommended
that you save your source file before using Replace All, so that you can use
the Revert command if you want to discard the changes.

Searching for special characters
To enter a Tab or Return character in the Find or Replace fields, you must either:

. copy and paste your selected text with the Tab or Return characters into the Find
or Replace text field

. enable the Regexp option, and enter \t for Tab or \r for Return into the field.
Using regular expressions alters the way in which the CodeWarrior IDE locates a string
match. See Using grep-style regular expressions on page 6-15 for more details.

6.2.3  Using batch searches

The batch search option in the Find dialog box enables you to collect all successful
matches of your search text in one window for easy reference.

To use batch searches:
1. Select Find... from the Search menu.

2. Ensure that the Batch option is selected (Figure 6-2).

- W Batch [ lgnoreCase [ Regexp
[ wiap [ Entire'word

Figure 6-2 Batch checkbox
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3. Enter your search criteria and options. See Finding and replacing text with the
Find dialog on page 6-4 for details.

4.  Click Find. The search results are displayed in a Search Results message window
(Figure 6-3 on page 6-7).

i@ Search Results [_TO] =]
E Dceurences of "Hinclude!! B |E|

F_@ main.c line

finclude

main.c line Z4
finclude <stdlib._h»

_'I.m:nnain.c line & _ILI
4 F

=

]
Vihen built as an enbedded application, this program uses _use_;l
to ensure that no functions which use semihosting SWIs are linld

*f

Biinclude <stdis. hs
#include <stdlik _h=
#include "stand.h"

int IntCTL o;

int IntTZ 0; ﬂ
h [ ] Line: 35 £l ¥ 2

Figure 6-3 Batch search results

5. Use the Search Results message window to navigate through the search results.
For example, click on an entry in the list view to display the match in the source
view pane, or double-click on an entry to display it an editor window. See Using
the message window on page 3-12 for more information on the features of the
message window.
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6.3 Finding and replacing text in multiple files

The CodeWarrior IDE Find dialog enables you to search multiple files for the
occurrence of text strings. The Multi-File Search section of the Find dialog box enables
you to specify searches through:

. source files in a project
. header files in the project
. any additional files you specify.

In addition, you can use the Multi-File Search section of the Find dialog box to save
sets of search files for future use.

This section describes:
. Using multi-file search
. Using file sets on page 6-12.

Note

You can also select the browser Go Back and Go Forward commands from the Search
menu to access information and search through multiple files. See Using Go Back and
Go Forward on page 7-22 for more information.

6.3.1 Using multi-file search

This section describes how to perform multi-file searches. See Using file sets on
page 6-12 for more information on configuring multi-file searches. To search for text in
multiple files:

1. Select Find... from the Search menu. The Find dialog box is displayed (see
Figure 6-1 on page 6-4).

2. Click the Multi-File Search Disclosure triangle to the left of the Multi-File
Search button so that the triangle points down. The CodeWarrior IDE displays
the Multi-File Search section of the Find dialog box (Figure 6-4 on page 6-9).
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Find: (#include @ Fird I
Replace: @ ﬂl
Eeplace & Find |
-y Femin T e |

_ Multifile Search
File: SEIS:IEE;}_\;?

= Praject: [ips_irg.mep -
] ™ Sources
™ Swstem Headers
™ Project Headers

In Others... I

| I Stop at End of Fils

Figure 6-4 The Find dialog box with multi-file search options

Click the Multi-File Search button to enable multi-file searching.

. When the Multi-File Search button is on, the button appears to be
depressed.

. When the Multi-File Search button is off, the button appears to be raised.

Select the search options you want. You can specify the same search options as
for a single file search. See Finding and replacing text with the Find dialog on
page 6-4 for details.

Click the Project pop-up menu (Figure 6-5) to select the project file with which
you want to perform your search. The Project pop-up menu displays a list of all
currently open projects.

ARM DUI 0065C
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Find: |#include @ Fird I

e [ e |
eplace:

@ Eeplace & Find |
- |-|._.| IV Batch [ lgnoeCase [ Regesp Replace Al |

[T wrap [ EntireWord
_ Multi-file Search
File: Sets:li; s i

r Others...
| I Stop at End of Fils

Figure 6-5 Project pop-up menu

6.  Select from the following options to specify the files you want to search. The file
types you select are added to the search file list. See Using file sets on page 6-12
for information on saving sets of search files for future use.

Note
. To remove a specific file from the file list, select the file and press the
backspace key.
. You can drag and drop groups or files from the Windows interface, or from

the project window, onto the file list.

Sources Select this option to add all the source files from the current project.
Deselect this option to remove all project source files from the file list.

System Headers

Select this option to add system header files. System header files are
defined in the CodeWarrior IDE access paths configuration panel. See
Configuring access paths on page 9-20 for more information.

Note

. You must have successfully compiled your source files in order
to search the system header files.

. If this option does not add the header files you expect, use the
Make command to update the internal list of header files. See
Making a project on page 2-77 for more information.
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Project Headers

Others...

Select this option to add all the project header files from the current
project. Deselect this option to remove all project header files from the
file list.

Note

. You must have successfully compiled your source files in order
to search the project header files.

. If this option does not add the header files you expect, use the
Make command to update the internal list of header files. See
Making a project on page 2-77 for more information.

Click the Others... button and use the standard file dialog box to add
non-project files to your search file list.

Note

The standard file dialog does not list files with filename extensions that
are not recognized by the CodeWarrior IDE. To view all available files,
enter *.+ in the Filename text field of the dialog box. Alternatively you
can drag and drop text files with any file name extension directly onto
the Others... button.

Stop at End of File

Select this option to search each file in the file list individually. When
the CodeWarrior IDE reaches the end of a file, it stops searching and
beeps. Select Find in Next File from the Search menu to continue the
search.

Deselect this option to treat all files in the file list as one large file.
When the CodeWarrior IDE reaches the end of a file, it searches the
next file in the file list until the search text is found. Select Find...,
Find Next, or Find Previous to resume searching. The CodeWarrior
IDE beeps when it reaches the end of the last file to search.

Use the dialog box buttons, or menu items from the Search menu, to start the find,
or find and replace operation. See Finding and replacing text with the Find dialog
on page 6-4 for details.

ARM DUI 0065C
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6.3.2 Batch searching through text files

By default, the CodeWarrior multi-files search dialog does not display text files with
arbitrary filename extensions, such as .txt. To search through text files you can either:

. Specify «.« as the filename in the Select files to search... dialog.

. Drag and drop the files you want to search directly onto the Others... button from
either the Windows interface, or from Windows Explorer (see The Find dialog
box with multi-file search options on page 6-9). From a project window you can
right-click on a file and select Open in Windows Explorer to open Windows
explorer.

6.3.3  Using file sets
You can use the multi-file search section of the Find dialog box to save sets of
frequently searched files for later use.
Saving a file set

To save a file set for use in future multi-file searches:

1. Ensure that the multi-file search section of the Find dialog is displayed, and select
the files you want to search. See Using multi-file search on page 6-8 for details.

2. Select Save this File Set from the File Sets pop-up menu (see Figure 6-4 on
page 6-9). The CodeWarrior IDE displays the Save File Set dialog box ( on
page 6-12).

i Save File Set

Save file set as:

|L|ti|'rtv classes |

Scope
’7 % Specific to this project

" Global, for all projects

Cancel | [o]24 I

Figure 6-6 The Save File Set dialog box
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3. Enter a name for the file set in the Save file set as text field, and select the scope
of the file set:

Specific to this project

Select this option if you plan to use this file set only with the current
project. The CodeWarrior IDE stores the file set in the project.

Global, for all projects

Select this option if you want to use this file set with other projects. The
CodeWarrior IDE stores the file set in its preferences file, enabling all
projects to use it.

4., Click OK to save the file set.

Choosing a file set

To select a previously-saved file set to include in your search, click on the File Sets
pop-up menu and select a file set from the menu. The files in the file set are added to
the search file list.

Removing a file set

To remove a file set from the list of saved search file sets:

1. Ensure that the multi-file search section of the Find dialog is displayed.

2. Select Remove a file set from the File Sets pop-up menu (see Figure 6-4 on
page 6-9) to remove a previously-saved file set. The CodeWarrior IDE displays
the Remove File Sets dialog box (Figure 6-7 on page 6-13).

{44 Remove File Sets

Select file sets to remove

N File sets

=
Remove | Cancel I Done I

Figure 6-7 Remove File Sets dialog box

3. Select the file set you want to remove and click Remove. The CodeWarrior IDE
removes the file set.
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4.

Click Done to return to the Find dialog box.
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6.4 Using grep-style regular expressions

The CodeWarrior IDE provides regular expression searching that is similar to the UNIX
grep command. A regular expression is a text string composed of characters, some of
which have special meanings within the regular expression. The regular expression
string describes one or more possible literal strings. In the CodeWarrior IDE Find dialog
box, it is used to match literal strings in the search text if the Regexp option is selected.

This section gives a brief introduction to regular expressions. For a comprehensive
book on using regular expressions, refer to Mastering Regular Expressions, by Jeffrey
E.F. Friedl.

This section describes:
. Special operators
. Using regular expressions on page 6-16.

6.4.1 Special operators

Table 6-1 shows the characters that have special meanings in a regular expression string.
In some cases, their meaning depends on where they occur in the regular expression.
See Using regular expressions on page 6-16 for more information.

Table 6-1 Regular expression metacharacters

Metacharacter Description

The match-any-character operator matches any single printing or
non-printing character except newline and null.

The match-zero-or-more operator repeats the smallest preceding
regular expression as many times as necessary (including zero) to
match the pattern.

+ The match-one-or-more operator repeats the preceding regular
expression at least once, and then as many times as necessary to match
the pattern.

? The match-zero-or-one operator repeats the preceding regular
expression once or not at all.

\n The back-reference operator is used in the replace string to refer to a
specified group in the find string. Each group must be enclosed within
parentheses. The digit n must range between 1 and 9. The number
identifies a specific group, starting from the left side of the regular
expression.

ARM DUI 0065C
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6.4.2

Table 6-1 Regular expression metacharacters (continued)

Metacharacter Description

The alternation operator matches one of a choice of regular
expressions. If you place the alternation operator between any two
regular expressions, the result matches the largest union of strings that
it can match.

The match-beginning-of-line operator matches the string from the
beginning of the string or after a newline character. When it appears
within brackets, the A represents a not action.

The match-end-of-line operator matches the string either at the end of
the string or before a newline character in the string.

List operators enable you to define a set of items to use as a match. The
list items must be enclosed within square brackets. You cannot define
an empty list.

Group operators define subexpressions that can be used elsewhere in
the regular expression as a single unit.

The range operator defines the characters that fall between the start
and ending characters within the list.

Using regular expressions

You can create powerful regular expressions to search for text and perform replace
operations on found text. To use regular expressions in your search and replace strings:

1.
2.

Select Find... from the Search menu.
Ensure that the Regexp option is selected (Figure 6-8).

b . [T Batch [ IgnoreCaze W Regexp
[T wrap [ Entire'word

Figure 6-8 Regexp checkbox

Enter the search and replace strings. Your search and replace strings are treated as
regular expressions.

The following examples show how to use regular expressions in search and replace
operations.

6-16
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Matching simple expressions

Most characters in a regular expression match themselves. The exceptions are the
regular expression metacharacters listed in Table 6-1 on page 6-15. For example, the
regular expression a matches all occurrences of the letter a in the search text.

To match a metacharacter literally, precede the metacharacter with a backslash. For
example, to find every occurrence of a dollar sign ($), type \$ in the Find text field. The
backslash instructs the CodeWarrior IDE to interpret the dollar sign as a literal
character, rather than a special character. If you do not use the backslash, the search
finds end of line characters, not $ characters.

Matching any character
A period (.) matches any character except a newline character or a null character.
For example, the regular expression:

var.

matches any four character sequence that begins with var, such as varl, and var2.

Matching repeating expressions

The following metacharacters enable you to match repeating occurrences of a regular
expression in your search string:

. A regular expression followed by an asterisk (*) matches zero or more
occurrences of that regular expression. If there is any choice, the editor chooses
the longest, left-most matching string in a line.

. A regular expression followed by a plus sign (+) matches one or more
occurrences of that regular expression. If there is any choice, the editor chooses
the longest, left-most matching string in a line.

. A regular expression followed by a question mark (?) matches zero or one
occurrences of that regular expression. If there is any choice, the editor chooses
the left-most matching string in a line.
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Table 6-2 shows some simple examples.

Table 6-2 Using repetition operators

Regular expression Matches

s«ion Zero or more occurrences of the character s immediately
preceding the characters jon. This regular expression matches
with ion in information and sections, and with ssion in
expressions.

s+ion One or more occurrences of the character s immediately
preceding the characters jon. This regular expression matches
the ssion in expressions.

s?ion Zero or one occurrences of the character s immediately
preceding the characters jon. This regular expression matches
with the sion in expressions, and with ion in information and
sections.

0\.? The number zero, followed by a period. The backslash tells
the CodeWarrior IDE to treat the period as a literal character,
and the ? operator acts on the period character.

The asterisk, question mark, and plus metacharacters can operate on both single
character regular expressions and grouped regular expressions. See Grouping
expressions on page 6-18 for details.

Grouping expressions

If an expression is enclosed in parentheses (()), it is treated as a single unit and
repetition operators, such as the asterisk («) or plus sign (+) are applied to the whole
expression.

For example, to find strings that match is, you can type is in the Find text field.
However, you can also use ( 1i)s as a regular expression. This regular expression
instructs the CodeWarrior IDE to look for the letter s, preceded by both a space and the
letter i. Whereas is matches the is within This, this, and is, ( i)s will match only with
is.

Matching any character in a list

A string of characters enclosed in square brackets ([]) matches any one character in that
string. For example, the regular expression:

[xyz]

6-18
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matches any of the characters x, y, or z.

To match any character that is not in the string enclosed within the square brackets,
precede the enclosed expression with a caret (7). For example, the regular expression:

[Aabc]
matches every character in the search text other than a, b, and c.

To specify a range of consecutive ASCII characters, use a minus sign (-) within square
brackets. For example, the regular expression:

[0-9]

is the same as:

[0123456789]

The following points apply to characters within the square brackets:

. If a minus sign is the first or last character within the square brackets, it is treated
as a literal character. For example, the regular expression:
[-bc]
matches any one of the -, b, and ¢ characters.

. A right square bracket immediately following a left square bracket does not

terminate the string. It is considered to be one of the characters to match. For
example, the regular expression:

[10-9]
matches the right square bracket and any digit.

. Metacharacters, such as backslash (\), asterisk (x), or plus sign (+), immediately
following the opening square bracket are treated as literal characters. For
example, the regular expression:

[.]

matches the period character.

You can use square brackets to group regular expressions in the same way as
parentheses. The text string in the square brackets is treated as a single regular
expression. For example, the regular expression:

[bs1]ag
matches any of bag, sag, or lag.

The regular expression:

ARM DUI 0065C
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[aeiou] [0-9]

matches any lowercase vowel followed by a number, such as al.

Matching the beginning or end of a line

You can specify that a regular expression matches the beginning or end of the line:

. If a caret (A) is at the beginning of the entire regular expression, it matches the
beginning of a line. For example, the regular expression:
A([ \t]xcout)

matches any occurrence of cout at the start of a line. The [ \t]« in the regular
expression specifies that zero or more spaces or tabs can precede cout.

. If a dollar sign ($) is at the end of the entire regular expression, it matches the end
of a line. For example, this$ matches any occurrence of the string this at the end
of a line.

. if an entire regular expression is enclosed by a caret and dollar sign (Alike this$),

it matches an entire line.

Using the find string in the replace string

You can specify the text found by a regular expression in the replace string by using an
ampersand (&) in the replace regular expression. For example, if the find expression is
var[0-9] and the replace string is my_&, the editor matches the find expression with
strings such as varl and var? in the search text, and replaces varl with my_varl and var2
with my_var2.

Use \& to specify a literal ampersand in the replace string. An ampersand has no special
meaning in the find string.
Using subexpressions in the replace string

You can specify subexpressions of a regular expression in a find string, and use the
subexpressions in the replace string. You can specify up to nine subexpressions for each
find string. Each subexpression must be enclosed within parentheses.

To use a subexpression in the replace string, type \n, where n is a digit that specifies
which subexpression to recall. Subexpressions are counted from the left side of the find
string to determine the value of n.

For example, to change #define declarations of the form:

#define varl 10

6-20
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into const declarations:

1.

Select Find... from the Search menu and ensure that the Regexp option is
selected.

Enter the following regular expression in the Find text field:
\#define[ \t]+(.+)[ \t]+([0-9]+);
This regular expression matches string patterns of the following form:

#define, followed by one or more spaces or tabs, followed by one or more
characters, followed by one or more spaces or tabs, followed by one or more
digits, followed by a semicolon.

Starting from the left side of the find regular expression, the first subexpression
is (.+), and the second subexpression is ([0-9]+).

Enter the following regular expression in the Replace text box:
const int \1 = \2;

The \1 specifies the text found by the first subexpression. The \2 specifies the text
found by the second subexpression. The two subexpressions recall the variable
name and its value from the original #define declaration.

Click Replace when the string is found. The replace string changes the #define
declaration into a const declaration by using references to the two subexpressions.
For example:

#define varl 10;
is changed to:
const int varl = 10;

ARM DUI 0065C
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Chapter 7
Working with the Browser

This chapter describes the CodeWarrior browser. The CodeWarrior browser provides
you with a user interface to access a database of all the symbols in your code quickly
and easily. The symbol database is generated by the ARM C and C++ compilers and the
ARM assembler when the browser is activated and you build your project. The
CodeWarrior browser works with both procedural and object-oriented code.

This chapter contains the following sections:

. About working with the browser on page 7-2
. Activating the browser on page 7-5

. Using browser views on page 7-8

. Using the browser on page 7-22

. Creating classes and members with browser wizards on page 7-31.
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7.1 About working with the browser

The CodeWarrior browser enables you to view symbolic information, generated by the
ARM compilers and assembler, on the objects defined in your code, and the
relationships between those objects.

Browser windows provide three views on the objects in the current build target, and
enables you to navigate quickly to the source code for any object in the database. For
example, you can find the function definition or declaration code for any member
function of any class in your code.

Note
The browser does not distinguish between the declaration and the definition of a
variable or constant, so the ARM compilers produce a browse item for both. For
example, the following code results in two items in the browse database:

// test.h
extern int var;
// test.c
#include test.h
int var;

You can use browser information both in browser windows, and from the CodeWarrior
editor. The browser is particularly useful for viewing object-oriented code, because it
can map the relationships between classes, subclasses, and members. However it is also
useful for navigating procedural code.

7141 Understanding the browser strategy

The browser enables you to sort and examine information in a variety of ways. You can
examine browser information using the following views:

Contents view You can use the Contents view to view all C and C++ language
constructs in your code, sorted by category into alphabetical lists.
Categories include type definitions, constants, enumerations,
macros, global variables, functions, templates, and classes. In
addition, the Contents view lists assembler constructs such as
register names, macros, and other symbols. Figure 7-8 on
page 7-17 shows an example of a contents view.

See Viewing data by type with the Contents view on page 7-17 for
details of the Contents window interface.

7-2
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Hierarchy view

Working with the Browser

You can use the Class browser view to examine your code from a
class-based perspective. Figure 7-3 on page 7-9 shows an
example.

The Class browser view lists all the classes in your current build
target, except classes that contain only data members. When you
select a class in the list, the Class browser view displays its
member functions and data members. When you select a list item,
the source code where the item is defined is displayed in the
Source pane.

See Viewing data by class with the Class browser view on
page 7-8 for details of the user interface elements in the Class
browser view.

The Hierarchy view is an inheritance-based view. It provides a
graphical map of the class hierarchy for your current build target.
You can use this view to follow class relationships. Figure 7-9 on
page 7-19 shows an example.

The Hierarchy view illustrates how your classes are
interconnected. You can expand and collapse a hierarchy from
within this view.

See Viewing class hierarchies and inheritance with the hierarchy
view on page 7-18 for details on the Hierarchy view interface.

The browser provides context-sensitive access to information. You can right-click on
any symbol for which there is information in the database to display the related source
code. See Using the Browser Contextual menu on page 7-22 for more information.

In addition, the browser enables you to decide the scope of the view. You can look at
data in all your classes, or you can focus on one class.

Within the browser and hierarchy views, you can look at multiple class hierarchies or
single class hierarchies. Table 7-1 summarizes the general viewing choices available
when using the browser.

Table 7-1 Browser viewing options

Viewing style Wide focus Narrow focus
Comprehensive Contents Not applicable
Inheritance-based Multi-class hierarchy Single-class hierarchy

ARM DUI 0065C
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The browser-related menu commands in the Windows menu (Browser Contents
window, Class Hierarchy window, and New Class Browser) display wide-focus
views. After you have selected a wide view, you can use a context-sensitive menu to
focus on a particular class.

7-4
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7.2 Activating the browser

You must activate the browser and recompile your project before browser information
is available. To activate the browser:

i‘ 1. Ensure that your project window is the active window and click the Target
Settings icon in the toolbar. The CodeWarrior IDE displays the Target settings
panel for your project.

2. Click Build Extras in the Target Settings Panels list. The CodeWarrior IDE
displays the Build Extras panel (Figure 7-1).

4 Semihosted Settings

B Target Settings Panels J H Build Extras
-

E- Target
- Target Settings
- Access Paths

Extraz
¥ Use modification date caching ¥ Cache Subprojects

¥ Activate Browser

[~ Dump intermal browse infarmation after compile

- File Mappings
- Source Trees
[l Language Settings I™" Use third party debugger

- AR Assembler | T
- ARM C Compiler

- AR C++ Compiler

- Thumb C Compiler

-~ Thumb C++ Compiler

- Linker

- FTP PostLinker

- AR Linker

- ARM fromELF

- Editar LI

Factany Settings | Frewert Fanel Save |

Figure 7-1 Target settings panel

3. Select Activate Browser and click Save. The CodeWarrior IDE marks your
source files for recompilation.

4. Close the Target Settings panel and select Make or Bring up to Date from the
Project menu, or click the Make button in your project toolbar to rebuild the
project.

When the project is rebuilt, the ARM compilers generate a database of
information about your code, and about the relationships between various parts of
your code, such as inheritance hierarchies.

—— Note

You can also selectively compile individual source files to generate browser
information for those files only.
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See Configuring browser options on page 7-6 for more details on browser settings and
options

7.21 Configuring browser options

Browser-related menu items and browser-specific options are available only when you
activate the browser. See Activating the browser on page 7-5 for more information. This
section describes how to configure additional browser options, including:

. Configuring symbol colors
. Browsing across subprojects.
Note

To determine quickly if the browser is enabled, look in the Windows menu at the
browser-related menu commands. If they are enabled, the browser is active.

Configuring symbol colors

You can use browser coloring to identify browser database symbols. If the browser is
enabled, symbols that are in the browser database are displayed in editor and browser
windows in the colors you select. See Browser Display on page 8-14 for more
information on setting browser colors.

Note

The default color setting is the same for all types of browser database symbols. You can
select a different color for each symbol type if you want. However, if syntax coloring is
also enabled for your code, you might find it easier to identify browser symbols if you
use only one or two colors.

Browsing across subprojects

To include browser information from subprojects of the current build target you must
enable subproject caching.

Note
This option is selected by default.

To enable subproject caching:

1. Display the Target Settings panel for the project you want to configure (see
Displaying Target Settings panels on page 9-8) for more information.
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2. Click Build Extras in the Target Settings Panels list and click the Target tab to

display the configuration panel (Figure 7-2).

§ Euild Extras

_ Eutraz

¥ Use modification date caching [¥ Cache Subprojects
W Activate Browser

r [~ Durnp internal broweze information after cormpile

_ I Use third party debugger

Browser., |

Figure 7-2 Build Extras settings panel

3. Select the Cache Subprojects checkbox. This option:

. improves multiproject updating and linking
. enables the Class browser to include browser information from target
subprojects.

However, this option also increases the amount of memory required by the

CodeWarrior IDE.

See Configuring build extras on page 9-36 for more information on the Build

Extras panel.

4. Click Save to save your changes.

ARM DUI 0065C
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7.3 Using browser views

This section describes how to use browser windows to display and work with data in
the browser database. It describes:

. Viewing data by class with the Class browser view
. Viewing data by type with the Contents view on page 7-17
. Viewing class hierarchies and inheritance with the hierarchy view on page 7-18.

7.3.1 Viewing data by class with the Class browser view

The Class browser window provides a class-based view of the information in the
browser database for the current build target. You can use the Class browser window to
view C++ classes, member functions, and data members in the current build target.

Note

. You must use the File Mappings configuration panel to map the ARM or Thumb
C++ compiler to process all source and header files containing classes. By
default, header files are mapped to the ARM and Thumb C compilers.

Opening a Class browser window
To open the Class browser window:

1. Ensure that the browser is activated. See Activating the browser on page 7-5 for
more information.

2. Select New Class Browser from the Windows menu. Alternatively, you can:

. right click a class name to display the Browser Contextual menu and select
Open Browser for classname

. double-click a class name in either a Single-class hierarchy window or a
Multi-class hierarchy window.

The CodeWarrior IDE displays a Class browser window (Figure 7-3 on page 7-9).
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List button Browser access  Toolbar Resize bar  New item button Pane zoom box
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Figure 7-3 A Class browser view

The main components of the Class browser window are:

Browser toolbar

The browser toolbar provides access to a number of CodeWarrior
commands, including Go Forward and Go Back navigation buttons, and
buttons to open hierarchy view windows. See Finding declarations,
definitions, overrides, and multiple implementations on page 7-25 for
more information.

Browser Access Filters pop-up menu

Use this menu to filter the display of member functions and data
members. See Filtering members by access type on page 7-15 for more
information.

Pane zoom box

The pane zoom box enlarges and shrinks panes within the Class browser
window.

Resize bar A resize bar is located between each pair of panes. To resize two panes,

drag the resize bar located between them.

ARM DUI 0065C
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Classes pane

List button

The Classes pane lists classes in the browser database for the current
build target. See Viewing class and member information on page 7-12 for
more information.

Click this button to toggle between an alphabetical list or a hierarchical
list in the Classes pane. See Viewing class and member information on
page 7-12 for more information.

Click this button to switch to a hierarchical list.
Click this button to switch to an alphabetical list.

Class display button

Click the Class display button at the bottom left of the Class browser
window to toggle the display of the Classes pane.

Class declaration button

Click the Class declaration button to display the class declaration for the
current class in the Source pane. The name of the current class is
displayed in the Status area of the Class browser window.

Member Functions pane

The Member Functions pane lists all member functions defined in the
selected class. Constructors and destructors are at the top of the list. All
other member functions are listed in alphabetical order.

To display inherited member functions select the Show Inherited

checkbox in the toolbar. The Inherited access icon in the Class
browser window darkens to indicate that inherited member functions are
currently displayed.

Note

Select a member function in the Member Functions pane in the Class
browser window and press the Enter key to open an editor window and
view the definition of the selected function.

Data Members pane

The Data Members pane lists all data members defined in the

selected class. You can also display inherited data members by
enabling the Show Inherited checkbox in the toolbar. The Inherited
access icon in the Class browser window darkens to indicate that
inherited data members are currently displayed.
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The entries in the Data Members pane are listed in alphabetical order. If
inherited members are displayed, data members are listed by superclass,
but alphabetically within each class.

Note

Select a data member in the Data Members pane in the Class browser

window and press the Enter key to open an editor window and view the
declaration of the selected data member.

Identifier icon

Member functions that are declared static, virtual, or pure virtual are
identified with an icon. Table 7-2 describes the icons.

Table 7-2 Browser identifier icons

Icon Meaning The member is...
a Static A static member.
Virtual A virtual function that you can override, or an override of an

inherited virtual function.

2 Pure virtual A member function that you must override in a subclass if you
want to create instances of that subclass.

Source pane
The Source pane displays the source code for the selected item.

Note

To enter function calls or variable names into the code in the source pane,
Alt-Click an item in the Member Functions pane or the Data Members
pane. The item is entered into the Source pane text at the current insertion
point.

The text in the Source pane is fully-editable. The path to the file that
contains the code on display is shown at the top of the Source pane.

Open File icon

Click this icon to open the file that contains the code displayed in the
Source pane in a new editor window.
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VCS pop-up menu
EE The VCS pop-up menu is available if you have a version control
system installed. See Chapter 10 Using CodeWarrior IDE with
Version Control Systems for more information.

Status area

The status area displays various status messages and other information.
For example, when you select a class from the Classes pane, the status
area displays the base classes for the selected class.

Viewing class and member information

The Class browser window enables you to locate and view class and member definitions
in your source code. To view class and member information:

1. Open a Class browser window. See Opening a Class browser window on page 7-8
for more information. The class and member information is displayed in the panes
of the Class browser window. The Classes pane (Figure 7-4 on page 7-12)
displays a list of classes in the current build target.

Note

The Classes pane does not display information about classes or structures that do
not have any member functions, base classes, or subclasses. This means that
structures and classes that have only fields and data members are not displayed.

L Rectangle

[ ]

Figure 7-4 The Classes pane
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2. Click the List button at the top right of the classes pane (see Figure 7-3 on
page 7-9) to select either a hierarchical list or alphabetical list of classes in the
classes pane:

Alphabetical list
This list type displays an alphabetical list of classes in the current build
target.

Hierarchical list
This list type displays a hierarchy expansion triangle next to class
names that have subclasses (Figure 7-4 shows an example of a
hierarchical list):
. Click an expansion triangle to toggle the display of subclasses.

. Alt-click an expansion triangle to open all subclasses at all
levels. This is called a deep disclosure.

. Ctrl-click an expansion triangle to open a single level of subclass
in a class and all of its siblings at the same level. This is a called
a wide disclosure.

. Ctrl-Alt-Click an expansion triangle to perform a wide and deep
disclosure.
— Note

When you select a class in the Classes pane, the Multi-class hierarchy window
selection scrolls to the newly-selected class if it is not already displayed.

3. Navigate to the class, member function, or data member you want to view:

a. Click within a pane to make it the active pane. You can also use the Tab key
to navigate through the panes, except for the Source pane.
—— Caution

If the Source pane is active and you press the Tab key, a tab is entered into
your source code.

b. Select an item within a pane in any of the following ways:

. Click an item in any list.
. Use the arrow keys to navigate through the items in the active pane.
. Type the name of the item. The item in the active pane that most

closely matches the characters you type is selected.
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When you select different items in the panels the Class browser window
display changes:

When you select a class name, the Member Functions pane and Data

Members pane display the members of the selected class. Figure 7-5
shows an example for the class Circle.

The source code pane displays the definition or declaration for the
selected item. If the selected item is:

— aclass, the pane shows the class declaration

—  afunction, the pane shows the function definition

a data member, the pane shows the data member declaration.

i @ DebugRel classes

M [=] B3
<::| ’ % -€ “é I % Wiew ag implementor jl_ Show Inherited
Classes 35 Member Functions 35 Ell [ata Members Sl
- Shape = Circlefint, int, int] =]
: print{) e
‘. Rectangle rad
IB__D Source:  C:\Program Files' AR M\ADSv1_14Examplestcpphshapes. o 1]
clazs Cirele : public Shape { 1=
int xe, yeo, red;
pukalic: [
wirtual weid print(veid);
Circlefint, int, int);
4 N RN 3|
3] # | Circle <- Shape BN 4

Figure 7-5 Member functions, data members, and declaration for class Circle

Use the features of the browser to control the display of browser information,
navigate to specific sections of code, or open other browser views. For more
information on browser functions see:

Filtering members by access type on page 7-15

Opening another view from the Class browser view on page 7-16

Using the Browser Contextual menu on page 7-22

Finding declarations, definitions, overrides, and multiple implementations
on page 7-25

Editing code in the browser on page 7-29.
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Filtering members by access type

You can use the Access Filters pop-up menu to filter the display of member functions
and data members in the Class browser view. The pop-up menu commands filter the
display according to public, private, and protected access types. To filter the display of

members:
1. Open a Class browser window. See Opening a Class browser window on page 7-8
for more information.
2. Select the class you want to display. See Viewing class and member information
on page 7-12 for more information.
3. Click on the Access Filters pop-up menu in the Class browser toolbar
(Figure 7-6).
W+ Wienw ag implementor
2 View as subclass
B iew as uger
B .+ Show public
& ¢ Show protected
* Show private
Figure 7-6 Access filters pop-up menu
The pop-up menu displays a list of access types. A bullet is displayed in the menu
next to each access type currently selected.
4.  Select the access type you want from the pop-up menu:

View as implementor

Select this option to show members with public, private, and protected
access.

View as subclass
Select this option to show members with public and protected access
View as user
Select this option to show only members with public access.
Show public
Select this option to show only members with public access
Show protected
Select this option to show only members with protected access.

Show private
Select this option to show only members with private access.

ARM DUI 0065C
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A b

The access icons at the bottom right corner of the Class browser window are dark if the
access type is selected, and grayed out if the access type is not selected (see Figure 7-7).

Protected )
Public Private

Gy % &
Figure 7-7 Browser access filter icons
Opening another view from the Class browser view

There are a number of ways in which you can open a hierarchy or class view from the
Class browser window, including:

. Click the show multi-class hierarchy button to open a multi-class hierarchy
window.

. Click the show single-class hierarchy button to open a single-class window.

. Right-click any browser symbol in the window and use the Browser Contextual
pop-up menu. See Using the Browser Contextual menu on page 7-22 for more
information.

Saving a default Class browser window

You can save Class browser window configurations to be used as the default for new
Class browser windows. You can save:

. The size and placement of Class browser window.

. The size and placement of the Classes, Member Functions, Data Members, and
Source code panes within the Class browser window.

To save a default Class browser window:

1. Set up the Class browser window to your preferences. See Opening a Class
browser window on page 7-8 for information on resizing controls in the Class
browser window.

2. Select Save Default window from the Window menu. The current Class browser
window is saved and used as a default for all your CodeWarrior projects.

7-16
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7.3.2 Viewing data by type with the Contents view
The Contents window displays browser objects sorted by category into alphabetical
lists.
Using the Contents window
To open a Contents window:

1. Ensure that the browser is activated. See Activating the browser on page 7-5 for
more information.

2. Select Browser Contents from the Windows menu. The CodeWarrior IDE
displays the Contents window (Figure 7-8 on page 7-17). Alternatively you can
click the Contents view button in the Class browser toolbar, or use the Browser
Contextual pop-up menu.

i @ DebugRel contents [_ O]

ICIasses - I

N Sumbols J

Rectangle
Shape
_ fpoz_b_struct

[-]
4

Figure 7-8 A Contents window

3. Select the category of data you want to view from the Category pop-up menu at
the top of the window. The Symbols pane displays an alphabetical list of all
symbols in the current build target for the selected category.

—— Note

Functions are listed alphabetically by function name, but the class name is
displayed first. Therefore, it might appear that the functions are not listed
alphabetically.
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4.  From the contents window you can:

. Right-click on any item in the contents list to display a Browser
Contextual pop-up menu for that item. See Using the Browser Contextual
menu on page 7-22 for more information.

. Double-click on any item in the contents list to open an editor window with
the source code for the item.

7.3.3 Viewing class hierarchies and inheritance with the hierarchy view

You can use the browser hierarchy view to analyze inheritance in your source code. You
can display a hierarchy view in two types of window:

Multi-class hierarchy window

The Multi-class hierarchy window displays a complete graphical map of
the classes in the browser database for the current build target. Each class
name is displayed in a box, and related classes are connected to each
other by lines.

Single-class hierarchy window

The Single-class hierarchy window displays a complete graphical map
for a single class in the browser database. The map displays all
immediate ancestors of the class, and all its descendants. The Multi-class
hierarchy window shows only one base class.

Multi-class hierarchy window

To open a multi-class hierarchy window and view the class hierarchy for the current
build target:

1. Select Class Hierarchy Window from the Window menu. The CodeWarrior IDE
displays a Multi-class hierarchy window for the current build target (Figure 7-9
on page 7-19).
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@ DebugRel hierarchy
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—|‘ numpLncts chars rl;l—| numpunct_bunameschar:
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-\ e ] _
=5 4] | v
Liéutton Ancestor Class pop-up menus

Hierarchy expansion triangles

In addition to the entry for each
hierarchy window are:

Line button

Figure 7-9 The Multi-class hierarchy window

class, the main components of the Multi-class

Click this button to toggle between diagonal lines and straight lines.
This feature affects only the on-screen appearance of the hierarchy.

Hierarchy expansion triangle

Click this button to expose or conceal subclasses for a class.

. Click the expansion triangle to toggle the display of subclasses.

. Alt-click an expansion triangle to open all subclasses at all
levels. This is called a deep disclosure.

. Ctrl-click an expansion triangle to open a single level of subclass
in a class and all of its siblings at the same level. This is called a
wide disclosure.

. Ctrl-Alt-Click an expansion triangle to perform a wide and deep

disclosure.
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Note

Ctrl-Alt-click the expansion triangle for a base class that has no
ancestors to expand or collapse an entire map.

Ancestor Class pop-up menu

If a class has multiple base classes the hierarchy window displays a
small triangle (the Ancestor Class triangle) to the left of the class name.
Click on the Ancestor Class triangle, to display the Ancestor Class
pop-up menu. Figure 7-10 shows an example.

Select the ancestor class you want from the pop-up menu to jump to
the hierarchy view for the ancestor class.

I nurnenic_linits<unsigned shork: |

5 A numpunct_datam—l numpunct_implm—" F— - umpunct_byname
nprct bse]B] .
| numpunct_dalamhar}m—l numpunct_impl  humpunet_impl numpunct_byname(char)l
output_iterator_tag

Figure 7-10 Ancestor pop-up menu

2. Navigate to the class you want to view:
. Use the arrow keys to change the selected class:
— use the up and down key to move between siblings

— use the left and right keys to move between ancestors and
descendents.

. Type the name of the class. The class selection changes to the closest match
to the characters you type.

. Use the Tab key to change the selected class alphabetically.

Note

The class selected in the Multi-class hierarchy window changes when you select
a class in the Classes pane of the Class browser window.

3. When you have selected a class you can:

. double-click the class entry, or select the entry and press the Enter key to
open a Class browser window for that class. Viewing data by class with the
Class browser view on page 7-8 for more information.

. Right-click on the class to open a Browser Contextual pop-up menu. See
Using the Browser Contextual menu on page 7-22 for more information.
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Single-class hierarchy window

The Single-class hierarchy window displays a graphical map for a single class in the

browser database. To open a Single-class hierarchy view:

. Use the Browser Contextual menu in the Contents, Multi-class hierarchy, or
Class browser window. See Using the Browser Contextual menu on page 7-22 for
more information.

. Click the Show Hierarchy Window button in the browser toolbar (see Figure 7-3
on page 7-9).

Figure 7-11 on page 7-21 shows an example of the single-class hierarchy window,
displaying multiple base classes and subclasses. The underlined class name is the focus
of the window.

The Single-class hierarchy window works in the same way as the Multi-class hierarchy
window. See Multi-class hierarchy window on page 7-18 for more information on using
this window.

i m'W hierarchy [_ (O] x|
=
B 4P

Figure 7-11 The Single-class hierarchy window
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7.4 Using the browser
This section gives some techniques you can use to perform common tasks with the
browser. It describes:
. Using Go Back and Go Forward
. Using the Browser Contextual menu
. Finding declarations, definitions, overrides, and multiple implementations on
page 7-25
. Using symbol name completion on page 7-28
. Editing code in the browser on page 7-29.
741 Using Go Back and Go Forward
Use the Go Back and Go Forward commands to retrace your navigational steps
through source code and browser views. Either:
. Click the Go Back or Go Forward buttons in the browser toolbar.
. Click and hold the Go Back and Go Forward buttons to display a pop-up menu
containing a list of previous views (Figure 7-12 on page 7-22).
Figure 7-12 Go Back and Go Forward toolbar buttons
. Select Go Back or Go Forward from the Search menu.
Note
Go Back and Go Forward do not undo any actions you performed.
7.4.2 Using the Browser Contextual menu
The Browser Contextual menu is a context-sensitive pop-up menu that provides quick
access to browser information. The Browser Contextual menu is available for any
symbol for which the browser database has data. You can use it to access the source
code related to any symbol. To display the Browser Contextual menu:
1. Ensure that the browser is activated. See Activating the browser on page 7-5 for
more information.
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2. Open any of the Class, Contents, or Hierarchy browser windows. See Using

browser views on page 7-8 for more information. You can also open a source code
file in the CodeWarrior editor.

3. Right-click on any symbol name in the window. The Browser Contextual menu

is displayed. The menu commands available in the menu depend on the symbol
type (class, function name, enumeration, and so on), and the context in which the
menu was called. Figure 7-13 shows an example of a Browser Contextual menu
for a member function.

Go to declaration of concordanc: | 3| <char, char_
Go to definition of concordance: readT extibasic_istream< char, char_traitz<chars »]
Find all implementations of readT ext

Figure 7-13 A Browser Contextual menu for a function

For member functions, you can:

. View the function declaration. See Viewing a class or member declaration
on page 7-25.

. View the function definition. See Viewing a function definition on
page 7-26.

. Use the Find all implementations of command to find all implementations

of a function that has multiple definitions. See Finding overrides and
multiple implementations of a function on page 7-27.

Using the Browser Contextual menu from an editor window

In the editor window, every symbol in your code, such as function names, class names,
data member names, constants, enumerations, templates, macros, and type definitions,
becomes a hypertext link to other locations in your source code. For example, you can
right-click on a class name to:

. open the class declaration
. open a Class browser window for that class
. open a Single-class hierarchy window for that class.

For function names, you can use the Browser Contextual menu to insert function
templates into your code. See Using the Insert template commands on page 7-24 for
more information.

—— Note

. The Browser Contextual menu displays a Set Breakpoint menu item in source
code windows. This command is not implemented in the ARM version of the
CodeWarrior IDE.

ARM DUI 0065C
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. The contextual menu features of the browser work with the CodeWarrior editor,
in addition to all browser windows. For this reason, you should consider enabling
the browser, even if you do not use the browser windows.

You can use symbol name completion to enter a browser symbol into your text file:

1. Select the text and right-click to display the Browser Contextual menu. The
menu contains a list of browser symbols that match part or all of the selected text.
Figure 7-14 shows an example for the character string bm, where bmw and bmw_h are
both symbols in the browser database.

i mbmw.h [_ (O] %]
i~ a
* brse h: This examele illustrates virtual base classes wit;l
* It iz medelled after Stroustup's BMW (Borders, Menum, Wir
* zection 10.10c of the A R .M. (p233-235). _I
*f
#ifndef | h
#define kr bmw
brove_h
class W o{
pukalic:

wirtual weid £(wveoid)
wirtual weodid o (veid)
wirtual weoid hi{wveid)
wirtual weoid kiveid);

nonon
oo

i

h [ 6B L ] Line: 7 Ta] | Y[

Figure 7-14 Using symbol name completion

2. Select an item from the list to enter it into your text file. See Using symbol name
completion on page 7-28 for other ways to type browser items.

Using the Insert template commands

You can use the context-sensitive menu in an editor window to insert function templates
into your code. To insert a function template for a specific function:

1. Ensure that the Include insert template commands option is selected in the
Browser Display configuration panel. See Browser Display on page 8-14 for
more information. This option is off by default.

2. Type the name of the function you want to insert, and right-click. If the function
has one or more definitions, the Browser Contextual menu displays Insert
commands for each definition. Figure 7-15 shows an example.

7-24
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etrowerks CodeW arrior for ARM Developer Suite ¥1.1 - [bmw_cpp] [_ (O] %]
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£ and is net portable 4+
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Figure 7-15 Inserting a function template

3. Select the function template you want to insert. The CodeWarrior IDE inserts
template code for the function.

7.4.3 Finding declarations, definitions, overrides, and multiple implementations

This section describes how to use the browser to navigate through your source code. It
describes:

. Viewing a class or member declaration
. Viewing a function definition on page 7-26
. Finding overrides and multiple implementations of a function on page 7-27.

Viewing a class or member declaration

Use any of the following methods to display a class or member declaration:

. Select a class name or data member name in a Class browser window. The
declaration is displayed in the Source pane. Double-click the name to open the file
that contains the declaration (if you select or double-click a function name, the
function definition is displayed).

. Click the Class Declaration button in the Class browser window to display a
class declaration in the Source pane.

ARM DUI 0065C
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. Right-click on a the class or member name in any editor or browser window and
select Go to declaration of name from the Browser Contextual menu to jump
to the declaration.

Viewing a function definition
Use the following methods to display a function definition:

. Select the function in the Member Functions pane of the Class browser window.
The definition is displayed in the Source pane. To open the file that contains the
definition, double-click the function name in the Member Functions pane.

. Right-click on the function name in any editor or browser window and select Go
to definition of name from the Browser Contextual menu to jump to the
function definition.

. Alt-double-click or Ctrl-double-click a function name in any source view. The
Symbol window is displayed for functions with multiple definitions to show all
implementations of that function. Figure 7-16 shows an example for the

symbol f.
Metrowerks CodeW arrior for ARM Developer Suite 1.1 - [Symbol: g]
File Edit Search Project Debug Browser Window Help =l =]
RAoEEos - x<bBaAdB83%er 00
Qo EhE
R/ Symbols 1]
wigl)
alBM)
=
R Souce:  C:%Program Files\aRMAAD Syl _15Examplestcppibmw.cpp ﬂ
wreaied MW cop (wedd) =
i
printf ("MW::g(), this %= mw'n", (char *)this == ms 7 "==" : "1="];
¥
RN _’l_I
4
Figure 7-16 Symbol window for a multiply defined function
. Right-click on a class name in any browser window. The Browser Contextual

menu displays a list of member functions, if any are defined for the class. Use the
menu to jump to the function definition.
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Finding overrides and multiple implementations of a function

The Symbol window lists all implementations of any symbol that has multiple
definitions. Typically, these symbols are multiple versions of overridden functions.
However, the Symbol window works for any symbol that has multiple definitions in the
browser database.

To list implementations of a symbol:

1.

Find an instance of the symbol name in any browser or editor window. For
example, to find overrides of virtual functions, open a Class browser window and

look for functions that are marked with a virtual identifier icon g . These are

either:

. overrides of inherited virtual functions

. virtual functions declared in the class that are not inherited from an
ancestor.

Right-click on the symbol name. A Browser Contextual menu is displayed.

Select Find all implementations of symbol_name from the Browser
Contextual menu. The CodeWarrior IDE displays the Symbol window with a list
of all definitions for the symbol (Figure 7-17 on page 7-28).

—— Note

In a source pane or editor window, Alt-double-click or Ctrl-double-click a
function or other symbol name to find all implementations, and open the Symbol
window without using the contextual menu.

ARM DUI 0065C
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Symbols pane
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Figure 7-17 The Symbol window

Most of the items in the Symbol window work in the same way as the
corresponding items in the Class browser window. See Viewing data by class with
the Class browser view on page 7-8 for more information. The Symbol window
has two items not found in the Class browser window:

Symbols pane

This pane lists all versions of a symbol in the database. Select an item
in the Symbols pane to display its definition in the Source pane.

Orientation button
Click this button to toggle the orientation of the Symbols pane and the
Source pane.

4. Select an implementation in the Symbol window list to display its definition in
the source pane.

7.4.4 Using symbol nhame completion

Use the following keyboard commands to find and select browser items that match the
text you have selected or just typed into a source code file.
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—— Note

The following commands are available only from the keyboard. They are not available
in the CodeWarrior IDE menus.

Find symbols with prefix
Type Ctrl-\ to enter the name of a browser item that has the same initial
characters as the text you have selected or just typed.
Find symbols with substring
Type Ctrl-Shift-\ to enter the name of a browser item that has a substring
with the same characters as the text you have selected or just typed.
Get next symbol and Get previous symbol

Type Ctrl-. after using one of the Find symbols commands to search for
the next symbol in the database that matches your search string.

Type Ctrl-, after using one of the Find symbols commands to search for
the previous symbol in the database that matches your search string.

When you find the browser item you want to enter, press the right arrow key to place
the insertion point next to the item and continue typing.

—— Note

Another way to find and enter a browser item is to right-click on the first few characters
of the text and wait for the Browser Contextual menu to display. The menu displays a
list of matching items. Select an item to enter it into your text. See Using the Browser
Contextual menu on page 7-22 for more details.

7.4.5 Editing code in the browser

Code displayed in a Source code pane is fully editable. You can use standard
CodeWarrior editor commands to edit your code. See Chapter 5 Editing Source Code
for more information.

Opening a source file

Use any of the following methods to open a source file:

. In the Class browser window, click the Open File button when the file is
displayed in the Source pane (see Figure 7-3 on page 7-9).

. Right-click on a symbol used in the source file and use the Browser Contextual
pop-up menu to open the file.

ARM DUI 0065C
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. Type Ctrl-" to move between a source file and its corresponding header file.
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7.5 Creating classes and members with browser wizards

When you open a Contents View, Browser View, or Hierarchy View browser window,
the CodeWarrior IDE adds a Browser menu to the main menu bar. You can use the
commands in the Browser menu to display browser wizards that help you create new
classes, member functions, and data members.

— Note
The wizards assume that you have a basic understanding of C++.

The commands in the Browser menu that are implemented by the ARM version of the
CodeWarrior IDE are:

New Class... Displays the New Class wizard to help you create a new class. You
can specify the name, location, file type, and modifiers for the new
class. See Using the New Class wizard.

New Member Function...

Displays the New Member Function wizard to help you create a
new member function for a selected class. You can specify the
name, return type, parameters, modifiers, and other optional
information for the new member function. See Using the New
Member Function wizard on page 7-36.

New Data Member...

Displays the New Data Member wizard to help you create a new
data member for a selected class. You can specify the name, type,
initializer, modifiers, and other optional information for the new
data member. See Using the New Data Member wizard on

page 7-39.

—— Note

The New Property..., New Method..., New Event Set..., and New Event... menu
items are not implemented by CodeWarrior for the ARM Developer Suite.

7.5.1 Using the New Class wizard

You can use the New Class wizard to create a new class declaration, or a class
declaration based on an existing class.
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To create a new class with the New Class wizard:

1.  Ensure that one of the browser windows is the currently active window. See Using
browser views on page 7-8 for information on opening browser windows.

2. Select New Class... from the Browser menu. The CodeWarrior IDE displays the
Name and Location page of the New C++ Class Wizard (Figure 7-18).

Mew C++ Clazz: Name and Location

Class Mame: |

Declaration File: |New File =l

| Bafore = | G2
|CABRM C plus plust. b Set...
MNamespace: |

v Lze geparate file for member definitions:

C:vaRk Cpluz plush. cpp

Mew. . | Er:isting...l

< Baclt HErs Bty | Cancel I

Figure 7-18 New C++ Class: Name and Location

3. Enter the name and location for the new class:

Class Name
Enter a name for the new class. The wizard names the declaration and
definition files depending on the values you specify for the options
listed below.

Declaration File
Use this pop-up menu to specify the type of declaration file.
Depending on the option you choose, different fields become enabled
below the Declaration File pop-up menu. You can select either:

New File Select this option to create a new declaration file. Enter the
pathname for the new file, or click Set... to use the standard
file dialog to set a directory for the new file. By default the
file is saved with the name classname.h.

7-32
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Relative to class
Select this option to add the class to an existing declaration
file. Enter the name of an existing class where you want to
declare the new class, or click Set... to select a class from a
list of current classes in the browser database. Use the
pop-up menu to place the new class Before or After the
selected class declaration.

Namespace
Namespaces are not supported by the ARM and Thumb C++
compilers. Leave this field empty.

Use separate file for member definitions
Select this checkbox if you want to use a separate file to define the
members of the new class. Type the path to the separate file in the field
below the checkbox, or click Existing to select the file with the
standard file dialog box. To create a new separate file, click New and
save the new file to a location on your hard disk.

4. Click Next... to move to the next page of the New Class wizard. The Base Class
and methods page is displayed (Figure 7-19 on page 7-33).

Mew C++ Class: Baze Clazzes and Methods

Baze Clazses: Example: public FirstB azeClasz, virtual SecondBaszeClass,

¥ Generate Constructor and Destructar

Arooess: IF'uinc "I

Constructor pararmeters: Example: int inSuperParaml, bool inHewParam, .

V¥ Wirtual destructor

MHamezpaces required for base clazzes
and constructor parameters (optional): E=ample: nspacel, nspace, ...

< Back I Ment » I Finizh Cancel

Figure 7-19 New C++ Class: Base Class and Methods

5. Specify base classes, member functions, and other information for the new class:

Base Classes
Enter a comma-separated list of base classes for the new class.
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Generate Constructor and Destructor
Select this checkbox to generate a constructor and destructor for the
new class. The following options are available:
Access  Selectan access type for the constructor and destructor from
the pop-up menu.
Constructor parameters

Enter a list of parameters for the constructor. Example
parameters are listed above the field.

Virtual destructor
Select this checkbox to create a virtual destructor for the
new class.

Namespaces
Namespaces are not supported by the ARM and Thumb C++
compilers. Leave this field empty.

6.  Click Next... to move to the next page of the New Class Wizard. The Include
Files page of the New Class wizard is displayed (Figure 7-20 on page 7-34).

New C++ Class: Include Files

— Include files that will automatically be added for baze claszes:

—dddtional keader include files:

Example: <strings, <vectars, "YourHeader h', ...

< Back I Ment » I Finizh Cancel

Figure 7-20 New C++ Class: Include Files

7. Enter alist of any additional #incTude files for the new class. Separate each file in
the list with a comma. The #include files that are added automatically are listed
in the field above.

8. Click Next... to move to the next page of the New Class wizard. The Targets page
is displayed (Figure 7-20 on page 7-34).
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MNew C++ Class: Targets

Project: IC:\.&HM C pluz pluz*ARM C pluz plus. mcp

Add file to targets:

w/Debug
DebugRel
Release

< Back HErs | Finizh I Cancel

Figure 7-21 New C++ Class: Targets

9.  Select the checkbox next to one or more build targets to assign the new class to
the build targets you want. You must select at least one build target.

10. Click Finish. The CodeWarrior IDE displays a summary of the class information
you have specified (Figure 7-22 on page 7-35).

The class will be created with the following settings:

— Summary

Clazz name: MyClazsz -
Clazz declaration file: C:%Proaram
Filez"ARM%ADSw1_T\ExampleshcppibplClazs. h
tember definitions file: C:\Program
Files\ ARk W05 w1 _1MExampleshcppibyClazs cpp
Clazz nameszpace: [none]

Baze clazses: [hone]

Generate constructor and destructor: ves
Constructor/destructor access: public

Congtructor parameters: [none]

Destructor iz virtual: yes

|Jzes nameszpace(z]: [none]

Hinchude files for baze clazses: [hone]

Additional finclude files: [none]

Clazz file will be added tao target(s]: DebugRel, Release, Debug LI

Figure 7-22 New class summary

11. Click Generate to create the new class.
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7.5.2 Using the New Member Function wizard

You can use the New Member function wizard to create a new member function for an
existing class. To create a new member function with the Member Function wizard:

1. Ensure that one of the browser windows is the currently active window. See Using
browser views on page 7-8 for information on opening browser windows.

2. Select the class to which you want to add the member function. For example, in
the Class browser window, click on the class name in the Classes list at the left of
the window.

3. Select New Member Function... from the Browser menu. The CodeWarrior
IDE displays the Member Declaration panel of the New Member Function
Wizard (Figure 7-18 on page 7-32).

Mew C++ Member Function: Member Function Declaration

M ame:

Fieturm tppe:

Paraneters: Example: int inParaml, bool, chark outParam3, ...

Mamezpaces reguired for parameters [optionall: Ex: nzpacel, n2, ...
b odifiers:
Arncess IF'uinc: 'I Specifier: INnne "I
[ Inline ™ Const

< Baclt HErs Bty | Cancel I

Figure 7-23 New Member Function: Member Function Declaration

4, Enter information for the new member function declaration:

Name Enter the name for the member function.
Return type

Enter the function return type.
Parameters

This field is optional. Enter a comma-separated list of parameters for
the member function, if required.
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Namespaces required for parameters (optional)

Namespaces are not supported by the ARM and Thumb C++
compilers. Leave this field empty.

Modifiers

Modify the function declaration, as required:

Use the Access pop-up menu to specify whether the new
member function is Public, Protected, or Private.

Use the Specifier pop-up menu if you want to declare the new
member function as a virtual, pure virtual, or static function.

Select the Inline or Const check boxes to declare the function
inTine or const. If you select the Inline checkbox, the
CodeWarrior IDE places the framework function definition
within the class.

Click Next... to move to the next page of the New Member Function wizard. The
File Locations page is displayed (Figure 7-24).

Mew C++ Member Function: File Locations

— Declaration:

IC: “Program FileshaRMYWARM Developer Suitehincludesmemony

r— Definition:

MHew... Enisting...

—Inziude files

r— Include files automatically added for return type and paranieters:

— &ddtional header include files: [Example: <stings. "vouHeader.h", ...]

< Back I HErs Bty Cancel

Figure 7-24 New Member Function: File Locations

Specify file locations for the new member function:

Declaration

This field displays the location of the file to which the member
function declaration will be added.

ARM DUI 0065C
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Definition

Enter the path to the file used for the member function definition or
click Existing... to select the file using a standard dialog box. To
create a new file to use for the member function definition, click
New... and save the new file to a location on your hard disk.

Include files automatically added...

This field displays a list of #incTude files that will be automatically
added to the member function. These files are automatically added
based on the return type and parameters you specified from the
previous section.

Additional header include files
Enter a list of any additional #incTude files you require for the new
member function.

7. Click Finish. The CodeWarrior IDE displays a summary of the information you
have entered for the new member function declaration (Figure 7-25).

The member function will be created with the following settings:

— Summary

(Adding member function to clazs: Bhw ;I
tember function name: kember]

Adding declaration to file; C:\Program

Files\ ARk W05 w1 _15Exampleshcppibrmwh

MHamezpaces reguired for parameters and returm bppe: [none]

Hinchude files for parameters and return type: [none]

Additional finclude files: [none]

tember function declaration:

inline void Member1[)

=

Figure 7-25 New member function declaration summary

8. Click Generate to generate source for the new member function. The
CodeWarrior IDE adds a member function declaration to the selected class, and
creates a framework function definition below the class, or inline if the inline
checkbox is selected.
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7.5.3 Using the New Data Member wizard

You can use the New Data Member wizard to create a new data member declaration in
an existing class. To create a new data member for a class:

1.

Ensure that one of the browser windows is the currently active window. See Using
browser views on page 7-8 for information on opening browser windows.

Select the class to which you want to add the data member. For example, in the
Class browser window, click on the class name in the Classes list at the left of the
window.

Select New Data Member... from the Browser menu. The CodeWarrior IDE
displays the Name and Location page of the New Class Wizard (Figure 7-18).

Mew C++ Data Member: Data Member Declaration

Tupe:

IHecnld

Mamezpaces reguired for bype [optional): Example: std

Initislizer. Exampls: 100 or inConstructorP arametert ame
Modifiers:
Access IF'lDtected vI Specifier; INQne vI
[T Const ™ olatile

< Baclt I Ment » I Finizh Cancel

Figure 7-26 New Data Member wizard: Data Member Declaration

Declare the new data member:
Name Enter a name for the data member.
Type Enter the data member type.

Namespaces required for type

Namespaces are not supported by the ARM and Thumb C++
compilers. Leave this field empty.

Initializer
Type an initial value for the data member. This field is optional.

ARM DUI 0065C
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Modifiers

Use the Access and Specifier pop-up menus to select the access level
and member specifier for the new data member. Possible access levels
include Public, Protected, and Private. Possible specifiers include
None, Static, and Mutable. Enable the Const or Volatile checkboxes
as desired to further describe the data member’s modifiers.

Click Next... to move to the next page of the New Data Member wizard. The File
Locations page is displayed (Figure 7-27).

Mew C++ Data Member: File Locations

— Declaration:

IC: “Program FileshaRMYWARM Developer Suitehincludesmemony

r— Definition:

¥ =it Epretingl..

—Inziude files

r— Include file automatically added far member type:

— &ddtional header include files: [Example: <stings. "vouHeader.h", ...]

< Back HErs | Finizh I Cancel

Figure 7-27 New Data Member wizard: File Locations

Specify file locations for the new data member:

Declaration
This field displays the location of the file to which the data member
declaration will be added.

Definition
This field does not apply to data members.

Include file automatically added for member type

This field displays any #include files automatically added for the
data-member type.
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Enter a list of any additional #incTude files you require for the new data

member.

Click Finish. The CodeWarrior IDE displays a summary of the information you

have entered for the new data member (Figure 7-28).

The data member will be created with the following settings:

— Summarny
Adding data member to clazs: Bhw ;I
[ata member name: Myl ata
Adding declaration to file; C:\Program
Files\ ARk W05 w1 _15Exampleshcppibrmwh
MHamezpace required for member twpe; [none]
Data member initializer: 100
Hinclude files for member twpe; [none]
Additional #include files: [none]
[rata member declaration:
Record Myl ata;

Figure 7-28 New data member summary

Click Generate to generate source for the new data member. The CodeWarrior

IDE adds a data member declaration to the selected class.

ARM DUI 0065C
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Chapter 8
Configuring IDE Options

This chapter describes how to set options in the CodeWarrior IDE Preferences window.
In addition, this chapter describes how to configure the CodeWarrior IDE toolbars and
keybindings for commands. It contains the following sections:

. About configuring the CodeWarrior IDE on page 8-2

. Overview of the IDE Preferences window on page 8-3
. Choosing general preferences on page 8-6
. Choosing editor preferences on page 8-14

. Setting commands and key bindings on page 8-26
. Customizing toolbars on page 8-37.
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8.1 About configuring the CodeWarrior IDE

You can use the IDE Preferences window to customize many features of the
CodeWarrior IDE. The settings you specify in this window are global settings. They
affect the way the CodeWarrior IDE works in all projects. In addition you can customize
toolbars and commands to fit your own working style.

This chapter describes:

Setting general preferences

General preferences enable you to customize a number of features of the
CodeWarrior IDE, including build settings and global source trees. See
Choosing general preferences on page 8-6 for more information.

Setting editor preferences

You can use the Editor preference panels to set many options that affect
how you edit text, including the number of items in the Open Recent
submenu, syntax coloring, and font and tabs settings. In addition you can
specify a third-party editor to be used in place of the CodeWarrior editor.
See Choosing editor preferences on page 8-14 for more information.

Customizing commands and keybindings

You can customize the menu commands that are displayed in the
CodeWarrior IDE, and the keyboard shortcuts that are assigned to menu
commands. See Setting commands and key bindings on page 8-26 for
more information.

Customizing toolbars

You can customize the items that are displayed as icons in the
CodeWarrior IDE toolbars. You can create toolbar icons for most menu
commands, and add interface elements to the toolbar. See Customizing
toolbars on page 8-37 for more information.
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8.2 Overview of the IDE Preferences window

This section gives an overview of how to use the IDE Preferences window to configure
global preferences for the CodeWarrior IDE. Detailed instructions on how to set
specific preferences are described in the sections that follow this overview.

8.2.1 Using the IDE Preferences window

This section gives basic information on using the IDE Preferences window to configure
preferences for all your CodeWarrior projects.

Opening the IDE Preferences panel
To open the IDE Preferences panels and select preferences:

1. Select Preferences... from the Edit menu. The CodeWarrior IDE displays the
IDE Preferences window with a hierarchical list of available panels on the left
side of the window. Figure 8-1 shows an example.

—— Note
The Debugger preferences panels are not used by CodeWarrior for the ARM
Developer Suite.

{4 IDE Preferences

B IDE Preference Panels J H Build Settings

= General X
- Seftings

uild Settings
. |DE Extras Build before running: IAIways - I ¥ Save open files before build
- Plugin Settings [~ Show message after building up-to-date project

- Source Trees . )
o Edior Compiler thread stack [k

- Browser Dizplay
- Editor Settings
- Font & Tabs

- Spntax Coloring
= Debugger

- Dizplay Settings
- \Windowing

- (Global Settings

Factany Settings | Frewert Fanel | Save |

Figure 8-1 Selecting a preference panel

2. Select the panel you want to configure from the list. You can use the arrow keys
or click the name of the panel.
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Each panel contains related options that you can set. The options you select apply
to all CodeWarrior IDE projects.

3. Select the options you require. See the following sections in this chapter for
detailed descriptions of the options in each configuration panel.

4. Save or discard your changes, as required. See Saving or discarding changes on
page 8-4 for more information on applying the changes you have made.

Saving or discarding changes

If you make changes in the IDE Preferences window and attempt to close it, the
CodeWarrior IDE displays a Preferences Confirmation dialog box like that shown in
Figure 8-2.

Metrowerks Codew arrior

IDE preferences not saved.

Do you wwant to save changes to the IDE preferences
befare closing them'?

Don't Save |

Cancel |

Figure 8-2 Preferences Confirmation dialog box

Click either:

. Save to save your changes and close the dialog box.

. Don’t Save to discard your changes and close the dialog box

. Cancel to continue using the IDE Preferences window without saving changes

In addition, you can use the dialog box buttons in the IDE Preferences window to apply
or discard your changes. The dialog buttons are:

Factory Settings

Click this button to reset the current panel to the settings that the
CodeWarrior IDE uses as defaults. Settings in other panels are not
affected. Only the settings for the current panel are reset.

Revert Panel

Click this button to reset the state of the current panel to its last-saved
settings. This is useful if you start making changes to a panel and then
decide not to use them.

8-4
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Click this button to commit any changes you have made in any of the
panels. If you have changed an option that requires that the project be
recompiled, CodeWarrior displays a confirmation dialog box. Click OK
or Cancel depending on whether you want to keep your changes or not.

ARM DUI 0065C
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8.3 Choosing general preferences

This section describes how to set preferences for the CodeWarrior IDE as a whole,
including editor preferences. The preferences you set apply to all your CodeWarrior
projects.

This section describes:

. Configuring build settings

. Configuring IDE extras on page 8-7

. Configuring plug-in settings on page 8-10

. Configuring global source trees on page 8-11.

8.3.1 Configuring build settings

The Build Settings panel enables you to customize a number of project build settings.
To open the Build Settings panel:

1. Select Preferences... from the Edit menu and click Build Settings in the IDE
Preference Panels list. The CodeWarrior IDE displays the Build Settings panel
(Figure 8-3).

44 IDE Preferences

B IDE Preference Panels H Build Settings
- General —

Seftings

. |DE Extras ; Build before running: IAIways - I ¥ Save open files before build
- Plugin Settings [~ Show message after building up-to-date project

- Source Trees .
o Edior Compiler thread stack [k

- Browser Dizplay
- Editor Settings
- Font & Tabs

- Spntax Coloring
= Debugger

- Dizplay Settings
- \Windowing

- (Global Settings

Factany Settings | Frewert Fanel | Save |

Figure 8-3 Build Settings preference panel
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2. Change the following options, as required:

Build before running

Use this pop-up menu to configure how the CodeWarrior IDE responds
if you try to run a project and the source for the project has been
changed since the last build. You can choose:

Always Always build changed projects before running them.
Never  Never build changed projects before running them.

Ask CodeWarrior will ask you how to proceed if you have
changed the project since the last build.
Show message after building up-to-date project

Select this option to configure the CodeWarrior IDE to display a
message when you try to build an up-to-date project. The up-to-date
project is not built.

If this option is not selected, the CodeWarrior IDE does nothing when
you try to build an up-to-date project.

Save open files before build
Select this option if you want to save all open files automatically
before a Preprocess, Compile, Disassemble, Bring Up To Date,
Make, or Run command is executed.

Compiler thread stack
This option is not used by CodeWarrior for the ARM Developer Suite.

3. Click Save to save your changes.

8.3.2  Configuring IDE extras

The IDE Extras panel has options to remember previously-opened projects and text
files, and enables you to configure the CodeWarrior IDE to use third-party editors. To
open the IDE Extras panel:

1. Select Preferences... from the Edit menu and click IDE Extras in the IDE
Preference Panels list. CodeWarrior displays the IDE Extras panel (Figure 8-4).
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44 IDE Preferences

B IDE Preference Panels J H IDE Extras

- General
Open Recent Menu

- Build Settings
Fecent Projects: Fecent Documents:
- Plugin Settings
- Source Trees ™ Use Third Party E ditor
- Editar .
. Browser Display Launch E ditor: | |
- Editor Settings Launch Editor v Line #: | |
- Font & Tabs -
. Syntax Caloring Other Settings
Bl Debugger [+ Use Multiple Document Interface (MD1)
- Display Settings
- Windowing
- Global Settings

Factany Settings | Frewert Fanel | Save |

Figure 8-4 IDE Extras preference panel

There are three groups of options. For details of how to change the options see:
. Configuring the Open Recent submenu

. Using a third-party text editor

. Other settings on page 8-9.

Configuring the Open Recent submenu

You can configure how many projects and documents are displayed in the File — Open
Recent submenu. To set the number of project and documents displayed:

1. Open the IDE Extras panel (see Configuring IDE extras on page 8-7).

2. Enter values for the following text fields:

Recent Projects
Enter the maximum number of projects you want the Code Warrior IDE
to display in the File — Open Recent submenu.

Recent Documents
Enter the maximum number of files you want the CodeWarrior IDE to
display in the File - Open Recent submenu.

3. Click Save to save your changes.
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Using a third-party text editor

You can configure CodeWarrior to use a third-party text editor in place of its built-in
text editor. To use a third-party editor:

1.
2.

Open the IDE Extras panel (see Configuring IDE extras on page 8-7).

Select the Use Third Party Editor checkbox. When this checkbox is selected,
CodeWarrior uses the third-party text editor you specify to open text files.

Enter the command line to invoke the text editor:

Type the name of the editor you want to use in the Launch Editor text field.

b.  Type the name of the editor and an initial line of text to jump to on launch
in the Launch Editor w/Line # text field. The IDE invokes this command
line when you double-click on an error message to display the line in the
text file that caused the error message.

You can use two variables to specify the file you want to open, and the line you
want to jump to:

%file CodeWarrior expands this into the full pathname of the file.
%1ine CodeWarrior expands this into the initial line number for the file.
For example, to use the Emacs text editor to edit text files, type:

runemacs %file

into the Launch editor text field, and type:

runemacs +%line %file

into the Launch Editor w/Line # text field.

See your text editor documentation for more information on specifying line
numbers.

— Note

The CodeWarrior IDE does not recognize that files have been modified in a third
party editor if the Use modification date caching option is selected. See
Configuring build extras on page 9-36 for more information.

Click Save to save your changes.

Other settings

The Other Settings group has a single option that enables you to configure which
Windows interface style is used by the CodeWarrior IDE. To change the Windows
interface style:

1.

Open the IDE Extras panel (see Configuring IDE extras on page 8-7).

ARM DUI 0065C
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2. Select the Use Multiple Document Interface checkbox to use the Windows
Multiple Document Interface (MDI).

Deselect the checkbox to use the Floating Document Interface (FDI).

3. Click Save to save your changes. You must quit and restart the CodeWarrior IDE
to apply your changes.

8.3.3  Configuring plug-in settings

Use the Plug-in Settings panel to specify how much plug-in diagnostic information the
CodeWarrior IDE provides. Plug-in diagnostic information is useful if you are using
CodeWarrior to develop plug-ins for the CodeWarrior IDE. Use this panel if you have
problems getting your plug-in to function properly, or if you want more information
about the properties of installed plug-ins.

Note

You cannot develop CodeWarrior plug-ins with the ARM tool chain. However, if you
develop a CodeWarrior plug-in using the standard Metrowerks CodeWarrior
development environment you can use this option to diagnose problems when you run
the plug-in from the ARM CodeWarrior environment.

To set plug-in diagnostics:

1. Select Preferences... from the Edit menu and click Plugin Settings in the IDE
Preference Panels list. The CodeWarrior IDE displays the Plugin Settings panel
(Figure 8-5 on page 8-10).

44 IDE Preferences

- General

- Build Settings
. |DE Extras Level:[Mone hd

B IDE Preference Panels J B Flugin Settings

Flugin Diagnostics

S Flugin Settings Keep the level zet to "Mone" unless you are developing plugins for the Code'w! arrior
- Source Trees IDE.

- Editar
- Browser Display Other Setings

- Editor Settings . . .
- Fort & Tabs I~ Disable third party COM plugins

- Spntax Coloring
= Debugger

- Dizplay Settings
- \Windowing

- (Global Settings

Factany Settings | Frewert Fanel Save |

Figure 8-5 Plugin settings panel
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2. Select the level of plug-in diagnostics you want. You can specify three levels of

plug-in diagnostics:
None Select this setting if you do not want to generate plug-in diagnostics.

This is the default setting. No plug-in diagnosis takes place, and no
output is produced.

Errors Only
Select this setting to display errors that occur when the CodeWarrior
IDE loads plug-ins. The errors are displayed in a new text document
after the CodeWarrior IDE starts up. You can save or print the text file
after it is generated so you can have a convenient error reference when
troubleshooting your plug-ins.

All Info Select this setting to display detailed information for each plug-in.
Problems with loading plug-ins, optional plug-in information, and
plug-in properties are reported. This information is displayed in a new
text document after the CodeWarrior IDE starts up.

The text document includes a complete list of installed plug-ins and
their associated preference panels, compilers, and linkers, and
provides suggestions for correcting general plug-in errors. You can
save or print the text file after it is generated so you can have a
convenient error reference when troubleshooting your plug-ins.

3. Click Save to save your settings. CodeWarrior warns that you must quit and
restart the CodeWarrior IDE for the changes to take effect. Plug-in diagnostics are
generated when you restart CodeWarrior.

8.3.4  Configuring global source trees

The Source Trees settings panel enables you to define global source trees (root paths)
for use in your projects. You can define your project access paths and build target output
in terms of source trees. See Configuring access paths on page 9-20 for more
information.

You can define source trees in two panels:

IDE Preferences panel
You can use the source trees you define in the IDE Preferences panel with
all projects. This section describes how to configure global source trees.
Target Settings panel

You can use the source trees you define in the Target Settings window
with the current build target only. See Configuring source trees on
page 9-45 for information on configuring target-specific source trees.

ARM DUI 0065C
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If you define the same source tree in both panels, the target-specific source trees take
precedence over the global source trees.

To add, change, or remove a source tree for all projects:

1. Select Preferences... from the Edit menu and click Source Trees in the IDE
Preference Panels list to display the configuration panel (Figure 8-6 on
page 8-12). The source trees panel displays a list of currently-defined source

paths.

44 IDE Preferences

IE IDE Preference Parels

IE Source Trees

- General

- Build Settings
- |DE Extras

- Plugin Settings
ol - ouice Trees
= Ed
- Browser Dizplay
- Editor Settings
- Font & Tabs

- Spntax Coloring
= Debugger

- Dizplay Settings
- \Windowing

- (Global Settings

|
=

IE Mame

Path
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2. Edit the source tree details:

Figure 8-6 Source Trees panel

. To remove or change an existing source path, double-click the entry in the
list of source trees. The source tree details are displayed. Click Remove to
remove the source tree, or follow the steps below to modify it.

. To add a new source tree, type a name for the new source path in the Name

field.

3. Click the Type pop-up menu to select the type of source tree. Select one of:

Absolute Path

Select this option to choose a specific directory as the root for your
source tree.
Environment Variable

Select this option to choose a directory defined in an environment
variable as the root for your source tree.

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring IDE Options

Registry Key
Select this option to choose a directory defined in a Windows registry
key as the root for your source tree.

4. Choose the source tree root:

. If the source tree is an absolute path, click Choose... to select the root
directory from the standard file dialog.

. If the source key is an environment variable enter the name of the
environment variable. If the environment variable is defined, the source
tree window adds the source tree to the list of defined source trees and
displays the value of the environment variable.

. If the source tree is a registry key enter the full pathname of the registry key,
without the prefix volume label (such as My Computer), and ending with the
name of the registry entry. If the registry key is defined, the source tree
window adds the source tree to the list of defined source trees and displays
the value of the registry key. For example, to add the directory defined by
the ARMHOME registry entry, enter:

HKEY_LOCAL_MACHINE\SOFTWARE\ARM Limited\ARM Developer
Suite\vl.1\ARMHOME

5. Click Add to add a new source tree, or click Change if you are modifying an
existing source tree.

6.  Click Save to save your settings. The new source path is displayed in dialogs that
require you to select a path type, such as the Select an Access Path dialog
(Figure 8-7). See Configuring access paths on page 9-20 for more information on
adding access paths to CodeWarrior projects.

Browse for Folder EHE

Choose a Folder

=L Examples ;I
2 asm

B cpp

1 databort

D dec

- dhryansi

[ explasm

[ flashload

- inline

[ intenwork

D picpid
77 ram LI

(] 3 Cancel
I |

Figure 8-7 Example Source path
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8.4 Choosing editor preferences
This section describes the preference panels that control editor features. The editor
panels are described in:
. Browser Display
. Editor settings on page 8-15
. Font & Tabs on page 8-19
. Syntax Coloring on page 8-22.
8.41 Browser Display
The Browser Display panel enables you to customize the browser. To open the Browser
Display panel:
1. Select Preferences... from the Edit menu. CodeWarrior displays the IDE
Preferences dialog.
2. Click Browser Display in the IDE Preference Panels list. CodeWarrior displays
the Browser Display panel (Figure 8-8).
144 IDE Preferences
B IDE Preference Panels J B Browser Display
= General — X X
. Build Settings ¥ Activate Browser Coloting
- |DE Extraz Symbaol Colors
- Plugin Settings Clazzes: (NN Constants: [
_SDU'CE Trees | | Furictions: [l
E- Edior . Globalz: [ Macros: [
Editar Settin Template:: [N Typedets: [N
. Font & Tabs Dther. [
- Spntax Coloring
- Debugger [+ include insert template commands in context menLé
- Dizplay Settings
- \Windowing
- (Global Settings
=
Factory Settings | Fievert Panel | Save |
Figure 8-8 Browser Display options
Use the Browser Display window to specify how the browser interacts with other parts
of the CodeWarrior IDE. For more information see:
. Setting browser coloring options on page 8-15
. Including insert template commands in the context menu on page 8-15.
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Setting browser coloring options

The browser can export its lists of symbols and their types to the CodeWarrior editor.
This enables the editor to use different colors for displaying various types of symbols.
To set this option:

1. Open the Browser Display window (see Browser Display on page 8-14 for
details).

2. Select Activate Browser Coloring. The color choice for each symbol type is
displayed in both the editor window and the browser window.

3. Specify colors you want to use for the different symbol types. The Browser
Display window displays a color sample next to each symbol type. To change the
color:

a. Click the color sample next to the symbol type you want to change. The
CodeWarrior IDE displays the standard Windows color selector.

b.  Select the color you want and click OK. The color sample changes to the
new color.

4. Click Save to save your settings.

Including insert template commands in the context menu

You can use the browser contextual menu to insert function templates into your source
code. See Using the Insert template commands on page 7-24 for more information. To
configure the CodeWarrior IDE to include an Insert Template command in the context
menu:

1. Open the Browser Display window (see Browser Display on page 8-14 for
details).

2. Select the Include insert template commands in context menu option. The
CodeWarrior IDE adds an Insert Template command to your context pop-up
menus. Figure 7-15 on page 7-25 shows an example.

3. Click Save to save your settings.

8.4.2 Editor settings

This section describes how to configure the behavior of the CodeWarrior editor. To open
the Editor Settings panel:

1. Select Preferences... from the Edit menu. CodeWarrior displays the IDE
Preferences dialog.

ARM DUI 0065C
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Click Editor Settings in the IDE Preference Panels list. CodeWarrior displays the
Editor Settings panel (Figure 8-9).

44 IDE Preferences
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- Font & Tabs Other Settings
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= Debu.gger . [V Balance while typing V¥ Drag & Drop editing
- Dizplay Settings : )
- Windowing V' Relaxed C popup parsing ™ Sart function popup
- Global Settings ¥ Left margin click selects line
Flashing delay [ticks]:
Default text file format:IDDS - I

Factany Settings | Frewert Fanel | Save |

Figure 8-9 Editor Settings preference panel

There are three groups of options. For more information on changing the options
see:

. Specifying editor color settings
. Setting Remember options on page 8-17

. Specifying Other Settings on page 8-17.

Specifying editor color settings

The Color Settings panel controls the main text color (non-syntax) and the background
color in the editor and browser windows. To set the color options:

1.

Open the Editor Settings panel (see Editor settings on page 8-15). The Color
Settings group of options at the top of the panel displays a color sample for the
Main text, and the Background color:

Main text color
The Main text color sample displays the color of any text not colored
by the Browser Display, Syntax Coloring, or Custom Keywords
color sets. See Browser Display on page 8-14 and Syntax Coloring on
page 8-22 for more information on these color sets.

Background color
This color sample displays the background color of the editor and
browser windows.

8-16
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2. Click either the Main text color sample or the Background color sample. The
CodeWarrior IDE displays the standard Windows color selector.

3. Select the color you want and click OK. The color sample changes to the new
color.

4. Click Save to save and apply your settings.

Setting Remember options

The Remember options determine the editor window settings that are saved from one
programming session to the next. To set Remember options:

1. Open the Editor Settings panel (see Editor settings on page 8-15).

2. Select the options you want the CodeWarrior IDE to remember between editing
sessions:

Font preferences
Select this option to specify that font information for individual files is

remembered. If this option is not selected, all files inherit the default
font settings from the CodeWarrior IDE.

Window position and size

Select this option to save the window position and size of editor
windows when they are closed.

Selection position

This option instructs the CodeWarrior IDE to remember what text was
scrolled into view, and the location of the insertion point or selection,
at the time the file is closed. You must turn this option off if you want
the editor to go to the top of the file when it opens.

—— Note

The CodeWarrior IDE can remember the window position and selection position
of a file only if the file is writable. Files might not be writable if you are using a
version control system and have checked out a read-only copy of a file. See
Performing common VCS operations on page 10-7 for more information.

3. Click Save to save your settings.

Specifying Other Settings
The Other Settings options control how the editor works. To change these settings:

1. Open the Editor Settings panel (see Editor settings on page 8-15).
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2. Select the options you require. The options available are:

Balance while typing
Select this option to instruct the CodeWarrior IDE to check for
balanced parentheses, brackets, and braces as you type. When you type
a right parenthesis, bracket, or brace, the editor attempts to locate the
matching left counterpart. If the counterpart is found, the editor brings
it into view, highlights it for a length of time specified by the Flashing
Delay (see below), and returns to where you were typing. If the
counterpart is not found, the editor beeps. By default, the Balance
while typing option is on.

Note

If you want to check for balanced punctuation without highlighting it,
set the Flashing Delay to 0.

Relaxed C popup parsing
Select this option if you use K&R-style coding conventions in your
source code. This option instructs the CodeWarrior IDE to recognize
and display function names in the Functions pop-up menu. You must
deselect this option if you use non-standard macros that can interfere
with K&R-styled code.

Note

Some macro functions will not be recognized when this option is
enabled. If you encounter problems with viewing function names,
disable this option and try again.

Use multiple undo
Select this option to undo and redo multiple actions. If this option is not
selected, you can undo or redo only the last action that you performed.
See Redo, Multiple Undo, and Multiple Redo on page B-6 for more
information.

Drag & Drop editing
Select this option to enable Drag and Drop text editing support in the
editor. See Moving text with drag-and-drop on page 5-13 for more
information on Drag & Drop editor features.

Sort function popup

Select this option if you want items in the Functions pop-up menu in
the editor window to be sorted alphabetically by default. See Using the
Functions pop-up menu on page 5-17 for more information.
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Left margin click selects line
Select this option to enable left margin editing features. Moving the
mouse pointer to the left edge of an editor window changes the mouse
pointer into a right-pointing arrow. Clicking the window when the
mouse pointer faces right selects the line at the mouse pointer. Clicking
and dragging the mouse when the mouse pointer faces right selects
more than one line. When this option is not selected, the mouse pointer
always faces left and cannot select an entire line with a click.

Flashing delay
Use this text field to specify the amount of time the CodeWarrior editor
highlights an opening parentheses, bracket, or brace when balancing
punctuation. The Flashing Delay is measured in 60ths of a second. See
Balancing punctuation on page 5-14, and the description of Balance
while typing above for more information.

Enter a value of 0 (zero) if you want to disable flashing entirely.

Default text file format
Use the Default text file format pop-up menu to set the end-of-line
conventions that the CodeWarrior IDE uses to create new files. You
can choose from:

. DOS
. UNIX
. Macintosh.

3. Click Save to save your changes. The new settings are applied immediately.

The Font & Tabs panel enables you to set the default font and tab information for the
CodeWarrior editor. You can change:

. the default settings used by the CodeWarrior IDE for all editor windows
. the settings to be used for an individual file.

—— Note

To change settings for individual files, you must ensure that the Remember Font
preferences option is selected in the Editor configuration panel. See Setting Remember
options on page 8-17 for more information. See Setting the font and tabs for a single file
on page 8-20 for detailed instructions.

ARM DUI 0065C
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To open the Font & Tabs panel:

1. Select Preferences... from the Edit menu. CodeWarrior displays the IDE
Preferences dialog.

2. Click Font & Tabs in the IDE Preference Panels list. The CodeWarrior IDE
displays the Font & Tabs panel (Figure 8-10).

44 IDE Preferences
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Figure 8-10 Font & Tabs preference panel

For more information on setting font and tabs options see:
. Setting the font and tabs for a single file on page 8-20
. Setting font and tabs defaults on page 8-21.

Setting the font and tabs for a single file
To change the font settings for an individual file:

1.  Ensure that the Remember Font preferences option is selected in the Editor
configuration panel. See Setting Remember options on page 8-17 for more
information.

2. Ensure that the editor window you want to configure is the active window.
3. Open the Font & Tabs preference panel (see Font & Tabs on page 8-19).

4.  Select the display font and font size from the pop-up menus, if required. The font
and size you select here are applied to the current editor window.
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Select tab options if required. The available options are:

Tab indents selection
Select this option if you want the CodeWarrior IDE to indent selected
lines when you press the Tab key. If this option is not set, selected lines
are replaced with a Tab character when you press the Tab key.

Note

This option applies only to selected complete lines of text. If you select
one or more words within a line and press Tab, the CodeWarrior IDE
replaces the selection.

Auto Indent
Select this option to maintain the current indent level when you press
the Enter key.

Tab Inserts Spaces
Select this option to insert space characters, instead of a tab character,
when you press the Tab key.

Tab Size Enter a tab size, in number of spaces. The CodeWarrior IDE:

. sets the tab character to the number of spaces you have selected,
if the Tab Inserts Spaces option is not selected.

. sets the number of characters to be inserted, if the Tab Inserts
Spaces option is selected.

Click Save to save your changes. CodeWarrior applies your settings to the current
editor file, and uses the settings when you close and re-open the file.

— Note

The CodeWarrior IDE can store the font settings for a file only if the file is
writable. Files might not be writable if you are using a version control system and
have checked out a read-only copy of a file. See Performing common VCS
operations on page 10-7 for more information.

Setting font and tabs defaults

To set the default font and tab settings that the CodeWarrior IDE will use for all text
files that do not have individual settings specified:

Ensure that the Remember Font preferences option is not selected in the Editor
configuration panel. See Setting Remember options on page 8-17 for more
information.

ARM DUI 0065C
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When this option is not selected, any changes you make in the Font & Tabs
configuration panel apply to all CodeWarrior editing sessions.

Follow the instructions in Setting the font and tabs for a single file on page 8-20
to select font and tab options. You do not require an open editor window to set
default values.

8.4.4  Syntax Coloring
The Syntax Coloring preferences panel enables you to change the default color for
comments, keywords, and strings in your source code.
Note
Syntax coloring does not apply to assembly language source. However, you can use
browser coloring to highlight assembly language constructs in the browser.
It also provides four Custom Keyword sets that you can use to specify the text color for
your own keyword sets. The Custom Keywords list can contain function names, type
names, or anything else you want highlighted in your editor windows.
To open the Syntax Coloring panel:
1. Select Preferences... from the Edit menu. CodeWarrior displays the IDE
Preferences window.
2. Click Syntax Coloring in the IDE Preference Panels list. CodeWarrior displays
the Syntax Coloring panel (Figure 8-11).
144 IDE Preferences
B IDE Preference Panels B Syntax Coloring
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- |DE Extraz Suntax Colors
- Plugin Settings Cormrnerit:: [ Custom Keyword Set 1: [N Edit...
.Source Trees Fegacrcts: [ Custom Keyword Set 2: [~ Edit...
= Edltg[ Disel Strings: [ Custom Keyword Set 3: [N Edit...
E::I?::?Z;tt:i;:y Custom Keyword Set 4: [N Edit...
- Font & Tabs
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Figure 8-11 Syntax Coloring preference panel
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3. Select the Use Color Syntax option to turn syntax coloring on.

Table 8-1 lists each element of text that the CodeWarrior editor displays in color.

Table 8-1 Syntax coloring highlights

Element Description

Main text Anything that is not a comment, keyword, or custom keyword,
such as literal values, variable names, function names, and type
names.

Comments Code comments. In C or C++, a comment is text enclosed by /x

and =/ or text from // to the end of the line.

Keywords C and C++ language keywords. It does not include any macros,
types, or variables that you or the system header files define.

Custom keywords Any keyword listed in the Custom Keyword List. This list is
useful for macros, types, and other names that you want to
highlight.

Changing syntax highlighting colors

The CodeWarrior IDE can use different colors for each type of text. To change the
syntax highlighting:
1. Open the Syntax Coloring panel (see Syntax Coloring on page 8-22).

2. Click the color sample next to type of text you want to change. For example, to
change the color used for comments in your source code, click the Comments
color sample. CodeWarrior displays a standard system color picker dialog.

3. Select the color you want from the color picker dialog and click OK.

4. Click Save to save your changes.

— Note

You can use Syntax Coloring from the Document Settings pop-up menu to turn syntax
coloring on or off as you view a particular file. See Controlling color on page 5-16 for
more information.

ARM DUI 0065C Copyright © 1999, 2000 ARM Limited. All rights reserved. 8-23



Configuring IDE Options

Using color for custom keywords

You can use the Custom Keywords dialog box to choose additional words to display in
color. These words can be macros, types, or other names that you want to highlight.
These keywords are global to the CodeWarrior IDE and will apply to every project.

To add one or more keywords to a Custom Keyword Set:

1.
2.

Open the Syntax Coloring panel (see Syntax Coloring on page 8-22).

Click Edit... to the right of the Custom Keyword Set you want to modify. The
CodeWarrior IDE displays the Custom Keywords dialog box (Figure 8-12 on
page 8-24).

14 Custom Keywords
_ Custom Keywords
[rintf | Add
Import from file... | Export tafile... |
cous |

Figure 8-12 Custom Keywords dialog box

Type a keyword in the Add text field. You can also import sets of custom
keywords that you have already saved. See Importing and exporting custom
keywords on page 8-25 for more information.

Click Add. The CodeWarrior IDE adds the keyword to the Custom Keywords list.

Note

To delete a keyword from the list, select the keyword and then press Backspace.
The CodeWarrior IDE removes the keyword from the Custom Keywords list.

You might not be able to add keywords if the Custom Keywords list is very large.
If the CodeWarrior IDE is unable to add a keyword to the list, it displays a dialog
box informing you that adding the keyword was unsuccessful.

Click Done when you have finished. The dialog box is closed.

8-24

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring IDE Options

6.  Click Save in the Syntax Coloring panel. The changes you have made are applied
to your current editor windows. All the custom keywords you have defined are
displayed in the appropriate color.

—— Note

. If you define a keyword in more than one Custom Keyword set, the CodeWarrior
IDE uses the definition from the first set it encounters. That is, definitions in
Custom Keyword Set 1 are used before those in Custom Keyword Set 2, and so
on.

. You can also set target-specific colors for custom keywords. See Custom
Keywords on page 9-133 for more information.

Importing and exporting custom keywords

You can use the Custom Keywords dialog box to export and import lists of defined
keywords. To save a list of the keywords defined in a Custom Keyword Set, or to
re-import a list of keywords that you have already saved:

1. Open the Syntax Coloring panel (see Figure 8-11 on page 8-22).

2. Click Edit to the left of the Custom Keyword Set you want to export or import to
(see Figure 8-11 on page 8-22).

3. Click either:
. Export to file..., if you want to save the current list of keywords.
. Import from file..., if you want to save the current list of keywords.
The CodeWarrior IDE displays a standard file dialog box.

4. Depending on whether you are exporting or importing a keyword set, use the
standard file dialog box to:
. Enter the name of the file you want to save to.

. Open the file that contains the list of keywords you want to import. If you
are importing a custom keyword set, the CodeWarrior IDE adds the
keywords in the imported file to any keywords already defined for the
current set.

5.  Click Done. To close the dialog box and save your changes.

6.  Click Save in the Syntax Coloring panel to apply the changes to your current
editor files.
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8.5 Setting commands and key bindings

This section describes how to:

. specify customized commands that can appear in the CodeWarrior IDE menus
. assign keyboard shortcuts to commands and change keyboard shortcuts that are
already defined.

See also Customizing toolbars on page 8-37 for information on customizing
CodeWarrior IDE toolbars.

8.5.1 Opening the Customize IDE Commands window

The Customize IDE Commands window contains two tabbed panels that enable you to
specify your own commands, assign keybindings to commands, and customize the
CodeWarrior IDE toolbar. To open the Customize IDE commands window:

1.  Select Commands & Keybindings... from the Edit menu. CodeWarrior displays
the Customize IDE Commands window (Figure 8-13). The window contains two
tabbed panels.

i44 Customize IDE Commands

[ [Tt |
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i
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Editar Commands
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Ciata

Browser

Lapout
E\::jlzi 1 Key Bindings ;‘ Hew Binding
™| Auto Repeat
=
Prefix ey Timeout: ™ Mumeric Keppad Bindings
Export... | Impat... |
Mew Group Mews Command | [elete | Factory Settings Revert | Save |
Figure 8-13 Key Bindings panel
2. Click either:

. The Toolbar Items tab, to display the toolbar control elements that you can

add to the CodeWarrior IDE toolbars. See Customizing toolbars on
page 8-37 for more information.
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. The Commands tab, to display the key bindings customization panel. The
CodeWarrior IDE commands are displayed in a hierarchical list, ordered by
their menu names.

Click a hierarchical control next to a command group to display the commands
for the command group. Figure 8-14 shows an example for the Edit group of
commands.

— Note
Some commands are not implemented by the ARM version of the CodeWarrior
IDE.

E Commands

= Edit
- %Y Undo

I 31

- & Redo

- 3 Cut

- Copy

- @8 Paste

- CIB Delete

- Select Al

{ll} Balance
- 4Z Shift Left

- BE Shift Right |

Figure 8-14 List of Edit commands

Click on a command to select it. The default key bindings for the command are
displayed. See Customizing keybindings on page 8-30 for more information on
modifying key bindings. See Customizing toolbars on page 8-37 for more
information on adding commands to the Code Warrior IDE toolbar.

8.5.2 Adding your own commands to the CodeWarrior IDE

You can use the Commands & Keybindings command to add menu items and
keybindings for your own external executable commands. You can add commands to
existing CodeWarrior IDE menus, or you can create your own menu groups. To
configure your own commands:

1.

Open the Customize IDE Commands window. See Opening the Customize IDE
Commands window on page 8-26.

Create a new group if you want to create a new menu for the command. See
Creating a new command group on page 8-29 for more information.
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Select the group to which you want to add the command and click New
Command.

Note
You cannot add your own commands to some default CodeWarrior groups.

The CodeWarrior IDE adds Action configuration fields to the Commands
window (Figure 8-15).

i44 Customize IDE Commands
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Figure 8-15 Configuring a new command

Enter the name of the command to run in the Execute field, or click the ... button
and select the command from the standard file dialog.

Enter arguments to the command in the Arguments field, if required. You can
click on the pop-up menu button next to the text field to select arguments from a
list of CodeWarrior IDE internal variables.

For example, select the Editor Selected Text pop-up menu item to specify the
text selected in the current editor window as an argument to the command.
Figure 8-16 shows an example.

8-28

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring IDE Options

i44 Customize IDE Commands
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Figure 8-16 Mail selected command

Enter the name of the working directory from which the command is to be
executed, if required. You can click on the pop-up menu button next to the text
field to select arguments from a list of CodeWarrior IDE internal variables.

For example, select the Current Target Output File Directory pop-up menu
item to specify the directory that contains the output from the currently selected
build target.

Define one or more keybindings for the new command, if required. See
Customizing keybindings on page 8-30 for more information.

Click Save to save your settings. The CodeWarrior IDE adds the command to the
specified group.

Creating a new command group

To create a new group for your own commands and optionally display it in the main

menu:

1. Open the Customize IDE Commands window. See Opening the Customize IDE
Commands window on page 8-26.

2. Click New Group.... The CodeWarrior IDE inserts the new group into the

commands list (Figure 8-17).
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8.5.3

i44 Customize IDE Commands
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Figure 8-17 Creating a new group
Type a name for the new group in the Name text field.

Ensure that the Appears in Menus option is selected if you want to add a menu
for the new group to the main CodeWarrior menu bar.

Click Save. The CodeWarrior IDE changes the name of the new group and creates
a new menu with the same name as the group.

Customizing keybindings

This section describes how to customize the default CodeWarrior keybindings
definitions and options. You can customize the keyboard shortcuts used for menu,
keyboard, and editor commands in the CodeWarrior IDE. You can attach or bind almost
any key to any command, and you can define multiple keybindings for the same
command. You can set the key bindings for menu commands, source code editor
actions, and other miscellaneous actions. You can also create multiple-keystroke
command bindings.

This section describes:

Restrictions on choosing key bindings on page 8-31

Using multiple-keystroke bindings on page 8-31

Setting the Prefix Key Timeout on page 8-31

Using a Quote Key prefix to create single-key keybindings on page 8-32
Setting Auto Repeat for keybindings on page 8-33
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. Modifying key bindings on page 8-34

. Adding a new keybinding on page 8-35
. Deleting a keybinding on page 8-35

. Exporting key bindings on page 8-36

. Importing key bindings on page 8-36.

Restrictions on choosing key bindings

The following restrictions apply to the keys you can bind to actions:
. The Escape and Space keys are always invalid for key bindings.
. Function keys and the Clear key are valid for creating key bindings.

. The Return and Tab keys require at least the Control or Shift key. This restriction
does not apply for the second key of a two-key sequence.

Using multiple-keystroke bindings

You can create multiple-keystroke command keys, such as those used in the Emacs text
editor. For example, the key sequence in Emacs to save a file is Control-X followed by
Control-S.

To emulate the Emacs key binding to save a file:

1. Delete the Ctrl-X keybinding for the Cut command. You must delete the current
keybinding because you cannot assign the same keybinding to more than one
command.

Delete the Ctrl-S keybinding for the Save command.
3. Set the command key for the Save command to Control-X Control-S.

You can adjust the maximum time to wait for a key press after a the first key sequence
is pressed (see Setting the Prefix Key Timeout on page 8-31).
Setting the Prefix Key Timeout

The Prefix Key Timeout field sets the length of time that the CodeWarrior IDE waits for
the second key sequence after the first sequence in a multi-keystroke binding is pressed.
Larger values indicate that the CodeWarrior IDE will wait longer for the second key to
be pressed.

To set the Prefix Key timeout:

1. Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).

2. Enter the value for the timeout key in the Prefix Key Timeout text field.
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The timeout value is in ticks (1/60th of a second). Valid values are in the range of
1 t0 999. The default value is 120.

3. Click Save to save your settings.

Using a Quote Key prefix to create single-key keybindings

In typical use, a key binding requires you to use two keys in combination:
. a modifier key, such as the Control key
. a printing key, such as the 1 key.

However, you can define key bindings that do not require a modifier key. For example,
you can assign the key for the number 1, with no modifier, to a command.

If you assign a keybinding to a single printing key, you must type a Quote Key prefix
in order to ignore the keybinding and type the printing character associated with the key.
For example, if you have assigned the 1 key to a command and the tilde (~) key as the
Quote Key, you must type ~1 in order to enter the character 1 into an editor window. To
enter a tilde character you must type the tilde key twice.

Note

The Quote Key affects only the next key or combination of keys that you type. You must
use the Quote Key once for each bound key or combination of keys for which you want
to type the equivalent character on-screen.

By default, the CodeWarrior IDE does not define a Quote Key. To assign a Quote key:

1. Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).

2. Click the hierarchical control next to the Miscellaneous group and select the
Quote Key entry (Figure 8-18).
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i44 Customize IDE Commands
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Figure 8-18 Selecting the quote key

3. Click New Binding to display the Edit Key Binding dialog (Figure 8-19).

Edit Key Binding

Binding: | |

Cancel | ak |

Figure 8-19 New Key binding for the Quote key

4.  Type the key you want to use as the quote key prefix and click OK to set the key
binding.

5.  Click Save to save your settings.

Setting Auto Repeat for keybindings

You can use Auto Repeat to specify that a keybinding is repeated automatically when
you press and continue to hold down its key combination. For example, you can use
Auto Repeat with the Find Next command to repeatedly find a search string in a file.
You can configure Auto Repeat separately for each key binding. See Modifying key
bindings on page 8-34 for more information.
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Modifying key bindings

The CodeWarrior IDE defines default keybindings for many commands. See
CodeWarrior IDE default key bindings on page B-25 for a list of the default
keybindings. To modify the default key bindings for the CodeWarrior IDE:

1.

Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).

Click the hierarchical control next to the group of commands that contains the
command you want to modify. Most commands are listed under groups that
correspond to the menus in the CodeWarrior IDE.

Double-click the command you want to modify, or select it and press the Enter
key. The Change Binding dialog box is displayed (Figure 8-20).

;74 Edit Key Binding B

Binding: | Ci+Ghift+N |

Cancel | ak |

Figure 8-20 Change Key Binding dialog box

Press the key combination you want to use for the command. For example, press
the Control key and the 8 key to make the command key Control-8.

Note
You cannot edit the contents of the Binding field.

Click OK to set the keybinding.

Select:

. Appears in Menus if you want the command to appear in the CodeWarrior
IDE menus.

. Auto Repeat, if you want the command to be applied repeatedly when you

hold down its key combination.

Click Save to save your changes.
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To add a new keybinding for a command:
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1. Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).
2. Click the hierarchical control next to the command group for the command you
want to modify and select the command from the list.
3. Click New Binding. The CodeWarrior IDE displays the Edit Keybinding dialog
(Figure 8-21).
|E Commands | Detailz
- [| Close &l =] _
M ame: |Exp0&rt Froject... |
- B save V' Appears in Menus
Action
B saves o
- ﬁ Save Az
i ﬁ Save fiLopy A 144 Edit Key Binding
D Revert... .
e PBinding | | I Mew Binding
- @3 Import Components.. — | = | ;I W] Al
- % Close Catalog T =l
Import Project... Prefi Kep Timeout: -I 20 " Mumeric Keypad Bindings
E=port Project... Export... | Import... |
Mew Group Mews Command | [elete | Factory Settings | Revert | Save |
Figure 8-21 Edit Keybinding dialog
4. Type the key sequence you want to use for the command, and click either:
. OK to confirm your setting
. Cancel if you make a mistake.
5. Click Save to apply your settings.

Deleting a keybinding
To delete a keybinding:

1.
window on page 8-26).

Open the Key Bindings panel (see Opening the Customize IDE Commands
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2. Select the keybinding you want to delete.
3. Press the Delete key. The keybinding is deleted from the list of keybindings.

4. Click Save to save your settings.

Exporting key bindings

You can save your key bindings in a file so that you can later import them into the
CodeWarrior IDE at another time. To export your current key bindings:

1. Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).

2. Click Export. A standard file dialog box is displayed.

3. Select the location where you want to save the key bindings file, and click Save.
The current keybindings are saved to the keybindings file.

Importing key bindings

To import a key bindings set that you have previously saved:

1. Open the Key Bindings panel (see Opening the Customize IDE Commands
window on page 8-26).

2. Click Import and select the keybindings file from the standard file dialog.

3. Click Open to read the keybindings from the file.
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8.6 Customizing toolbars

This section describes how to customize the CodeWarrior IDE toolbars. It describes:
. Toolbar overview on page 8-37

. Showing and hiding a toolbar on page 8-38

. Modifying a toolbar on page 8-38.

8.6.1 Toolbar overview

A toolbar contains elements, represented by icons, that act as buttons. A toolbar can
contain the following elements:

Commands These are buttons that execute CodeWarrior IDE menu commands when
clicked.

Controls These are the CodeWarrior IDE interface controls such as Document
Settings, Function, Header, Marker, Version Control, and Current Target
pop-up menus.

Figure 8-22 shows the default toolbar from the CodeWarrior project window.

. DebugRel ¥ ABe

Figure 8-22 The Project window toolbar

Toolbar types

The following types of toolbar are available in the CodeWarrior IDE:

. Project window toolbars. These are displayed at the top of project windows.

. Editor window toolbars. These are displayed at the top of editor windows, and in
the editing pane of other windows, such as the message window.

. Browser window toolbars. These are displayed in the Class Browser window in
the single-class and multi-class browser views.

. The main window toolbar.

When you modify a toolbar, the changes apply wherever toolbars of that type are
displayed. For example, if you modify an editor window toolbar, the change affects all
editor windows and editor panes. See Modifying a toolbar on page 8-38 for more
information on adding and removing elements to toolbars.

Each toolbar type has a default configuration of elements that you can restore if you
want to discard your changes. See Restoring a toolbar to default settings on page 8-42
for more information.
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8.6.2

8.6.3

Showing and hiding a toolbar

The Window menu contains a Toolbar submenu that enables you to show, hide, reset
or clear a toolbar. There are separate menu items for the main window toolbar, and the
toolbar for the currently active window. When you select a toolbar command it applies
to all toolbars of the same type. Hiding a toolbar does not change the elements contained
in the toolbar.

To show or hide a window toolbar:

1.
2.

Click on the window which you want to configure to make it the active window.

Select either:

. Window — Toolbar — Hide Window Toolbar to hide the window
toolbar

. Window — Toolbar — Show Window Toolbar to show the window
toolbar.

You can also show or hide the editor window toolbar with the Toolbar disclosure
button. See Displaying window controls on page 5-7 for more information.
Note

When you hide an editor window toolbar, the default toolbar elements are
displayed at the bottom of the editor window. Figure 8-23 shows an example.

i @ bmw.cpp =] B3

/f by armlink. lg

wedd of (BMW *phboee) ;I
i
phose-=£ () ; /4 sheuld be BW::£(): o
phom-ar (] ;
phrso-=h () ;
phrso-=k () ;

i

_ =]
hi »I & »IM »I@ »I :i"»l Line: 22 |i|_| ¥ .z

Figure 8-23 The editor window with hidden toolbar

Modifying a toolbar

You can modify a toolbar by:

Adding a toolbar element on page 8-39

Removing a toolbar element on page 8-41
Removing all toolbar elements on page 8-41
Restoring a toolbar to default settings on page 8-42.
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There are restrictions on the elements you can add or remove from a toolbar. These are
described in Adding a toolbar element on page 8-39 and Removing a toolbar element

on page 8-41.

If you modify a toolbar type, the changes apply to every instance of that toolbar type
created after the modification. For example, if you customize the project window
toolbar, the changes apply to every project window you open, not just the toolbar in the
active project window. Windows that are already open are not affected.

Adding a toolbar element

To add an element to a toolbar:

1.  Ensure that the destination toolbar to which you want to add the element is open.

2. Select Commands & Keybindings from the Edit menu. The Customize IDE
Commands window is displayed (Figure 8-24 on page 8-39). The window
contains two tabbed panels:

Commands

Toolbar Items

Use the commands tab to add toolbar elements for menu

commands.

Use the Toolbar Items tab to add interface elements, such as
the dirty files pop-up menu, or the file path indicator.

i Customize IDE Commands [ %]
|E Commands | |E Detailz

File =

Edit Name: |

Search ¥ | &ppears in kerus

Project .

Debug __ Action

Ciata

Browser

Miscellaneous

Lapout
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“indow

EEEEEECEEE

Editar Commands

-

Mew Group

e Eammatid | [elete |
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|

=

™| Auto Repeat
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Factory Settings
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Figure 8-24 Customize IDE Commands window
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3. Click on the tab for the type of toolbar element you want to add. If you are adding
a Command, click on the hierarchical control next to the command group to
navigate to the command.

4. Click on the icon for the command or interface element you want to add, and drag
it to the toolbar where you want to add the element (Figure 8-25 on page 8-41).

Note
You must click on the icon. You cannot drag the element if you click on its name.

If the toolbar accepts the element, framing corners are displayed in the toolbar. If
you cannot add the selected element to this particular toolbar, framing corners are
not displayed. There are several reasons why a toolbar will not accept an element:

. the toolbar is full
. the element already exists in the toolbar

. commands can be added to a window toolbar only for menu commands that
are available when the current window 1is the active window

. the pop-up menus and the File Dirty and File path indicator in the Toolbar
Controls tab can only be added to the editor window toolbar

. the Target pop-up element in the Toolbar Controls tab can only be added
to the project window toolbar.
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Figure 8-25 Dragging a toolbar element

5. Release the mouse button to add the element to the toolbar.

Removing a toolbar element
To remove an element from a toolbar:

1. Ctrl-right-click on the element in the toolbar. The CodeWarrior IDE displays a
pop-up menu.

2. Select Remove Toolbar Item from the menu to remove the item.

—— Note
Some default toolbar items cannot be removed.

Removing all toolbar elements
To remove all elements from a toolbar:

1. Click on the window which you want to configure.
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2. Select either:

. Window — Toolbar — Clear Window Toolbar to clear all toolbar items
from they type of toolbar in the currently selected window

. Window — Toolbar — Clear Main Toolbar to clear all toolbar items
from the main window toolbar.

Note
Some default toolbar items cannot be removed.

Restoring a toolbar to default settings
To restore the default settings for a toolbar:
1. Click on the window which you want to configure.

2. Select either:

. Window — Toolbar — Reset Window Toolbar to reset the type of
toolbar in the currently active window

. Window — Toolbar — Reset Main Toolbar to reset the main window
toolbar.

The toolbar is reset to contain its default elements.
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Chapter 9

Configuring a Build Target

This chapter describes how to configure build target options, including Compiler,
Assembler, and Linker options, for a specific build target in a project. Build target
options specify how the CodeWarrior IDE should process a build target in a project.
This chapter contains the following sections:

About configuring a build target on page 9-2

Overview of the Target Settings window on page 9-4

Configuring general build target options on page 9-8

Using the Equivalent Command Line text box on page 9-29
Configuring assembler and compiler language settings on page 9-31
Configuring linker settings on page 9-61

Configuring editor settings on page 9-75

Configuring the debugger on page 9-77.
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9.1 About configuring a build target

The Target Settings window handles settings that affect how the CodeWarrior IDE
builds a specific build target within a project. The build settings that you specify in the
Target Settings window apply to the currently selected build target only. This means that
you must set the Target options for each build target in your project separately.

For example, if you are configuring a project based on the ARM Executable Image
project stationery and you want to change the ATPCS options for your project, you must
configure the options for each of the:

. Debug build target

. DebugRel build target

. Release build target.

See Using ARM-supplied project stationery on page 2-24 for more information on
default ARM stationery. See also Setting the current build target on page 2-55 for more
information on selecting build targets.

The Target Settings window is organized into a series of panels that apply to a specific
group of build options. For example, one panel contains settings that specify the folders
in which the CodeWarrior IDE searches for the source files and libraries. See Figure 9-2
on page 9-5 for an example of the Target Settings window. The panels are divided into
the following main groups:

Target The panels in this group enable you to configure basic settings for the
current build target, including the target name, and the linker to use. The
linker setting is particularly important because the CodeWarrior IDE uses
the linker setting to determine which panels to display in the other
groups.

Language Settings

The panels in this group apply specifically to the ARM tool chain. They
enable you to set options for the ARM assembler and compilers,
including ATPCS options, and debug and optimization options.

Note

Language settings are used to compile and assemble all source files
within a single build target. You cannot specify individual settings for
specific source files. You must use separate build targets to change the
settings for one or more files.

Linker The panels in this group enable you to configure ARM linker options and
fromELF options. You can use this panel to configure fromELF to
convert ELF output images to a number of binary formats.

9-2
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Editor This group contains one panel that enables you to configure custom
keywords for the CodeWarrior editor.

Debugger  The panels in this group enable you to select the ARM debugger you want
to use for debugging output, and for running executable images. These
panels also enable you to configure options for the debugger you have
selected.

9.1.1 Configuration recommendations

If you have based your CodeWarrior project on one of the ARM project stationery
templates then many of the configuration options are preset to values that are likely to
be appropriate for your project. For example, if your project is based on the ARM
Executable Image project stationery, the project is configured to use:

. the ARM compilers

. the ARM linker, to output executable ELF format images

. the AXD debugger, to debug and run executable image files.

However, there are a number of configuration panels that you should review in order to
ensure that the configuration options are appropriate for your target hardware and
development environment. In particular, you should review:

. the Target and ATPCS panels for the compilers and assembler, to ensure that the
settings are appropriate to your target hardware and procedure call standard
preferences

. the ARM linker panels, to ensure that the appropriate output is produced
. the ARM fromELF panels, if you are using fromELF to produce a ROMable
image or disassembled source.
9.1.2  Creating project stationery

After you have configured the settings you require for each of the build targets in your
project, you can create Project stationery of your own so that you can create new
projects based on your preferences. See Creating your own project stationery on

page 2-35 for more information.
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9.2 Overview of the Target Settings window

This section gives an overview of how to use the Target Settings window to set Target
options in the CodeWarrior IDE. It describes how to display the Target Settings window,
and how to save and discard changes to the target settings. For detailed descriptions of
how to set specific target options see:

. Configuring general build target options on page 9-8

. Configuring assembler and compiler language settings on page 9-31
. Configuring linker settings on page 9-61

. Configuring editor settings on page 9-75

. Configuring the debugger on page 9-77.

Note

The settings you define in these panels apply to the currently selected build target only.
You must configure each build target in your project separately.

9.2.1 Using the Target Settings window

This section gives basic information on using the Target Settings window to configure
Target options. When you change target settings, the changes you make apply to the
currently selected build target in the current project.

Displaying Target Settings panels

To display Target Settings panels for a specific build target in the current project:

1. Open the project file you want to configure. See Opening a project on page 2-15
for more information.

2. Use the build target pop-up menu to select the build target you want to configure
(Figure 9-1).

:mARM Project. mcp

Link Drder Targets

I 8. DebugRel j i
Release
Diebug

Figure 9-1 Select build target
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Either:
. click the Target Settings button in the Project window.
. select the Settings menu item for your build target from the Edit menu.

The name of the Settings menu item matches the build target for your
currently selected project. For example, if your current build target is
DebugRel, the Settings menu item is named DebugRel Settings....

The CodeWarrior IDE displays a Target Settings window with a list of available

panels on the left side of the window. The panel selected in the list is displayed on
the right side of the window. Figure 9-2 shows an example.

—— Note

The panels that are listed depend on the linker that is selected for the current build
target. See Configuring general build target options on page 9-8 for more
information on specifying a linker.

44 DebugRel Settings

B Target Settings Panels B Target Settings
E- Target -
Target Mame: |DebugF|eI |

- Access Paths

- Build Extras Linker:[ARM Linker =]
- Runtime Settings PIE'“nkerilNone ;I
- File Mappings S
- Source Trees Pastlinker:[ARM fromELF =]
[E- Language Seftings Output Directony:
- AR Assembler : Choose... |
- ARM C Compiler {Project} -
- ARM C++ Compiler [ |

- Thumb C Compiler

- Thumb C++ Compiler

- Linker

- FTP PostLinker

- AR Linker

- ARM fromELF

(- Editar LI

Factory Settings | Frewert Fanel | Save |

Figure 9-2 Selecting a settings panel

[T Save project entries using relative paths

Select the panel you want to configure in the list. You can use the arrow keys or
click the name of the panel.

Each panel contains related options that you can set. The options you select apply
to the currently selected build target in the active project.

Select the options you require. See the following sections in this chapter for
detailed descriptions of the options in each configuration panel.

Save or discard your changes, as required. See Saving or discarding changes on
page 9-6 for more information on applying the changes you have made.
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Saving or discarding changes

If you make changes in the Target Settings window and attempt to close it, the
CodeWarrior IDE displays a Settings Confirmation dialog box (Figure 9-3).

Metrowerks Code'W arrior E

“ExampleProject” settings not saved.

& Do you want to save changes to the settings for target
"ExampleProject” before closing them?

Don't Save |

Cancel |

Figure 9-3 Settings Confirmation dialog box

Click one of:

. Save to save your changes and close the dialog box

. Don’t Save to discard your changes and close the dialog box

. Cancel to continue using the Target Settings window without saving changes.

In addition, you can use the dialog buttons in the Target Settings window to apply or
discard your changes. The dialog buttons are:

Factory Settings

Click this button to reset the current panel to the settings that the
CodeWarrior IDE uses as defaults. Settings in other panels are not
affected. Only the settings for the current panel are reset.

Revert Panel

Click this button to reset the state of the current panel to its last-saved
settings. This is useful if you start making changes to a panel and then
decide not to use them.

Save Click this button to commit any changes you have made in any of the
panels. If you have changed an option that requires that the project be
recompiled, the CodeWarrior IDE displays a confirmation dialog box
(Figure 9-4 on page 9-7). Click OK or Cancel depending on whether you
want to keep your changes or not.
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Metrowerks Code'W arrior E

Target "ExampleProject” must be rebuilt.

Changes to the seftings of target "ExampleProject” recuire
that its sources must be recompiled. Do you want to
continue?

Cancel |

Figure 9-4 Rebuild confirmation dialog box
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9.3 Configuring general build target options

This section describes how to configure general options for a specific build target, such
as the name of the output file, and the linker and post-linker to use. It gives information
on:

. Configuring target settings on page 9-8

. Configuring access paths on page 9-11

. Configuring build extras on page 9-20

. Configuring runtime settings on page 9-23

. Configuring file mappings on page 9-23

. Configuring source trees on page 9-25.
Note

The settings you define in these panels apply to the currently selected build target only.
You must configure each build target in your project separately.

9.3.1 Configuring target settings

The Target Settings panel enables you to specify basic settings for your project such as:

. the name of the target

. the linker and post-linker to use

. the output directory, and whether to use relative or absolute paths for files in the
project.

Because the linker choice determines which panels are displayed in the Targets Settings
Panels list, you must select the linker first before you can specify other target-specific
options such as compiler and linker settings.

The CodeWarrior IDE ensures that only the files affected by an option are marked for
recompilation when you change the option.

To set the Target Settings for the selected build target within a project:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click Target Settings in the Target Settings Panels list to display the
configuration panel (Figure 9-5).
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Figure 9-5 Target Settings panel

3. Specify the settings for your target:

Target Name

Linker

Use the Target Name text field to set or change the name of your
current build target. This is not the name of your final output file. See
Output file naming conventions and locations on page 2-73 for more
information on how CodeWarrior for the ARM Developer Suite names
output files.

Select a linker option from the pop-up menu. You can choose:

ARM linker

Use the ARM linker to link the output from the assembler
and compiler. See Configuring the ARM linker on page 9-62
for more information on linker options.

ARM librarian

Use the ARM librarian to create a library from the compiler
and linker output.

None Do not define a linker. This means that source files will not
be compiled or assembled, because your choice of linker
determines the compiler and assembler that CodeWarrior
calls. You can use this option if you want to define a prelink
or postlink step only, or if you want to use the CodeWarrior
IDE to maintain a collection of non-source files.

ARM DUI 0065C
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Note
See Configuring file mappings on page 9-23 for more information
about the file mappings associated with the linker. The file mappings
determine which filename extensions the CodeWarrior IDE
recognizes.

Pre-Linker
This field is not used by CodeWarrior for the ARM Developer Suite.

Post-Linker
Select a post-linker to process output from the linker. Choose one of:

None Do not use a post-linker.

ARM fromELF

Send the output from the linker to the ARM fromELF
utility. FromELF processes the output using the options set
in the fromELF configuration panel. Use this option to
convert ELF images output by the linker to other formats.
See Configuring fromELF on page 9-72 for more
information.

FTP Post-Linker

This option is not used by CodeWarrior for the ARM
Developer Suite.

Batch File Runner
Use the Batch File Runner to run a DOS batch file as the
final step in the link process. The batch file runner runs the
first, and only the first, .bat file in the link order view of the
project. See Running batch files with the batch runner on
page 2-84 for detailed information on using the Batch File
Runner.

Output Directory
This field displays the name of the directory where the data directory
containing your build output is placed. The default location is the
directory that contains your project file. Click Choose... to select a
different directory. You can define the output directory relative to a
defined source tree. See Configuring source trees on page 9-25 for
more information.
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Save Project Entries Using Relative Paths

Select this option to instruct the CodeWarrior IDE to store project
entries as a relative path from one of the access paths. The
CodeWarrior IDE remembers the location even if it needs to re-search
for files in the access paths.

If this setting is not selected, project entries are stored by name. See
Re-search for files on page B-14 and Reset project entry paths on
page B-14 for more information.

Note

The standard CodeWarrior IDE uses this option to enable you to add
multiple source files with the same name to your project. However,
CodeWarrior for the ARM Developer Suite does not allow you to add
multiple copies of source files that produce output objects. See
Filename requirements on page 2-38 for more information.

4. Click Save to save your changes.

9.3.2 Configuring access paths

You can use the Access Paths panel to define directories that the CodeWarrior IDE
searches for libraries, header files, and source files. The CodeWarrior IDE defines two
types of access path:

User Paths The ARM tools search these paths for:

. User header files. These are header files that you include with a

#include".." statement.

. User libraries. These are libraries that correspond to your
#include".." header files.

. Your source files. When you add a source file to your project from
any directory, the Code Warrior IDE adds the path for the source file
to the User Paths list automatically.

By default, the User Paths setting contains {Project}. This is the folder
that contains the open project.

System Paths
The ARM tools search these paths for:

. C++ system header files. These are C++ header files included with
a #include <.> statement. See Default header file search paths on
page 9-12 for more information on how the ARM C and C++
compilers search for C system header files.

ARM DUI 0065C
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. System libraries. These are the corresponding libraries for the
system header files.

By default, the system paths list contains:

. {Compiler}1ib. The ARM C and C++ compilers use this path to
locate the arm1ib directory containing the C standard libraries. The
ARM C++ compilers use this path to locate the cpplib directory
containing the standard C++ libraries.

. {Compiler}include. The default directory for the ARM standard
C++ library header files.

Note

Previous releases of the ARM development tools used the ARMLIB environment variable
to define the location of C standard libraries. You can configure the ARM linker to use
the ARMLIB environment variable, rather than the System access paths defined here. See
Configuring linker options on page 9-66 for more information.

—— Caution

If you use the ARMLIB environment variable with the CodeWarrior IDE, and you are using
The ARM Developer Suite and the ARM Software Development Toolkit on the same
machine, you must configure ARMLIB to point to the correct libraries for the development
system you are using. The ADS installer gives you the option of overwriting the value
of ARMLIB when you install. The ADS standard libraries are not compatible with the
standard libraries for the SDT.

Default header file search paths

The default search path for header files are defined by the Access path options you have
chosen. The ARM project stationery defines the following access paths:

User Paths {Project}. This is the directory in which the project file is located.

System Paths

{Compiler}Include and {Compiler}Lib, where {Compiler} is the directory
in which the ARM Developer Suite is installed.

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring a Build Target

—— Note

. The ARM compilers use the search paths defined in the CodeWarrior Access
Paths configuration panel when they are called from the CodeWarrior IDE. This
means that the default search paths are different from those used by the compilers
when they are invoked from the command line. In particular:

—  the ARMINC environment variable is ignored
—  the :mem directory is not searched
—  there is no current place (Berkeley search rules are not followed).

If you are using a default ADS installation, these differences have no affect. If you
have made changes to your default installation, such as changing the value of
ARMING, or editing system header files, the behavior of the command line tools and
the CodeWarrior IDE will be different. See the compiler chapter of the ADS
Compiler, Linker, and Utilities Guide for details of how the compilers search for
header files when invoked from the command line.

. The CodeWarrior IDE stops searching when it finds the first match for a header
file. If you have two header files with the same name in your project, the
CodeWarrior IDE does not search the second header file.

. You can speed up compilation if you ensure that search paths defined in the
CodeWarrior IDE are not searched recursively. See Setting access path options on
page 9-14 for more information.

You can change the default search paths in the following ways:

. Select the Always Search User Paths option (see Figure 9-6 on page 9-14) to
search for system header files in the same way as user header files.

. Enter -1, -j, -fd, and -fk command-line options in the Equivalent Command Line
text box. See the compiler chapter in the ADS Compiler, Linker, and Utilities
Guide for a description of these options. See Using the Equivalent Command Line
text box on page 9-29 for more information on specifying command-line options
in the CodeWarrior IDE.

If your standard header files or libraries are not in the default access search paths, the
ARM tools cannot find them when compiling, linking, or running your project. See
Adding an access path on page 9-16 for information on adding access paths.
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Setting access path options

There are a number of options you can set to modify the way in which access paths are
searched, including:

specifying recursive searches

turning off searches for specific access paths

always searching user paths.

To set access path options for a build target:

1.

3.

Display the Target Settings panel for the build target you want to configure (see

Displaying Target Settings panels on page 9-4).

Click Access Paths in the Target Settings Panels list to display the configuration
panel (Figure 9-6).

44 DebugRel Settings
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Figure 9-6 Access Paths settings panel
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4. Specify the search options you want:
Specifying recursive searches

Note

It is strongly recommended that you do not use recursive searching in
complex, or multi-user projects. See Configuring CodeWarrior for
complex or multi-user projects on page 2-51 for more information.

Click in the Recursive Search column next to a folder name to toggle
searching recursively through the folder (see Figure 9-7):

. If a folder icon is displayed next to the name of the folder, the
CodeWarrior IDE performs a recursive search on the path. That
is, the CodeWarrior IDE searches that folder and all the folders
within it.

. If a folder icon is not displayed, the CodeWarrior IDE searches
the named folder only.

Search column Recursive search icon

F'ru:uiect.."aF'ru:ugram Filez R Limited" &R Developer SuitehE xamples
Project}. \TestSource

Figure 9-7 Access paths detail

Note
You can speed up project compilation by turning off recursive path
searches and adding each specific path of every directory that contains
your files to either the System path list or the User path.

Disabling search for a directory
Click in the Search column next to a folder name to toggle searching
that directory (see Figure 9-7):
. if a check mark is displayed next to the name of a folder, the
folder is searched from the current host computer.

. if a check mark is not displayed, the folder is not searched from
the current host computer.
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5.

Note

You can prevent any folder and all its subfolders in an access path from
being searched by renaming the Windows directory with enclosing
parentheses. For example, changing GameImages to (GameImages)
excludes the folder from all subsequent searches. To add it to the
search list, you must explicitly add it as an access path.

Always search user paths

Select this option to search for system header files in the same way as
user header files. See Default header file search paths on page 9-12 for
more information.

Note

It is strongly recommended that you select this option for complex, or
multi-user projects. See Configuring CodeWarrior for complex or
multi-user projects on page 2-51 for more information.

If this option is not selected, and any source file is found in a system
search path, it is effectively promoted to an unchanging system file.
This means that if a later version of the source file is placed in a user
search path, it is not found by the CodeWarrior IDE until this option is
selected.

Click Save to save your changes.

Adding an access path

User access paths are added automatically by the CodeWarrior IDE when you add a
source file to your project that is not in an existing access path. In addition, you can
specify both User and System access paths explicitly. Access paths are searched in the
order that they are defined in the User and System panels. See Changing or removing
an access path on page 9-19 for information on changing the order of access paths.

To add a new access path to a project:

1.

Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click Access Paths in the Target Settings Panels list to display the configuration
panel (see Figure 9-6 on page 9-14).

Select one of:

. User Paths

. System Paths

9-16

Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring a Build Target

depending on which path type you want to add.

4. Click Add. The CodeWarrior IDE displays the Select Access Path dialog
(Figure 9-8).

Please Select an Access Path EHE

Fath Type I Project Relative j

- Bin

B0 drexstd1

D Examples

- Himl _

D Pdf
-] Comman Files

-0 DevStudio
.17 Furead nt LI

(] 8 I Cancel |

Figure 9-8 Select an Access Path dialog box
5. Select the path type you require from the Path Type pop-up menu.

— Note

You can use relative paths to enable projects to contain two or more files with
identical names. However, for large projects, using relative paths will slow
performance.

You can select from the following path types:

Absolute Path

The CodeWarrior IDE defines the access path of the added folder
relative to the root level of the startup volume, including all folders in
between. You must update absolute access paths if you move the
project to another system, rename the startup volume, or rename any of
the folders along the access path.

Project Relative
The CodeWarrior IDE defines the access path of the added folder
relative to the folder that contains the project. You do not need to
update project relative access paths if you move a project, provided the
hierarchy of the relative path is the same. You cannot create a project
relative path to a folder on a volume other than the one on which your
project file resides.
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Compiler Relative
The CodeWarrior IDE defines the access path of the added folder
relative to the folder that contains the CodeWarrior IDE executable.
You do not need to update compiler relative access paths if you move
a project, provided the hierarchy of the relative path is the same. You
cannot create a compiler relative path to a folder on a volume other
than the one on which your CodeWarrior IDE resides.

System Relative

The CodeWarrior IDE defines the access path of the added folder
relative to the base folder containing your operating system. You do not
need to update system relative access paths if you move a project,
provided the hierarchy of the relative path is the same. You cannot
create a system relative path to a folder on a volume other than the one
on which your active operating system base folder resides.

Source Tree Relative
The Path Type pop-up menu contains the name of any source trees you
have defined. If you select a source tree, the CodeWarrior IDE defines
the access path of the added folder relative to a folder defined in either
a build target source tree, or a global source tree. See Configuring
source trees on page 9-25 for more information on defining source
trees for a specific build target. See Configuring global source trees on
page 8-11 for more information on defining source trees for all
projects.

Select the folder that you want to add to the access path and click OK to add the
path, or Cancel to leave the list unchanged.

Note

You can also add a path by dragging and dropping the directory onto the Access
Paths list pane. The path is added as:

. a project-relative path if the directory is on the same as volume the
CodeWarrior IDE
. an absolute path if it is on a different volume from the CodeWarrior IDE.

You can also drag and drop single paths between the Access Paths configuration
panels for different build targets in the same project, and in other projects.

Click Save to save your changes.

9-18
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Changing or removing an access path

To change an access path for a build target:

1.

Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click Access Paths in the Target Settings Panels list to display the configuration
panel (see Figure 9-6 on page 9-14).

Select one of:

. User Paths

. System Paths

depending on which path type you want to change or remove.

Select the path you want to change or remove and click either:

. Change, if you want to change the access path. The CodeWarrior IDE
displays the Select Access Path dialog (see Figure 9-8 on page 9-17). Use
the dialog box to navigate to the new folder location. See Adding an access
path on page 9-16 for a description of the Path Type options.

. Remove, if you want to remove the access path. The access path is removed
from the list.

—— Note

You can use drag and drop to change the order of the User and System access path
lists. Click the access path you want to re-order and drag it to its new location.
Access paths are searched in the order in which they appear in the Access paths
lists.

Click Save to save your changes.

Adding the default access path

You can click the Add Default button to add the default CodeWarrior paths to the User
and System paths lists if you delete them by accident.

—— Note

If you are working with a project based on ARM stationery, the default System paths
for the project are:

{Compiler}include
{Compiler}Tib

ARM DUI 0065C
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The Add Default button does not add these paths to your project. It adds the
CodeWarrior IDE default path of recursive {Compiler}. You must add the ARM-defined
default path yourself if you delete it. See Adding an access path on page 9-16 for
information.

Host Flags

The Host Flags pop-up menu specifies the host platform that can use an access path.
This menu does not apply to the ARM version of the CodeWarrior IDE. By default, all
host platforms are selected. If you add a new access path, you should not deselect the
Windows host flag, because this instructs the Code Warrior IDE not to search the access
path on a Windows-based host.

9.3.3  Configuring build extras

The Build Extras panel contains a number options that affect the way a project builds,
including:

. how project information is cached

. whether browser information is generated

. whether a third-party debugger is used.

To modify the Build extras for a build target:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click Build Extras in the Target Settings Panels list to display the configuration
panel (Figure 9-9).
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Figure 9-9 Build Extras settings panel

3. Select values for the following options:

Use modification date caching

Select this option to instruct he CodeWarrior IDE not to check the
modification dates of files you have changed outside the CodeWarrior
IDE. Select this option if you edit files with the CodeWarrior editor
only, and are working in a single user environment. Selecting this
option reduces compilation time.

Deselect this option if you have configured the CodeWarrior IDE to
use a third-party editor, or you are working on a multi-user project with
shared access to source files. See Configuring IDE extras on page 8-7
for more information on using a third-party editor. See Configuring
CodeWarrior for complex or multi-user projects on page 2-51 for more
information on using CodeWarrior in a complex build environment.

Cache Subprojects
Select this option to:

. Improve multiproject updating and linking.

. Enable the CodeWarrior browser to include browser information
from target subprojects. See Chapter 7 Browsing Source Code
for more information on the browser.

You can deselect this option to reduce the amount of memory required
by the CodeWarrior IDE.
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Activate Browser

Select this checkbox to generate the information needed by the
CodeWarrior browser. The information is generated the next time you
build your project. You cannot open browser windows for your project
if this option is not selected.

See Making a project on page 2-77 for more information about
rebuilding your project. For more information on browser settings and
options, see Chapter 7 Browsing Source Code.

Note

The contextual menu features of the browser work in the Code Warrior
editor, in addition to all browser windows. You should consider
enabling the browser, even if you do not use the browser windows, so
that you can use the context-sensitive browser menu features such as
finding definitions, declarations and multiple definitions in your
source code, and using symbol name completion.

If the Activate Browser option is selected you can also select the
Dump internal browser information after compile option to view
the raw browser information that a plug-in compiler or linker provides
for the CodeWarrior IDE. This information is useful only if you are
developing plug-ins for the CodeWarrior IDE.

Note
. You cannot build plug-ins for the CodeWarrior IDE with the
ARM tool chain.
. Compile only single files, or small files with this option selected.

The information that the CodeWarrior IDE displays can be very
large if you compile an entire project.

Use third party debugger

Note

Use the ARM Debugger panel to specify a third-party debugger in
preference to this option. The ARM Debugger panel enables you to
specify a command line for the third-party debugger. See Choosing a
debugger on page 9-78 for details. If you select this option, it overrides
the ARM Debugger panel option.

9-22 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Configuring a Build Target

You can select this checkbox to use any third-party debugger capable
of loading and debugging ARM ELF/DWARF2 images, in place of the
ARM debuggers. Enter the path to the debugger in the text field, or
click the Browse... button to locate the debugger of your choice with
the standard open file dialog.

4. Click Save to save your changes.

9.3.4  Configuring runtime settings

The Configure runtime settings panel is not used by the ARM version of the
CodeWarrior IDE.

9.3.5 Configuring file mappings

Use the File Mappings settings panel to associate a filename extension, such as .c, with
a plug-in tool, such as the ARM C compiler. The file mappings you define in this panel
tell the CodeWarrior IDE which tool, if any, to use to process files with defined
extensions. The default file mappings for the ARM version of the CodeWarrior IDE
depend on:

. the project stationery you use to create a project
. the currently selected build target.

For example, if you create a project from the ARM Executable Image stationery, files
with an extension of .c are mapped to the ARM C compiler. If you create a project from
the Thumb Executable Image stationery, files with an extension of . c are mapped to the
Thumb C compiler.

—— Note

. File mappings determine whether the CodeWarrior IDE will recognize files in the
project. If you have trouble adding files to your project, or if the CodeWarrior IDE
refuses a folder or file that is dragged and dropped on the Project window, check
the File Mappings settings panel to ensure that the relevant file extensions are
defined.

. File mappings sets are associated with the currently selected linker. If you change
the selected linker, the defined list of file mappings also changes. See Configuring
target settings on page 9-8 for more information.

To view and modify the file mappings for a build target:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).
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2.

§ﬁ DebugRel Settings

Click File Mappings in the Target Settings Panels list to display the configuration
panel (Figure 9-10).
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Figure 9-10 File Mappings panel
The File Mappings List contains a File Type, associated Extension, and compiler

choice for each filename extension in the list. This list tells the Code Warrior IDE
which tool, if any, to invoke for files with specified filename extensions.

Figure 9-10 shows the default filename extensions used by the CodeWarrior IDE
for a project based on the ARM Executable Image project stationery. Projects
based on Thumb stationery invoke the Thumb C or C++ compilers, as
appropriate.

Click the entry you want to modify in the File Mappings list and enter the File
Type for the file. Alternatively, click the Browse... button and select a file of the
same type.

Enter the filename extension, such as .c or .h, for the file type.

Click the Compiler pop-up menu and select a compiler for the File Type from the
list of available tools. Select None if you want to be able to add files with the
specified filename extension to your project, but you do not want to use a plug-in
tool to process them.
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6.  Click the Flags pop-up menu to set flags that determine how the CodeWarrior
IDE treats files of the current type. If a flag is set, the File Mappings panel
displays a dot in the appropriate flag column (see Figure 9-10 on page 9-24). The
flags are:

Resource File
This flag does not apply to the ARM tool chain.

Launchable

Select this flag to instruct the CodeWarrior IDE to open this type of file
with the application that created it when you double-click it in a Project
window.

Precompiled

Select this flag to instruct the CodeWarrior IDE to compile this type of
file before other files. This option is useful for file types that are used
to generate files used by other source files or compilers. For example,
this option enables you to create a compiler that translates a file into a
C source code file and then compiles the C file. YACC (Yet Another
Compiler Compiler) files are treated as precompiled files because
YACC generates C source code to be compiled by a C compiler.

Note

You cannot develop CodeWarrior plug-ins with the ARM tool chain.
However, if you can use the standard Metrowerks CodeWarrior
development environment to write your own plug-ins to work with
CodeWarrior for the ARM Developer Suite.

Ignored by Make

Select this flag to instruct the CodeWarrior IDE to ignore files of this
type when compiling or linking the project. This option is useful for
documentation files that you want to include with your project.

7. Click either:
. the Add button, to add a new file mapping

. the Change button, to change the configuration for a selected file mapping.

8. Click Save to save your changes.

9.3.6  Configuring source trees

The Source Trees settings panel enables you to define target-specific source trees (root
paths) for use in your projects. You can define your project access paths and build target
output in terms of source trees.
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You can define source trees in two panels:

Target Settings Panel

You can use the source trees you define in the Target Settings window
with the current build target only. This section describes how to configure
target-specific source trees.

IDE Preferences Panel

You can use the source trees you define in the IDE Preferences panel with
all projects. See Configuring global source trees on page 8-11 for
information on configuring global source trees.

If you define the same source tree in both panels, the target-specific source trees take
precedence over the global source trees.

To add, change, or remove a source tree for the current build target:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click Source Trees in the Target Settings Panels list to display the configuration

panel (Figure 9-11 on page 9-26). The source trees panel displays a list of
currently defined source paths.
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Figure 9-11 Source Trees panel

9-26

Copyright © 1999, 2000 ARM Limited. All rights reserved.

ARM DUI 0065C



Configuring a Build Target

Edit the source tree details:

. To remove or change an existing source path, double-click the entry in the
list of source trees. The source tree details are displayed. Click Remove to
remove the source tree, or follow the steps below to modify it.

. To add a new source tree, type a name for the new source path in the Name
field and follow the steps below.

Click the Type pop-up menu to select the type of source tree. Select one of:

Absolute Path

Select this option to choose a specific directory as the root for your
source tree.

Environment Variable

Select this option to choose a directory defined in an environment
variable as the root for your source tree.

Registry Key
Select this option to choose a directory defined in a Windows registry
key as the root for your source tree.

Choose the source tree root:

. If the source tree is an absolute path, click Choose... to select the root
directory from the standard file dialog.

. If the source key is an environment variable enter the name of the
environment variable. If the environment variable is defined, the source tree
window adds the source tree to the list of defined source trees and displays
the value of the environment variable.

. If the source tree is a registry key enter the full pathname of the registry key,
without the prefix volume label (such as My Computer), and ending with the
name of the registry entry. If the registry key is defined, the source tree
window adds the source tree to the list of defined source trees and displays
the value of the registry key. For example, to add the directory defined by
the ARMHOME registry entry, enter:

HKEY_LOCAL_MACHINE\SOFTWARE\ARM Limited\ARM Developer
Suite\vl.1\ARMHOME

Click Add to add a new source tree, or click Change if you are modifying an
existing source tree.

Click Save to save your settings. The new source path is displayed in dialogs that
require you to select a path type, such as the Select an Access Path dialog
(Figure 9-12). See Configuring access paths on page 9-11 for more information
on adding access paths to CodeWarrior projects.
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Browse for Folder

Choose a Folder

=L Examples
2 asm
B cpp
1 databort
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- dhryansi
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[ flashload
- inline
[ intenwork
D picpid
77 ram

.

|

Cancel |

Figure 9-12 Example source path
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9.4 Using the Equivalent Command Line text box

The Equivalent Command Line text box is displayed at the bottom of configuration
panels for each of the:

ARM Language Settings panels
ARM Linker panels
ARM Debugger panels.

Figure 9-13 shows an example for the ARM C compiler configuration panel.

R AFM C Compiler

Target and Source  ATPCS l'w'arnings] Errorz ] D

ARMAThumb Procedure Call Standard Options
[ ARMAThumb interaaorking

[ Software stack check
W Bead-only position independant

[ Read-write position independent

Options selected in the
interface are reflected

in the Equivalent
Command Line text box.
i~ Equivalent Command Line

-071 -g+ -apcs Aopi -D__APCS_ROPI

Figure 9-13 Equivalent Command Line text box

The Equivalent Command Line text box:

Displays the command-line equivalent for any tool options you select in the panel.
For example, if you select the Read-only position independent option in the
Compiler ATPCS panel, the Equivalent Command Line text box changes to
display -apcs /ropi on the command line.

Enables you to edit the command line, and enter command-line options for which
there are no interface controls in the configuration panels. Not all command-line
options to the ARM compilers, assembler, linker, and other tools, have equivalent
interface controls in the configuration panels. If you want to use a tool
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command-line option from the CodeWarrior IDE, you can enter it in the text box.
See ADS Compiler, Linker, and Utilities Guide for more information on the
command-line options to the ARM tools.

. Enables you to copy and paste language settings between build targets.

Press the Enter key after you have edited the command line to apply the options and
update the panel interface settings.
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9.5 Configuring assembler and compiler language settings

This section describes the language settings group of panels. These panels provide
configuration options that are specific to the ARM compilers and assembler:

Assembler Use this panel to configure options for the ARM assembler, including:

the processor type or architecture version, and other capabilities of
your target hardware

ATPCS options
debug and optimization options
listing options, and other miscellaneous options.

In addition, you can use this panel to predefine variable values for the
assembler. See Configuring the ARM assembler on page 9-32 for details.

Compilers There is a separate configuration panel for each of the ARM compilers in
the language settings group. These panels are identical. Use the compiler
configuration panels to configure options including:

the processor type or architecture version, and other capabilities of
your target hardware

ATPCS options

language mode, for example ANSI C or strict ANSI C
debug and optimization options

warning, error, and other preferences.

See Configuring the compilers on page 9-42 for details of options
common to all the compilers.

—— Note

The settings you define in these panels apply to the currently selected build target only.
You must configure each build target in your project separately. The settings for a build
target are applied to all files in the build target. You can use the Equivalent Command
Line text box to copy settings from one build target to another.

For information on configuring the other tools in the ARM tool chain see:

. Configuring linker settings on page 9-61

. Configuring the debugger on page 9-77.
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9.5.1 Configuring the ARM assembler

This section describes how to configure the ARM assembler from within the
CodeWarrior IDE. It provides general descriptions of the available assembler options.
Where necessary, you are referred to more detailed descriptions in the assembler
chapter of the ADS Compiler, Linker, and Utilities Guide.

Note
Many of the configuration settings described here are optional. However, you should
review at least the Target options, ATPCS options, and Debug table generation options
to ensure that they are suitable for your project.

The configuration options are described in:

. Configuring the target on page 9-32

. Configuring assembler ATPCS options on page 9-34
. Configuring assembler options on page 9-37

. Configuring predefined variables on page 9-38

. Configuring code listings on page 9-40

. Reading assembler options from a file on page 9-41.

These sections give general descriptions of the available assembler options. Where
necessary, you are referred to more detailed descriptions in the Assembler chapter of the
ADS Compiler, Linker, and Utilities Guide.

Configuring the target

Use the Target panel to configure the target processor and architecture for the ARM
assembler:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Assembler in the Target Settings Panels list and click the Target tab
to display the configuration panel (Figure 9-14 on page 9-33).
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44 DebugRel Settings

B Target Settings Panels J B 4R &szembler

= Target Target |ATPES| Dptionsl Predefinesl Listing Eontroll Extrasl

- Target Settings L - .
J N —&rchitecture or Processor—————— 1~ Eloating Paint
- Access Paths

e, o J|| P
- File Mappings
- Source Trees
= Lai

r— Byte Order Initial State——
& Little Endian { = ARM

- ARM C Compiler

- AR C++ Compiler
- Thumb C Compiler

- Thumb C++ Compiler
= Linker Equivalent Command Line
- FTP PostLinker

- AR Linker

- ARM fromELF

(- Editar LI

Factany Settings | Frewert Fanel | Save |

Figure 9-14 ARM Assembler Target panel

" Big Endian ' Thumb

Select values for the following options:

Architecture or Processor
Select the processor or architecture for your target hardware from the
pop-up menu. Some processor-specific instructions produce either
errors or warnings if assembled for the wrong target architecture.
Floating Point

Use this option to select the target floating-point unit (FPU)
architecture. If you specify this option it overrides any implicit FPU set
by the -cpu option. Floating-point instructions produce either errors or
warnings if assembled for the wrong target FPU.

The assembler sets a build attribute corresponding to name in the object
file. The linker determines compatibility between object files, and
selection of libraries, accordingly.

Valid values are:

FPA format and instructions
Selects hardware Floating Point Accelerator.

VFPv1 format and instructions
Selects hardware vector floating-point unit conforming to
architecture VFPvl1.

VFPv2 format and instructions

Selects hardware vector floating-point unit conforming to
architecture VFPv2.
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Old-style mixed-endian softfp
Selects software floating-point library with mixed-endian
doubles.

Pure-endian softfp
Selects software floating-point library (FPLib) with
pure-endian doubles. This is the default.

VFP with softvfp calling standard
Selects hardware Vector Floating Point unit.

To armasm, this is identical to -fpu vfpvl. See the C and C++
Compilers chapter in ADS Compiler; Linker, and Utilities
Guide for details of the effect on software library selection
at link time.

No floating point
Selects no floating-point option. This makes your
assembled object file compatible with any other object file.
Byte Order
Select the byte order used by your target hardware.

Initial State

Select the state that the processor is expected to be in when your code
is executed. This option is available only if you have selected an
architecture or processor that supports the Thumb instruction set.

Note

This option does not generate code to switch the processor state. All
ARM processors start in ARM state. You must ensure that the
processor is in the state you expect when your code is run. See the ADS
Developer Guide for information on switching between ARM state and
Thumb state.

Click Save to save your changes.

Configuring assembler ATPCS options

Selecting ATPCS options sets the appropriate attribute values for the code sections
generated by the assembler. The linker checks the attribute values at link time and

generates error messages if you attempt to link incompatible objects.
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—— Note

Selecting ATPCS options does not provide checks that your assembly language code
conforms to a given ATPCS variant. You must ensure that your assembly language code
follows the conventions required by the ATPCS options you select. See the chapter on
using the ATPCS in the ADS Developer Guide for more information.

If you expect to call your assembly language code from C or C++, you must ensure that
your C and C++ compiler options are configured to use the same calling standard
options. See Configuring compiler ATPCS options on page 9-46 for details.

To configure the ARM/Thumb Procedure Call Standard settings for the ARM
assembler:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Assembler in the Target Settings Panels list and click the ATPCS tab
to display the configuration panel (Figure 9-15).
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Figure 9-15 ARM Assembler ATPCS panel

— Predeclared Register Mames ——
& ATPCS
" Not applicable " Mone

Software stack checking

 On & Qi

Factany Settings | Frewert Fanel |

3. Select values for the calling standard and predefined register names options:

Calling standard
Select ATPCS if your assembly language code is expected to conform
to one of the ATPCS variants. You should select ATPCS if you are
writing assembly language routines that are called from C or C++, or
from other assembly language routines that expect your code to follow
ATPCS calling conventions.
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You can select None if you are writing standalone assembly language
routines that are not called from other routines that expect ATPCS
calling conventions to be followed. In this case you are responsible for
maintaining your own register usage conventions.

Predeclared Register Names

Select ATPCS if you are writing assembly language routines that
conform to one of the ATPCS variants and you want the assembler to
recognize the conventional predefined register names, such as al-a4.
See the Assembler chapter of the ADS Compiler, Linker, and Utilities
Guide for a complete list of predefined register names.

Select the ATPCS variant options that you require.
The following options are available:

ARM/Thumb interworking
Select this option if you are writing ARM code that you want to
interwork with Thumb code, or Thumb code that you want to interwork
with ARM code. The linker generates suitable interworking veneers
when the assembler output is linked. See the description of
Interworking in the ADS Developer Guide for more information.

Read-only position independent
Select this option to mark your code as read-only
position-independent. When this flag is set, the assembler sets the PI
attribute on read-only sections output by the assembler.

Read-write position independent
Select this option to mark your code as read-write
position-independent. When this flag is set, the assembler sets the PI
attribute on read-write sections output by the assembler.

Software stack checking
Select the software stack checking option you require:

On Select this option if you are writing code that performs stack
checking in software.

Off Select this option if you are writing code for a system that
does not require software stack checking.

Not Applicable

Select this option if you are writing code that can work with
either software stack checking, or non software stack
checking code.

Click Save to save your settings.
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Configuring assembler options

To configure other options, such as code checks, warnings, and debug options, for the
ARM assembler:

1. Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Assembler in the Target Settings Panels list and click the Options
tab to display the configuration panel (Figure 9-16).
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Figure 9-16 ARM Assembler Options panel

3. Select values for the following options:

Check Register Lists
Select this option to instruct the assembler to check RLIST, LDM, and STM
register lists to ensure that all registers are provided in increasing
register number order. If this is not the case, a warning is given.

No Warnings
Select this option to turn off all warning messages.

Source Line Debug
Select this option to instruct the assembler to generate debug tables. By
default, when you select this option the Keep Symbols option is also
selected.

Keep Symbols

Select this option to keep local labels in the symbol table of the object
file, for use by the debugger.
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Ignore C-style escape characters
Select this option to instruct the assembler to ignore C-style escaped
special characters, such as \n and \t.

Fault long running Load and Store Multiples

Select this option to instruct the assembler to fault LDM and STM
instructions if the maximum number of registers transferred exceeds:

. five, for all STMs, and for LDMs that do not load the PC
. four, for LDMs that load the PC.

Avoiding large multiple register transfers can reduce interrupt latency
on ARM systems that:

. do not have a cache or a write buffer (for example, a cacheless
ARM7TDMI)
. use zero wait-state, 32-bit memory.
Note

Avoiding large multiple register transfers increases code size and
decreases performance slightly.

Avoiding large multiple register transfers has no significant benefit for
cached systems or processors with a write buffer.

Avoiding large multiple register transfers also has no benefit for
systems without zero wait-state memory, or for systems with slow
peripheral devices. Interrupt latency in such systems is determined by
the number of cycles required for the slowest memory or peripheral
access. This is typically much greater than the latency introduced by
multiple register transfers.

4. Click Save to save your settings.

Configuring predefined variables

Use the Predefines panel to configure the assembler to predefine a global variable and
execute one of the SET directives to set its value, for example:

Debug SETL {TRUE}

The SET directives enable you to configure numeric, string, or logical variables. See the
Assembler chapter in the ADS Compiler, Linker, and Utilities Guide for detailed
information on using these directives.
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To predefine a new variable:

1.

Display the Target Settings panel for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click ARM Assembler in the Target Settings Panels list and click the Predefines
tab to display the configuration panel (Figure 9-17 on page 9-39).
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Figure 9-17 ARM Assembler Predefines panel

Enter the name of the variable in the Variable Name field. Alternatively, if you
want to modify or delete an existing predefined variable, select the variable from
the List of Predefines pop-up menu.

Select the directive you require. Use:

. SETA, for numeric values
. SETS, for string values
. SETL, for logical values.

Enter the value of the variable in the value field, or click the appropriate boolean
value button if you have selected a SETL directive.

Click either:

. Add, if you are creating a new variable definition

. Replace, if you are modifying an existing variable definition
. Delete, to delete an existing variable definition.

Click Save to save your settings.
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Configuring code listings
To configure options for code listings generated by the assembler:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Assembler in the Target Settings Panels list and click the Listing
Control tab to display the configuration panel (Figure 9-18).
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Figure 9-18 ARM Assembler Listing Control panel

3. Select values for the following options, as required:
Listing on
Select this option to instruct the assembler to output a detailed listing
of the assembly language produced by the assembler after it has

resolved assembler constructs such as directives and
pseudo-instructions. The listing is displayed in a new text window.

Terse Deselect this option to display lines skipped due to conditional
assembly in the listing.

Cross-references

Select this option to instruct the assembler to list cross-referencing
information on symbols, including where they were defined and where
they were used, both inside and outside macros.
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Use the Page Width and Page Length fields to set the page width and
page length for your listings. Select the Continuous Page option if you

do not want page breaks inserted in the listing.

Click Save to save your settings.

Reading assembler options from a file

Use the Extras panel to specify a via file for the assembler. A via file is a text file that
contains additional command-line arguments to the assembler. You can use via files to
ensure that the same assembler settings are used by different build targets and projects.
See the ADS Compiler, Linker, and Utilities Guide for a description of via file syntax.

To specify a via file:

1.

44 DebugRel Settings

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click ARM Assembler in the Target Settings Panels list and click the Extras tab
to display the configuration panel (Figure 9-19).
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Figure 9-19 ARM Assembler Extras panel

Click Save to save your settings.

Enter the path name of the via file, or click Choose... and select the via file from
the standard file dialog. The via file options are processed after the options
specified in the configuration panels, and override them if there is a conflict.
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9.5.2 Configuring the compilers

This section describes how to configure compiler options that are common to each of
the ARM compilers:

. the ARM C compiler, armcc

. the Thumb C compiler, tcc

. the ARM C++ compiler, armcpp
. the Thumb C++ compiler, tcpp.

Note
Many of the configuration settings described here are optional. However, you should
review at least the Target options, ATPCS options, and Debug table generation options
to ensure that they are suitable for your project.

Each compiler has its own configuration panel consisting of a number of tabbed panes.
The panels are listed in the Target Settings Panels list (see Figure 9-20 on page 9-43 for
an example) when you select the ARM linker or the ARM librarian as the linker in the
Target Settings panel. See Configuring target settings on page 9-8 for more information
on selecting the linker in the Target Settings panel.

The configuration options are described in:

. Configuring the target and source on page 9-42

. Configuring compiler ATPCS options on page 9-46
. Configuring warnings on page 9-48

. Configuring errors on page 9-52

. Configuring debug and optimization on page 9-54
. Configuring the preprocessor on page 9-55

. Configuring code generation on page 9-56.

These sections give general descriptions of the available compiler options. Where
necessary, you are referred to more detailed descriptions in the C and C++ Compiler
chapters of the ADS Compiler, Linker, and Utilities Guide.

Configuring the target and source

To configure the target processor and architecture for the ARM compilers:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).
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Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Target and Source tab to display the
configuration panel (Figure 9-20).
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Figure 9-20 ARM compiler Target and Source panel

Select values for the following options:
Architecture or Processor

Select an architecture or processor for your target hardware from the
pop-up menu. The pop-up menu contains menu items for all current
product names and architectures. If you select:

. an architecture, for example 4T, your code is compiled to run on
any processor that implements that architecture

. a processor, the compiler compiles code that is optimized for that
processor.

Some processor selections imply a floating-point selection. For
example, with the ARM compilers ARM10200E implies VFPv2
format and instruction. The implied option is overridden if you
specify an explicit floating point option. If no processor or
floating-point options are specified, Pure-endian softfp is used.

Floating Point
Select the floating-point system you are using. Valid values are:
FPA format and instructions

Select this option if you are targeting a system with a
hardware Floating Point Architecture unit. This option is
not available for the Thumb compilers.
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VFPv1 format and instructions

Select this option to target hardware vector floating-point
unit conforming to architecture VFPv1, such as the
ARMI10™ rev 0. This option is not available for the Thumb
compilers.

VFPv2 format and instructions

Select this option to target hardware vector floating-point
unit conforming to architecture VFPv2, such as the
ARMI10200E. This option is not available for the Thumb
compilers.

Old-style mixed-endian softfp
Select this option to use the software floating-point library
and your source code uses FPA-format double-precision
floating-point representations.

Pure-endian softfp
Select this option to use the software floating-point library
with pure-endian doubles. This option specifies that your
code uses VFP format double-precision floating-point
representations, but does not use any floating-point
coprocessor instructions. This is the default.

VFP with softvfp calling standard
Selects software floating-point library with pure-endian
doubles, software floating-point linkage, and requiring a
VFP unit. Select this option if you are interworking Thumb
code with ARM code on a system that implements a VFP
unit.

If you select this option the compiler behaves exactly as for
Pure-endian softfp except that it links with VFP-optimized
floating-point libraries.

Note

If this option is specified for both armcc and tcc, it ensures
that your interworking floating-point code is compiled to
use software floating-point linkage. If you select VFPv1
format and instructions, or VFPv2 format and
instructions for armcc you must use the __softfp keyword
to ensure that your interworking ARM code is compiled to
use software floating-point linkage. See the description of
__softfp in the ADS Compiler, Linker, and Utilities Guide
for more information.
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No floating point

Select this option if you are neither targeting a hardware
floating-point unit, nor the software floating-point library.

Byte Order
Select the byte order used by your target hardware.

Source language
Select the source language you require from the pop-up menu. See the
compiler chapters of the ADS Compiler, Linker, and Utilities Guide for
detailed information on C and C++ standards conformance and
implementation details. Valid options for both C and C++ compilers
are:

ANSV/ISO Standard C
Select this option to compile fairly strict ANSI standard C,
with some characteristics removed, and some minor
extensions, such as accepting C++ style comments (//), and
accepting $ characters in identifiers.

Strict ANSI/ISO Standard C

Select this option to enforce stricter adherence to the ANSI
standard.

The ARM C++ compilers provide the following additional options:

ISO/IEC Standard C++

Select this option to compile standard ISO/IEC C++ with
minor extensions.

Strict ISO/IEC Standard C++
Select this option to enforce stricter adherence to the
ISO/IEC standard. For example, the following code gives an
error when this option is selected, and a warning when
compiled with the standard ISO/IEC option:
static struct T {int i;};
The static declaration is spurious because no object is
declared. In strict C++ it is illegal.

Embedded C++

Select this option to compile C++ that closely conforms to
the industry standard for embedded C++. Embedded C++ is
a subset of standard C++ that is designed to encourage
efficient code for use in embedded systems. The Embedded
C++ standard is evolving. The proposed definition can be
found on the web at http://www.caravan.net/ec2plus.

4. Click Save to save your changes.
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Configuring compiler ATPCS options

Selecting ATPCS options instructs the compiler to generate code that conforms to the
appropriate ATPCS variant. In general, you must ensure that you use compatible calling
standard options when you are compiling objects or libraries that you expect to link
together.

Note

Routines that are entered from exception vectors do not necessarily need the same
settings as the rest of your project code. For example, software stack checking should
be avoided in FIQ handlers in order to maximize the speed of the handler.

In addition, if you are calling routines written in ARM assembly language you must
ensure that your assembly language code conforms to the appropriate ATPCS variant,
and that the assembler is configured with the same ATPCS options. See Configuring
assembler ATPCS options on page 9-34 for details. See also the ATPCS chapter in the
ADS Developer Guide for more information.

To configure the ARM and Thumb procedure call standard options for the ARM
compilers:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the ATPCS tab to display the configuration panel
(Figure 9-21).
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Figure 9-21 ARM compiler ATPCS panel
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3. Select the ATPCS variant options that you require:

ARM/Thumb interworking
Select this option if you are writing ARM code that you want to
interwork with Thumb code, or Thumb code that you want to interwork
with ARM code. Only functions called from the other state need to be
compiled for interworking. The linker generates suitable interworking
veneers when the compiler output is linked. See the description of
Interworking in the ADS Developer Guide for more information.

Software stack check
Select this option if you are writing code that performs stack checking
in software.

Read-only position independent

Select this option if you are compiling code that you want to be
position-independent. If this option is selected, the compiler:

. addresses read-only entities (code and data) pc-relative
. sets the PI attribute on read-only output sections.
Note

The ARM tools cannot determine if the final output image will be
Read-Only Position-Independent until the linker finishes processing
input sections. This means that the linker might emit ROPI error
messages, even though you have selected this option.

Read-write position independent
Select this option to ensure that output data sections in your compiled
code are addressed position-independently. If this option is selected,
the compiler:

. Addresses writable data using offsets from the static base (sb).
This means that:

— data addresses can be fixed at run time

— data can be multiply instanced

— data can be, but does not have to be, position-independent.
. Sets the PI attribute on read-write output sections.

Note

The compiler does not force your writable data to be
position-independent. This means that the linker might emit RWPI
messages, even though you have selected this option.
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4.

Click Save to save your changes.

Configuring warnings

The compiler issues warning messages to warn about portability problems or other
potential problems in your code. You can use the Warnings tab to configure the C and
C++ compilers to suppress or enable specific warnings.

To configure warnings given by the ARM compilers:

1.

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Warnings tab to display the configuration panel
(Figure 9-22).
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Figure 9-22 ARM compiler Warnings panel

Select warning options that apply to both C and C++, as required:
No warnings
Select this option to turn off all warnings.
Warn for all conditions
Select this option to turn on all warnings, including those that are
disabled by default.
Assignment in condition
Select this option to enable the warning:
C2961W: use of “=” in condition context
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This warning is issued when the compiler finds a statement such as:
if (a=b) {...
where it is possible that one of the following is intended:
if ((@a=Db) 1=0) {...
if (a==0b) {...

ANSI C extensions
Select this option to enable warning messages that are issued when
extensions to the ANSI standard are used implicitly. Examples include:
. using an unwidened type in an ANSI C assignment
. specifying bitfields with a type of char, short, Tong, or Tong Tong

. specifying char, short, float, or enum, arguments to variadic
functions such as va_start().

Header file not guarded
Select this option to enable the warning given when an unguarded
header file is #included. An unguarded header file is one that is not
wrapped in a declaration such as:
#ifndef foo_h
#define foo_h
/% body of include file =/
#endif
Unused declaration
Select this option to enable not used warnings such as:
C2870W: variable 'y' declared but not used.
Warning are given for:

. local (within a function) declarations of variables, typedefs, and
functions

. labels (always within a function)

. top-level static functions and static variables.

Non-ANSI header
Select this option to enable the warning message:
C2812W: Non-ANSI #include <.>
The ANSI C standard requires that you use #include <.> for ANSI C
headers only. However, it is useful to disable this warning when
compiling code that does not conform to this aspect of the standard.
These warnings are suppressed by default unless you have selected a
strict source language option in the Target and Source panel (see
Configuring the target and source on page 9-42).
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Padding inserted in struct
Select this option to enable warnings given when the compiler inserts
padding in a struct.
For example:
(2221W: padding inserted in struct 's'

C to C++ incompatibility
For C code, select this option to enable warnings about future
compatibility with C++. Warnings are suppressed by default. For
example:
int xnew(void #p) { return p; }
results in the following warnings:
C2204W: C++ keyword used as identifier: 'new'
C2920W: implicit cast from (void ), C++ forbids

Lower precision in wider context
Select this option to enable the warning message:
Lower precision in wider context
that is given when code like the following is found:
Tong x; int 'y, z; x = y*z
where the multiplication yields an int result that is then widened to
Tong. This warning indicates a potential problem when either the
destination is Tong long, or when the target system defines 16-bit
integers or 64-bit longs.

Implicit narrowing
Select this option to enable the Implicit narrowing cast warning
message.
This warning is issued when the compiler detects the implicit
narrowing of a long expression in an int or char context, or the implicit
narrowing of a floating-point expression in an integer or narrower
floating-point context.
Implicit narrowing casts such as these almost always cause problems
when you move code that has been developed on a fully 32-bit system
to a system in which integers occupy 16 bits and longs occupy 32 bits.

Double to float
Select this option to disable the warning:
C2621W: doubTle constant automatically converted to float
This warning is given when the default type of unqualified

floating-point constants is changed by the Narrow double constants
to float constants option. This warning is switched on by default.
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4. Select warning options specific to C++, if required:

Member and base inits out of order
Select this option to enable warnings given when base and member
initializations are out of order. For example:
struct T { T(int); int i, j; };T::T(int x) @ j(x), i(3%3) { }
The base and member initializations are done in declaration order
(virtual bases are done first) no matter what the order specified in the
definition of the constructor. In this case 1 is initialized before j and so
j*3 gives an undefined value.

Unused this in non-static member function

Select this option to enable the unused this warning. This warning is
issued when the implicit this argument is not used in a non-static
member function. It is applicable to C++ only. The warning can also
be avoided by making the member function a static member function.
The default is off. For example:
struct T {

int f() { return 42; }
b
results in the following warning:
C2924W: '"this' unused in non-static member function

To avoid the warning, use static int f() ...

Implicit virtual
Select this option to enable the implicit virtual warning that is given
when a non-virtual member function of a derived class hides a virtual
member of a parent class. For example:
struct Base { virtual void f(); };
struct Derived : Base { void f(); };
// warning "implicit virtual'
C2997W: 'Derived::f()' inherits implicit virtual from
'Base::f()'
Adding the virtual keyword in the derived class prevents the warning.

Implicit constructor
Select this option to enable the implicit constructor warning that is
given when the code requires a constructor to be invoked implicitly.
For example:
struct X { X(int); };
X x = 10; // actually means, X x = X(10);
// See the Annotated C++
// Reference Manual p.272

5.  Click Save to save your changes.
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Configuring errors

The compiler issues error messages to indicate serious problems in the code it is
attempting to compile.

The options described below enable you to:

. turn specific recoverable errors off
. downgrade specific errors to warnings.
Caution

These options force the compiler to accept C and C++ source that normally produces
errors. If you use any of these options to ignore error messages, it means that your
source code does not conform to the appropriate C or C++ standard.

These options might be useful when importing code from other environments. However,
they might allow the compiler to produce code that does not function correctly. It is
generally better to correct the code than to use options to switch off error messages.

To configure error messages issued by the ARM compilers:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Errors tab to display the configuration panel
(Figure 9-23).
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Figure 9-23 ARM compiler Errors panel
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Select error options that apply to both C and C++, if required:

—— Note

By default, all the following options are selected. Deselect an option to instruct
the compiler to suppress or downgrade the error message.

Implicit pointer casts
Deselect this option to suppress all implicit cast error messages, such
as the error message generated by casting a nonzero int to pointer. No
warning message is given.

Other dubious casts
Deselect this option to downgrade error messages for illegal casts, such
as those generated by casting pointer to short, to warnings.

Junk at end of #endif/#else/#undef
Deselect this option to suppress error messages generated as the result
of extra characters at the end of a preprocessor line. No warning
message is given.

Zero-length arrays

Deselect this option to suppress error messages arising from
zero-length arrays. No warning message is given.

Linkage conflicts

Deselect this option to suppress error messages about linkage
disagreements where functions are implicitly declared as extern and
then later redefined as static. No warning message is given.

Select error options that apply only to C++, as required:

Access control violations
Deselect this option to downgrade access control errors to warnings.
For example:
class A { void f() {}; }; // private member
A a;
void g() { a.f(); } // erroneous access
Implicit int types
Deselect this option to downgrade error messages produced by
constructs such as:
const i;
//missing type specification for 'i' - 'int' assumed
to warnings.

Click Save to save your changes.
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Configuring debug and optimization

Use the Debug/Opt panel to set debug controls, and optimization levels and criteria for
the compiler. The optimization selections you make affect the quality of the debug view
of your code.

To configure optimization and debug options for the compilers:

1.

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Debug/Opt tab to display the configuration
panel (Figure 9-24 on page 9-54).
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Figure 9-24 ARM compiler Debug and optimization panel

Select Debug control options:

Enable debug table generation
Select this option to instruct the compiler to generate DWARF2 debug
tables. This option enables you to debug your output images at the
source level. If this option is not selected, only limited debugging is
available.

Include preprocessor symbols

Select this option to include preprocessor symbols in the compiler
output.
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Enable debug of inline functions
Select this option to instruct the compiler to compile inline qualified
functions out of line so that they can be debugged at source more
easily.

4.  Select the level of optimization you want:

None Select this option to disable all compiler optimizations. Use this option
in combination with enabled debug table generation to generate the
best possible debug view of your output image.

Most Select this option to disable compiler optimizations that impact
seriously on the debug view. Use this option in combination with
enabled debug table generation to generate code that provides a good
compromise between optimization and debug.

All Select this option to enable all compiler optimizations. This option
results in a poor debug view of your output image due to code
movement and register re-use. You can use this option with debug table
generation turned off, or by linking with debug data discarded, to
generate the most efficient code possible, after you have finished
debugging.

5.  Select the optimization criterion:

For space Select this option to favor small code size over execution
speed. This is the default.

For time Select this option to favor execution speed over code size.

6.  Click Save to save your changes.

Configuring the preprocessor

Use the Preprocessor panel to configure preprocessor macros, and to set search path
options. To add, replace, or delete a preprocessor macro for the ARM compilers:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Preprocessor tab to display the configuration
panel (Figure 9-25). The panel displays a list of all predefined macros.
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44 DebugRel Settings
arget Settings Panels ompiler
BT Settings Panel B AR C Compi
= T_a?eat[get Settings - Target and Sourcel ATPLCS I W'amingsl Ermorg I Debug/ Opt  Preprocessor | Ced I L4
- Aoeess Paths ~ List of HDEFINE
- Build Extras TARGET FEATURE THUME ﬁl
- Runlime Settings __TARGET_FEATURE_HALFWORD
- File Mappings —sizedl pli=t | i =l
- Source Trees
[E- Language Seftings
HM sember Add | Replace Delete
=Rt C Compiler
- ARM C++ Compiler
- Thumb C Compiler
- Thumb C++ Compiler
= Lirker — Equivalent Command Line
- FTP PostLinker 01 g+ =]
- AR Linker
- ARM fromELF [
(- Editar LI
Factory Settings | Frewert Fanel | Save |

Figure 9-25 ARM compiler Preprocessor panel

3. Double-click on a preprocessor macro definition in the List of #DEFINEs field to
modify the definition. If you want to add a new definition, double-click on any
existing definition. The name of the macro is displayed in the text field below the
list.

4.  Edit the value of the macro definition as appropriate. If you want to create a new
macro, type over the existing macro name. Specify the value of the macro with an
equals sign. For example:

EXAMPLE_DEFINE=2
If you do not enter a value, the value defaults to 1.

5. Click Add to add a new macro definition, or click Replace to edit the value of an
existing macro definition.

—— Caution
Do not replace the macro definitions predefined by ARM.

6.  Click Save to save your changes.

Configuring code generation
To configure code generation options for the ARM compilers:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).
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Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Code Gen tab to display the configuration panel
(Figure 9-26 on page 9-57).

4 DebugRel Settings

B Target ATPLCS I W'amingsl Ermorg I Debug/ Opt | Preprocessor  Code Gen | Extras I LI_’|

B Target Settings Panels H 4Fit C Compiler
- Target Settings

- Access Paths o

- Build Extras

- Runlime Settings ™ Plain char is signed

- File Mappings [ Spiitload and store rultiple

- Source Trex.as ™ Namow double constants to float constants
B Language Settings ™ One ELF section per function

-~ ARAM Aszembler

C Compiler

- ARM C++ Compiler
- Thumb C Compiler
- Thumb C++ Compiler

= Linker Equivalent Command Line
- FTP PostLinker 01 -g+ ;I
- AR Linker
- ARM fromELF =l
(- Editar LI

Fesert Fanel | Save |

Figure 9-26 ARM Compiler Code Gen panel

Factory Settings |

Select Code Generation options:

Enum container always int
Select this option to force all enumerations to be stored in integers. By
default, the compiler uses the smallest data type that can hold all values
in an enum.

Note

This option is not recommended for general use and is not required for
ANSI-compatible source. If used incorrectly, this option can cause
errors in the resulting image.

Plain char is signed
Select this option to make the char type signed. It is normally unsigned
in C++ and ANSI C modes.
Note

This option is not recommended for general use and is not required for
ANSI-compatible source. If used incorrectly, this option can cause
errors in the resulting image.
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Split load and store multiple

Select this option to instruct the compiler to split LDM and STM
instructions into two or more LDM or STM instructions, where required,
to reduce the maximum number of registers transferred to:

. five, for all STMs, and for LDMs that do not load the PC

. four, for LDMs that load the PC.
This option can reduce interrupt latency on ARM systems that:

. do not have a cache or a write buffer (for example, a cacheless
ARM7TDMI)

. use zero-wait-state, 32-bit memory.

Note

Using this option increases code size and decreases performance
slightly.

This option does not split ARM inline assembly LDM or STM instructions,
or VFP FLDM or FSTM instructions, but does split Thumb LDM and STM
inline assembly instructions where possible.

This option has no significant benefit for cached systems, or for
processors with a write buffer.

This option also has no benefit for systems with non-zero-wait-state
memory, or for systems with slow peripheral devices. Interrupt latency
in such systems is determined by the number of cycles required for the
slowest memory or peripheral access. This is typically much greater
than the latency introduced by multiple register transfers.

Narrow double constants to float constants
Select this option to change the type of unsuffixed floating-point
constants from double (as specified by the ANSI/ISO C and C++
standards) to unspecified. In this context, unspecified means that
uncast double constants and double constant expressions are treated as
float when used in expressions with values other than double. This can
sometimes improve the execution speed of a program.

Compile-time evaluation of constant expressions that contain such
constants is unchanged. The compiler uses double-precision
calculations, but the unspecified type is preserved. For example:
(1.0 + 1.0) // evaluates to the floating-point

// constant 2.0 of double precision and
// unspecified type.
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float f1l(float x) { return x + 1.0; }
float f2(float x) { return x + 1.0f;}

float f3(double x) { return x + 1.0; }

Configuring a Build Target

In a binary expression that must be evaluated at run-time (including
expressions that use the ?: operator), a constant of unspecified type is
converted to float, instead of double. The compiler issues the
following warning:

C2621W: double constant automatically converted to float

You can avoid this warning by explicitly suffixing floating-point
constants that you want to be treated as float. You can turn this
warning off with the -Wk compiler option.

Note
This behavior is not in accordance with the ANSI C standard.

If the other operand in the expression has type double, a constant of
unspecified type is converted to double. A cast of a constant of
unspecified type to type T produces a constant of type T.

For example:

// Uses float add and is treated the same

// as f2() below, a warning is issued.

// Uses float add with no warning, with or
// without -auto_float_constants.

// Uses double add, no special treatment.

float f4(float x) { return x + (double)1.0;} // Uses double add, no special treatment.

One ELF section per function

Select this option to generate one ELF section for each function in a
source file. This option enables the linker to remove unused functions.
This option increases code size slightly for some functions, but when
creating code for a library, it can prevent unused functions being
included at the link stage. This can result in the reduction of the final
image size.

4. Click Save to save your changes.

Reading compiler options from a file

A via file is a text file that contains additional command-line arguments to the compiler.
Via files are read when the compiler is invoked. The via file options are processed after
the options specified in the configuration panels, and override them if there is a conflict.
You can use via files to ensure that the same compiler settings are used by different build
targets and projects. See the ADS Compiler, Linker, and Utilities Guide for a description
of via file syntax.
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To specify a via file:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Depending on the compiler you are using, click the appropriate entry in the Target
Settings Panels list and click the Extras tab to display the configuration panel
(Figure 9-27).
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Figure 9-27 ARM Compiler Extras panel

3. Enter the path name of the via file you want to use, or click Choose... and select
the via file from the standard file dialog box.

4. Click Save to save your changes.
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9.6 Configuring linker settings

This section describes how to configure the ARM linker from within the CodeWarrior
IDE. The linker settings you can configure depend on the linker that is selected in the

Target Settings window. If you want to process your output with more than one linker
or postlinker you can use dependent subprojects or subtargets to select additional linkers
or postlinkers. See Working with multiple build targets and subprojects on page 2-53 for
more information.

You can use the following linker and postlinker options with the ARM tool chain:

FTP PostLinker
This panel is not used by CodeWarrior for the ARM Developer Suite.

Linker Use this panel to configure the ARM linker. See Configuring the ARM
linker on page 9-62 for details.

fromELF  Use this panel to configure the ARM fromELF utility as a post-linker to
process output from the linker. The fromELF utility can perform a
number of format conversions on linker output, such as converting an
ELF image file to plain binary format suitable for embedding in ROM.
See Configuring fromELF on page 9-72 for details.

The ARM librarian

There is no configuration panel for armar. You can use armar to combine
ELF object files into a library. See also the utilities chapter of the ADS
Compiler, Linker, and Utilities Guide for detailed information on the
ARM implementation of ar.

The batch runner
There is no configuration panel for the batch runner. See Running batch

files with the batch runner on page 2-84 for more information.

For information on configuring the other tools in the ARM tool chain see:
. Configuring assembler and compiler language settings on page 9-31
. Configuring the debugger on page 9-77.

—— Note

The settings you define in these panels apply to the currently selected build target only.
You must configure each build target in your project separately.
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9.6.1 Configuring an FTP PostLinker

This panel is not used by CodeWarrior for the ARM Developer Suite.

9.6.2 Configuring the ARM linker

This section describes how to configure options for the ARM linker (armlink). It
provides a general description of the options that you can configure through the
CodeWarrior IDE. See the ADS Compiler, Linker, and Utilities Guide for a description

of:

. the ARM linker and its command-line options

. how the linker constructs images and partially linked objects
. scatter-loading.

Linker configuration options are described in:
. Configuring linker output on page 9-62
. Configuring linker options on page 9-66
. Configuring image layout on page 9-68
. Configuring linker listings on page 9-69
. Configuring linker extras on page 9-71.

Configuring linker output

Use the linker output panel to configure basic linker options that determine the type of
image it produces. You can configure the linker to produce three basic types of output
file. The options available in this panel depend on the type of image you select. You can
choose to produce:

. A partially linked object. You can use this option to produce a partially linked
ELF object file that you can use in a later link or armar operation. See
alsoWorking with multiple build targets and subprojects on page 2-53 for
information on configuring dependent subtargets and subprojects.

. A simple image that does not require a scatter-load description file to describe the
structure of the image. This option provides an easy way to produce an executable
ELF image. It gives limited control over the structure of the image.

. A scatter-loaded image. Use this output type for more detailed control over the
linker output. You must write a scatter-load description file for the image you
want to produce.
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See the linker chapter of the ADS Compiler, Linker, and Utilities Guide for detailed
information on how to control output from the linker, including a description of
scatter-loading. See also the description of writing code for ROM in the ADS Developer
Guide for guidance on producing images suitable for embedding in ROM.

To set the output options for images:

1.

44 DebugRel Settings

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click ARM Linker in the Target Settings Panels list and click the Output tab to
display the configuration panel (Figure 9-28).
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Figure 9-28 ARM linker Output panel

Select the type of image you want to produce in the Link type group of options.
Select one of:

Partial  Select this option to produce a partially linked ELF object file. No

other options are available if you select this option.

Select this option to produce a simple ELF image file without using a

scatter-load description file. If you select this option the Simple image
group of options becomes active and a Layout panel tab is added to the
list of available panels. See Configuring image layout on page 9-68 for
more information on specifying layout options when linking a simple
image. See below for more information on setting the simple image

options.
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Scattered

Select this option if you want to use a scatter-load description file to
specify the linker output. If you select this option the Scatter
description text field becomes active. You must provide a scatter-load
description file to be used by the linker. Either:

. enter the pathname of the file in the text field

. click Choose... to select the file from the standard file dialog
box.

By convention, scatter-load description files use a filename extension of . scf. You
can add scatter-load description files to your project. See the linker chapter of the
ADS Compiler, Linker, and Utilities Guide for information on writing a
scatter-load description file.

4.  If you have selected a Simple image type in the previous step, the Simple image
output options become available. These options give you limited control over the
type of image output by the linker. The following options are available.

RO Base This text field sets both the load address and execution address of the
region containing the RO section. If you do not enter a value, the value
defaults to 0x8000.

RW Base

This text field sets the execution addresses of the region containing the
RW and ZI output sections. If you enter a value in this field, the linker
creates an image with an execution view that contains two, possibly
non-contiguous, regions:

. a region containing the RO output section

. a region containing the RW and ZI output sections.

If you enter a value for RW Base and select the Split image option, the
linker creates an image that has two load regions in addition to two
execution regions. In this case the value you enter for RW Base sets
both the load address and the execution address of the region that
contains the RW and ZI output sections.

Ropi Select this option to instruct the linker to make the execution region
containing the RO output section position-independent. Usually, each
read-only input section must be read-only position-independent. If this
option is selected, the linker:

. checks that relocations between sections are valid

. ensures that any code generated by the linker itself, such as
interworking veneers, is read-only position-independent.
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Note

The ARM tools cannot determine if the final output image will
be Read-Only Position-Independent until the linker finishes
processing input sections. This means that the linker might emit
ROPI error messages, even though you have selected the ROPI
options for the compiler and assembler.

Select this option to instruct the linker to make the execution region
containing the RW and ZI output sections position-independent. If this
option is not selected, the region is marked as absolute. Each writable
input section must be read-write position-independent. If this option is
selected, the linker:

. checks that the PI attribute is set on input sections to any
read-write execution regions

. checks that relocations between sections are valid
. generates sb-relative entries in Region$$Table and
ZISection$$Table.
This option requires a value for RW Base. A value of zero (0) is
assumed if you do not specify one.
Note

The compiler does not force your writable data to be
position-independent. This means that the linker might emit RWPI
error messages, even though you have selected the RWPI options for
the compiler and assembler.

Split Image

Select this option to split the default load region, which contains the
RO and RW output sections, into two load regions:

. one containing the RO output section

. one containing the RW output section.

This option requires a value for RW Base. A value of zero (0) is
assumed if you do not specify one.

Select a symbol definitions file, if required. See the description of the -symbols
option in the ADS Compiler, Linker, and Utilities Guide for more information on
symbol files.

Select a symbol editing file, if required. See the description of the -edit option in
the ADS Compiler, Linker, and Utilities Guide for more information on editing
symbols in output objects.
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7.  Click Save to save your changes.

Configuring linker options

Use the linker options panel to configure options such as unused section elimination and
symbol resolution. To configure linker options:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Linker in the Target Settings Panels list and click the Options tab to
display the configuration panel (Figure 9-29).
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Figure 9-29 ARM Linker Options panel

3. Select unused section elimination options, as required:

Remove unused sections
Select one or more of these options to remove unused sections from the
image:
. Read-only
. Read-write
. Zero-initialized.
See the description of unused section elimination in the linker chapter

of the ADS Compiler, Linker, and Utilities Guide for detailed
information on when a section is considered to be unused.
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—— Caution

You must take care not to remove interrupt handlers when you remove
unused read-only sections. There are a number of ways to do this,

including:

. using -keep directly in the command line text field

. ensuring that the section containing the interrupt handlers is
placed first

. using the ENTRY assembler directive.

See the linker chapter in the ADS Compiler, Linker, and Utilities Guide
for more information on unused section elimination.

Select additional linker options, as required. The following options are available:

Include debugging information
Select this option to instruct the linker to include debug table
information from the output image. The image output by the linker is
larger, but you can debug it at source.
If this option is not selected, the linker discards any debug input section
it finds in the input objects and library members, and does not include
the symbol and string table in the image. If you are creating a partially
linked object rather than an image, the linker discards the debug input
sections it finds in the input objects, but does produce the symbol and
string table in the partially linked object.

Search standard libraries
Select this option to instruct the linker to scan libraries to resolve
references.

Use ARMLIB to find libraries
Select this option to search the paths defined in the ARMLIB
environment variable for the ARM standard C libraries, instead of the
system paths defined in the Access Paths panel. See Configuring
access paths on page 9-11 for more information on access paths.

Output local symbols
Select this option to instruct the linker to add local symbols to the
output symbol table when producing an executable image.

Give progress information while linking
Select this option to print progress information during a link.

Report “might fail”’ conditions as errors

Select this option to instruct the linker to report conditions that might
result in failure as errors, rather than warnings.
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5.  Enter a value for the image entry point, if required. You can specify an entry point
in the following forms:

. as a unique entry point address
. as the start of the input section that defines a symbol
. as an offset inside a section within a specific object.

The entry point specified here is used to set the ELF image entry address. See the
description of the -entry linker option in the linker chapter of the ADS Compiler,
Linker, and Utilities Guide for details.

6.  Click Save to save your changes.

Configuring image layout

You can use the Image Layout panel to specify which sections should be placed first and
last in an image:

. The Place at Beginning of Image options enable you to place a selected input
section first in its execution region.

. The Place at End of Image options enable you to place a selected input section
last in its execution region.

You can use this, for example, to place:

. the section containing the reset and interrupt vector addresses first in an image
. an input section containing a checksum last in the RW section.
Note

You cannot use these options to override the basic attribute sorting order for sections in
output regions. The basic sorting rules place RO sections before RW sections, and place
both RO and RW sections before ZI sections. This means, for example, that you cannot
use the image layout options to place an RW section before an RO section in an output
region.

You can use scatter-loading to specify more complex ordering of sections. See the
Linker chapter in the ADS Compiler, Linker, and Utilities Guide for more information.

To configure the layout of ELF images output by the linker:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Linker in the Target Settings Panels list and click the Image Layout
tab to display the configuration panel (Figure 9-30).
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Figure 9-30 ARM Linker Layout panel

B Target Settings Panels J H &R Linker

Dutputl Options  Layout | Listingsl Extras I
— Place at beginning of image

— Place at end of image

3. Enter section specifications in the appropriate fields, as required. You can enter
specifiers for either, or both, the first and last sections. Section specifiers can be:

. A symbol. This selects the section that defines the symbol. You must not
specify a symbol that has more than one definition.

. An object name, and section label. This selects the specified section from
within the specified object.

See the linker chapter of the ADS Compiler, Linker, and Utilities Guide detailed
information on specifying first and last sections.

4. Click Save to save your changes.

Configuring linker listings

Use the Listings panel to instruct the linker to output link information to a listing file.
To configure how the linker produces listing information:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Linker in the Target Settings Panels list and click the Listings tab to
display the configuration panel (Figure 9-31).
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Figure 9-31 ARM Linker Listings panel

3. Select the information you want to list during the link operation:

Image map

Select this option to create an image map listing the base and size of
each region and section in the image.

Symbols Select this option to list each symbol used in the link step, including
linker-generated symbols, and its value.

Mangled C++
Select this option to instruct the linker to display mangled C++ symbol
names in diagnostic messages, and in listings produced by the various
linker listing options. If this option is selected, the linker does not
unmangle C++ symbol names. The symbol names are displayed as
they appear in the object symbol tables.

Section cross-references
Select this option to list all cross-references between input sections.

4., Enter the name to be used for the list file, or click Choose... to select a listing file
from the standard file dialog box. When you make your project, the listing text
file is displayed in an editor window.

If you do not enter a filename the listing information is displayed in a Message
window.
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5.  Select the Callgraph checkbox if you want to generate a static callgraph of
functions. This option generates an HTML file in the same directory as the output
binary. The callgraph gives definition and reference information for all functions
in the image. See the description of the -callgraph linker option in the ADS
Compiler, Linker, and Utilities Guide for a description of the output.

6.  Select the link information you want to view. These options instruct the linker to
generate size information for sections in the output image:

Sizes Gives a list of the Code and Data (RO Data, RW Data, ZI Data, and
Debug Data) sizes for each input object and library member in the
image.

Totals Gives totals of the Code and Data (RO Data, RW Data, ZI Data, and
Debug Data) sizes for input objects and libraries.

Unused Lists all unused sections that were eliminated from the image. See
Configuring linker options on page 9-66 for more information on
unused section elimination.

Veneers Gives details of the linker-generated veneers. See the linker chapter in
the ADS Compiler, Linker, and Utilities Guide for more information on
linker-generated veneers, such as interworking veneers.

7.  Click Save to save your changes.

Configuring linker extras
Use the Extras panel to configure extra linker options:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Linker in the Target Settings Panels list and click the Extras tab to
display the configuration panel (Figure 9-31 on page 9-70).
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Figure 9-32 ARM Linker Extras panel

3. Enter a symbol to match to each reference to an undefined symbol in your code.

The symbol must be both defined and global, otherwise it will appear in the list
of undefined symbols, and the link step will fail. This option is useful during
top-down development. It enables you to test a partially-implemented system by
matching references to missing functions to a dummy function.

4, Enter a filename, or click Choose... to select a via file from the standard file
dialog box. You can use a via file to specify additional linker options. See the
linker chapter in the ADS Compiler, Linker, and Ultilities Guide for more
information on using via files with the linker.

5. Click Save to save your settings.

9.6.3 Configuring fromELF

The fromELF utility can perform a number of format conversions on linker, compiler,
or assembler output, such as:

. converting an ELF image file to a binary format suitable for embedding in ROM

. disassembling output, and extracting other information such as object sizes,
symbol and string tables, and relocation information.

To use fromELF you must specify it in the Post-linker field of the Target settings
configuration panel. See Configuring target settings on page 9-8 for more information.
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In addition to calling fromELF as a post-linker, you can also call it as a third-party
debugger. This enables you to use fromELF a second time, for example, to generate a
disassembled code listing from your converted binary output. See Choosing a debugger
on page 9-78 for more information.

—— Note

The options you configure in the ARM fromELF panel apply only when you call
fromELF as a post-linker, not when you call it as a third-party debugger.

To configure the fromELF utility:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM fromELF in the Target Settings Panels list to display the fromELF
configuration panel (Figure 9-33).
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Figure 9-33 ARM fromELF panel

3. Select Include debug sections in output to ensure that debug table information
is included in the fromELF output.

4. Click the Output format pop-up menu and select the output format you want.
Either:

. Select from the binary output options. See the Toolkit Utilities chapter of
the ADS Compiler, Linker, and Utilities Guide for details.
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. Select Text information to extract a text file of information on the output
image. Select one or more text format flags to choose the information you
want. These flags also control how source files are disassembled when you
use the Disassemble command. See Disassembling code on page 2-81 for
more information.

5.  Enter the pathname of the output file or click Choose... to select an output file
from the standard file dialog box. If you do not enter a pathname:

. output text information is displayed in a new editor window if the Text
information output format is selected

. the converted binary is saved in the target subdirectory of the project data
directory if a binary output is selected.

6.  Click Save to save your changes. When you make your project, the CodeWarrior
IDE calls fromELF to process the output.
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9.7 Configuring editor settings

This section describes changes you can make to the CodeWarrior editor that apply to
the current build target. See Choosing editor preferences on page 8-14 for information
on setting global editor preferences.

9.7.1 Custom Keywords

The Custom Keywords settings panel enables you to set colors for defined sets of
keywords. The colors you define are used to display the keywords in the CodeWarrior
editor. Custom keywords are project-specific, not global to the CodeWarrior IDE. See
Syntax Coloring on page 8-22 for more information on:

. setting global keyword sets
. setting color options
. importing and exporting keyword sets.

To configure custom keyword sets:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click Custom Keyword in the Target Settings Panels list to display the
configuration panel (Figure 9-34)
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Figure 9-34 Custom Keywords settings panel

3. Change the keyword sets, as required:

. To change the color for the keyword set, click the color sample and select
the color you want from the standard Windows color picker.
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. To change the contents of a keyword set, click Edit... and make the
appropriate entries in the dialog box. To delete a keyword from the list,
select it and press the Backspace key.

You can also export and import sets of keyword definitions from this dialog.
Keyword files are alphabetically sorted text files with one line for each
keyword. Each line is terminated with a carriage return.

4. Click Save to save your changes.
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9.8 Configuring the debugger

You can configure the CodeWarrior IDE to call any of the ARM debuggers to load and
debug your images. This section describes how to configure the ARM debuggers to
debug and run executable images built from CodeWarrior IDE projects. See Chapter 3
Working with the ARM Debuggers for more information on how the CodeWarrior IDE
interacts with the ARM debuggers. See the ADS Debuggers Guide for detailed
information on working with the ARM debuggers.

For information on configuring the other tools in the ARM tool chain see:
. Configuring assembler and compiler language settings on page 9-31
. Configuring linker settings on page 9-61.

—— Note

The settings you define in these panels apply to the currently selected build target only.
You must configure each build target in your project separately.

This section describes:

. Debugger settings on page 9-77

. Configuring the ARM Debugger on page 9-77
. Configuring the ARM Runner on page 9-87.

9.8.1 Debugger settings

The Debugger settings panel is not used by the ARM version of the CodeWarrior IDE.

9.8.2 Configuring the ARM Debugger

Use the Choose Debugger panel to configure options for the ARM debugger that the
CodeWarrior IDE calls when you select Debug from the Project menu. You can call
any of the ARM debuggers. Depending on the debugger, you can provide startup and
configuration options, or specify a script file to call when the debugger is executed.

In addition, you can use this panel to specify a third-party debugger, or other
post-processing tool, in place of the ARM debuggers. The following sections describe:

. Choosing a debugger on page 9-78

. Configuring ADW on page 9-80

. Configuring armsd on page 9-83

. Specifying arguments for your executable image on page 9-86.
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Choosing a debugger

Use the Choose Debugger panel to specify which ARM debugger is called to debug or
run output images from the CodeWarrior IDE. You can select any ARM debugger, or
you can specify a third-party debugger with the Other option.

Note

Use the Other option in this panel in preference to the Use Third Party debugger
option Build Extras panel.

In addition, you can use the Other option to select any post-processing tool for your
output images. You can use this, for example, to run the ARM fromELF utility twice
during a build so that you can generate a disassembled listing of a plain binary output
file:

1.  Configure fromELF as a post-linker to convert your output image to ROMable
binary format (see Configuring target settings on page 9-8 and Configuring
fromELF on page 9-72)

2. Call fromELF as a third-party debugger to generate a disassembled code listing
of your output binary.

To select the debugger called by the CodeWarrior IDE:

1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

2. Click ARM Debugger in the Target Settings Panels list and click the Choose
Debugger tab to display the configuration panel (Figure 9-35 on page 9-79).
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- AR Assembler oh Deb
- ARM C Campiler S ) D B
. BRM G+ Compiler (% 44D [ARM eitended Debuager} C?gﬂ;e
- Thumb C Compiler 4DV [ARM Debugger for Windows) un
L gt G+ Compier € amsd [8RM Symbolic Debuggsn) L
- Linker
- FTP PostLinker C Other I Ehoose...l
- AR Linker
- ARM framELF r— Command Line for non-4FAM debugger
El- Editar I
‘o Custam Keywards
- Debugger - =
. Dehbugger Settings — Equivalent Command Line
SR Debugger axd -debug &1 ;l
- ARM Runner
Bl Miscellaneous LI
- ARM Features -
Factany Settings | Fievert Panel | Save |

Figure 9-35 Choose debugger panel

3. Choose the debugger you want to use when you select Debug from the Project
menu. To select an ARM debugger, click one of the AXD, ADW, or Armsd radio
buttons and configure the debugger in the appropriate panel. For more
information on configuring ADW or armsd see:

. Configuring ADW on page 9-80

. Configuring armsd on page 9-83.
— Note

AXD does not have a configuration panel

See also the ADS Debuggers Guide for detailed information on using the ARM
Debuggers.

To select a third-party debugger:
Click Other.

b. Click Choose... and select the third-party debugger from the standard file
dialog.

c. Enter the debugger command-line arguments in the Command-line for
non-ARM debugger field.

—— Note

Third-party debuggers must be capable of loading and debugging an ARM
ELF/DWAREF?2 image.
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Configuring ADW

If you have configured the CodeWarrior IDE to use ADW as your debugger you can

configure a number of ADW options from the CodeWarrior IDE.

Note

Use the ADW configuration dialog to configure other ADW options that are not
available from the CodeWarrior IDE, such as the byte order used for target memory, and
ARMulator™ clock speed.

Use the following panels to configure ADW options:

1.

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click ARM Debugger in the Target Settings Panels list and click the ADW1 tab
to display the first configuration panel (Figure 9-36).

14 Debug Settings

B 4Rt Debugger

B Target Settings Panels J
[E- Language Seftings -

Choose Debugger  ADW 1 |ADW’ 2| Armsd 1 I Armsd 2| Arguments

- ARM Assembler
N — Diebug Target Image
- ARM C Compiler
- ARM T+ Campiler " ARMulator ™ Only load symbol
. Thumb C Compler & ADP ol E'ar;e\;itous infarmation
- Thumb C++ Compiler g
= Linker — Option: Part Specification
- FTP Postlinker ™ Reset ADW reqistry settings Device
- ARM Linker V' Display splash screen
- ARM fromELF 5
B Editar [V ‘wam about remote debugging .
: : Line speed -
i Custom Keywords I¥ | &llovy Break ar main(] I j
=+ Debugger ) )
— Equivalent Command Line
adw  -exec &1 ;I
Bl Miscellaneous LI
- ARM Features -
Factany Settings | Fievert Panel Save |

Select the debug target for the debugger:

ARMulator
Select ARMulator to target an ARMulator processor.

ADP

Figure 9-36 ADW1 panel

Select ADP if you are connecting to an ADP-compatible remote target
such as an ARM development board. If you select this option you can
specify the port and line speed for your target device.

9-80

Copyright © 1999, 2000 ARM Limited. All rights reserved.

ARM DUI 0065C



Configuring a Build Target

Previous target
Select Previous target if you want the debugger to start with the debug
target configuration that was used for the most recent debugging
session.
Note
Targeting Multi-ICE®
You should use this option if you are targeting Multi-ICE:

1. Start ADW and select Configure Debugger from the Options
menu to configure the debugger to target Multi-ICE.

2. Select the Previous target option from the ADW 1 configuration
panel to configure the CodeWarrior IDE to restart the debugger
with Multi-ICE.

Enter an expression to select the target communication method if you have
selected an ADP debug target in the previous step. The expression selects serial,
serial/parallel, or ethernet communications and can be one of:

s=n selects serial port communications. n can be 1, 2 or a device name.
s=n,p=m

selects serial and parallel port communication. n and m can be 1, 2, or
a device name. There must be no space between the arguments.

e=1d selects ethernet communication. idis the ethernet address of the target
board.

For serial and serial/parallel communications, you can prefix h=0 to the port
expression to switch off the heartbeat feature of ADP. For example

s=1,h=0

selects serial port 1 and turns off the ADP heartbeat.

Select Only load symbol information if you want to load only debugging
information from an image file. You can use this option when you do not need to
download an image because it already exists on your target, for example, in Flash.

Select other debug options:

Reset ADW registry settings
Select this option to reset the ADW Windows registry entries on
startup.

Display splash screen
Select this option to display the ADW splash screen on startup.

ARM DUI 0065C
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Warn about remote debugging
Select this option to enable the warning given when ADW is started
with an ADP remote debug target.

Allow break on main()

Select this option to allow ADW to insert a breakpoint on main(). This
option is selected by default. Deselect it if you want to run your
executable images until they reach an explicit breakpoint, or until
program termination if there are no breakpoints.

6.  Click ARM Debugger in the Target Settings Panels list and click the ADW 2 tab
to display the second configuration panel (Figure 9-37).

44 DebugRel Settings

B Target Settings Panels J |H ARM Debugger

[E- Language Seftings |
- AR Assembler

- ARM C Compiler — bulti-ICE support: start this session

- ARM C++ Compiler

- Thumb C Compiler Il
- Thumb C++ Compiler

- Linker

- FTP PostLinker — Use this seript

- AR Linker

. ARM fromELF Ehoose...l

- Editor

L Custam Kepwords

= Debugger

- Debugger Settings

= Fitd Debugger

- ARM Runner

Bl Miscellaneous
i ARM Features hd

Factany Settings | Fievert Panel Save |

Figure 9-37 ADW2 panel

Choose Debugger | ADWw 1 ADW 2 |Armsd1 I Armsd 2| Arguments

— Equivalent Command Line
adw  -debug &1 ;I

|

7.  Enter Multi-ICE session and script file information if required:

Multi-ICE Support: start this session

Use this field to specify an ADW session name. You can use this option
to save ADW configuration settings in the windows registry:

. If you specify a new session name, ADW creates a new named
session and saves the configuration information for the current
debug session in the Windows registry when you exit ADW.

. If you specify a previously used session name, ADW is
configured using the information in the named session.

This option is useful for saving and restoring multiple configurations

for use with Multi-ICE, or in any other case where you want to restore

your previous ADW configuration.
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Use this script

Use this field to specify a script file containing additional startup
commands for ADW. A script file is a text file that contains a sequence
of commands in the ADW/armsd command language. For example,
the script file can contain commands to set breakpoints, load an image
to memory, and execute to a specified point in the image.

Enter the full pathname to a script file, or click Choose... and select a
script file from the standard file dialog box.

Use the Arguments tab to enter command-line arguments to be passed to the
executable image you are debugging. See Specifying arguments for your
executable image on page 9-86 for more information.

Click Save to save your settings.

Configuring armsd

If you have configured the CodeWarrior IDE to use armsd as your debugger (see
Choosing a debugger on page 9-78), use the armsd panels to configure debugger
options:

1.

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click ARM Debugger in the Target Settings Panels list and click the Armsd1 tab
to display the first configuration panel (Figure 9-38).

i Debug Settings

|E Target Settings Panels |IE ARM Debugger
[E- Language Seftings -

Choose Debuggerl ADW 1 I ADW 2 Amsd 1 |Armsd 2| Argumentsl

- ARM Assembler
- ARM C Compiler —Debug Target— — Target Processor
- ARM C++ Compiler & ARMulator | | T Feset taroet processor [ Don't specify a processor
- Thumb C Compiler ~ ADP I j
Thumb C++ Cormpiler © Other
= Linker —Emulated Clock Speed Part Specification
- FTF PastLinker I 0 @& inHz Device
- ARM Linker  inkHz I
. ARM fromELF r— Byte Order I~ Mone  inMHz
=8 _Editor & Little Endian Dptions Line speed I vl
~ Custom Keywords ¢ BigEndian || [” Load FPE emulatar
= Debugger 5 X
. Dehbugger Settings — Equivalent Command Line
Rt Debugger armad -armul &1 ;I
- ARM Runner
Bl Miscellaneous LI
- ARM Features -

Factany Settings | Fievert Panel Save |

Figure 9-38 Armsd1 panel
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3. Select the debug target for the debugger:
ARMulator
Select Armulator to target an ARMulator processor.

ADP Select ADP if you are connecting to an ADP-compatible remote target
such as an ARM development board. If you select this option you can
specify the port and line speed for your target device.

Other  Select Other if you are connecting to a third-party debug target.

Note
You cannot use armsd with Multi-ICE.

4. Select values for the following options, as required:
Target Processor

Select the processor for your target system from the pop-up list. For
ADP targets, select the Reset target processor checkbox to instruct
the debugger to reset the target processor, if this is supported by the
target system. Select Don’t specify a processor to accept the default.

Byte Order

Set the byte order used by your target system. The image you are
debugging must be compiled and assembled with the same byte order
settings.

Emulated Clock Speed

Select a clock speed for the ARMulator. This option is valid only if you
you are using an armsd.map file. The armsd.map file must be located in
the same directory as armsd. See ADS Debug Target Guide for more
information on map files.

Port Specification

If you have selected an ADP debug target, enter an expression in the
Device text field to select the target communication method. The
expression selects serial, serial/parallel, or ethernet communications
and can be one of:

s=n selects serial port communications. n can be 1,2 or a device
name.

selects serial and parallel port communication. n and m can
be 1, 2, or a device name. There must be no space between
the arguments.

e=id selects ethernet communication. 7dis the ethernet address of
the target board.
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For serial and serial/parallel communications, you can prefix ,h=0 to
the port expression to switch off the heartbeat feature of ADP. For
example:

s=1,h=0

selects serial port 1 and turns off the ADP heartbeat.

5.  Click the Armsd2 tab to display the second configuration panel (Figure 9-39).

44 DebugRel Settings

B Target Settings Panels !H ARM Debugger
B Language Settings =l I Choose Debuggerl AW I Al 2| msd 1 Armnsd 2 |Arguments|
- ARM Aszembler —=
-~ ARM T Compiler -
- ARM C+ Compiler Spmitl (il || Chmse___|
- Thumb C Compiler e
- Thurmb C++ Compiler Simip(fis I Ehoose...l
- Linker
- FTP PostLinker Load configuration I Ehoose...l
- ARM Linker . 5
. ARM fromELF Select configuration I
=l Editar
L Custom Keywards Capture autput to I Ehoose...l
=+ Debugger - -
. Dehbugger Settings — Equivalent Command Line
SR Debugger armsd -armul &1 ;l
- ARM Runner
- Mizcellaneous LI
L. ARM Features ﬂ

Factany Settings | Fievert Panel Save |

Figure 9-39 Armsd2 panel

6.  Enter values for the following options:

Symbols file

Enter the full pathname to an image file. Armsd reads debug
information from the image file, but does not load the image.
Alternatively, click Choose... to select a symbols file from the
standard file dialog box.

Script file

Enter the full path to a script file containing armsd commands that you
want to execute on startup. Alternatively, click Choose... to select a
script file from the standard file dialog box.

Load configuration

Enter the full path to an EmbeddedICE™ configuration file.
Alternatively, click Choose... to select a configuration file from the
standard file dialog box. Use the Select configuration field to select a
specific configuration block from this file.
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7.

Specifying arguments for your executable image

1.

Select configuration

Enter an armsd selectconfig command to select a data block from the
configuration file specified in the Load configuration field. An
EmbeddedICE configuration data file contains data blocks, each

identified by a processor name and version.

The selectconfig command selects the required block of

EmbeddedICE configuration data from those available in the specified
configuration file. See the armsd chapter of the ADS Debuggers Guide
for more information.

Capture output to

Enter a filename to which output information from the debuggee is
written. Alternatively, click Choose... to select an output file from the
standard file dialog box.

i4f DebugRel Settings

Click Save to save your settings.

Click ARM Debugger in the Target Settings Panels list.

Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).

Click the Arguments tab to display the arguments configuration panel
(Figure 9-40 on page 9-86). Use this panel to enter any command-line arguments
required by your executable image.

B Target Settings Panels

B 4Rt Debugger

[l Language Settings
- AR Assembler
- BRM C Compiler
- ARM C++ Compiler
- Thumb C Compiler
- Thumb C++ Compiler
- Linker
- FTP PostLinker
- AR Linker
- ARM fromELF
- Editor
L Custam Kepwords
= Debugger
- Debugger Settings
=Rk Debugger
- ARM Runner
- Mizcellaneous

L. ARM Features

al

H

Choose Debugger | ADW 1| ADW 2| Amsd1 | Amsd 2 Arguments |

—Arguments for image file

Kl
— Equivalent Command Line
axd -debug &1 d

Factany Sethings |

Revert Panel

Save |

Figure 9-40 Arguments panel
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4. Click Save to save your settings.

9.8.3 Configuring the ARM Runner

The term ARM Runner refers to the ARM debugger that is called to execute, rather than
debug, an image file.

The ARM Runner panel is used to configure the debugger that is called when you select
Run from the Project menu in the CodeWarrior IDE. You can use any of the ARM
Debuggers, or a third-party debugger, to run executable images. You can specify
different debuggers to be called when you debug, and when you run. For example, you
can use AXD to debug your image, and armsd to run it without the overhead of starting
a GUI debugger.

The options for this panel are exactly the same as for the ARM Debugger panel. See
Configuring the ARM Debugger on page 9-77 for information.
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9.9 Configuring Miscellaneous settings
This section describes the following miscellaneous configuration options:
. ARM Features on page 9-88.
9.9.1  ARM Features
This panel is required only if you are using versions of the ARM Developer Suite that
are feature-restricted through FLEX/m license management software. The ARM
Features panel enables you to select the feature set supplied with your version of ADS.
This panel enables you to select the feature set in use if you are moving a project from
one restricted toolkit to another restricted toolkit with a different feature set.
To configure the feature set:
1. Display the Target Settings window for the build target you want to configure (see
Displaying Target Settings panels on page 9-4).
2. Click ARM Features in the Target Settings Panels list to display the
configuration panel (Figure 9-41).
4 DebugRel Settings
B Target Settings Panels J B 4Rt Features
=3 _Language Settings -
o ARM Azsembler .
RM C Compier Fiestricted feature set name
ARM C++ Compler f [
Thumb C Compiler
i Thumb C++ Compiler
= Linker
- FTP PostLinker
ARM Linker
o ARM fromELF
=~ Editar
L Custam Kepwords
= ;-e‘lj:)uegbg;;ger Settings Equivalent Command Line
ARM Debugger ;I
ARM Runner LI
Factany Settings | Frewert Fanel Save |
Figure 9-41 ARM Features panel
3. Select the appropriate feature set.
4. Click Save to save your changes.
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Chapter 10
Using the CodeWarrior IDE with Version
Control Systems

This chapter explains how to use the CodeWarrior IDE version control integration
facilities to control your source code. It contains the following sections:

. About version control systems on page 10-2
. Activating VCS on page 10-3
. Using your VCS from the CodeWarrior IDE on page 10-6.
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10.1

10.1.1

About version control systems

A revision control or version control system (VCS) enables you to maintain a database
of your source code, and then check files in or out of the database. Version control
systems can help you track code changes, particularly when more than one person is
working on a software project.

Note

See Configuring CodeWarrior for complex or multi-user projects on page 2-51 for
important information on using CodeWarrior in multi-user environments.

Commercially available VCS plug-ins

The CodeWarrior IDE plug-in architecture supports a variety of version control
systems.

Plug-ins are available for the following version control systems:
. CVS

. Visual SourceSafe

. Clearcase

. Perforce.

To see the latest list of available plug-in tools, visit the Metrowerks web site at:
http://www.metrowerks.com

10-2
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10.2 Activating VCS

This section describes how to install and activate a version control system so that it can
be used with the CodeWarrior IDE.

10.2.1 VCS plug-in software

The installation instructions for your VCS plug-in software will depend on which VCS
software you are using. This section gives general instructions that apply to most VCS
systems.

Installing VCS plug-in software
To install most version control system plug-in software:
1. Exit the CodeWarrior IDE if it is running.

2. Copy your VCS plug-in to the {Compiler}\PTugins directory.

— Note

You must also follow any installation instructions that accompany the VCS
software you plan to use. If you encounter any problems, contact the VCS
software vendor for assistance.

3. Restart the CodeWarrior IDE.

This is usually sufficient to make the VCS software available for use.

10.2.2 Activating VCS software

You must configure VCS options separately for each project that you want to use your
version control system. This section gives general instructions for activating version
control for a project.

— Note

You must also follow any activation instructions that accompany the VCS software you
plan to use. If you encounter any problems, contact the VCS software vendor for
assistance.
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Configuring your VCS settings
To configure your VCS settings and activate VCS:
1. Ensure that the project you want to configure is the currently active window.

2. Select Version Control Settings... from the Edit menu. The VCS Settings
window is displayed (Figure 10-1).

{46 VC5 Settings

H 5 Settings Panels /L5 Setup
[+ Wersion Cantral

I W Use Yersian Contral

Sources afe Method: |SourceS afe hd
Login Settings
¥ Caonnect on open ¥ Remember password

[ Always show login dialog

D atabase Path

I8 _Choose. |
¥ Ty ta mount shared volume

Local Path

i _Choose. |

Factory Settings | Fievert Panel | Save

Figure 10-1 The VCS settings panel

3. Select the Use Version Control checkbox to activate version control.

4. Select a version control system from the Method menu.

The CodeWarrior IDE supports several different types of VCS. If your VCS
software is correctly installed, its name is displayed in the Method list, as shown
in Figure 10-2.

W Usze Yersion Contral

Method: |k ClearCaze -

Figure 10-2 VCS Method pop-up list.
5.  Enter your VCS user name in the Username field.

6.  Enter your password (optional).
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Set any additional Login Settings options you require. The following options are
available:

Connect on Open

If this option is selected, CodeWarrior connects to the VCS database
when you open this project.

Always Show Login Dialog

If this option is selected the login window is displayed every time you
connect to the VCS database.

Remember Password
If this option is selected your password is saved after you connect to
the database for the first time. You will not be required to enter your
password each time you connect.

Click the Choose button next to the Database Path field to select the VCS
database you want to access. The setting of the Database Path field depends on
which VCS software you are using. See your VCS software documentation for
more information.

Click the Choose button next to the Local Path field to select the destination
folder where your local files will be stored. The setting of the Local Path field
depends on which VCS software you are using. See your VCS software
documentation for more information.

Click Save to save your settings. The CodeWarrior IDE uses the settings you have
specified to connect to the VCS database.

—— Note

Some VCS software might have additional setup requirements. If you encounter any
problems, contact the VCS software vendor for assistance.
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10.3 Using your VCS from the CodeWarrior IDE

10.3.1

The CodeWarrior IDE provides several ways to access common VCS operations and
view status and log information. These include:

. Using the Version Control Login window on page 10-6
. Performing common VCS operations on page 10-7.

Using the Version Control Login window

Many version control systems require you to log in before you can use the system. The
CodeWarrior IDE provides the Version Control Login window to support systems that
require password authentication.

The CodeWarrior IDE displays the Version Control Login window if you are not
already logged in to your VCS and:

. You perform an operation that requires CodeWarrior to communicate with the
VCS, such as updating the status of a file.

. You log in manually.
. You configure your project to connect each time the project is opened. See

Configuring your VCS settings on page 10-4 for more information.

Logging in to your VCS

To log into your VCS:
1.  Either:
. perform an operation that will cause the CodeWarrior IDE to communicate
with your VCS
. select Connect from the VCS menu to connect manually, if this menu item

is supported by your VCS software.
The CodeWarrior IDE displays the Version Control Login window.

2. Enter your VCS username and password, if required by your system.

3. Click OK to log in, or Cancel to stop.

Logging out of your VCS

To log out of your VCS select Disconnect from the VCS menu.

10-6
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10.3.2 Performing common VCS operations

When version control is active for a project, the CodeWarrior IDE makes the following
additions to its graphical interface:

A Checkout Status column is displayed in the project window. Figure 10-3 shows
an example.

A VCS menu is added to the menu bar. See Figure 10-4 on page 10-9 for an
example.

A VCS pop-up menu is added to editor windows for the project. See Figure 10-5
on page 10-11 for an example.

Checkout status column

| ¥y Release j I = @ [=
[&] File Code| Datal s [#]
¢ ) dhy 2c 416 0 o' & =]
by 1 c 372 10244 o'
B dhiyh 1] 1] o' =
o' 3 files 3k 10K,

Figure 10-3 Checkout Status Column

You can use the VCS interface items to perform the most common VCS operations,
such as determining file status, checking in files, and checking out files, from within
both the project window, and the editor window.

— Note
Other operations

Other operations might be available, depending on which revision control system
plug-in you use. See the documentation that accompanies the VCS software you are
using for more information.

The following sections describe how to perform the most common VCS operations
from within the CodeWarrior IDE project and editor windows:

Viewing and synchronizing the VCS status of files

ARM DUI 0065C
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. Working from a project window on page 10-9

. Working from an editor window on page 10-11

. Viewing VCS messages on page 10-12.

Viewing and synchronizing the VCS status of files

If you have configured your project to use a VCS, the CodeWarrior IDE uses icons to
represent the current checkout status, or file permission, of the files in your project.
When you change the checkout status of a file in the CodeWarrior IDE, the icon updates

to reflect the change.

Each file in a project can have a different permission setting. The CodeWarrior IDE
displays file status icon for a file:

. In the Checkout Status column of the project window. See Figure 10-3 on
page 10-7 for an example.

. As the icon for the VCS Pop-up menu in the editor window for the file. See
Figure 10-3 on page 10-7 for an example.

Table 10-1 shows the most common status indicator icons. The operations that you can
perform on a file depend on the current status of the file, and the type of VCS system

you use.

Table 10-1 VCS status icons

If the icon is...

Then...

E Checked out

You can edit the file and add your changes to the revision
control database.

"-ﬂ Checked in

You cannot edit the file. It is part of the revision control
database.

E Writable You can edit the file, but you cannot add your changes to the
) revision control database because the file was not properly
checked-out for modification.
Ii-. Unlocked The file can be edited. It is not checked into a revision control
database.
Locked You cannot edit the file. It is not part of the revision control
p

database. You might not have the access privileges necessary to
access the file, or someone might have locked the file.
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Most version control systems provide a command to synchronize the status of a local
copy of a file with the status of the file in the version control system. To perform a
synchronize status command either:

. click the Checkout Status icon at the top of the column
. select Synchronize Status from the VCS menu.

The status of your local files is compared and synchronized with the status of the files
in the version control database.
Working from a project window

You can perform many common VCS operations from the project window by using the
VCS menu (Figure 10-4).

Synchronize Status

Project r

et

[Efeckout

Indo Checlout
Checkin

Statug
Difference

Edd

Digconnect
Ahbout

Figure 10-4 VCS menu

The VCS menu enables you to perform Get, Checkout, Checkin, and other common
VCS operations. To perform a VCS operation on all the files in a project:

1. Ensure that the project window is the currently active window.

2. Select the command from the VCS menu.

— Note

. The menu items available in the VCS menu might vary, depending on the
VCS operations that are supported by your VCS software. See the
documentation that accompanies your VCS software for more information.
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. VCS plug-ins can assign different names to these operations. See the
documentation that accompanies your VCS software to determine which
operations are supported.

The following VCS menu commands are typical:

Synchronize Status

Updates the VCS Status column in the project window by examining
each project file’s status and updating its information. See Viewing and
synchronizing the VCS status of files on page 10-8 for more
information.

Project Contains a submenu of VCS commands that enable you to perform
Get, Checkout, Undo Checkout, Checkin, Status, and Add
operations on project files themselves.

Recursive

Contains a submenu of VCS commands that enable you to perform
recursive operations in some version control systems.

Get Retrieves a copy of the file without checking it out of the project
database.

Checkout

Checks out files for modification. Depending on your version control
software, checkout can be exclusive or non-exclusive.

Undo Checkout
Cancels a checkout and discard all changes.

Checkin
Returns a modified file to the database and relinquishes the checkout.

History Displays a modification history of a project or file.
Status  Displays the status of a file.

Properties
Displays database information about a project or file.

Comment
Changes a comment for a specific version of a project or file.

Label Assigns a label to a project or file.
Add Adds a file to the database.

Connect or Disconnect

Connects or disconnects you from the project database, depending on
the current open status.

About  Displays VCS plug-in copyright and version information.

10-10
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Variables
Displays the VCS user variable settings in an editor window.

Working from an editor window

The VCS pop-up menu (see Figure 10-5 on page 10-11) is displayed in editor
windows when a VCS is activated. The icon that represents the VCS pop-up
menu indicates the current permission setting for the file. For more information
on permission settings, see Viewing and synchronizing the VCS status of files on
page 10-8.

imdhiy_1.c =] 3
‘va {}v N3 Eﬁl n Fath: |E:\Program Filez' AR M'ARM Developer SuitesE xamplesidhipansivdhn_1.c ()
* Author: Get Weicker Eg
* Get... -
3636 36 36 36 3 36 3N
iy Undo Checkout
Undo Checkout... _I
#include "dhr Checkin

<% (Global Wariables: =~

Rec_Pointer Ptr_Glohb,
Hext_Ptr_ Glob:
int Int_Glob:]
Boolean Bool_Glob;
char Ch_1_Glob,
Ch_2_Glob;
int Arr 1 Glob [50]:
int Arr 2 _Glob [50] [&0]:

#ifndef REG
Boolean Eeg = false:
#define REG
<% REG becomnes defined as empty *7
<% 1.2, no register wvariables *®.
telse
Boolean Eeg = true; -

Line: 36 Ta] | Mz

Figure 10-5 VCS Pop-Up Menu

The VCS pop-up menu enables you to perform a subset of the available VCS commands
on the file you are currently editing. The VCS operations you can perform depend on
the current status of the file, and the operations supported by your VCS.

To perform a VCS operation on a source file:
1. Open the file in the CodeWarrior editor.
2. Click the VCS pop-up menu.

—— Note

The button that represents this menu changes to reflect the current status of the
file. See Table 10-1 on page 10-8 for more information.
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A VCS menu is displayed that contains menu items for VCS operations that are
supported by your VCS system. See Figure 10-5 for an example.

See the documentation that accompanies your revision control system for more
information on supported VCS operations.

3. Select an item from the VCS menu to execute a VCS operation. If the menu item
contains an ellipsis character (...), a dialog box is displayed that enables you to
customize the operation before you execute it.

The following VCS pop-up operations are typical:
Unlock Changes the lock on the file (if possible), enabling it to be writable.

Add Adds the file to the revision control database.
Get Retrieves a fresh copy of the file from the revision control database.
Checkout
Checks the file out from the revision control database for
modifications.

Undo Checkout

Discards any changes made to the file, and instructs the revision
control database to cancel the checkout of the file.

Checkin

Instructs the revision control database to accept the file with the
changes that have been made to it.

Make Writable

Makes the file writable. Depending on your VCS, you might not be
able to be check the modified version into the version control database.

Viewing VCS messages

The CodeWarrior IDE uses a message window to display a log of revision control
messages. See Using the message window on page 3-15 for details of how to use the
controls in the window.

10-12 Copyright © 1999, 2000 ARM Limited. All rights reserved. ARM DUI 0065C



Appendix A
Perl Scripts

This appendix describes how to use the CodeWarrior IDE Perl support. It describes how
to install and configure the Perl plug-ins, and how to configure your project to recognize
and run Perl scripts. It contains the following sections:

. Perl software plug-ins on page A-2
. Configuring a prefix file on page A-4
. Using Perl scripting on page A-6.
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A1 Perl software plug-ins
The CodeWarrior IDE uses software plug-ins to process Perl scripts. This section
describes how to install the Perl plug-ins for Windows.

A.1.1 Installing Perl software plug-ins

The CodeWarrior IDE Perl plug-ins are available in the MWPer1Win.zip zip archive on
your installation CD. To install the plug-ins:

1. Open the MWPer1Win.zip archive in a zip extraction utility such as WinZip.

2. Ensure that your zip extraction utility is configured to recreate the directory
structure of the archive.

3. Extract the contents of the zip archive to the bin\plugins subdirectory of your
ADS installation directory. If you have installed ADS in its default location, this
will be c:\Program Files\ARM\ADSv1_1\Bin\plugins.

4.  Start the CodeWarrior IDE. The Perl plug-ins are available.
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A.2  Configuring your project for Perl

This section describes how to configure the CodeWarrior IDE to recognize and process
Perl scripts, and how to configure a prefix file that is executed before each Perl script in
your project.

A.2.1 Configuring file mappings

If you want to add Perl files with a standard .p1 filename extension to your project you
must configure the File Mappings panel to associate .p] files with the MW Perl plug-in
compiler. To configure file mappings:

1. Open the project window for your project.
2. Select the build target you want to configure.

— Note
You must configure File Mappings separately for each build target in your project.

3. Select target_name Settings... from the Edit menu and select File Mappings
from the list of Target Settings Panels. The CodeWarrior IDE displays the File
Mappings panel (Figure A-1).

4 DebugRel Settings

B Target Settings Panels  File Mappings
= Target -
- Target Settings E File Type | Estension| £P ‘ﬁ? e Compiler
. Access Paths -=: .C ARM C Compiler
- Build Extraz TE=T oG AR C++ Compiler
- Runtime Settings TE=T .CPp ARM C++ Compiler
S File b appings TE=T h +  ARM C Compiler
- Source Trees TEXT hpp +  ARM C++ Compiler
[E- Language Seftings TE=T 5 ARM Azzembler
- BAM Aszembler TEXT scf
- ARM C Compiler TE=T bt .
. ARM o+ Campiler 4 ARM ELF Impoter hd|
- Thumb C Compiler M apping Info
=8 Link::umb L+ Compler File Type: MI Extension:
- FTP PastLinker Flags: || Compiler[ARM C Compler =]
- AR Linker
- ARM fromELF Add | Change | Remove |
- Editar LI

Factory Settings | Frewert Fanel | Save |

Figure A-1 File mappings configuration panel

4. Select an existing file mapping, such as the ARM C compiler mapping.

5.  Change the Extension field to .p1 and select MW Perl from the Compiler pop-up
menu.
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Note

If the MW Perl menu item is not displayed in the pop-up menu, check that you
have correctly installed the Perl plug-in software. See Perl software plug-ins on
page A-2 for more information.

6.  Click Add to add the filename extension to the File Mappings list.

7.  Click Save to save your changes.

A.2.2 Configuring a prefix file

You can use the Perl target settings panel to specify a prefix script to be used for the Perl
scripts in your project. The CodeWarrior IDE treats the prefix script as an implicit
require file. The require directive is the Perl equivalent of the #include directive in C
and C++. The Perl commands in the prefix file are executed before each Perl script file
in your project.

To configure a prefix file:
1. Open the project window for your project.
2. Select the build target you want to configure.

Note
You must configure the prefix file separately for each build target in your project.

3. Selecttarget_name Settings... from the Edit menu and select Perl Panel from the
list of Target Settings Panels. The CodeWarrior IDE displays the File Mappings
panel (Figure A-2 on page A-5).
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14 Debug Settings

= Target

- Target Settings
- Access Paths Prefix File:
- Build Extras

- Runtime Settings
- File Mappings
- Source Trees
ol =1l Panel

[E- Language Seftings
- AR Assembler

- ARM C Compiler

- ARM C++ Compiler

- Thumb C Compiler

- Thumb C++ Compiler

- Linker

- FTP PostLinker

- AR Linker

- &AM fromELF =|

Factany Settings | Fresert Bame! | Save |

Figure A-2 Perl configuration panel

B Target Settings Panels J H Peil Panel
-

4. Enter the name of the Perl file you want to use as a prefix file.

—— Note

The Perl plug-in for CodeWarrior uses the find-and-load functionality of the
CodeWarrior IDE. This functionality depends on the ability of the IDE to find
referenced files using absolute paths. You must specify the access paths for any
files in the Perl script or the Prefix file that are not referenced by absolute paths.
See Configuring access paths on page 9-20 for more information.

5.  Click Save to save your changes. The CodeWarrior IDE will execute Perl
commands in the prefix file prior to executing each Perl file in the project.
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A3

A.3.1

Using Perl scripting

This section describes how to add Perl files to your project, and gives an example Perl
script.

Adding Perl files to you project

To add a Perl file to your project:

1.

Ensure that you have installed the Perl plug-in software and have configured the
CodeWarrior IDE to recognize the filename extension for your Perl files. See Perl
software plug-ins on page A-2 and Configuring your project for Perl on page A-3
for more information.

Select Add Files... from the Project menu. The CodeWarrior IDE displays the
Add Files dialog box (Figure A-3).

Select files to add... EHE

Look jr: Ia ARM Executable Image

1 4RM_Executable_mage_Data
ARM Executable Image.mep
foo.cpp

E output. bkt

File name: IperIE wample.pl Add

Files of type:  [AllFiles 4| Cancel |

Figure A-3 Adding Perl source to a project

Select All Files from the Files of Type pop-up menu to display .p]1 files in the
dialog.

Select the Perl file you require and click Add. The CodeWarrior IDE adds the Perl
file to your project.

Changing the build order of added files

The CodeWarrior IDE executes Perl scripts in the order in which they appear in the Link
Order view, regardless of their order in the Files view. For example, if a Perl script is
listed after a C source file in the Link Order view, the CodeWarrior IDE calls the ARM
C compiler to compile the source file, and then calls the MW Perl plug-in to process the
Perl script.

A-6
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A.3.2 Restrictions

A.3.3 Example

Perl Scripts

To change the order in which source files and Perl scripts are processed, use drag and
drop in the Link Order view. See Setting the link order on page 2-78 for more

information.

The following usage restrictions and special considerations apply to using Perl with the

CodeWarrior IDE.

Stdin Usage

StdIn is not supported in the prefix file. This means that the Perl script cannot accept

keyboard input.

Example A-1 shows a simple example of a Perl script.

Example A-1

# Simple Perl Example

# Print a Tine of text
print "Hello World!\n";

$scaled
§scalel
$scale2

Il
N =S

# Create and open a file for output
open (theFile, ">output.txt");

# Dump some text into the file
print theFile "The file should now be open\n";
print theFile "Let's try a few things:\n\n";

# Arithmetic

print theFile "#xArithmetic \n";

print theFile $scalel + $scale2 . "\n";
print theFile $scalel = $scale2 . "\n";
print theFile $scalel % $scale2 . "\n\n";

# Boolean logic

print theFile "«xBoolean \n";

print theFile ($scaled && $scaled) . "\n";
print theFile ($scaled && $scalel) . "\n";

ARM DUI 0065C
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print theFile ($scalel && $scalel) . "\n";

print theFile ($scaled || $scale@) . "\n";
print theFile ($scaled || $scalel) . "\n";

print theFile (!$scale@) . "\n\n";
# Comparison

print theFile "xxComparisons \n";
print theFile ($scale2 == $scale2) . "\n";

print "That's it, closing file\n";

# Close the file
close theFile;
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Appendix B
CodeWarrior Reference

This chapter describes each menu command in the CodeWarrior IDE, and the default
key bindings for those commands. You can use this chapter as a convenient reference
when you want to find information quickly. It contains the following sections:

. CodeWarrior IDE menu reference on page B-2

. CodeWarrior IDE default key bindings on page B-25.
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B.1 CodeWarrior IDE menu reference

This section gives an overview of the menu commands in the CodeWarrior IDE. The
following sections describe the menus in the CodeWarrior IDE menu bar:

. File menu on page B-3

. Edit menu on page B-5

. Search menu on page B-8

. Project menu on page B-12
. Browser menu on page B-17
. Window menu on page B-18

. Version Control System (VCS) menu on page B-21
. Help menu on page B-22
. Toolbar submenu on page B-23.

Table B-1 summarizes the menus that are displayed at all times, and which menus are
displayed only when a window that can use their menu commands is available.

Table B-1 Menu command availability

Menus always available Context-sensitive menus

File Data (This menu is not used by CodeWarrior
for the ARM Developer Suite.)

Edit Browser

Search Catalog (This menu is not used by
CodeWarrior for the ARM Developer Suite.)

Project Layout (This menu is not used by
CodeWarrior for the ARM Developer Suite.)

Debug (This menu is not used by
CodeWarrior for the ARM Developer Suite.)

Window

Help

The Version Control System (VCS) menu is displayed only if you have installed and
configured the CodeWarrior IDE to work with a compatible revision control system that
you purchased separately. See the documentation that came with the additional revision
control software for more information on revision control systems, and how to use them
with the CodeWarrior IDE.
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CodeWarrior Reference

The File menu contains the commands you use to open, create, save, close, and print
existing or new source code files and projects. The File menu also provides different
methods for saving edited files.

New Text File

This command creates a new editable text file. See Creating a new file on page 4-3 for
more information.

New...

This command opens the New dialog box. This dialog box helps you create new projects
and files in the CodeWarrior IDE.

Open...

This command opens an existing file. See Opening files from the File menu on page 4-5
for more information.

Open Recent

This command displays a submenu of projects and files that were recently opened.
Select a filename from the submenu to open the file.

If two or more files in the submenu have identical names, the full paths to those files are
displayed in order to distinguish them. See Opening files from the File menu on
page 4-5 for more information.

Find and Open File

This command opens an existing file, searching the current access paths as specified in
the Access Paths panel of the Target Settings window. See Opening header files from
an editor window on page 4-9 for more information.

Find and Open ‘Filename’

This command opens an existing text file, using the currently selected text in the editor
window as the target file name. See Opening header files from an editor window on
page 4-9 for more information.

ARM DUI 0065C
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Close

This command closes the active window. See Closing files on page 4-16 for more
information.

Close All

This command closes all open windows of a certain type. The menu command is based
on the type. For example, when several editor windows are currently open and one of
them is selected, the menu command is Close All Editor Documents. See Closing all
files on page 4-17 for more information.

Save

This command saves the contents of the active window to disk. See Saving editor files
on page 4-12 for more information.

Save All

This command saves all editor files that are currently open. See Saving all files on
page 4-13 for more information.

Save As...

This command saves the contents of the active window to disk under another name of
your choosing. See Renaming and saving a file on page 4-13 for more information.
Save A Copy As...

This command saves the active window in a separate file. This command operates in
different ways, depending on the active window. See Saving a backup copy of a file on
page 4-14 for more information.

Revert...

This command reverts the active editor window to its last saved version. See Reverting
to the most recently saved version of a file on page 4-20 for more information.
Import Components...

This menu item is not used by CodeWarrior for the ARM Developer Suite.

B-4
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CodeWarrior Reference

Close Catalog

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Import Project...

This command imports an eXtensible Markup Language (XML) file into the
CodeWarrior IDE so you can save the XML file as a CodeWarrior project. The
CodeWarrior IDE prompts you to choose a name and location to save the new project
file. See Importing and exporting a project as XML on page 2-23 for more information.

Export Project...

This command exports a CodeWarrior project to XML format. The CodeWarrior IDE
prompts you to choose a name and location to save the new XML file. See Importing
and exporting a project as XML on page 2-23 for more information.

Print Setup...

This command sets the options used when printing files from the CodeWarrior IDE. See
Setting print options on page 4-18 for more information.

Print...

This command prints files from the CodeWarrior IDE on your printer. See Printing a
window on page 4-18 or read the documentation that accompanies your printer for more
information.

Exit

This command exits the CodeWarrior IDE immediately, provided either of the
following conditions has been met:

. all changes to the open editor files have already been saved

. the open editor files have not been changed.

If a project window is open, all changes to the project file are saved before the
CodeWarrior IDE exits. If an editor window is open and changes have not been saved,
the CodeWarrior IDE asks if you want to save the changes before exiting.

The Edit menu contains all the customary editing commands, along with some
CodeWarrior additions. This menu also includes the commands that open the
Preferences and Target Settings windows.

ARM DUI 0065C
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Undo

The text of this menu command varies depending on the most recent action, and your
editor options settings.

Undo reverses the effect of your last action. The name of the undo command varies
depending on the type of operation you last executed. For example, if you have just
typed in an open editor window, the undo command is renamed Undo Typing.
Choosing the Undo Typing command will remove the text you have just typed.

See Undoing the last edit on page 5-15 and Undoing and redoing multiple edits on
page 5-15 for more information.

If you do not have Use Multiple Undo turned on in the Editor Settings preference
panel, the Undo menu item toggles between Undo and Redo. See Editor settings on
page 8-15 for more information.

Redo, Multiple Undo, and Multiple Redo

When an operation has been undone, it can be redone. For example, if you select Undo
Typing, the menu item is changed to Redo Typing. Choosing this command overrides
the previous undo.

If you have Use Multiple Undo turned on in the Editor Settings preference panel, you
have more flexibility with regard to undo and redo operations. Select Undo multiple
times to undo multiple actions. Select Redo multiple times to redo multiple actions.

See Undoing the last edit on page 5-15 and Undoing and redoing multiple edits on
page 5-15 for more information on undo and redo operations. See Editor settings on
page 8-15 for information on configuring multiple undo.

Cut

This command deletes the selected text and puts it in the system clipboard, replacing
the contents of the clipboard.

Copy

This command copies the selected text in the active editor window onto the system
clipboard. If the messages window is active, the Copy command copies all the text in
the messages window onto the clipboard.

B-6
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Paste

This command pastes the contents of the system clipboard into the active editor
window.

The Paste command replaces the selected text with the contents of the clipboard. If no
text is selected, the clipboard contents are placed after the text insertion point.

If the active window is the messages window, the Paste menu item is dimmed and
cannot be executed.

Delete

This command deletes the selected text without placing it in the system clipboard. The
Delete command is equivalent to pressing the Delete or Backspace key.

Select All

This command selects all the text in the active window. This command is usually used
in conjunction with other Edit menu commands such as Cut, Copy, and Clear. See
Selecting text on page 5-12 for more information.

Balance

This command selects the text enclosed in either parentheses (), brackets [], or braces
{}. For a complete procedure on how to use this command, and how to balance while
typing, see Balancing punctuation on page 5-14.

Shift Left

This command shifts the selected source code one tab size to the left. The tab size is
specified in the Preferences window. See Shifting text left and right on page 5-15 for
more information.

Shift Right

This command shifts the selected source code one tab size to the right. See Shifting text
left and right on page 5-15 for more information.

Preferences...

Use this command to change the global preferences for the CodeWarrior IDE. See
Choosing general preferences on page 8-6 for more information.

ARM DUI 0065C
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Targetname Settings

Use this command to display the Target Settings window where you can change settings
for the active build target. The name of this menu command will vary depending on the
name of your current build target.

See Configuring target settings on page 9-14 for more information on the Settings
window. See Set Current Target on page B-15 for information on changing the current
build target.

Version Control Settings...

This menu command displays the Version Control System options panel. See
Chapter 10 Using CodeWarrior IDE with Version Control Systems for more
information.

If this command is not enabled, you do not have a revision control system configured
for use with the CodeWarrior IDE.
Commands & Keybindings...

Use this menu item to set keybinding for commands, and to customize the CodeWarrior
IDE toolbars.

B.1.3 Search menu

The Search menu contains all the necessary commands used to find text, replace text,
and compare files. There are also some commands for code navigation.

Find...

This command opens the Find dialog box which is used to find and/or replace the
occurrences of a specific string in one or many files. See Chapter 6 Searching and
Replacing Text for more information.

Find Next

This command finds the next occurrence of the Find text box string in the active
window. This is an alternative to clicking the Find button in the Find dialog box. See
Finding and replacing text with the Find dialog on page 6-4 for more information.
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Find Previous

Find Previous operates the same way as Find Next, except that it finds the previous
occurrence of the Find text box string. See Finding and replacing text with the Find
dialog on page 6-4 for more information.

Find in Next File

This command finds the next occurrence of the Find text box string in the next file
listed in the Multi-File Search portion of the Find window (as exposed by the Multi-File
Search Disclosure triangle in the Find window). This is an alternative to using the Find
window. If the Multi-File Search button is not enabled this command is dimmed. See
Finding and replacing text in multiple files on page 6-8 for more information.

Find in Previous File

This command operates in much the same way as Find in Next File. The Find in
Previous File command begins at the end of the previous file in the file list and searches
for the next occurrence of the Find text box string. See Finding and replacing text in
multiple files on page 6-8 for more information.

Enter Find String

This command copies the selected text in the active window into the Find text box,
making it the search target string. This is an alternative to copying text and pasting it
into the Find window. See Selecting text on page 5-12 for more information.

Enter Replace String

This command copies the selected text in the active window into the Replace text box,
making it the replacement string. This is an alternative to selecting the string and
copying it into the Find window. See Finding and replacing text with the Find dialog
on page 6-4 for more information.

Find Selection

This command finds the next occurrence of the selected text in the active text editor
window. See Finding and replacing text with the Find dialog on page 6-4 for more
information.

ARM DUI 0065C
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Find Previous Selection

This command finds the previous occurrence of the selected text in the active text editor
window. See Finding and replacing text with the Find dialog on page 6-4 for more
information. See Selecting text on page 5-12 for more information on how to select text.

Replace

This command replaces the selected text in the active window with the text string in the
Replace text box of the Find window. If no text is selected in the active editor window,
this command is dimmed.

This command is useful if you want to replace one instance of a text string without
having to open the Find window. For example, say that you have just replaced all the
occurrences of the variable icount with jcount. While scrolling through your source
code, you notice one instance of the variable icount is misspelled as icont. To replace
this variable with jcount, select icont and select Replace from the Search menu. See
Finding and replacing text with the Find dialog on page 6-4 for more information. See
Selecting text on page 5-12 for more information on selecting text.

Replace & Find Next

This command replaces the selected text with the string in the Replace text box of the
Find window, and then performs a Find Next. If no text is selected in the active editor
window and there is no text in the Find text box string field of the Find window, this
command is dimmed. See Finding and replacing text with the Find dialog on page 6-4
for more information. See Selecting text on page 5-12 for more information on selecting
text.

Replace & Find Previous
This command operates the same way as Replace & Find Next, except that it performs
a Find Previous after replacing text.

Replace All

This command finds all the occurrences of the Find string and replaces them with the
Replace string. If no text is selected in the active editor window and there is no text in
the Find text box in the Find dialog box, this command is dimmed.
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Find Definition

This command searches for the definition of the function name selected in the active
window. Searching occurs in the source files belonging to the open project. If the
definition is found, the CodeWarrior IDE opens the source code file where the function
is defined and highlights the function name.

If the CodeWarrior IDE finds more than one definition, a messages window appears
warning you of multiple definitions. For more information on the messages window,
consult Using the message window on page 3-15.

If no definition is found, the system beeps.

Go Back

This command returns you to the previous view in the browser. See Using Go Back and
Go Forward on page 7-22 for more information.

Go Forward

This command moves you to the next view in the browser (after you have used the Go
Back command to return to a previous view). See Using Go Back and Go Forward on
page 7-22 for more information.

Go To Line

This command opens a dialog box (in which you enter a line number) and then moves
the text insertion point to the line number you specify. See Going to a specific line on
page 5-20 for more information.

Compare Files...

This command opens a dialog box to choose two files or folders to compare and merge.
After choosing files to compare, a file comparison window appears, showing
differences between the two files. If two folders are compared, the differences between
the folders are shown in the Compare Folders window. See Comparing and merging
files and folders on page 4-21 for more information.

Apply Difference

This command adds, removes, or changes text in the destination file shown in a file
comparison window that is different from the text in the comparison window source file.
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Unapply Difference

This command reverses the action of an Apply Difference command in a file
comparison window.

B.1.4 Project menu

The Project menu lets you add and remove files and libraries from your project. It also
lets you compile, build, and link your project. All of these commands are discussed in
this section.

Add Window

This command adds the file in the active editor window to the open project. See Adding
the current editor window on page 2-42 for more information.

Add Files...

This command adds files to the project window. See Using the Add Files command on
page 2-39 for more information.

Create New Group...

The Create New Group command enables you to create a new group in the current
project. This command is present in the Project menu if the Files category is selected
in the current project window. See Creating groups on page 2-42 for more information.

Create New Target

The Create New Target command enables you to create a new build target for the
current project. This command is present in the Project menu if the Targets view is
selected in the current project window. See Working with multiple build targets and
subprojects on page 2-53 for more information.

Check Syntax

This command checks the syntax of the source code file in the active editor window or
the selected file(s) in the open project window. If the active editor window is empty, or
no project is open, this command is dimmed.

Check Syntax does not generate object code. It only checks the source code for syntax
errors. The progress of this operation is tracked in the toolbar message area. To abort
this command at any time, press the Escape key.
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If one or more errors are detected, the messages window appears. For information on
how to correct compiler errors, consult Correcting compilation errors and warnings on
page 3-17.

Preprocess

This command performs preprocessing on selected C and C++ source code files. See
Preprocessing source code on page 2-77 for more information.

Precompile

This menu option is not used by CodeWarrior for the ARM Developer Suite.

Compile

This command compiles selected files. If the project window is active, the selected files
and segments/groups are compiled. If a source code file in an editor window is active,
the source code file is compiled. The source code file must be in the open project. See
Compiling and linking a project on page 2-72 for more information.

Disassemble

This command disassembles the compiled source code files selected in the project
window, and displays object code in a new window. See Disassembling code on
page 2-81 for more information.

Bring Up To Date

This command updates the open project by compiling all of its modified and fouched
files. See Bringing a project up to date on page 2-76 for more information.

Make

This command builds the selected project by compiling and linking the modified and
touched files in the open project. The results of a successful build depend on the selected
project type. See Making a project on page 2-77 for more information.

Stop Build

This command stops the current make operation.

ARM DUI 0065C
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Remove Object Code...

This command removes all compiled source code binaries from the open project. The
numbers in the Code column and Data column of each file are reset to zero. See
Removing objects from a project on page 2-79 for more information.

Re-search for files

To speed up builds and other project operations, the CodeWarrior IDE caches the
locations of project files after it has found them in the access paths. Re-search for files
forces the CodeWarrior IDE to forget the cached locations of files and re-search for
them in the access paths. This command is useful if you have moved files around on disk
and want the CodeWarrior IDE to find them in their new locations.

If the Save Project Entries Using Relative Paths setting is enabled the CodeWarrior
IDE does not reset the relative path information stored with each project entry, so
re-searching for files will find the source files in the same location (the exception is if
the file no longer exists in the old location). In this case the CodeWarrior IDE will only
re-search for header files. To force the CodeWarrior IDE to also re-search for source
files, you must first select Reset Project Entry Paths.

If the Save Project Entries Using Relative Paths setting is disabled, the CodeWarrior
IDE will re-search for both header and source files.

Reset project entry paths

This command resets the location information stored with each project entry when the
Save Project Entries Using Relative Paths setting is enabled. The next time the
project entries are accessed, the CodeWarrior IDE will re-search for the project entries
in the access paths. This command does nothing if the Save Project Entries Using
Relative Paths setting is disabled.

Synchronize Modification Dates

This command updates the modification dates stored in the project file. It checks the
modification date for each file in the project, and if the file has been modified since it
was last compiled, the CodeWarrior IDE marks it for recompilation. See Synchronizing
modification dates on page 2-48 for more information.

Enable Debugger and Disable Debugger

Use these commands to turn debugging on or off for the current build target. The
command displayed depends on the current debug status of the target. See Controlling
debugging in a project on page 3-4 for more information.
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Run

This command compiles and links the current build target, and launches an ARM
debugger to run the output image. If the project type is set as a library, the Run
command is dimmed.

Debug

This command compiles and links the current build target, and launches an ARM
debugger to debug the output image.

Set Default Project

This menu command selects which project is the default project. See Choosing a default
project on page 2-22 for more information.

Set Current Target

This command enables you to choose a different target within the current project to
work with. This menu command might be useful if you want to switch between multiple
targets in a project and do a build for each one.

The Debug menu is not used by CodeWarrior for the ARM Developer suite. For more
information on debugging your code using the ARM debuggers see:

. Chapter 3 Working with the ARM Debuggers
. ADS Debuggers Guide.

The following menu items are documented for completeness only.

Kill

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Restart

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Step Over

This menu item is not used by CodeWarrior for the ARM Developer Suite.

ARM DUI 0065C
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Step Into

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Step Out

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Stop

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Set Breakpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Clear Breakpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Enable Breakpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Disable Breakpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Clear All Breakpoints

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Show Breakpoints

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Hide Breakpoints

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Set Watchpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.
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Clear Watchpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite

Enable Watchpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Disable Watchpoint

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Clear All Watchpoints

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Break on C++ Exception

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Break on Java Exceptions

This menu item is not used by CodeWarrior for the ARM Developer Suite.

Switch to Monitor

This menu item is not used by CodeWarrior for the ARM Developer Suite.

B.1.6 Browser menu

You can use the Browser menu to create new classes, member functions, and data
members in the active project. This menu is present when a browser window is open.
Otherwise, the menu is not displayed.

New Class...

This command displays a dialog box to help you create a new class for your project.

New Member Function...

This command displays a dialog box to help you create a new member function for a
class in your project.
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New Data Member...

This command displays a dialog box to help you create a new data member for a class
in your project.

New Property...

This menu item is not used by CodeWarrior for the ARM Developer Suite.

New Method...

This menu item is not used by CodeWarrior for the ARM Developer Suite.

New Event Set...

This menu item is not used by CodeWarrior for the ARM Developer Suite.

New Event...

This menu item is not used by CodeWarrior for the ARM Developer Suite.

B.1.7 Window menu

The Window menu includes commands that tile open editor windows, switch between
windows, and open Debugger windows. There is also a submenu for customizing the
toolbars.

Stack Editor Windows

This command opens all editor windows to their full screen size and stacks them one on
top of another, with their window titles showing. This command is dimmed when the
active window is the project window or messages window.

Tile Editor Windows

This command arranges all editor windows so that none overlap. This command is
dimmed when the active window is the project window or messages window.

Tile Editor Windows Vertically

This command arranges all the editor windows in a single row.

This command is disabled when the active window is the project window or messages
window.
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Zoom Window

This menu command expands the active window to the largest possible size. If you
select the menu command again, the window returns to its original size.
Minimize Window

This command minimizes the currently selected window.

Restore Window

This command restores the currently selected minimized window to its original size.

Save Default Window

This command saves the settings of the active browser window, so that the next time
you open a browser window, the CodeWarrior IDE opens it with the saved settings. See
Saving editor window settings on page 5-9 or Saving a default Class browser window
on page 7-16 for more information.

Toolbar

This command causes the Toolbar submenu to appear. See Toolbar submenu on
page B-23 for more information.

Browser Contents

This command displays the browser Contents window. This menu command is dimmed
when the browser is not activated. See Viewing data by type with the Contents view on
page 7-17 for more information. See Activating the browser on page 7-5 for details of
how to activate the browser.

Class Hierarchy Window

This command displays the browser Multi-Class Hierarchy window. This menu
command is dimmed when the browser is not activated. See Multi-class hierarchy
window on page 7-18 for more information. See Activating the browser on page 7-5 for
details of how to activate the browser.
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New Class Browser

This command displays the browser Class window. This menu command is dimmed
when the browser is not activated. See Viewing data by class with the Class browser
view on page 7-8 for more information. See Activating the browser on page 7-5 for
details of how to activate the browser.

Build Progress Window

This command displays the progress window for builds, as shown in Figure 2-54 on
page 2-75.

Errors & Warnings Window

This command displays the Errors and Warnings window. See Using the message
window on page 3-12 for more information. See also Using batch searches on page 6-6.

Project Inspector

This command allows you to view information about your project and enable debug
information generation.

See Overview of the project window on page 2-4 for more information.

Processes Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

Expressions Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

Global Variables Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

Breakpoints Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

B-20
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Watchpoints Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

Register Window

This window is not used by CodeWarrior for the ARM Developer Suite. See Chapter 3
Working with the ARM Debuggers for more information.

Other Window menu items

The other Window menu items depend solely on which project, source files, header
files, and other windows you have open.

All the open windows are shown in this menu and the first nine files (1 through 9) are
given key equivalents. The current project is always assigned the number 0 (zero). You
must press the Control key and a number to open a specific editor window. A check
mark is placed beside the active window.

To make one of your open CodeWarrior files active and bring its window to the front,
do one of the following:

. click in its window
. select it from the Window menu
. use the key equivalent shown in the Window menu.

B.1.8 Version Control System (VCS) menu

The Version Control System (VCS) menu, similar to that shown in Figure B-1 on
page B-22, is displayed in the menu bar of the CodeWarrior IDE if you are using a
Version control system.
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B.1.9

Help menu

Synchronize Status

Project r

et

[Efeckout

Indo Checlout
Checkin

Statug
Difference

Edd

Digconnect
Ahbout

Figure B-1 VCS menu

Online help is available from the Help menu. When you are working in the
CodeWarrior IDE, select one of the items to get interactive, online help.

CodeWarrior Help

This menu item is not used by CodeWarrior for the ARM Developer Suite.

How to...

This command opens the main help file for CodeWarrior for the ARM Developer Suite.

Glossary

This command displays the CodeWarrior IDE glossary of terms.

IDE

This command opens the main help file for CodeWarrior for the ARM Developer Suite.

Debugger

This command displays the online help that describes how the ARM debuggers interact
with CodeWarrior for the ARM Developer Suite.

B-22
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Error Reference

This menu option is not used by CodeWarrior for the ARM Developer Suite.

C/C++ Compiler Reference

This menu option is not used by CodeWarrior for the ARM Developer Suite. Refer to
the ADS online books for information on the ARM C and C++ compilers.

MSL C Reference

This menu option is not used by CodeWarrior for the ARM Developer Suite. Refer to
the ADS online books for information on the ARM C libraries.

MSL C++ Reference

This menu option is not used by CodeWarrior for the ARM Developer Suite. Refer to
the ADS online books for information on the ARM-supplied Rogue Wave C++
libraries.

Other

This menu option is not used by CodeWarrior for the ARM Developer Suite.

About Metrowerks

This command displays the Metrowerks About Box.

B.1.10 Toolbar submenu

The Window menu has another submenu under it for the Toolbar command. The
Toolbar submenu contains all the commands used to customize the toolbars that appear
in CodeWarrior IDE windows. See Customizing toolbars on page 8-37 for more
information.

Show Window Toolbar

This command cause the CodeWarrior IDE to display the toolbar in the active window.
The actual command shown in the menu will toggle between Show Window Toolbar
and Hide Window Toolbar, depending on whether the active window’s toolbar is
visible.
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Hide Window Toolbar

This command cause the CodeWarrior IDE to hide the toolbar in the active window. The
actual command shown in the menu will toggle between Show Window Toolbar and
Hide Window Toolbar, depending on whether the active window’s toolbar is visible.

Reset Window Toolbar

This command causes the toolbar in the active window to reset to a default state. You
should use this menu command if you want to return the editor window toolbar to its
original default settings.

Clear Window Toolbar

This command causes the toolbar in the active editor, project, or browser window to
have all icons removed from it. Once all the icons have been removed, you can add icons
using the Toolbar Elements window.

Use the Reset Window Toolbar command to cause all the default icons to come back.

Show Main Toolbar

This command displays the main window toolbar.

Hide Main Toolbar

This command hides the main window toolbar.

Reset Main Toolbar

This command sets the main window toolbar to its default state.

Clear Main Toolbar

This command removes all elements from the main window toolbar. When all the icons
have been removed, you can add icons using the Toolbar Elements window.

B-24
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B.2 CodeWarrior IDE default key bindings

This section lists the default key bindings assigned to commands in the CodeWarrior
IDE.

Some commands do not have any key bindings assigned to them by the CodeWarrior
IDE. You can assign key bindings to any blank command. For more information on key
bindings, see Setting commands and key bindings on page 8-26.

The key bindings sections include:

B.2.1 File menu

File menu on page B-25

Edit menu on page B-26

Search menu on page B-27
Project menu on page B-28
Window menu on page B-29
Miscellaneous on page B-30
Editor commands on page B-31.

Table B-2 lists the default key bindings for manipulating projects and files from within

the CodeWarrior IDE.
Table B-2 File key bindings

Command Key binding
New Ctrl-N
New... Ctrl-Shift-N
Open Cul-O
Find and Open ‘selection’ Cul-D
Find and Open File Ctrl-Shift-D
Close Ctrl-W
Close All Ctrl-Shift-W
Save Ctrl-S
Save All Ctrl-Shift-S
Save As -
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Table B-2 File key bindings (continued)

Command Key binding

Save A Copy As -

Revert _

Page Setup -

Print Ctrl-P

Quit _

B.2.2 Edit menu

Table B-3 contains the default key bindings for the commands in the Edit menu of the

CodeWarrior IDE.
Table B-3 Edit key bindings
Command Key binding
Undo Ctrl-Z
Redo Ctrl-Shift-Z
Cut Ctrl-X
Copy Ctrl-C
Paste Ctrl-V
Clear -
Select All Cul-A
Balance Ctrl-B
Shift Left Ctrl-[
Shift Right Ctrl-]

Insert Reference Template -

Preferences -

Target Settings Alt-F7

VCS Settings -
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Table B-4 contains the default key bindings for the commands in the Search menu of

the CodeWarrior IDE.
Table B-4 Search key bindings
Command Key binding
Find Ctrl-F
Find Next F3
Find Previous Shift-F3
Find in Next File Ctrl-T

Find in Previous File

Ctrl-Shift-T

Enter Find String

Ctrl-E

Enter Replace String

Ctrl-Shift-E

Find Selection

Ctrl-F3

Find Previous Selection

Ctrl-Shift-F3

Replace

Ctrl-=

Replace & Find Next

Ctrl-L

Replace & Find Previous

Ctrl-Shift-L

Replace All

Find Definition

Ctrl-

Find Definition & Reference

Find Reference

Go Back Ctrl-Shift-B
Go Forward Ctrl-Shift-F
Goto Line Ctrl-G

Compare Files

Apply Difference

Unapply Difference
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B.2.4 Project menu
Table B-5 contains the default key bindings for commands in the Project menu.
Table B-5 Project key bindings
Command Key binding
Add Window -
Add Files -
Create Group/ Segment/Target -
Check Syntax Ctrl-;
Preprocess -
Precompile -
Compile Ctrl-F7
Disassemble -
Bring Up To Date Ctrl-U
Make F7
Stop Build Ctrl-Break
Remove Object Code Cul - -
Re-search For Files -
Reset Project Entry Paths -
Synchronize Modification Dates -
Enable Debugging -
Run/Debug F5
Debug/Run Ctrl-F5
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Table B-6 contains the default key bindings for handling many common windows in the

CodeWarrior IDE.
Table B-6 Window menu key bindings

Command Key binding
Stack -
Tile -
Tile Vertical -
Zoom Window Ctrl-/
Collapse/Expand Window -
Save Default Window -
Browser Catalog Window -
Class Hierarchy Window -
New Class Browser Alt-F12
Build Progress Window -
Errors & Warnings Window Ctrl-1
Project Inspector Alt-Enter
ToolServer Worksheet -
Processes Window -
Expressions Window Alt-Shift-3
Global Variables Window -
Breakpoints Window Alt-F9
Watchpoints Window -
Select Default Project Ctrl-0
Select Document 1 Ctrl-1
Select Document 2 Ctrl-2
Select Document 3 Ctrl-3

ARM DUI 0065C

Copyright © 1999, 2000 ARM Limited. All rights reserved. B-29



CodeWarrior Reference

Table B-6 Window menu key bindings (continued)

Command Key binding
Select Document 4 Ctrl-4
Select Document 5 Ctrl-5
Select Document 6 Ctrl-6
Select Document 7 Ctrl-7
Select Document 8 Ctrl-8
Select Document 9 Ctrl-9

B.2.6 Miscellaneous

Table B-7 contains the default key bindings for handling miscellaneous tasks in the

CodeWarrior IDE.
Table B-7 Miscellaneous key bindings
Command Key binding
Go to Header/Source File Ctrl-
Go to Previous Error Message F4
Go to Next Error Message Shift-F4
Run Script -

Stop Script -
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Table B-8 contains the default key bindings for handling editor windows in the

CodeWarrior IDE.
Table B-8 Editor window key bindings
Command Key binding
Move Character Left Left Arrow
Move Character Right Right Arrow
Move Word Left Ctrl-Left Arrow

Move Word Right

Ctrl-Right Arrow

Move Sub-word Left

Alt-Left Arrow

Move Sub-word Right

Alt-Right Arrow

Move to Start of Line Home
Move to End of Line End
Move Line Up Up Arrow

Move Line Down

Down Arrow

Move to Top of Page Page Up
Move to Bottom of Page Page Down
Move to Top of File Ctrl-Home
Move to Bottom of File Ctrl-End
Delete Character Left Backspace
Delete Character Right Del

Delete to End of File

Character Select Left

Shift-Left Arrow

Character Select Right

Shift-Right Arrow

Select Word Left

Ctrl-Shift-Left Arrow

Select Word Right

Ctrl-Shift-Right Arrow

Select Sub-word Left

Alt-Shift-Left Arrow
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Table B-8 Editor window key bindings (continued)

Command

Key binding

Select Sub-word Right

Alt-Shift-Right Arrow

Select Line Up

Shift-Up Arrow

Select Line Down

Shift-Down Arrow

Select to Start of Line

Shift-Home

Select to End of Line

Shift-End

Select to Start of Page

Shift-Page Up

Select to End of Page

Shift-Page Down

Select to Start of File

Ctrl-Shift-Home

Select to End of File

Ctrl-Shift-End

Scroll Line Up

Ctrl-Up Arrow

Scroll Line Down

Ctrl-Down Arrow

Scroll Page Up

Scroll Page Down

Scroll to Top of File

Scroll to End of File

Scroll to Selection

Find Symbols with Prefix

Ctrl-\

Find Symbols with Substring

Ctrl-Shift-\

Get Next Symbol

Ctrl-.

Get Previous Symbol

Ctrl-,

B-32

Copyright © 1999, 2000 ARM Limited. All rights reserved.

ARM DUI 0065C



Appendix C
CodeWarrior IDE Installation and Preference
Settings

This appendix describes how to install multiple copies of the CodeWarrior IDE, and
how to use CodeWarrior for the ARM Developer Suite with other versions of the
CodeWarrior IDE. It contains the following sections:

. The CodeWarrior preferences directory on page C-2
. Using different versions of the CodeWarrior IDE on page C-3.
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C.1

The CodeWarrior preferences directory

The CodeWarrior IDE maintains preferences and persistence information in the
following locations:

For Windows NT c:\Winnt\Metrowerks\CodeWarrior Pro 5 IDE Prefs
For Windows 95/98 c:\Windows\Metrowerks\CodeWarrior Pro 5 IDE Prefs

The preferences file is created when the CodeWarrior IDE is started for the first time, if
it does not already exist.

Note
If you want to install multiple copies of CodeWarrior for the ARM Developer Suite you
can preconfigure a single installation and copy the preferences directory for that
installation to each machine.

CodeWarrior preferences are deleted when you uninstall the CodeWarrior for the ARM
Developer Suite.
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C.2  Using different versions of the CodeWarrior IDE

CodeWarrior for the ARM Developer Suite is customized to support the ARM tool
chain. This means that:

. your CodeWarrior IDE preferences might not be applicable to other CodeWarrior
versions

. some components of the CodeWarrior IDE that are registered in the Windows
registry at installation are specific to CodeWarrior for the ARM Developer Suite.

To switch from CodeWarrior for the ARM Developer Suite to another version of the
CodeWarrior IDE on the same machine:

1. Rename the CodeWarrior Preferences file.

2. Run the regservers.bat batch file for the installation you want to use. Typically
regservers.bat is located in the CodeWarrior bin subdirectory.

To switch back to CodeWarrior for the ARM Developer Suite, rename your preferences
directories and run regservers.bat from install_directory\ARM\ADSv1_1\Bin.
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Cc-4
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ADS
ADU
ADW

ANSI

ARM Debugger for
UNIX

ARM Debugger for
Windows

ARM Developer
Suite

ARM eXtended
Debugger

ARMulator

See ARM Developer Suite.
See ARM Debugger for UNIX.
See ARM Debugger for Windows.

American National Standards Institute. An organization that specifies standards for,
among other things, computer software.

ARM Debugger for UNIX (ADU) is the UNIX version of the ARM Debugger for
Windows. This debugger will not be supported in future versions of the ARM Developer
Suite.

ARM Debugger for Windows (ADW). This debugger will not be supported in future
versions of the ARM Developer Suite.

A suite of applications, together with supporting documentation and examples, that
enable you to write and debug applications for the ARM family of RISC processors.

The ARM eXtended Debugger (AXD) is the latest debugger software from ARM that
enables you to make use of a debug agent in order to examine and control the execution
of software running on a debug target. AXD is supplied in both Windows and UNIX
versions.

ARMulator is an instruction set simulator. It is a collection of modules that simulate the
instruction sets and architecture of various ARM processors.
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armsd

ATPCS

AXD

Big-Endian

Coprocessor

Debugger

Double word

DWARF
EC++
ELF

Environment

The ARM Symbolic Debugger (armsd) is an interactive source-level debugger
providing high-level debugging support for languages such as C, and low-level support
for assembly language. It is a command-line debugger that runs on all supported
platforms.

ARM and Thumb Procedure Call Standard, defines how registers and the stack will be
used for subroutine calls.

See ARM eXtended Debugger.

Memory organization where the least significant byte of a word is at a higher address
than the most significant byte.

An additional processor which is used for certain operations. Usually used for
floating-point math calculations, signal processing, or memory management.

An application that monitors and controls the execution of a second application. Usually
used to find errors in the application program flow.

A 64-bit unit of information. Contents are taken as being an unsigned integer unless
otherwise stated.

Debug With Arbitrary Record Format
A variant of C++ designed to be used for embedded applications.
Executable and linking format

The actual hardware and operating system that an application will run on.

Executable and linking format

Execution view

Flash memory

Halfword

Heap
Host

ICE

The industry standard binary file format used by the ARM Developer Suite. ELF object
format is produced by the ARM object producing tools such as armcc and armasm. The
ARM linker accepts ELF object files and can output either an ELF executable file, or
partially linked ELF object.

The address of regions and sections after the image has been loaded into memory and
started execution.

Non-volatile memory that is often used to hold application code.

A 16-bit unit of information. Contents are taken as being an unsigned integer unless
otherwise stated.

The portion of computer memory that can be used for creating new variables.
A computer which provides data and other services to another computer.

In Circuit Emulator.

Glossary-2
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IDE

Image

Inline

Input section

Interworking

Library

Linker

Little-endian

Local

Load view
Memory
management unit
MMU

Multi-ICE

Output section

PCS

Glossary

Integrated Development Environment (CodeWarrior).
An executable file which has been loaded onto a processor for execution.

A binary execution file loaded onto a processor and given a thread of execution. An
image can have multiple threads. An image is related to the processor on which its
default thread runs.

Functions that are repeated in code each time they are used rather than having a
common subroutine. Assembler code placed within a C or C++ program.

See also Output sections

Contains code or initialized data or describes a fragment of memory that must be set to
zero before the application starts.

See also Output sections
Producing an application that uses both ARM and Thumb code.

A collection of assembler or compiler output objects grouped together into a single
repository.

Software which produces a single image from one or more source assembler or
compiler output objects.

Memory organization where the least significant byte of a word is at a lower address
than the most significant byte. See also Big-endian.

An object that is only accessible to the subroutine that created it.

The address of regions and sections when the image has been loaded into memory but
has not yet started execution.

Hardware that controls caches and access permissions to blocks of memory, and
translates virtual to physical addresses.

See Memory Management Unit.
Multi-processor in-circuit emulator. ARM registered trademark.

Is a contiguous sequence of input sections that have the same RO, RW, or ZI attributes.
The sections are grouped together in larger fragments called regions. The regions will
be grouped together into the final executable image.

See also Region
Procedure Call Standard.

See also ATPCS
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PIC

PID

Reentrancy

Regions

Retargeting

RO
RW

ROPI

RWPI

Scatter loading

Scope

Section

Semihosting

Swi

Target

Position Independent Code.

See also ROPI

Position Independent Data or the ARM Platform-Independent Development card.
See also RWPI

The ability of a subroutine to have more that one instance of the code active. Each
instance of the subroutine call has its own copy of any required static data.

In an Image, a region is a contiguous sequence of one to three output sections (RO, RW,
and ZI).

The process of moving code designed for one execution environment to a new execution
environment.

Read-write.
Read-only.

Read Only Position Independent. Code and read-only data addresses can be changed at
run-time.

Read Write Position Independent. Read/write data addresses can be changed at
run-time.

Assigning the address and grouping of code and data sections individually rather than
using single large blocks.

The accessibility of a function or variable at a particular point in the application code.
Symbols which have global scope are always accessible. Symbols with local or private
scope are only accessible to code in the same subroutine or object.

A block of software code or data for an Image.
See also Input sections

A mechanism whereby the target communicates I/O requests made in the application
code to the host system, rather than attempting to support the I/O itself.

Software Interrupt. An instruction that causes the processor to call a
programer-specified subroutine. Used by ARM to handle semihosting.

The actual target processor, (real or simulated), on which the application is running.

The fundamental object in any debugging session. The basis of the debugging system.
The environment in which the target software will run. It is essentially a collection of
real or simulated processors.

Glossary-4
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Thread A context of execution on a processor. A thread is always related to a processor and
might or might not be associated with an image.

Veneer A small block of code used with subroutine calls when there is a requirement to change
processor state or branch to an address that cannot be reached in the current processor
state.

VCS Version Control System.

Watchpoint A location within the image which will be monitored and which will cause execution to

break when it changes.

Word A 32-bit unit of information. Contents are taken as being an unsigned integer unless
otherwise stated.

Zl Zero-initialized.
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The items in this index are listed in alphabetical order, with symbols and numerics appearing at the end. The
references given are to page numbers.

A Add Window command 2-42, B-12 Multi-ICE support option 9-145
Add (VCS operation) 10-10 Only load symbol information
About Metrowerks help command Adding 9-143
B-23 batch files 2-86 port selection 9-142
About (VCS operation) 10-10 default access path 9-35 Previous target option 9-141
Absolute Path  9-31 files and file mappings 9-41 Reset ADW registry settings option
Access control violations option 9-95 files to projects 2-38 9-143
Access paths  9-20, 9-33 Adding a marker 5-19 target configuration 9-140
adding 9-29 Adding files to a project 2-41 Use this script option  9-145
adding default 9-35 Additional Header Include Files Warn about remote debugging
and ARMLIB variable 9-120 of New Data Member wizard 7-41 9-143
Host Flags 9-35 of New Member Function wizard After option, of New Class wizard 7-33
modifying 9-33 7-38 Allow break on main() option (ADW)
recursive search 9-27 ADP option (ADW) 9-141 9-143
relative paths 9-31 ADP option (armsd) 9-147 Always search user paths 2-51
Access pop-up menu ADW Always Search User Paths option 9-24,
of New Class wizard 7-34 ADP option 9-141 9-28
Private option 7-40 Allow break on main() option 9-143 Always Show Login Dialog (VCS
Protected option 7-40 ARMulator option 9-140 option) 10-5
Public option 7-40 command-line arguments to image  Analyzing inheritance in browser 7-18
Activate Browser option 9-38 9-146 Ancestor Class pop-up menu 7-20
Add Files command B-12 configuring 9-139 ANSI C extensions option 9-85
Add Targets to Project 2-19 Display splash screen option 9-143  ANSI C header files 9-87
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Index

Applying a difference 4-25
Architecture or Processor option
(Assembler) 9-55
ARM librarian 9-16, 9-108
ARM linker 9-16
ARM Miscellaneous settings 9-155
ARM Runner 9-153
ARMLIB environment variable 9-120
armlink 9-110
armsd
ADP option 9-147
arguments to image file 9-152
ARMulator option 9-147
BATS option 9-148
Byte Order option 9-148
Capture output to option 9-152
configuring 9-146
Emulated Clock Speed option
9-148
Load configuration option 9-151
Port Specification option 9-149
Script file option 9-151
Select configuration option 9-151
Symbols file option 9-150
target processor 9-148
ARMulator option (ADW) 9-140
ARMulator option (armsd) 9-147
ARM/Thumb interworking option
9-61
ARM/Thumb interworking option
(Compilers) 9-81
Arrow keys 2-4
Assembler
Architecture or Processor option
9-55
ARM/Thumb interworking option
9-61
Byte Order option 9-57
Calling standard option 9-60
Check Register Lists option 9-63
code listings 9-68
Cross-references option 9-70
Dimensions option 9-70
Floating Point option 9-55
Ignore C-style escape characters
option 9-64
Initial State option 9-57
Keep Symbols option 9-64
Listing on option 9-69

Lsting control 9-68

No Warning option 9-64

Predeclared Register Names option

9-60

predefined variables 9-66

Source Line Debug option 9-64

target options 9-54

Terse option 9-69

via files 9-70
Assigning files

to build targets 2-58

with the Project Inspector 2-59

with the Target column 2-58
Assigning files to build targets 2-58
Assignment in condition option 9-85
Assignment operator warning 9-85
ATPCS options (Assembler) 9-58
Automatically saving files 4-13

B

Background Color 8-16

Backup files 2-18, 4-15

Balance command 5-14, B-7

Balancing punctuation 5-14

Base Classes and Methods section, of
New Class wizard 7-33

Base Classes field

of New Class wizard 7-33

Basic ARM Ten system 9-148

Batch file runner 2-84,9-17, 9-18,
9-108

Batch option (Find and Replace) 6-5

Batch search 6-6

BATS option (armsd) 9-148

Before option, of New Class wizard
7-33

Bitfield type warning 9-85

Bowser

Contents view 7-2

Break on C++ Exception command
B-17

Break on Java Exceptions command
B-17

Breakpoints Window command B-20

Bring Up To Date command B-13
Browser
Activating 9-38

activating 7-5

analyzing inheritance 7-18

assigning build targets to classes
7-35

base classes in hierarchy 7-20

Class Display button 7-10

Classes pane 7-10

Contents view 7-17

contextual menu 7-22

controlling lines in hierarchy
window 7-19

customizing windows 7-16

Data Members pane 7-10

describing name and location of new
classes 7-32,7-36

editing code 7-29

Hierarchy view 7-3

identifier icon 7-11

including subprojects 9-38

Member Functions pane 7-10

multi-class hierarchy 7-18, 7-20

navigating code with 7-22, 7-25

opening a source file 7-29

resize bar 7-9

saving windows 7-16

setting options 7-6

single-class hierarchy 7-18

Source pane 7-11

specifying base classes and methods
for classes 7-33

specifying file locations for member
functions 7-37, 7-40

status area 7-12

strategy 7-5

Symbol window 7-27

synchronized class selection 7-13,
7-20

toolbar 7-9

view 7-3
data by type 7-17
member functions and data
members 7-9

viewing options 7-2

Browser Catalog Window command

B-19

Browser Display preference panel

8-14, 8-16, 8-20, 8-22

Browser Menu B-17

New Class command B-17
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New Data Member command B-18
New Member Function command
B-17
Browser views 7-8
Browser window 7-8
pane zoom box 7-9
Build Progress Window command
B-20
Build targets 2-3, 9-1
changing names of 2-60
creating 2-57
defined 1-2
dependencies 2-61
overview 2-2,2-27,9-3
selecting 9-8
settings 9-13
specifying access paths 9-33
Building all targets 2-65
Building projects 2-15
Byte order option (armsd) 9-148
Byte order option (Assembler) 9-57

C

C to C++ incompatibility option 9-88

Cache subprojects option 9-38

Calling standard option 9-60

Capture output to option (armsd) 9-152

Category pop-up menu, in Contents
window 7-17

Changing a build target name 2-60

Changing syntax highlighting colors
8-23

Char, changing sign of 9-102

Check Register Lists option (assembler)
9-63

Check Syntax command B-12

Checkin (VCS operation) 10-10

Checkout Status column 2-9, 10-8

Checkout (VCS operation) 10-10

Choosing a default project 2-22

Class browser view (browser) 7-3

Class Display button, in browser 7-10

Class Hierarchy Window command
B-19

Class Name field

of New Class wizard 7-32
Class View pop-up menu 7-9

Classes
assigning to build targets 7-35
describing name and location of
7-32,7-36
specifying base classes and methods
for 7-33
Classes pane
and items not displayed in 7-12
in browser 7-10
Clear All Breakpoints command B-16
Clear All Watchpoints command B-17
Clear Breakpoint command B-16
Clear command 5-12, B-7
Clear Floating Toolbar command B-24
Clear Watchpoint command B-17
Clear Window Toolbar command B-24
Close All command B-4
Close command B-4
Closing projects 2-17
Code column 2-7
Code disassembly 2-81
Code generation, configuring 9-101
Code listings, assembler 9-68
CodeWarrior
available tools 1-2
browser 7-1
converting makefiles to projects
2-19, 2-21
menu reference B-2
reference information B-1
CodeWarrior Help command B-22
Collapsing groups 2-44
Color Syntax option
and printing 4-19
Command line, editing 9-49
Commands
Add Window 2-42
New Class 7-31
New Data Member 7-31
New Member Function 7-31
New Project 2-14
Open 2-15
Open Recent 2-16
Save A Copy As 2-18
Show Private 7-15
Show Protected 7-15
Show Public 7-15
Touch 2-48
View As Implementor 7-15

Index

View As Subclass 7-15
View As User 7-15
Comment (VCS operation) 10-10
Comments, coloring 8-23
Compare Files command B-11
Comparing
XML-formatted projects 4-28
Comparing files and folders 4-21
Comparison column (comparing and
merging) 4-22
Compile command B-13
Compiler
associating with a filename
extension 9-43
Compiler options
Assignment in condition warning
9-85
-auto_float_constants 9-104
Enum container always int 9-102
Implicit constructor warning 9-91
Lower precision in wider context
warning 9-88
Non-ANSI header warning 9-87
-split_ldm 9-102
-Wk 9-105
Compiler Relative Path 9-31
Compiler Thread Stack (K) 8-7
Compilers
Access control violations option
9-95
ANSI C extensions option 9-85
ARM/Thumb interworking option
9-81
Assignment in condition option
9-85
C to C++ incompatibility option
9-88
configuring warning 9-83
Double to float option 9-89
Enable debug of inline functions
option 9-98
Enable debug table generation 9-97
Enum container always int option
9-102
Error messages 9-94
For space option 9-99
For time option 9-99
Header file not guarded option 9-86
Implicit constructor option 9-91
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Implicit int types option 9-95
Implicit narrowing option 9-89
Implicit pointer casts option 9-94
Implicit virtual option 9-91
Include preprocessor symbols 9-97
Junk at end of #endif/#else/#undef
option 9-94
Linkage conflicts option 9-95
Lower precision in wider context
option 9-88
macro definition 9-100
Member and base inits out of order
option 9-90
No warnings option 9-84
Non-ANSI header option 9-87
One ELF section per function 9-106
Other dubious casts option 9-94
Padding in struct option 9-87
Plain char is signed option 9-102
Read-only position independent
option 9-82
Read-write position independent
option 9-82
Software stack check option 9-81
suppressing error messages 9-92
Unused declaration option 9-86
Unused this in non-static member
function option 9-90
Warn for all conditions option 9-84
Zero-length arrays option 9-94
Compiling
one file 2-75
project 2-72
selected files 2-76
source files 2-76
speeding up 9-27
Compiling and linking
debugging 3-10
overview 2-72
preprocessing 2-77
removing object code 2-79
setting file extension 2-73
Synchronizing Modification Dates
2-76
Completion of symbol names 7-28
Configuring
Miscellaneous 9-155
the ARM assembler 9-53
the ARM compilers 9-72

the ARM Debugger 9-136
the ARM linker 9-108
the ARM Runner 9-153
Connect on Open (VCS option) 10-5
Connect (VCS operation) 10-10
Const checkbox
of New Data Member wizard 7-40
of New Member Function wizard
7-37
Constructor Parameters field, of New
Class wizard 7-34
Contents view (browser) 7-2
Contents window
browser 7-17
Controlling syntax highlighting withina
window §8-23
Converting ARM projects to Thumb
projects 2-30
Converting Executable image projects
to Library projects 2-34
Copy command 5-12, B-6
Copy message window to clipboard
3-20
Create New Group command B-12
Create New Target command B-12
Creating
build target dependencies 2-61
build targets 2-57
groups 2-43
interworking projects 2-27
libraries with armar 2-83
project stationery 2-35
ROMable output 2-34
Creating files 4-3
Cross-references option 9-70
Custom Keywords
coloring 8-23
Custom Keywords settings 9-134
Customizing
toolbars 8-37
Cut command 5-12, B-6
C/C++ Compiler Reference help
command B-23

D

Data column 2-7
Data directory 9-18

Data Member Declaration section, of
New Data Member wizard 7-39
Data members
declaring 7-39
viewing in browser 7-9
Data Members pane, in browser 7-10
Database Path (VCS option) 10-5
Dates
synchronizing modification dates
2-48
Debug column 2-7, 2-11, 3-6
Debug Info marker 3-6
Debug information
generating for single files 3-5
in the linker 9-119
Debug Menu B-15
Break on C++ Exception command
B-17
Break on Java Exception command
B-17
Clear All Watchpoints command
B-17
Clear Breakpoint command B-16
Clear Watchpoint command B-17
Disable Breakpoint command B-16
Disable Watchpoint command B-17
Enable Breakpoint command B-16
Enable Watchpoint command B-17
Hide Breakpoints command B-16
Kill command B-15
Restart command B-15
Set Breakpoint command B-16
Set Watchpoint command B-16
Show Breakpoints command B-16
Step Into command B-16
Step Out command B-16
Step Over command B-15
Stop command B-16
Switch To Monitor command B-17
Debug tables
assembler 9-64
compilers 9-97
including in fromELF output 9-131
Debugging
activating for source code 3-5
ADW remote debug warning 9-143
and optimization 9-96
configuring the debugger 9-135
controlling in projects 3-4
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enabling debug info 3-4
generating debug information 9-64
inline functions 9-98
loading symbols only 9-143,9-150
projects 3-4
using a third-party debugger 9-39,
9-137
Debugging a project 3-10
Declaration field
of New Data Member wizard 7-40
of New Member Function wizard
7-37
Declaration File field
of New Class wizard 7-32
Default Text File Format 8-19
Definition
of subproject 2-54, 2-67
Definition field
of New Data Member wizard 7-40
of New Member Function wizard
7-38
Destination file column (comparing and
merging) 4-22
Differences list (comparing and
merging) 4-22
Dimensions option 9-70
Directives, assembly language
RLIST 9-63
SETA 9-66
SETL 9-66
SETS 9-66
Dirty File marker 5-5
Disable Breakpoint command B-16
Disable Watchpoint command B-17
Disassemble command B-13
Disassembling code 2-81,9-131
Disconnect (VCS operation) 10-10
Display splash screen option (ADW)
9-143
Double to float option 9-89
Drag & Drop editing support 8-18
Dragging and dropping text 5-13
Dump internal browser information
option 9-39

E

Edit Menu B-5

Balance command B-7
Clear All Breakpoints command
B-16
Clear command B-7
Copy command B-6
Cut command B-6
Multiple Redo B-6
Multiple Undo B-6
Paste command B-7, B-8, B-9,
B-10, B-11, B-12
Preferences command B-7
Redo command B-6
Select All command B-7
Shift Left command B-7
Shift Right command B-7
Target Settings command B-8
Undo command B-6
Version Control Settings command
B-8
Editing code in the browser 7-29
Editor 5-1
adding text 5-11
balancing punctuation 5-14
basic navigation 5-10
color syntax 5-16
configuring 5-7
deleting text 5-11
drag and drop 8-18
font 5-7
font preferences 8-17
Go Back and Go Forward 5-21
go to line number 5-20
moving text 5-13
navigating text 5-17
opening related file 5-21
overview 5-2
panes 5-8
saving window settings 5-9
selecting text 5-12
text editing 5-10
text size 5-7
undoing changes 5-15
user interface elements 5-3
Editor Settings preference panel 8-15
ELF
converting to other formats 9-129
ELF output 9-111
Empty project stationery 2-13
Empty projects 2-13

Index

Emulated Clock Speed option (armsd)
9-148
Enable Breakpoint command B-16
Enable debug of inline functions option
9-98
Enable debug table generation option
9-97
Enable Watchpoint command B-17
Enabling debugging 3-4
End key 2-4
Enter Find String command 6-3, B-9
Enter Replace String command B-9
Entire Word option (Find and Replace)
6-5
Enum container always int option
9-102
Enumerations
as signed integers 9-102
Environment variable, in source trees
9-47
Equivalent Command Line 9-49
Error Button 3-14
Error messages 3-12
compilers 3-16
controlling 9-92
Error Reference help command B-23
Errors & Warnings Window command
B-20
Existing button
of New Class wizard 7-33
of New Member Function wizard
7-38
Exit command B-5
Expanding groups 2-44
Export Project command B-5
Exporting project as XML 2-23
Expressions Window command B-20
Extra Information Button 3-14

F

Factory Settings button 8-4, 9-11

FDI 8-10

File column 2-6, 2-11

File Control popup menu 2-11

File Control pop-up menu 2-9

File Locations section, of New Member
Function wizard 7-37, 7-40
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File Mappings 9-40
File mappings
selecting a compiler 9-43
File Menu B-3
Close All command B-4
Close command B-4
Exit command (Windows) B-5
Export Project command B-5
Find and Open File command B-3
Find and Open Filename command
B-3
Import Project command B-5
New command B-3
New Text File command B-3
Open Recent command B-3
Print command B-5
Print Setup command (Windows)
B-5
Revert command B-4
Save A Copy As command B-4
Save All command B-4
Save As command B-4
Save command B-4
File Path Caption 5-5
File Sets List 6-10
File view
Checkout Status column 2-9
Data column 2-7
Debug column 2-7, 2-11
File column 2-11
File Control pop-up menu 2-9
Interface pop-up menu 2-8, 2-11
Project Checkout Status icon 2-9
Target column 2-8
Touch column 2-8,2-11
Files
activating debugging 3-5
adding files to projects 2-38
adding to projects 2-39
assigning with the Project Inspector
2-59
assigning with the Target column
2-58
backingup 2-18
closing 4-16
comparing 4-21
comparing XML-formatted projects
4-28
creating 4-3

empty project 2-13
ignoring in build 9-44
items saved with projects 2-18
managing project files 2-37
merging 4-21
moving 2-45
naming 9-19
naming projects 2-15
opening 5-21
opening existing 4-3
opening project files from other
hosts 2-16
permissions
Checked out 10-8
Locked 10-8
Modify Read-Only 10-8
Read-Only 10-8
Unlocked 10-8
printing 4-18
project stationery 2-13, 2-14
removing 2-46
reverting to saved 4-20
saving 4-12
saving a copy of a project 2-18

saving in default text format 8-19

selecting 2-37
touching and untouching 2-47
Files view 2-5

Filtering members by access type 7-15

Find and Open File command B-3
Find and Replace
Batch option 6-5
Entire Word option 6-5
Ignore Case option 6-5
Regexp option 6-5
Wrap option 6-5
Find command B-8

Find Definition command 5-18, B-11

Find in Next File command B-9

Find in Previous File command B-9

Find Next command B-8

Find Previous command B-9

Find Previous Selection command
B-10

Find Selection command B-9

Finding

function overrides in browser 7-27

Finding and replacing text 6-2
Floating Document Interface 8-10

Floating Point option (Assembler) 9-55
Folders
comparing 4-21
merging 4-21
Font and Tabs panel, Preferences
window 8-19
Font Preferences 8-17
FPA option 9-55
fromELF 9-17, 9-108, 9-129
Include debug sections in output
option 9-131
Output format option 9-131
FTP Postlinker 9-17
Functions
describing name and location of
7-36
specifying file locations for 7-37,
7-40
virtual 7-27
Functions pop-up menu 5-17
Future compatibility warning 9-88

Generate Constructors and Destructors
checkbox, of New Class wizard
7-34
Generating debug information 9-97,
9-131
Get (VCS operation) 10-10
Give progress information while linking
option (linker) 9-121
Global Variables Window command
B-20
Glossary help command B-22
Go Back command B-11
limitations of 7-22
Go Forward command B-11
limitations of 7-22
Go To Line command B-11
Grouping files 2-42
Groups
creating 2-42
expanding and collapsing 2-44
moving 2-45
naming 2-43
removing 2-46
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removing with menu commands
2-46
selecting 2-37

H

Header file not guarded option 9-86
Header files
Non-ANSI header warning 9-87
non-ANSI include warning 9-87
opening 4-8,4-12
recursive searches 9-27
searching for 9-20, 9-21
Header Files pop-up menu 4-8, 5-21
Help Menu B-22
About Metrowerks command B-23
C/C++ Compiler Reference
command B-23
Error Reference command B-23
Glossary command B-22
How to command B-22
IDE command B-22
MSL C Reference command B-23
MSL C++ Reference command
B-23
Other command B-23
Hide Breakpoints command B-16
Hide Window Toolbar command B-24
Hierarchy expansion triangle 7-19
Hierarchy view, browser 7-3
History (VCS operation) 10-10
Home key 2-4
Host Flags option 9-35
How to help command B-22

IDE
about 1-2
available tools 1-2
browser 7-1
menu reference B-2
Preferences window 8-3
reference information B-1
IDE Extras preference panel 8-7
IDE help command B-22
IDE Preferences

discarding changes 8-4
opening 8-3
overview 8-2
saving changes 8-4
Identifier icon, in browser 7-11
Ignore Case option (Find and Replace)
6-5
Ignore C-style escape characters option
9-64
Ignored by Make flag 9-44
Ignored by make flag 9-44
Image
and fromELF 9-131
converting format 9-131
generating ROMable 9-129
including debug tables 9-131
layout 9-122
output section information 9-127
section placement 9-123
setting the entry point 9-121
specifying image structure 9-114
Image map option (linker) 9-125
Images, partial, simple, scattered 9-113
Implicit constructor option 9-91
Implicit int types option 9-95
Implicit narrowing option 9-89
Implicit pointer casts option 9-94
Implicit virtual option 9-91
Import Project command B-5
Importing project as XML 2-23
Include debug sections in output option
(fromELF) 9-131
Include debugging information option
(linker) 9-119
Include File Automatically Added For
Member Type field
of New Data Member wizard 7-40
Include files
searching for 9-20, 9-21
Include Files Automatically Added For
Return Type And Parameters
field
of New Member Function wizard
7-38
Include preprocessor symbols option
9-97
Inheritance
analyzing in browser 7-18
Inherited access icon 7-10

Index

Initial State option 9-57
Inline checkbox

of New Member Function wizard

7-37

Inline functions, debugging 9-98
Insert template commands 7-24
Instructions, assembly language

LDM 9-63

STM 9-64
Interface pop-up menu 2-8, 2-11, 2-48
Interrupt latency 9-102
Interworking

linker veneers 9-127
Interworking ARM and Thumb 9-81
Interworking projects, creating 2-27

J

Junk at end of #endif/#else/#undef
option 9-94

K

Keep Symbols option 9-64
Key bindings 8-30
Keywords, coloring 8-23
Kill command B-15

L

Label (VCS operation) 10-10
Latency, interrupts 9-102
Launchable flag 9-43
LDM instruction 9-63
Libraries

and the ARMLIB environment

variable 9-120

creating with armar 2-83
Line button in hierarchy window 7-19
Line Number Button 5-6
line number, going to  5-20
Link information 9-127
Link Order view 2-9
Link order, setting 2-78
Linkage conflicts option 9-95
Linker
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and file mappings 9-41

configuring 9-110

fromELF 9-17,9-108

FTP Postlinker 9-108

Give progress information while
linking option 9-121

Image map option 9-125

Include debugging information
option 9-119

Mangled C++ option 9-125

options 9-16
Symbols 9-125

Output local symbols option 9-120

Partial option 9-113

prelinker 9-17

Remove unused sections option
9-118

Report "might fail" conditions as
errors option 9-121

RO Base option 9-114

RO section base address 9-114

Ropi option  9-115

RW Base option 9-114

Rwpi option 9-115

Scattered option 9-113

Search standard libraries option
9-120

Section cross-references option
9-126

selecting 9-9, 9-16

Sizes option 9-127

specifying image entry point
Entry point, configuring 9-121

Split Image option 9-116

symbols
mangled names 9-125
used in link step 9-125

Symbols option 9-125

Totals option 9-127

undefined symbol resolution 9-128

undefined symbols 9-129

unresolved symbols 9-129

Unused option 9-127

Use ARMLIB tofind libraries option
9-120

Veneers option 9-127

via files 9-128

Listing
Page settings 9-70

Listing on option 9-69

Listings 9-127

Load configuration option (armsd)
9-151

Local Path (VCS option) 10-5

Local symbols in liinker output 9-120

Lower precision in wider context option
9-88

Lower precision warning 9-88

M

Macros, defining 9-100
Main Text Color 8-16, 8-23
Make command B-13
Makefile Importer 2-19, 2-21
Makefile Importer Wizard 2-20
Makefiles
converting to projects 2-19, 2-21
Managing files in a project 2-37
Mangled C++ option (linker) 9-125
Markers 5-19
adding 5-19
removing 5-20
Markers Pop-up Menu 5-4
MDI 8-10
Member and base inits out of order
option 9-90
Member Fucntion Declaration section,
of New Member Function wizard
7-36
Member functions
specifying file locations for 7-37,
7-40
viewing in browser 7-9
Member Functions pane, in browser
7-10
Merging files and folders 4-21
Message List Pane 3-15
Message Window
command B-20
error and warning messages 3-12
stepping through messages 3-16
Message window
copying to clipboard 3-20
printing 3-19
saving 3-20
Messsage window 3-12

Method option 10-4
Minimize Window command
(Windows) B-19
Modification dates, synchronizing
2-48
Modifiers section
of New Data Member wizard 7-40
of New Member Function wizard
7-37
Moving
files and groups 2-45
projects 2-22
Multi-class hierarchy, browser 7-18
Multi-File Search Disclosure triangle
6-4
Multi-ICE
and armsd 9-148
script file 9-145
session information 9-145
targeting in ADW 9-141
Multi-ICE support option (ADW)
9-145
Multiple build targets and subprojects
2-53
Multiple Document Interface 8-10
Multiple redo B-6
multiple Redo command 5-16
Multiple undo B-6
Multiple Undo command 5-16
Multi-user projects 2-51
Mutable option, of Specifier pop-up
menu 7-40

N

Name and Location section, of New
Class wizard 7-32,7-36
Name field
of New Data Member wizard 7-39
Namespace field
of New Class wizard 7-33
Namespaces Required For Parameters
field
of New Member Function wizard
7-37
Navigating
code in the browser 7-25
Project window 2-4
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through code in the browser 7-25
Navigation
editor window 5-10
New button
of New Class wizard 7-33
of New Member Function wizard
7-38
New Class Browser command B-20
New Class command 7-31, B-17
New Class wizard
Access pop-up menu  7-34
After option 7-33
Base Classes and Methods section
7-33
Base Classes field 7-33
Before option 7-33
Class Name field 7-32
Constructor Parameters field
Declaration File field 7-32
Existing button 7-33
Generate Constructors and
Destructors checkbox 7-34
Name and Location section 7-32,
7-36
Namespace field 7-33
New button 7-33
Targets section 7-35
Use separate file for member
definitions checkbox 7-33
Virtual destructor checkbox 7-34
New command B-3
New Data Member command 7-31,
B-18
New Data Member wizard
Additional Header Include Files
7-41
Const checkbox 7-40
Data Member Declaration section
7-39
Declaration field 7-40
Definition field 7-40
Include File Automatically Added
For Member Type field 7-40
Modifiers section 7-40
Name field 7-39
Type field 7-39
Volatile checkbox 7-40
New Event Set wizard
Set button 7-32, 7-33

7-34

New Member Function command
7-31, B-17
New Member Function wizard
Additional Header Include Files
7-38
Const checkbox 7-37
Declaration field 7-37
Definition field 7-38
Existing button 7-38
File Locations section 7-37, 7-40
Include Files Automatically Added
For Return Type And Parameters
field 7-38
Inline checkbox 7-37
Member Function Declaration
section 7-36
Modifiers section 7-37
Namespaces Required For
Parameters field 7-37
New button 7-38
Parameters field 7-36
Return Type field 7-36
New Project command 2-14
New Text File command B-3
No Warning option (Assembler) 9-64
No warning option (Compilers) 9-84
Non-ANSI header option 9-87
Non-ANSI include warning 9-87
None option, of Specifier pop-up menu
7-40

O

Object output 9-18
One ELF section per function 9-106
Only load symbol information option
(ADW) 9-143
Open command 2-15
Open Recent command 2-16, B-3
Open recent command 2-16
Open Recent Menu  8-8
Opening
a project 2-15
project files from other hosts 2-16
source files with the browser 7-29
Opening files 4-3
Opening subprojects 2-16
Optimization

Index

compiler options 9-98
configuring 9-96
for space or time 9-99
Options
browser display 8-14, 8-16, 8-20,
8-22
Build Extras 9-36
Build target settings 9-13
Custom Keywords panel 9-133
Editor settings 8-15
IDE extras 8-7
key bindings 8-30
overview 8-2
setting in browser 7-6
syntax coloring 8-23
Options Pop-up Menu 5-4
Other dubious casts option 9-94
Other help command B-23
Output
configuring 9-111
from fromELF 9-132
Output Directory 9-18
Output format option (fromELF) 9-131
Output local symbols option 9-120
Overrides, finding 7-27

P

Padding inserted in struct option 9-87

Padding inserted in structure warning
9-87

Page Down key 2-4, 5-11

Page size for assembler listings 9-70

Page Up key 2-4

Pane Resize Bar 3-15

Pane Splitter Controls 5-5

Pane zoom box, of Browser window
7-9

Panes, in editor window 5-8

Parameters field

of New Member Function wizard

7-36

Partial option (linker) 9-113

Partially linked objects 9-111

Paste command 5-12, B-7, B-8, B-9,
B-10, B-11, B-12

Performance

reducing compile time 9-27
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Performance reducing build time
Cache subprojects option 9-38
Perl scripting  A-1
with IDE plug-in API A-7
Perl software plug-ins
installation A-2
Perl target settings panel
configuring A-4
PIC 9-61,9-82,9-115
PID 9-61,9-82,9-115
plain binary images 9-129
Plain char is signed option 9-102
Plugin Diagnostics 8-10
Port selection (ADW) 9-142
Port Specification option (armsd)
9-149
Position-independent 9-61, 9-82
code 9-82,9-115
data 9-82,9-115
Postlinker
selecting 9-9
Precompile command B-13
Precompiled flag 9-43
Predeclared Register Names option
9-60
Predefined macros 9-100
Preferences command B-7
Preferences window 8-3
Prefix key
Quote Key 8-32
timeout §8-31
Preprocess command B-13
Preprocessing code 2-77
preprocessor 2-77
Previous target option (ADW) 9-141
Print command B-5
Print Selection Only 4-19
Print Setup command (Windows) B-5
Printing
message window 3-19
window 4-18
with syntax coloring 4-19
Private option, of Access pop-up menu
7-40
Processes Window command B-20
Project Checkout Status icon 2-9
Project Information Caption 3-14
Project Inspector 2-59
Project Inspector command B-20

Project Menu B-12
Add Files command B-12
Add Window command B-12
Bring Up To Date command B-13
Check Syntax command B-12
Compile command B-13
Create New Group command B-12
Create New Target command B-12
Disassemble command B-13
Make command B-13
Precompile command B-13
Preprocess command B-13
Remove Binaries command B-14
Remove Object Code command
B-14
Re-Search for Files command B-14
Reset File Paths command B-12
Reset Project Entry Paths command
B-14
Run command B-15
Set Current Target command B-15
Set Default Project command B-15
Stop Build command B-13
Synchronize Modification Dates
command B-14
Project Relative Path  9-31
Project stationery 2-13, 2-24, 9-6
creating 2-35
Project structure 2-2
Project window 10-7
Checkout Status column 2-9
Data column 2-7
Debug column 2-11
File column 2-11
File Control pop-up menu 2-9
guided tour 2-4
Interface pop-up menu 2-8, 2-11
Link Order view 2-9
navigating 2-4
Project Checkout Status icon 2-9
Target column 2-8
Targets view 2-12
toolbar 2-4
Touch column 2-8,2-11
Project (VCS operation) 10-10
Projects
about project stationery 2-24
activating debugging 3-4
adding files 2-38, 2-41

backing up 2-18

Build target settings 9-13

build targets 1-2

building 2-15, 2-72

choosing stationery 2-14

closing 2-17

compiling 2-72,2-76

converting makefiles 2-19, 2-21

copying language settings between
9-49

creating groups 2-42

debugging 3-10

defined 1-2

empty project 2-13

expanding and collapsing groups
2-44

grouping files 2-42

items saved with 2-18

managing files 2-37

moving 2-22

moving around 2-4

moving files and groups 2-45

multi-user 2-51

naming 2-15

new 2-14

opening project files from other
hosts 2-16

output directory 9-9, 9-18

removing files and groups 2-46

renaming groups 2-43

revision control 2-9

running 3-10

saving 2-18

saving a copy 2-18

selecting files 2-37

selecting files and groups 2-37

selecting groups 2-37

setting link order 2-78

stationery 2-13

subproject definition 2-54, 2-67

switching between 2-15

synchronizing modification dates
2-48

updating 2-76

Properties (VCS operation) 10-10
Protected option, of Access pop-up

menu 7-40
Public option, of Access pop-up menu
7-40
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Pure-endian softfp option 9-55

Q

Quote Key prefix 8§-32

R

Read-only position independence
9-115

Read-only position independent code
option 9-61

Read-only position independent option
9-82

Read-write position independence
9-115

Read-write position independent code
option 9-61

Read-write position independent option
9-82

Recent Documents  8-8

Recent Projects  8-8

Recent Strings pop-up menu 6-5

Recompiling files 2-76

Recursion (VCS operation) 10-10

Recursive search of access paths 9-27

Redo command B-6

Regexp option (Find and Replace) 6-5

Registers Windows command B-21

Registry key, in source trees 9-47

Regular expressions 6-15

Relative access paths 9-31

Relative paths 9-19

Remember options, Preferences
window 8-17

Remote debugging warning (ADW)
9-143

Remove a file set command 6-13

Remove Binaries command B-14

Remove Object Code command B-14

Remove unused sections option (linker)
9-118

Removing

files and groups 2-46

Removing a marker 5-20

Removing access paths 9-34

Replace All command B-10

Replace & Find Next command B-10

Replace & Find Previous command
B-10

Report "might fail" conditions as error
option (linker) 9-121

Re-Search for Files command B-14

Reset ADW registry settings option
(ADW) 9-143

Reset File Paths command B-12

Reset Floating Toolbar command B-24

Reset Project Entry Paths command
B-14

Reset Window Toolbar command B-24

Resize bar, in browser 7-9

Resource file flag 9-43

Restart command B-15

Restore Window command (Windows)
B-19

Return Type field

of New Member Function wizard

7-36

Revert command B-4

Revert Panel button 8-4

Revert panel button 9-11

Revert to most recent saved copy of file
4-20

Revision control systems 2-9

RLIST directive 9-63

RO Base option (linker) 9-114

ROM images 9-129

ROPI 9-61,9-82,9-115

Ropi option (linker) 9-115

Routine pop-up menu 5-17

Run command B-15

Running a project 3-10

Running batch files 9-17

Running image files 9-153

Runtime settings panel 9-40

Run/Debug button 3-2

Run/Debug button, configuring the
Runner 9-153

RW Base option (linker) 9-114

RWPI 9-61, 9-82,9-115

Rwpi option (linker) 9-115

Index

S

Save A Copy As command 2-18,4-15,
B-4
Save All command B-4
Save As command 4-14, B-4
Save command B-4
Save Default Window command B-19
Save Project Entries Using Relative
Paths option 9-19
Save this File Set command 6-12
Saving
a copy of a project 2-18
all files 4-13
backup copies of files 4-14
files automatically 4-13
items saved with projects 2-18
message window 3-20
projects 2-18
Scatter loading 9-111, 9-113
Scattered option (linker) 9-113
Script file option (armsd) 9-151
Scripting
using Perl A-1
Search Menu B-8
Compare Files command B-11
Enter Find String command B-9
Enter Replace String command B-9
Find command B-8
Find Definition B-11
Find in Next File command B-9
Find in Previous File command B-9
Find Next command B-8
Find Previous command B-9
Find Previous Selection command
B-10
Find Selection command B-9
Go Back command B-11
Go Forward command B-11
Go To Line command B-11
Replace All command B-10
Replace & Find Next command
B-10
Replace & Find Previous command
B-10
Search Menu Find Selection command
B-9
Search paths
source tree relative 9-32
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Search standard libraries option (linker)
9-120
Searching 6-3
find and replace 6-8
for selected text 6-3
for selection 6-3
through multiple text files 6-12
Section cross-references option (linker)
9-126
Section elimination 9-127
Section placement, in the linker 9-123
Select All command B-7
Select configuration option (armsd)
9-151
Selected text search 6-3
Selecting text in the editor 5-12
Selection
by keyboard 2-37
by mouse-clicking 2-37
finding 6-3
printing 4-19
Selection Position 8-17
Seleting ARM debugger and ARM
runner 3-2
Session information (ADW) 9-145
Set Breakpoint command B-16
Set button
of New Event Set wizard 7-32, 7-33
Set Current Target command B-15
Set Default Project command B-15
Set Watchpoint command B-16
SETA directive 9-66
SETL directive 9-66
SETS directive 9-66
Setting
options in browser 7-6
Setting current build target 2-55
Setting link order 2-78
Shift Left command B-7
Shift Right command B-7
Show Breakpoints command B-16
Show Catalog Window command B-19
Show Floating Toolbar command B-24
Show Global Toolbar B-24
Show Inherited checkbox 7-10
Show Private command 7-15
Show Protected command 7-15
Show Public command 7-15

Show Window Toolbar command
B-23
Single-class hierarchy, in browser 7-18
Sizes option (linker) 9-127
Softfp option 9-55
Software stack check option 9-81
Software stack checking option 9-62
Sort function popup, Preferences
window §8-18
Source code
activating debugging 3-5
Source Code Disclosure Triangle 3-15
Source Code Pane 3-15
Source file column (comparing and
merging) 4-22
Source files
compiling 2-76
opening with the browser 7-29
Source Line Debug option 9-64
Source pane, in browser 7-11
Source Tree Relative option 9-32
Source tree relative search paths 9-32
Source trees 9-45
Special opterators (regular expressions)
6-15
Specifier pop-up menu
Mutable option 7-40
None option 7-40
Static option 7-40
Split image option (Linker) 9-116
Stack checking 9-62, 9-81
Stack command B-18
Standard C++
and error messages 9-92
Standard libraries 9-120
Static option, of Specifier pop-up menu
7-40
Stationery 2-24
creating 2-35
project stationery 2-14
Stationery, project 9-6
Status area
of browser 7-12
Status (VCS operation) 10-10
Step Into command B-16
Step Out command B-16
Step Over command B-15
Stepping Buttons 3-15
STM instruction 9-64

Stop at EOF option 6-11
Stop Build command B-13
Stop command B-16
Subproject
definition 2-54,2-67
Subprojects
opening 2-16
Switch To Monitor command B-17
Symbol colours 7-6
Symbol name completion 7-28
Symbol window, in browser 7-27
Symbols
linker 9-125
loading into armsd 9-150
undefined 9-129
Symbols file option (armsd) 9-150
Symbols option (linker) 9-125
Synchronize Modification Dates
command B-14
Synchronize Status (VCS operation)
10-10
Synchronizing
modification dates 2-48
Synchronizing modification dates 2-48
Syntax Coloring
and printing 4-19
preference panel 8-23
Syntax Coloring, Preferences window
8-22
Syntax coloring, table of 8-23
System header files
search paths 9-20
System paths  9-20, 9-21
System Paths Pane 9-20
System Relative Path 9-32

T

Target column 2-8, 2-58
Target name 9-15
Target Name option 9-15
Target name, changing 9-9
Target processor (armsd) 9-148
Target Settings command B-8
Target Settings panel 9-14
Targets
copying language settings between
9-49
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creating build targets 2-57
Targets section
of New Class wizard 7-35
Targets view 2-12
of Project window 2-12
Terse option 9-69
Text
drag and drop of 5-13
Text Editing Area 5-6
Text replacing
in multiple files 6-8
Replace All 6-6
replacing found text 6-6
single file 6-3
Text search
activating multi-file search 6-8
batch search 6-6
choosing file sets 6-13
controlling range 6-5
for selection 6-3
multiple file 6-8
regular expressions 6-15
text search
finding text 6-5
Thumb
ARM/Thumb interworking veneers
9-127
interworking with ARM 9-61, 9-81
specifying initial state 9-57
Thumb ARM interworking stationery,
using 2-27
Tile command B-18
Tile Vertical command B-18
Toolbar Disclosure Button 5-6
Toolbar Submenu B-19, B-23
Clear Floating Toolbar command
B-24
Clear Window Toolbar command
B-24
Hide Window Toolbar command
B-24
Reset Floating Toolbar command
B-24
Reset Window Toolbar command
B-24
Show Floating Toolbar command
B-24
Show Window Toolbar command
B-23

Index

Toolbar (comparing and merging) 4-22 \/

Toolbars
adding elements 8-39
customizing 8-37
elements 8-37
modifying 8-38
Project window toolbar 2-4
removing elements 8-41
showing and hiding 8-38
window toolbar 8-38
Tools Submenu B-23
Totals option (linker) 9-127
Touch column 2-8, 2-11, 2-47
Touch command 2-48
Touching files 2-47
Type field
of New Data Member wizard 7-39

U

Unapplying a difference 4-25

Undo Checkout (VCS operation) 10-10

Undo command B-6

Untouching files 2-47

Unused declaration option 9-86

Unused option (linker) 9-127

Unused section elimination 9-118

Unused this in non-static member
function option 9-90

Updating projects 2-76

updating projects 2-76

Use ARMLIB to find libraries option
9-120

Use modification date caching option
9-37

Use separate file for member definitions
checkbox

of New Class wizard 7-33

Use third party debugger option 9-39

Use Third Party Editor 8-9

Use this script option (ADW) 9-145

Use Version Control option 10-4

User paths 9-20

Username field 10-4

Using the Thumb ARM interworking
stationery 2-27

Variables (VCS operation) 10-11
VCS Message window 10-12
VCS Pop-up menu 10-11, 10-12
VCS Setup panel 10-3
Veneers option (linker) 9-127
Version Control pop-up menu 5-5
Version Control Settings command
B-8
Version Control Settings (VCS option)
10-4
Version Control System (VCS)
file permissions
Checked out 10-8
Locked 10-8
Modify Read-Only 10-8
Read-Only 10-8
Unlocked 10-8
Menu B-21
menus
VCS Pop-up menu 10-11
operations
About 10-10
Add 10-10, 10-12
Checkin 10-10, 10-12
Checkout 10-10, 10-12
Comment 10-10
Connect 10-10
Disconnect 10-10
Get 10-10, 10-12
History 10-10
Label 10-10
Make Writable 10-12
Project 10-10
Properties 10-10
Recursion 10-10
Status 10-10
Synchronize Status 10-10
Undo Checkout 10-10, 10-12
Unlock 10-12
Variables 10-11
windows
Project window 10-7
VCS Message Window 10-12
VFP option 9-55
Via files
compiler 9-106
linker 9-128
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via files
assembler 9-70
View
class or member declarations 7-25
function definitions 7-26
member functions and data members
in browser 7-9
View As Implementor command 7-15
View As Subclass command 7-15
View As User command 7-15
Views 2-5
Views, browser 7-8
Virtual destructor checkbox
of New Class wizard 7-34
Virtual function overrides 7-27
Volatile checkbox
of New Data Member wizard 7-40

W

Warn about remote debugging option
(ADW) 9-143
Warn for all conditions option 9-84
Warning Button 3-14
Warning messages, compilers 3-12
assignment operator 9-85
bitfield type 9-85
configuring 9-83
double constants automatically
converted to float 9-89
future compatibility 9-88
implicit constructor 9-91
implicit narrowing cast 9-89
implicit virtual 9-91
lower precision 9-88
member and base inits out of order
9-90
non-ANSI include 9-87
padding inserted in structure 9-87
unused this 9-90
Watchpoints Window command B-21
Wildcard searching 6-15
Window Menu B-18
Breakpoints Window command

Build Progress Window command
B-20
Class Hierarchy Window command
B-19
Errors & Warnings Window
command B-20
Expressions Window command
B-20
Global Variables Window command
B-20
Minimize Window command
(Windows) B-19
New Class Browser command B-20
Processes Window command B-20
Project Inspector command B-20
Registers Windows command B-21
Restore Window command
(Windows) B-19
Save Default Window command
B-19
Show Catalog Window command
B-19
Stack command B-18
Tile command B-18
Tile Vertical command B-18
Toolbar submenu B-19
Watchpoints Window command
B-21
Zoom Window command B-19
Window Position and Size 8-17
Window Toolbar 8-38
Windows
class browser 7-8, 7-12
help B-22
Help Menu B-22
Project window Link Order view
29
Project window navigation 2-4
Project window Targets view 2-12
Project window toolbar 2-4
Wrap option (Find and Replace) 6-5

X

XML- formatted projects,
comparing 4-28

y4

Zero-length arrays option 9-94
Zoom Window command B-19

B-20 XML
Browser Catalog Window command comparing files 4-28
B-19 importing and exporting as 2-23
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